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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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1.4

1.41

When you invoke the application, the Sign In screen is displayed.
ORACLE: O

Financial Services Lending and Leasing

sign In

Please enter userid and password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
e Left Pane
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e Right Pane/Work Area

ORACLE"
Financial Services Lending and Leasing

DashBoard
4 Dashgoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WP

> Tools

> Setup

You can view the application version details and copyright information by clicking About link
at the right corner of the screen.

About

Orack Finandal Services Lending and Leasing 14.3.1.0.0
Buld OFSLL_14.3.1.0.0_B253.

Copyright © 1885,2017, Oracie andior fs affistes. Al ights reserved.

Oracke and Java are registered trademarks of Oracke andior s af filates. Other names may be trademarks of thei respective owners.

property laws. Except as expressly perited in your cense agreement or alowied by law, you may not use, copy, reproduce, ranslate, broadcast, medify; liense,
transmt, distribute, exhibd, perform, publish or display any part in any form, o by any means. Reverse engineering, disassembly, or decomplation of tis software,
unless required by law for nteroperabilly,is prohibted.

The information is subject Ifyou find any errors, please report them o us in wriing.

that US. Government or behalf of the U S. Govemment, the following notice s
appicatle:

U.S. GOVERNMENT END USERS: g tem, any hardware, andior
documentation, deliveredto U.S. - Jation and agency-
‘specific supplemental reguiations. As Such, use, duplication, disclosure, modificaton, and adaptation of the: programs, inchuding any operating system, infegrated
software, any programs installed on the hardware, and/or documentation, shal be Subject o icense terms and icense restrictons applicable to the programs. No
other rights are granted to the U.S. Government

hardware is ger na variety r use in any inherently
dangerous applications, including appiications that may create a risk of personal inury. i you use this software or hardware in dangerous applications, then you shal
be responsibe totake all appropriate faisafe, backup, redundancy,
liabity for any damages caused by use of this Software or hardware in dangerous appiicafions.

ey informaton on content, products and services from thrd parties. Orack Carporaton and fs
y respec o thid-party content poducts, and servioes. Oracie Corporation and

ts affiiates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.

[ Dose

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

ibility [ SIGMOUEIOA]

Change Password

m  UserInfo 3]

— Change Password — Click to change the current password.
=~ A [ e O

oot
L v

-

e

El!il
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Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone |JSER TIME ZONE ¥
Division U301 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDVA Company US/CENTRAL (CENTRAL STANDARD
) i Branch Time TIME)
Responsibility SUPERUSER S
GLPost Date 02/10/2016 Server Time  ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT v Skin Family Skyros (Default) v

Debug Enabled Ind

|_—|5 Submit | 3% Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.
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You can click on := List Files button to view the list of logged files.

ORACLE’
Financial Services Lending and Leasing

DashBoard 3 System Monitor [3] Close
Batch Jobs = Jobs | Services Database Server Log Files  Parked Transactions | Users o~
Database Server Log Files
View v Format~ Freezz i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 fob 5706 02/18/2016 06:14:11 A) »
ALERT lob 395 02/22/2016 03:59: 15 A_|
CSYPRC_EN_100_01_DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP =
CSVPRC_EN_100_01 DB12C_3854338 lob 116750 02/22/2016 05:36:42 AP
JSYPRC_EN_000_01_DB12C_2094362 lob 5706 02/18/2016 10:57:09 AP -
e - e :
v
File Content
View * Format v Freeze  CfiDetach ol Wrap B} ©Begring@End #oflines 50 [E] Show File

Text

: 45:FLL:1lv_use BI::Y [

: cmnsyp cl D00 0l.get syp pazemeter value value: weblogic

.get_syp parameter value value: http://ofss2221142.in.oracle.com:.

.get_syp_parameter_value valus: http://ofss2221142.in.oracle.com:

.get_sSyp parameter value parameter:

J5V_BI_USER
J5V_REPORT_ARCHIVE_DIRECTORY
: cmnsyp_cl_D00_01l.get_syp_parameter wvalus parameter: JSV_REPORTS_SERVER TIMECUT

11: cmnsyp_cl_000_0l.get_syp paramet alue parame

.get_syp_parameter value value: /scratch/work area/DEV/QA143REL/r.. |

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of
this user manual.

Click Submit to save the changes or Close to close the screen without changes.
e Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.
e Sign Out — Click the link to sign off from the application. You can also click on
icon to sign off from the application.
Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click > to expand the Module Master Tabs and < to collapse them.

» DashBoard
> Origination
Servicing
Eles 5
Customer Service Il
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions

m

Account Documents d
Collateral Management |
Reparts
Producers
vendors
Batch Transactions
Interfaces
AP Transactions
GL Transactions -
> Collections
> WFP
» Tools

> Setup
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To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is
displayed in the main window/work area.

ORACLE’
Financial Services Lending and Leasing

A @8 | Access x (0 Gose
Appication Retrieval(Origination) Data Scesn Reports | Correspondence  Transaction
Appiication Documents (Crigination)
Asset Types(setup Products) Access Grid Fpadd || ZEdt || [Fvien || At
, )
Account Documents(Serviding) vew~ Fomat~ | & Freeze ] Detach wrap )
Access(setup User)
o s o QOrganization Division Company Branch Allowed
‘rsnssc retsenieng inirfces) R R AL AL ¥
Application Entry(Origination) oG i AL ALL ¥
Audit Tables{setup System) c K AL AL ¥
Advances(Servicing Batch Transactions) e P04 AL AL \

> Origination
> Servicing
> Collections
> WEP

» Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through
the module from which the screen is accessed which is indicated in angular brackets. For
example typing 'VEN' displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

RACLE
Financial Services Lending and Leasing

Sales Lead x Close
> DashBoard s cedt -

/Le;aknl’l’v Follow-Up | Maintenance

Applicant Information a0 | P | Elwew || & avoe
v - Freez =p ]
anch R ary
i1+ Haws unco:
o o [ prvon
L-00003002 121772015 usra o1/01/1997 w HorE BoTHEL
L-o0o02002 127127201 usiia 10/10/1302 consuLTATION 1ot TRvINE
L-o0002004 12/12201 usii 12/03/1370 =l ot Junco!
L-o0o0co02 02/02/2010 usiia 077251300 CONSULTATION  OFTLINC APPLICA... 1I0ME ADD1 o
L 00001001 12/19/2015 usko o8/06/1980 consuLTATION = HowE LEAD e Lotza
L ooooso2 122372015 usko sam san 112372901 oHERS Wes ENTRY HowE UNITEDSTATES 123 ronce
ts || Request
b add |[ P oo || Elview || o avde
Feee i Detac @
Te Phone Current
CAR/MOBILE PHONE (0045323823 ¥
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You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

ORACLE"
Financial Services Lending and Leasing
5

2 Edt || Blview || 2 avsie
i octach

AUL/ PAULA 02/03/2016 crianceD orF cRroR v 02/09/2015 UNDEFNED
20100100014000:000 SULGAN c2/0a/2010 Criareco orr chror VeRouTIL o2/0v/201c UNpErIED
vetach wee | @
Velus Srriz
osiosr0te v

> Collections.

> Tools

> sctup

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

Few screens in WFP are identical and are linked. Hence, when multi tab option is not enabled,
you can open only one screen at a time from the group. A sample of the grouping structure is
given below, based on stages of the screens:

WFP:

e Producers
e Credit Lines
e Units

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and F to toggle the view of Right Splitter/Action Window.

Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

ORACLE' i &, Welcome, AVAIDYA + ccesiity =)
Financial Services Lending and Leasing

rigination x Close:
> DashBoard ki =
origination Search/Tack | Funding: 0000000378 | Review Requests (Pending: 0) -
Quick Search
origi -
n: 0000000378: TIFFANY RUSSEL / GRACE B view [ <2 audt
B ([l Freeze ffiDetach wap @) Overide ok v v
o nops subune status — o R conne | ([ %
% Application (B submt || @ dlear
o1josf20i2 0000000378, UNGEFINED APPROVED-FUNDED  FUNDED GA-000D4 : ADVANCELER... . N N
, Summary
Requested  Approved
Advance 1500000 1500000
Summary | Applicant | Request || Decision | Contract || Collateral | Comments || Tracking || Document || Verffication | Correspondence || Toals Fate £.0900 as00
Tem 3 E
> Applicant Grade  DGRADE  Score 0
v 1000 15000
Stated PTI954 Stated After DTI58.92
g AT 10000 i 0
2012 CHEVROLET MONTE CARLO
z 200
> Bureau
Quese FUNDED APPLICATIONS QUELE
b Checklist Change Status
Status APPROVED - FUNDED
Collateral Change Status
Collateral Add Comment
Asset Type SubType Primary  Vear Vake Vodel Mileage New Wholesale Value
> Servicing veHicLE car v w2 cHEVROLET MONTE CARLO on 10,000.00
> Collections =
S WER Trade T
> Tools
b Setup Trade-In = =
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Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.

For detailed information on the above options, refer to respective sections in the
document.

Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:

ORACLE
Financial Services Lending and Leasing

Company
jusoz.

Summary

Alerts
ert

Dues

Account(s): 20170100010097:
P B

Alerts

Nodstato

Account Details

09302017
.03

Definquency In

Den

& st

 Current © Show A1 O Group ol

Efoen - @ &
st
ueene

Branch
st

DaysPast Due Cusrency Pay OFf Amt

158155

Amount e Status OldestDue Dt

290,21 [EREETED) 21072017

DQResson

Product
2170100010057 | LOANVEHIGLE () isTPAMENTOR.

Bownt| Qoo

=

Colectons || Customer Servce || AccountDetals | Customer Detats | Customer references | Transacton Hstory || Pt Hodes || Barknptcy <idency || Colateral | Burea

rossUp Sel Acvites || Extema Interfoces

[ ecnt
Condiions
AcauntCodion
rerossession
vanaer o

Condiion StartDt  Folowp Dt 1 .
Bl [ Biteed Accaunt

o8/
w1807

dspiay.

Add Comment
*Type REGUAR
*siTye

Other Information Comment

Collateral Informati
os/0/2017 os/02017 pravey
5003 s50.12 v

o717
5003

o6fs0/2017
50,03

o ssetCass  AssetType

e sbType
BAPHSGURTES2 05 NEW wicE  oe

Desas
2005 CHEVROLET MONTECARLO 20R

Customer Information B restconment | | @ Clear
CHSEETE ame Relaton s National D Bithot Gender

Add Call Activity

o ot 0zj10/m17 T B

PRORY

o3fas/ises

=
=
=
=

ot o2j10017

000000, MADHAN ORACLE ooz -0

1 Cotegory Days L COM
W

Collecor DEMOCOLL

yyyyyyyy

Tyee Malng  Address

W v v Y TaSneworkMA30®

Employment Information

Erestcaiacoiy | | oo

Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking ‘Next Account’ button opens the subsequent account listed in search and
clicking ‘Filtered Account’ opens the subsequent account fetched during a queue search
and listed in Queue Assignment section.

Use Add Comment section to post an alert or comment based on Type and Sub Type.

Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.
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The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click ==u to toggle upper pane and j to toggle left
pane. To un-toggle click == and |: respectively.

Time Zone Preference

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone  USER TIME ZONE v
Division US01 Level
First Name VARSHA User Time Zone  UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD

Branch Time  TIME)
Responsibility SUPERUSER AR

Sii-Bost Lste- A1 020G Server Time  ASIA/CALCUTTA (INDLA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)

Session Language DEFAULT b Skin Family Skyros (Default) »

Debug Enabled Ind

Dh? Submit || 3% Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e In the Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone'is selected as the time zone in User Info screen, then on save,

all the time and date fields are automatically updated with the time zone of the company
branch.
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1.4.2

1.5

1.5.1

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.

To modify the User Time Zone:

e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service x [®cle

‘Sta\(h Customer Service: 20120200010231 Pewe.uREqu:l(Pendmg:U)‘

Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE Elview | o Audt

Views Format~ [ Freeze i Detach op | G & © Current © ShowAll O Group Follow-up
Company Branch Sub Unit Account * Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
us01 UsR1 UNDEFINED 20120200010231  LEASE VEHICLE 0 usD 0.00 0.00 ACTIVE 02/10/2015

‘Eunr\'al‘f KCustomer Service | Account Details || Customer Details | Transaction History | Pmt Modes = Bankruptcy | Repo/Foreclosure | Deficiency = Collateral = Bureau C\u::QLDSE\\lft\‘y'\IIE:‘

‘Ca“ﬁdivilies Maintenance = Comments = Promises | Checlists = Tracking Attributes = References = Correspondence | Letters = Document Tracking

Call Activities Fpadd | ZEit | [Fview | o audt
View= Formatv [ Freeze ] Detach Wrap ®
Adtion Result Contact Resson Cancel Promise Dt Promise Amt Condition Appointr Followup Dt Time Zone Adi Follovup Dt Cor
AT o ANSWERING MACHINE N 12300015 1,000.00 NONE N 102085 12/29/201512:30:00 P
AT PH ANSWERING MACHINE N 123002015 1,000.00 NONE N 12302015 12/29/201512:30:00 PH

»

You can click # to view the hidden tabs, if any.

Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.

e Basic Operations
e Basic Actions
e Personalization Options

Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
o Edit
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1.5.2

e View
) Audit

P Add

& Edit

E] view | < Audit

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation

Description

Add

Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with “’ symbol.

Edit

Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View

Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit

Click to view audit info. If an audit is set for a field, then the system
tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close

Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

4 save and Add

[ save and stay

[ save and Return

<3 Return

The table below gives a snapshot of them:

Basic Actions

Description

Save And Add

Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay

Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return

Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return

Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.
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The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Basic Actions Description

Click to navigate to the first record.

Click to navigate to the previous record.

= [F[E

Click to navigate to the next record.

Click to navigate the last record.

A

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|ﬂr Download File - Click to download the details of selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|“FlieWY Format « % Freeze HEDetach o] hirap E’ﬂl
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The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View’.

M Format ~ | [&p Freeze pfiDetach

LI b showal
| Freez= + Product |
Detadh + Description ,
#ork » ¥ StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

Format Click to resize columns or wrap a data in the table cells.
| e
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column = I

Column DESCRIPTION

width | 100 ] [pixels [=]
OK. Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View » Format{ Freeze i Detach o1l Wrap o)
¢ | | @) %) i_
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.
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Options Description

Wrap Select the column in which the data needs to be wrapped and click
Wrap.

loan  lne  lesse
Product Definition dpadd | Sedt | Evew | Lot
view - [Faimats] | B | [Freee ffivetach | [EIWRBN | @ NewProduct Create Copy
T T 7 7 T
I T T T (Credtpurea
ot et Jenao [prea |Fextle Repayment |enabied Jocdateraype  |cotatera subype [hedtBuens |
o+ LOANHOME () p1/01/1800 12/31/4000 B Y Y 'HOME COLLATERAL  REAL PROPERTY HOM INSTALLMENT
LOAN SECLRED

LOAN-SG 12/31/4000 N N Y HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT

LOAN-UN R NSSEERE 1 011300 12/31/4000 Y Y Y UNSECURED COLLATIUNSECURED INSTALLMENT

LOAN-VE LOANVERICLEFR)Y p1/01/1800 12/31/4000 N Y La VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT

MDP1 MOP1. 3/08/1863 12/31/4000 Y N id VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT

MURABAHA ) A LMY 1/01/1800 03/13/2013 Y N Y HOME COLLATERAL REAL PROPERTY HON INSTALLMENT

s NORM DSER 3/11/1853 12/31/3000 v N v UNSECURED COLLATIUNSECURED INSTALMENT

o1 e 1oy/201 12/31/000 v N v HOME COLLATERAL REAL PROPERTY HOMMORTGAGE

Click to refresh the data in the table.

View Last For usability and performance, some of the data intensive screens
have ‘View Last’ option to sort the volume of data being displayed
on screen based on elapsed days.

View Last (2 1Day (7 1 Week(©) 1Month @) By Date  StartDt  07/01/2017 I'_?'@ EndDt 09/20/2017 E"@ &

You can select the ‘View Last’ option as 1 Day / 1 Week / 1 Month /
By Date. When ‘By Date’ is selected you can specify a date range
(within 3 months) in ‘Start Dt’ and ‘End Dt fields using the adjoining
calendar and clicking ‘Search’.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the
contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new
tab is opened where the print content is displayed.

Detach
ORACLE

Financial Services Lending and Leasing

> DashBoard [ ——— [ Close
> Origination )| @ E quest (Pending: 0) ”
Servicing
seavid Account(s): 20120200010231: YUTAKA OZAKA / AKANE Bl view || «2 Audt
Ctboics: Sl Viewv Formatw [5 Freeze 5 Detach o wrap W & @ curent O ShowAll C* Group Follow-up
Secuitization Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Ant Amount Due Status Oldest Due Dt
Transaction Authorization usot Usk1 UNDEFINED 2012020010231 LEASEVEHICLE 01 000 0.00 ACTIVE o2j10/2015

Post Date Checks
Escrow Transactions

Summary | Customer Service | Account Details | Customer Details | Transaction History | Pmt Modes || Bankuptcy | Repo/Foreclosure  Deficiency  Collateral || Bureau | Cross/Up Sell Activiies
Account Documents

Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes  References Corespondence Letters Document Tracking
Repoits
Producers i i
Vendors Transaction Batch Information padd | At || Fview | & Auit
Batch Transactions View~ Formatv [ Freeze 5 Detach Wrap o Frrost [ vod
s Date Honet Transaction status Batch
02/10/201 ADD CUSTOMER ADDRESS PHONE POSTED N
AT TTS015 v TERMINATE ERROR ]
Iterfaces 01/06/2016 v TERMINATE vom N “
01050016 Fzann vom "
Detached Table %
View~| Format v [ Freeze (DR vap @ ot [5hvoid
Date Honetary Transaction Status Batch
02/102016 N ADD CUSTOMER ADDRESS PHONE POSTED N
01/07/2016 Y TERMINATE ERROR N
01/06/2015 Y TERMIATE vom ]
01/06/2016 Y EXTENSION Vo N
12/24/2015 Y PAYOFF QUOTE LEASE POSTED N
View~ Formatv [ Freeze & Detach wap @
> Collections Transaction Processing Details
>wee ||| | = Direct Record Update, Transaction Posting Successful **++%
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:
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e Drop-down list — Provides the selection option. You can either select a record from the
list or enter first alphabet of the required value.

e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

ORACLE = Welcome, VAVAIDYA v - accessibilty o
Financial Services Lending and Leasing

e Customer service x W

> Origination Search | G # Request (Pending: 0)

Servicing

Sarvicng Account(s): 20151200010012; MADHU BOBBURI Elview || 2 ausit
Customer Service Viewv Formatv Freeze i Detach Nrap W & ' curent O showall O Group Follow-up
Securitization Company Branch Sub Unit. Account = Days Past Due Currency Pay Off Amt. Amount Due Status Ol dest Due Dt
sthorizatien uso1 Ustig 2015120020012 LOAN VEHICLE (FR), 5031881 2,193,350 01/01/2016
E‘;[‘Dum;ﬁim Sunmary || Customer Service | Account Detals || Customer Details | Transaction Hstory |t Hodes || Bankruptcy || Repojforedos’ ¢ 2= -
;‘”-“:‘“‘”“””‘”““‘ Call Adtivities Maintenance Commen ts || Promises | Checkists | Tracking Attributes || References | Correspondence | Letters [ Jsenrepy Py
Vendors Transaction Batch Information e onde i Add | Edit i o Audit
Batch Transactions: View~ Fomatv [ Freeze g Detach p @ oot [} i
(i Date Monetary Transactior ACCOUNTCL )
P 02/10/2016 ¥ Pt [suun: mnsmﬂ
B || e — e s
oyj072016 [ ACH ONE TIME PHONE PAY el G L . @41 @ Foy

c

> Collections
> WP, Hio data to display.
> Tools

EiSetp Result

Transaction Batch Information

Reset | | AddFields ~|| Rearder

Date 02/10/2016

* Monetary @ 0K || Cancel

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu Do this

Basic Click ‘Basic’ for normal search.

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select
the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual

ones.
| * Channel | WEB ENTRY = * Producer Name [
NY-02 : PR : HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR e 1
TIF-OUOO L T TEST-00T RTINS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
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1.6

1.6.1

Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a

combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt +y’.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the

keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

4. Arrow Keys to hover within the drop-down list.

Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Operating

monic

Browser Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click

monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom

level.
Shortcut Action
Ctrl++ To increase zoom level.
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1.7

1.8

1.8.1

1.8.2

Shortcut Action

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.

Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Application

n? VORI
o &

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled. You can set the
accessibility preferences after login. On the landing screen using 'Accessibility’ link on the
right end of the header set the following preferences as required

Screen Reader

Screen reader provides assistance to the visually impaired users. It interprets the screen
elements by reading them aloud.

High Contrast

High contrast feature increases contrast level to make the screen more appealing for the
reader with low vision.

Large Fonts

Large fonts feature increases font size to ensure clear display and appropriate spacing. This
benefits the reader with low vision.
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1.8.2.1

1.8.2.2

1.8.2.3

For Visual Challenges

The visual challenges varies widely, however it generally includes, blindness, low vision or
color blindness. To make the application more accessible, following features are provided.

Blindness:

In order to interpret the visual display information in the audible form, Screen reader
compatibility is provided.

In places where Screen reader technology cannot obtain information from images, text
equivalents for images are provided.

For Users with difficulty in using mouse, since it requires hand and eye coordination,
Keyboard navigation is provided. Details of keyboard navigation is provided in ‘Section 1.8.3.2
Keyboard Compatibility’.

Low vision:

For Users who cannot view the content that has small font size and cannot be enlarged,
Software magnifier is provided to enlarge text and images beyond normal font enlargement.

Also, there is no information presented using attributes such as depth, size, location, font etc.

For high contrast requirements Screen setting can be adjusted.

Color blindness:

Oracle Accessibility guidelines have been followed and hence accessibility issues relating to
color blindness are addressed.

Also, high contrast colors have been used to address difficulty in identifying shades of colors.
For example, Black text in white background.

For Hearing Challenges

People with hearing challenges or hard of hearing might encounter problems accessing the
information presented using sounds. Some application features minimize their concerns.

Visual representations of audible information is provided so that Users with this challenge do
not miss information presented using audio.

For Age-related Challenges

Apart from the above, there can be aging issues like week eye-sight or hearing.

Issues related to weak eyesight can be addressed through Application features for Visual
Challenges provided in ‘Section 1.8.2.1 For Visual Challenges’.

Issues related to hearing can be addressed through Application features for hearing
challenges provided in ‘Section 1.8.2.2 For Hearing Challenges’.

For Users who are less familiar with computers, the simplified user interface with easy

navigation options, uniform layout and design and commonly used terminology in the
application is of great advantage.
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To address issues relating to understanding complex information, User manuals are provided
for online help and tool tips at all required places are provided. In addition, system messages
like error, warning or information helps you through.

1.8.3  Other Accessibility Considerations

1.8.3.1 Documentation Accessibility

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics

e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
e Usage of styles and formatting elements

e Documentation in simple language to ensure easy understanding

e Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate

1.8.4  Setting up Accessibility Preferences

You can setup or change the accessibility preferences.
To edit accessibility settings

1. Click Accessibility in the header part of application. The system displays the following
screen:

Oracle Financial Services Lending and Leasing *
| Accessibility Preferences
Edit Accessibility Settings

Any setting made is saved until changed here again.' : 'Any setting must
be made for each browser session,

[T screen reader

[ High contrast
[FLarge fonts

D‘é Submit $2 Cancel

2. Select any or all of the required options to edit or change the accessibility settings.
3. Click Submit.

Note

You need to define the required Settings for each browser session and defined settings
are saved until next modification.
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2.1

2. Search Function

Oracle Financial Services Lending and Leasing allows you to search for an account, customer
or application using specific search criteria. Since this section details the general search
options available in the User Interface, some or all the parts of this section are applicable to
you as per access provisions & licensing. The following sections explain the Search options
in detail.

Search Criteria

Search criteria has a list of parameters which enables to query the application / account from
the database by providing one or more parameter values. There are 15 parameters whose
values can be specified in combination with comparison operators which are described in the
table below. The Reset button enables to clear the comparison values for a fresh search.
Apart from this, Search can also be performed using wild card characters.

ORACLE
Financial Services Lending and Leasing

2, Welcome, PRAKRRAO »  Accessibilty [=)

Customer Service [E3f=
Search | | Customer Service | | Review Request (Pending: 0)
> Quick Search

Search Criteria

&P Reset Criteriz || @8 Search
Vieww Formatv [EH| [Fesze fivewmch | o wrap o))

e =]
Lixe ] =
LIKE [~]

EQU [~
LIKE =2
Lie vl
EQUAL =
Like I~
Lixe =l
Eau [~
LIKE [~]
e ~]
LIKE [~
Lixe ~]
LIKE ~l
Lixe = =

) Lixe ~1
ke

<

Search Results
View  Fommat~ | B Freeze B Detach oo | @R
> Collections Company Branch Account 7 Date Title Product Status Sokequency amount Due S
> WEP N data ta display.
<
> Tools
> Setup

Description | Example Expression

LESS THAN | APPLICATION DATE < 01/22/2002
Result: The system searches for all applications created before Jan.
22, 2002.

LESS THAN | APPLICATION DATE <= 01/22/2002

gg EQUAL Result: The system searches for all applications created on or before
Jan. 22, 2002.

EQUAL APPLICANT SSN = 111-22-3333
Result: The system searches for all applications with applicant social
security number 111-22-3333.

NOT APPLICANT SSN <> 111-22-3333

EQUAL . o .
Result: The system searches for all applications except those with an
applicant whose social security number is 111-22-3333.
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Description | Example Expression

GREATER APPLICATION DATE > 01/22/2002

THAN Result: The system searches for all applications created after Jan. 22,

2002.

GREATER APPLICATION DATE >= 01/22/2002

THAN Result: The system searches for all applications created on or after
OR EQUAL | Jan. 22, 2002

IN ACCOUNT NUMBER IN (20001000012512°, <20010100012645°,
£20010300012817°)

IN is used with values that are within parenthesis.

Result: The system searches for the applications with the account num-
bers of 20001000012512”, <20010100012645”, and 20010300012817.)

NOT IN ACCOUNT NUMBER NOT IN (‘20001000012512°, 20010100012645°,
€20010300012817°)

NOT 1IN is used with values that are within parenthesis.

Result: The system searches for all applications except those with the
account numbers of 20001000012512°, <20010100012645°, and
120010300012817°.)

IS VIN IS NULL

IS is only used with a value of “NULL”. It enables you to search for crite-
ria that has no value; that is, fields where no information is present.

Result: The system searches for all applications without a vehicle iden-
tification number.

ISNOT VIN IS NOT NULL

ISNOT is only used with a value of “NULL". It enables you to search for
criteria that has any value; that is, fields where information is present.

Result: The system searches for all accounts with a VIN, vehicle identi-
fication number.

LIKE ASSET TYPE LIKE VEH%

LIKE enables you to search for close matches using wildcard charac-
ters.

Result: The system searches for all applications with asset type begin-
ning with the characters “veh” such as “vehicle car” or “vehicle van.”

NOT LIKE ASSET TYPE NOT LIKE VEH%

NOT LIKE enables you to search for close matches using wildcard
characters.

Result: The system searches for all applications with asset type other
than those starting with the characters “veh.”

Using Wildcard Characters

e Wildcard characters can only be used with the operator LIKE and NOT LIKE.
e % (percent) represents any number of characters, including no characters.
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e _ (underline) represents any single character.

Using Criteria Value

Search criteria values of 1234% will locate character strings of any length that begin with
“1234” for example,

e 1234ACB
e 12345678
e 1234

e 12348

e 12340980988234ABIL230498098

Search criteria values of 1234_ will locate character strings of five characters that begin with
“1234” for example,

o 12345
e 1234A
e 12340

Search criteria values of %1234 will locate character strings of any length that end with
“1234” for example,

e 1234
o 01234
e (098908LKJKLJLKJI000988071234

Search criteria values of _1234 will locate five character strings that end in “1234” for
example,

e A1234
e 11234

Search criteria values of %1234% will locate character strings of any length that contain
“1234” for example,

e 1234
e 01234
e 12340

e AKJLKJ1234128424

Search criteria values of _1234_ will locate character strings of 6 characters that contain
“1234” for example,

e A1234B
e 012341
e A12341

Using Search Criteria examples

Result: The system searches for all applications with application date May 1, 2001.

Criteria Comparison Operator Value
APPLICATION EQUAL 05/01/2001
DATE
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2.2

Criteria Comparison Operator Value
APPLICATION DATE EQUAL 05/01/2001
APPLICATION NUMBER | GREATER THAN OR EQUAL 0000000278

Result: The system searches for all applications with application date May 1, 2001 and an
application number greater than or equal to 0000000278.

Criteria Comparison Operator | Value

FIRST NAME EQUAL

JAN

Result: The system searches for all applications with applicant whose first name is “JAN”

e JAN ARBOR
e JAN FISHER

Criteria Comparison Operator | Value

FIRST NAME LIKE

JAN%

Result: The system searches for all applications with applicant’s first name starting with “JAN”

e JAN ARBOR

e JAN FISHER

e JANE MEYERS

e JANETTE NORDSTROM

Searching for an Application

Oracle Financial Services Lending and Leasing allows you to search and retrieve a particular

application.
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During application entry, queues can be created based on your user id and your user
responsibility. You can view the assigned queues in the Origination screen of DashBoard.

ORACLE

Financial Services Lending and Leasing

e Y— o

DashBoard
Dashgoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

DashBoard 3
Origination Setup
My User Queues Product Expiring in Next One Month

Description Count Froduct End Date
No data to display. No data to display.

My Pending Review Requests By Applications
App # Friority
No data ta display.

My Pending Review Requests By Priority
Priority Count
No data to display.

Servicing Producer

Number of Queues Hard Assigned
Queus Description Count
No data to display.

A Producers Count By Status
Status Count
ACTIVE 82

Number of Accounts
Quaus Description Count
No data to display.

Producers Expiring in Next One Month
Producer End Date
No dats to display.

My Pending Review Requests By Accounts
Acc# Priority
No data to display.

My Pending Review Requests By Priority
Priority Count. v
Na data to display.

(3] Close.
Admin

Critical Batch Job Status
Batch Job Status
No data to display.

Vendor

Vendors Count By Status
Status Count
ACTIVE 35

Vendors Expiring in Next One Month
Company Name End Date
No data to display.

In each stage of application, the queue name to which the selected application is assigned,
appears in Queue name field in Result screen.

You can begin processing the applications in the order in which they are listed. Select the
record and click Submit.

Search/Task tab

To view the Search/Task screen during Lease origination

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2-5
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Depending on the task to be performed and the link clicked, the respective screen opens
in the Search Results/Task screen.

ORACLE’
Financial Services Lending and Leasing

jinati Close
mET Origination » )
Origination Search[Task Application Entry ~ Review Requests (Pending: 0)
Quick Search
Simple Application Entry . N B = -
Application Entry App # sSN Identification # [ submit
Underwriting
Funding Queue [~] | [ next Application
Application Retrieval
Scenario Analysis * search Criteria
Application Documents
Image Maintenance A New application | | (L) Open Application || (5] View Application Unlock Application
Reports.
Producers Search Results/Task
Vandars View~ Format~ R freeze [fiDetach | ol wrap W viewan [
Crit Loc Allo Company Branch App # Date Title: Product Status Sub Status Qu
No data to display.
< >
Columns Hidden 1
1
> Servicing
> Collections
> WFP
> Tools
> Setup

2. Click the Search Criteria tab.

ORACLE"
Financial Services Lending and Leasing

Origination

DashBoard

Scarde/Task || Auplication Entiy || Rein Rexuets (Persdin: 0)
> Quick search
Search Criteria
& Reset Criteio || @ Search

view - rormatw  [E¥] [ Fresss EfiDamon ol wrep =
e L)

Criteria Comparison Oparator B vaive
vEAR EQUAL ~
EQuAL L~
TSI = =S
[ET3 =3 =
i =~ 3]
Like <1
i =]
e 1
ke L]
e 3]
ke &
ke L]
Like 1]
[ET =1
i =
ke <1
@ New appiicarion | | (O anen anpticarion | | (5] wiew appiicanon Linieck applicaion
Search Results/Task
View v rormat~ B Freeze i Detach 0 wrap @ veewan O]
Branh A et Titke Product Statea Suls Status au

> Servicing
> Collections.
> wre

> Tools

> Setup

The search tab enables you to locate an application using a broad range of search criteria.

e During Lease origination, the results are sorted according to the priority of application
and application identification number. However you can sort the records using any
criteria.

e If you try to open an application which is already opened by another user, system
displays an alert message indicating “Application is locked by <User Name> Phone
<phone number>".

The Search Results/Task screen.

3. On the Results screen, select the application you want to load and click Open
Application.
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The system loads the application on the respective screen.

ORACLE
Financial Services Lending and Leasing
R Close
DashBoard Origination EE
Origination Search/Task | Application Entry: 0000001537 || Review Reauests (Pending: 0) ~
Application: 0000001537: RODRIGUEZ ROBINSON Bl iew || <2 audt
e =" Freeze [ Detach Wrop @ OverrideOK v  Warning OK v
Origination Stage Producer Contact 5 Duplicate
ot App = Sub Unit Status i Producer Name  RTOdUCe! Bxsting Customer  DURICR® Contact
0s/05/2015 0000001537 APPROVED - FUN... FUNDED CA-00003 : ACE H.. (818)-761-2277 N N
>
Summary || Applicant || Business || Request || Dedision || Contract || Collateral || Comments || Tracking || Document | | Verification || Correspondence || Toals
Vendors > Applicant
» Ratios
> Bureau
4
“
» Checkdist
Collateral
Collateral
Asset Type Sub Type Primary  Year rake Model Mileage New Wholesale Volue  Retail
VEHICLE car ¥ 2015 Aupr A oy 12,000.00 13,500
< >
Trade-In
Trade-In
Asset Type Asset Sub Type Description Identification Year Make Model BaseRetail Amt  Addons
> Serviang vERICLE 2015 DODGE RAM... 3GCPCRECSEG145156 2015 DODGE RAM PICKUP 2500  5,300.00 200.00
verICLE 2012 CHEVROLET .. 3GCPCRECSEG145647 2012 CHEVROLET camaro 1,600.00 0.00
> Collections < >
> WFP
> Tools
> Requested -
> Setup

You are now ready to begin work on the application.

2.2.2 Quick Search section

Quick Search enables to search for an account using any one of the following values -
Account Number, Customer ID, SSN, Identification Number or Queue.

To load an account using the Quick Search section:

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. In the Quick Search section’s Acc # field, specify the account number you want to load
and click Submit.

You can also load the account by specifying the last 4 digits of the SSN Number. System
retrieves only those accounts where the searched SSN is of the Primary Applicant. If multiple
matches are found, system displays an error message as ‘Multiple Matches found for the
SSN, Please use normal Search’.
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Note

Search cannot be performed using wild card characters in the Quick Search section.

ORACLE
Financial Services Lending and Leasing

~1 [ [ Next Appiication

> search Criteria

Search Results/Task
i Format+ B Freere i netach T viewan O
ny = Date Title

> Servicing
> Collections
> WEP

> Tools
> Setup

The system loads the selected application.

To load an account from a queue during application entry

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. In the Quick Search section’s Queue field, select the queue you want to work with and
click Next Account.

2.2.2.1 Other Features on the Results screen

The Results screen on the Applications screen has below listed common features (these
features are not present on the Result screen on Customer Service screen):

What is it? What does it do?

View All If you select View All check box, all applications in the system acces-
sible with your user id appear in the Results screen under search sec-
tion.

Queue Name This display only field indicates the queue in which the selected appli-
field cation is currently in. (This in normally related to one or more of the
following, based on setup: producer, state, or status.)

Secured box Indicates that the selected application is secured (that is, that the
applicant is an employee of the organization) and may only be loaded
by authorized users.

Copy Applica- | Creates a copy of the selected application. This feature is usually
tion button used when an applicant has submitted a previous application or when
an applicant submits a second application and you don’t want to
retype the information.

New Applica- | Opens a screen where a user can create a new application by provid-
tion ing required details.
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What is it? What does it do?

Open Applica- | Displays the application details for the selected application.
tion

Unlock Appli- | Unlocks the selected application locked by another user.
cation

2.2.2.2 Copying an Application

Once the application clears the pre-qualification edits successfully, it moves to the
underwriting queue. In the Underwriting/Funding screen, you can copy the information of an
existing application into a new application. using Results screen. The new application will
contain duplicated data of application information, the requested Lease information, credit
bureau data, and collateral information. The new application will have status/sub status as
NEW - REVIEW REQUIRED.

To copy an application

1. Open the Underwriting/Funding screen and use Quick Search screen to locate the
application you want to copy.

2. Select the application you want to copy on the Search Results/Task screen.

3. Click Copy Application.

ORACLE . . . . @ PRAKRRAQ ~ Accessibility o
Financial Services Lending and Leasing

— Origination 5 (39 Gose

Origination (@ Information
Application copy successful, New application # success
Search/Task = Underwriting: 0000001537 ~ Review Requests (Pending: 0)
Quick Search

pp # | DDDODO1537 £ Identification # [ subm

Queue [~] | BB Next Application

©» Search Criteria

3 Open Application | | [E] wiew Application | | i nkock Application | £ [i5] Copy Application

Search Results/Task
View~ Format~ P Frecze Gt Detach Wrap W viewar O
Crit Loc Alls Company  Branch App Dat= Title Product Status Sub Status u
No data to display.

> Servicing
> Collections
> WFP

> Tools

> Setup

An Information message is displayed as “Application copy successful. New application # (new
application number).”

System creates a new application with details of the copied application with status NEW -
REVIEW REQUIRED. The new application can be accessed from the underwriting screen
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irrespective of whether it is copied in Underwriting/Funding screen. The system also notes

that this is a copied application with a system generated comment.

ORACLE" . . 8 Welcome, PRAKRRAO ~  Accessibility (52
Financial Services Lending and Leasing
tginath Close
e Origination x 7]
Origination Search/Task  Underwriting: 0000001533  Review Requests (Pending: 0)
‘Onigination
SelesLead Application: 0000001533 SIGG MARK Zedt | Evew | o aude
simple Application Entry _—
Application Entry View - Format~ [ Freeze i Detach Wrap W overrideok v Waming Ok v
Underriting Origination Stage Producer Contact 3 Duplicate
i Dt App # Sub Unit Status. Code Producer Nama N Existing Customer application ‘Contact
Apglication Retrieval 05/05/2015 0000001533 REJECTED - AUTO.. NEW CA-00003 : ACE H... (B18)-761-2277 N N
Scenario Analysis < >
Application Documents
Image Maintenance
Reports Summary | Applicant || Business | Request| Decision  Bureas | Collstersl Comments | Tracking | Document | Verification || Comespondence | Tools
Producers
Vendors
Comments
i Bl saveandstay | [ save and Retum || G Retum
View v Format~ [ Freeze (i Detach 1l Wrap @
Alert Type Sub Type ‘Comment Comment By Comment Dt
O REGULAR [v] | LOAN GRIGINATION [v] PRAKRRAQ 02/04/2016 04:35:38 AM
‘
DECISION_MULTI_OFFER LETTER GENERATED, ~ i
O SYSTEM GENERATED SYSTEM GENERATED {(CORRESPONDENCE: INTERNAL 02/01/2016 08:33:04 AM
CNLNCE_DEC_MULTIOFFER_FAX_VR JOB REQUEST 1D: ¥
'CONTRACT_FUNDING LETTER GENERATED.
O SYSTEM GENERATED SYSTEM GENERATED (CORRESPONDENCE: CNLNCE_CON_LTR_VR 3OB REQUEST VEROUTHU 01/30/2016 12:30:35 AM
1D: 41039)
DECISION LETTER GENERATED. (CORRESPONDENCE:
O SYSTEM GENERATED SYSTEM GENERATED CNLNCE_DEC_FAX_VR JOB REQUEST ID: 41038) VEROUTHU 01/30/2016 12:06:18 AM
HAVING GOOD REFERRAL
O REGULAR LOAN ORIGINATION VEROUTHU ©£1/29/2016 11:24:13 PM
> Servicing
> Collections
> WEP
> Tools
> Setup

2.2.2.3 Unlocking an Application

When an application is opened by a user, the same would be locked for other users. Using

Results screen in the Applications screen user can unlock the application.

To unlock an application

1. Open Applications Entry screen and use Quick Search screen to locate the application

you want to work with.

Submit.

On Search Results/Task screen, select the application you want to load and click

An Information message appears with the message: “An application is locked by another
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user.”

ORACLE" . . & Welcome, PRAKRRAD +  Accessibity o
Financial Services Lending and Leasing

i Close
TR Origination x 5]

Origination Search/Task | Undenwriting | Review Requests (Pending: 0)

Origination

Sales Lead Qb panh

Simple Application Entry . _ ,, B =
Apolication Entry App ¥  DO00001622 E=Y Identification # EB submit
Underwriting & Warning *

Funding Queus v By

Bpplication Resial ] [ Application is locked by: KGOUDU Phone: 0 - Ext.: 0

A (i > search Criteria ok

Application Dacuments |||~ e -

Image Maintenance (] Cpen Application | | [5] View Application Unlock Application Copy Application
Reports

Producers Search Results/Task

Vendors View » Format v [EF Freeze FfiDetach | ol wrap W viewan []

Critical Locked  Allowed  Company Branch  App # Dat= Title Product Status Sub Status Qu
No data to display.
<

> Servicing
> Collections
> WFP

> Tools
 Setup

3. Click Unlock Application.

4. Click Open Application. The system loads application on the Underwriting screen.

2.2.2.4 View Application

2.3

The View Application button is available in all origination screens (Application Entry,
Underwriting and Funding). You can view a selected application in the search results by
clicking on the View Application button even when the application is locked by another User.

The application will be opened in ‘View Mode’ only and no edits are allowed. However in Tools

sub tab, the 'Initialize' and 'Calculate’ buttons will be enabled allowing you to use the calculator
options.

Searching for an Account and Customer

You can search or retrieve a particular account or customer through Customer Service

screen. The search tab available in the screen enables you to locate an account or customer

using a broad range of search criteria.

To view the Search screen during Lease servicing

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform a customer service task on the application, click Customer
Service link.
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Depending on the link clicked, Customer Service screen appears, opening at Results

screen.

ORACLE
Financial Services Lending and Leasing

g somout ©

@ Customer Service x (%] Close
Search | Customer Service | Review Request (Pending: 0) | Queue Assignment 2
et Quick Search
> Origination
Servicng Ac# Customer Id ==t Identification # [ submit
Serviding 5
Customer Service Queue/ Condition [=] mutorun [ [ [B NextAccount | | [ Hltered Account
Secritization
Transaction Authorization I Search Criteria |
Post Date Cheds e 3
Escrow Transactions 3
Account Documents 1 Search Results
G iR vien ~ Format ~ 53 Freezz 5 Detach 2 7]
Reports _ =
Producers ¢ &
Neer Company Branch Account # Date Tite Product Status DRI | mourtoye (D2End
Batch Transactions dars s
Advarces uso1 UsHQ 00123456 01/20/2000 Downprtamt Test .. LOAN VEHICLE (<R} CHARGED OFF 0 0.00 0.00 -
e uso1 UsHQ 1005228531 01j01/2017 BAUER CHRISTIAN  LOAN VEHICLE (FR) ACTIVE:DELQ 217 158288 90700 [0
o = uso1 usHQ SEREEEEES 01/20/2000 Downpmtamt Test .. LOAN VEHICLE (FR) CHARGED OFF q 0.00 0.00
5 uso1 usHQ 12 012012017 ORACLEMADHAN  LOAN VEHICLE (FR) ACTIVE 35 0.00 8,226.25
O tnes uso1 usHQ 1235459789 01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF Gl 0.00 0.00
> Wrp uso1 usHQ 2000010010385 01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF [ 0.00 0.00
> Tools uso1 usHQ 2000010010533 01/20/2000 Downpmtamt Test .. LOAN VEHICLE (FR) CHARGED OFF ] 0.00 0.00
uso1 usHQ 2000010001820 01/20/2000 ALIVEPRI /DEAS... LOAN VEHICLE (FR) CHARGED OFF 0 0.00 0.00
e uso1 usHQ 2000010001846 01/20/2000 ALIVEPRI [DEAS... LOAN VEHICLE (FR) CHARGED OFF 0 0.00 0.00 -

Note

Oracle Financial Services Lending and Leasing does not display the financial details of se-
cured accounts if the logged-in user is not authorized. Though the search display the re-
sults, the fields such as Status, Delinquency Days, Amount Due, and Outstanding Balance
are masked with ‘xxxxx’ and clicking on the same displays an error message indicating

‘Cannot open secured account’.

3. Click the Search Criteria tab.

ORACLE
Financial Services Lending and Leasing

e Customer Service [#lCese
> Origination Search Customer Service  Review Request (Pending: 0) =
Sarvicing > Quick Search
Serviding
Customer Service ‘Search Criteria
Securitzation Search Options: (@) Account ) Custamer ) Business
Transaction Autherization
Post Date Checks & Reset Criteria. || @8 Search
Escrow Transactions View > Format > Ep Freeze  {fiDetach Wrap %) R
Account Documents Criteria Comparisan Operatar Value i
Collateral Management: N & e =
';:;::s ACCOUNT STATUS LiE [=] [=]
Vendors PRODUCT LIKE [=] HLOAN%
Advances i CUSTOMER LAST NAME LKE [=]
Payments CUSTOMER FIRST NAME Lxe [=]
re CUSTOMER D EQUAL [=]
mj:a;:nsa[ o BUSINESS NAME LIKE [«
6L Transactions N e =
CASA Recondliation YEAR EQUAL [=]
Conversion Accounts MAKE e &
MODEL Lxe [=]
ASSETTYPE Lxe [=]
PRODUCER # LIKE =]
> Collections PRODUCER NAME LKE =
b WP ACCOUNT CONDITION it [=] [+
> Tools 'QUEUE NAME {UNDEFINED FOR DEFALLT) LIE [=]
> Setup QUELE DESCRIPTION LIKE [=] -

Using the Search tab

1. Create a search criteria by specifying the required details in Comparison Operator and

Value columns.

tab.

Account.

Click Search. System displays all accounts that meet the search criteria in the Results

On the Search Results/Task screen, select the account you want to load and click Open

ORACLE



The system loads account on Customer Service screen.

ORACLE'
Financial Services Lending and Leasing

g Sign Qut o

S
; o
TR Customer Service x el
' Origination Search  Customer Service: 0160700010141 Review Request (Pending: 0) | Queue Assignment 2
Servicing
Senvidng - Account(s): 20160700010141: KLM NAVEEN Eltew || o auit
Customer Service View~ Formatv [ Freeze ifi Detach ] Wrap B & © curent® show Al O Group Folow-p
Securitization Company Branch Sub Unit Account # Product Days PastDue Currency Pay Off Amt Amount Due St
Transaction Authorization uso1 USRHQ UNDEFINED 2016070001041 LOAN VEHICLE (FR) -24 USD 27,021.00 0.00 At
Post Date Chedks ' L] ¢
Escron Trensactons 3
Account Documents Summary = Customer Service | AccountDetalle  Customer Details | Transaction History = PmtModes  Bankruptcy  RepofForecoswre | Defidency  Collateral | Buresu  CrossUp Sel Activi » ¥
Collateral Management
Reports
i Alerts Conditions
Producers
Vendors
Alerts Conditions
Batch Transactions
) Alert Condition Start Dt Followup Dt
vances |
S— E| Mo data to display. ON ACTIVE MILITARY DUTY 07/26/2016 07/26/2016
b g DO NOT CHARGE OFF 07/26/2016 07/26/2016 -
Fees
Interfaces
AP Transactions
GL Transactions
Conversion Accounts Account Details Other Information
Dues | | Collateral Information [
Desription Identification # Year  AssetClass  AssetType
0.00 0.00 0.00 0.00 0.00 | 0 TOYQOTA CAMRY (] NEW VEHICLE |
a7 i ' < i '
= DelgDue 0.00 TodaysPayoff 27,02L00  AmtPaid Excess 0,00 . )
A - LCDue 0.00 Future Payoff 27,051.00 Memo Excess 0.00 Cirstomer TnformaBon
7 Collections A e
— NSF Due 0.00 Future Payoff 08/12/2016 Amount & Name Relation 5N Mational
/ Date Paid Term 0
" Other Dus 000 ) 000000... NAVEENKLM PRIMARY Xt 5665 -
» Tools Tt Due 0,00 FutwiePmtDt 08/26/2016  RemainingTerm 12 o = - al
> Satup OldestDue Dt 08/26/2016 Days to Time Bar - /]

2.31 Quick Search section

The Quick Search section in Customer Service screen enables you to load accounts using
any one of the fields Account Number, Customer Id, SSN, Identification #, or Queue/
Condition.

To load an account using the Quick Search section

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform customer service task on the application, click Customer
Service.
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2.3.2

3. Inthe Quick Search section’s Acc#/Customer Id/SSN/Identification # fields, specify the
corresponding Account number, or Customer Id, or last four digits of SSN or complete
SSN in the respective fields and click Submit.

ORACLE ) . SSHEKAR y g oo ©
Financial Services Lending and Leasing
@ Customer Service x [ Close
Search  Custome: Service | Review Request (Pending: 0) | Queve Assgnment
> DashBoard Quick Search
> Origination
Servicing Acc# Customer Id SSN Identification # 3 submit
S
Customer Senvice Quete/ Coniton [#] Autorn [ | 3 NextAccount | | (5§ Fitered Account
Securitization
Transaction Authorization » Search Criteria
Post Date Checks T
Escrow Transactions 3
A(Tun( I‘Z)n[umenfs 4 Search Results
Collateral Mz it =
S vien~ Fomat~ || [[[Frezze EiDetach U
Reports 4
Producers ¢ %
Deli Qutstandi
eriors Company Branch Account # Date Tite Product Status de'”q”E”q Amount Due B“‘ S prog
Batch Transactions ays alance
o n— No data to display.
‘ i ] v
Payments
Fees -
> Collections
5 WEP
> Tools
> Setup

4. You can also search for accounts which are mapped to a particular Queue or Condition
by selecting the same from ‘Queue/ Condition’ drop-down list and clicking ‘Next Account’
button. Clicking ‘Filtered Account’ opens the subsequent account fetched during a queue
search and listed in Queue Assignment section.

5. When the request to access an application comes from an external system, user needs
to check ‘Auto Run’ and click ‘Next’ button. System displays the customer service screen
for the respective Account.

To load an account from a queue

In the Quick Search section’s Queue field, select the queue you want to work with and click
Next Account.

Search Using Customer Details

There are different ways to search a customer account using the customer details.

To search for and load the customer details with the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria
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Select Customer as a search option.

ORACLE’
Financial Services Lending and Leasing

> DashBoard Customer Service 5 [ Close
> Origiation Search | Customer Service | Revien Request (Panding: 0) =
Servicing " Quick Search
Servicng
Customer Service Search Criteria
Securitization Search Options: (£ Account @) Customer ©) Business
Transaction Authorization
Past Date Checks & ResetCritera | @@ Search
Eserow Transactions View ¥ Format~  Ep Freeze  iffiDetach D ®
Account Documents Criteria Comparisen Operatar Value
Collateral Management = gt =
Reports
S CUSTOMER FIRST NAME Lne [=]
producers
- CUSTOMER LAST NAME LIKE [=]
Batch Transactions CUSTOMER S5N EQUAL [l
Advances CUSTOMER NATIONAL ID LIKE [=] =
«
Payments CUSTOMER PASSPORT NUMBER LKE [=]
e CUSTOMER PHONE NUMBER EQUAL [=]
neteces CUSTOMER ZIP CODE LiKE [=]
AP Transactions =
GL Transactions
Conversion Accounts W
Search Results
View > Format~ B Freeze [ Detach Wrap o)
Customer 1d Natioral D First Name Last Name ssit Passport = )
No data to display.
» Collections
AL vew~ Fomatv B l[Freeze [iDetach | @
> Tools Company Branch Account # product currency Pay Off Amt Amount Due Status Oldest Due Dt Type
& Sotun No data to display.
O] i Fl |

1. On Search Criteria screen, use Comparison Operator and Value columns to create a
search criteria to find the account using customer details. You can click Reset Criteria at
any time to clear the Comparison Operator and Value columns.

2. Click Search.

The system locates and displays all the accounts that meet your search criteria on Search

Results screen.

ORACLE
Financial Services Lending and Leasing

e Customer Service y

> Origination Search | Customer Service | Review Request (Pending: 0)

ST Quick Search
Servicing

Customer Service Acc# Customer 1d
Securitzaton
Transacton Autharization
Post Date Checks
Escrow Transactions

Queue/ Condition

> Search Criteria
Account Documents

Collateral Management

Reports
Producers Search Results
Vendors View ~ Format~ [ Freeze i Detach
Batch Transactions Customer 1d
Advances 31030
Payments f
Fees
Interfaces -
AP Transacions View v Format+  [Ep Freeze [ Detach
&L Transactions Company Branch Account #
uso1 usHg 20160200015584

Conversion Accounts

> Collections
> WP

> Tools

> Setup

B s B

=N

[ Next Account
National D
456321789
Product Currency
LOAN VEHICLE (FR)  USD

First Name
SATKRISHNAN

Pay Off Amt
5,037.08

Identification #

Last Name
K

Amount Due
422.78

=
0000@356

Status
ACTIVEDELQ

[ ose
[ submit
(2] Qpen Account
Passport # Zp
00775
Oldest Due Dt Type
03/01/2016 PRIMARY

3. On the Search Results screen, view the following information for each account:

In this field: View this:

Company

The company of the account.

Branch

The branch of the account

Account #

The account number

Product

The Lease product of the account.
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2.3.3

In this field: View this:

Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.
Amount Due The total amount due on the account.

Status The status of the account.

Oldest Due Dt The oldest payment due date on the account.
Type The type of account.

Also the ‘Customer Details’ section below displays the Customer Information along with
Addresses, Telecoms, Employments, and Tracking Attributes. You can click ‘View’ to display
the details in each section.

4. On the Search Results screen, select the customer you want to retrieve. The system
displays all the accounts pertaining to that customer Id. Select an account and click Open
Account.

The system displays the account details on Customer Service tab.

Search Using Account Details

To search for and load an account using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

1. Select Account as a search option.

ORACLE
Financial Services Lending and Leasing

Close
e Customer Service x Bl
(= s s Search | Customer Service || Review Request (Pending: 0)
SHLELY » Quick Search
Senviang
Customer Service Search Criteria
Securtzaton Search Options: @ Account (©) Customer () Business
Transaction Autharization
- Greserciena | @@search
Escron Transactions Vien ¥ Format~  Ep Freeze  EfiDetach Wirap 5]
Account Documents Crteria Comparison Operator Value
Collateral Management AECONT e =]
Renats ACCOUNT STATUS LiE [=] [=]
Producers
Vendsre PRODUCT LKE [=] SLOAN
AT CUSTOMER SSN EQUAL [+l
Advances i CUSTOMER LAST NAME LKE =
Payments CUSTOMER FIRST NAVE LiE [=]
= CUSTOMER 1D EQuAL [=]
Interfoces g
4P Traneactons BUSINESS NAME LIKE -
6L Transactons ‘v‘IN e =
CASAReconaliation R EQUAL [=]
Conversion Accounts MAKE e =
MODEL LIE [+l
ASSET TYPE LiE [=]
PRODUCER = LiE [=]
> Collections PRODUCER NAME LKE [=l
> WP ACCOUNT CONDITION LIKE ] =]
> Tools 'QUEUE NAME (UNDEFINED FOR DEFAULT) LIE [=]
> Setup ‘QUEUE DESCRIPTION LKe [+l <

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find an account. You can click Reset Criteria at any time to clear the
Comparison Operator and Value columns.
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3. Click Search. The system locates and displays all the accounts that meet your search

criteria on Results screen.

ORACLE’
Financial Services Lending and Leasing

{Customer Service

~ DashBoard
> Origination
oo Quick Search
Senidng
Customer Service Acc

Securitization
Transaction Authorization
Post Date Checks

Escrow Transactions

Queue Condition

» Search Criteria

Account Documents
Collateral Management
Reports
Producers Search Results
Vendors View v Formatv [
Batch Transactions
q Company Branch
Advances
Payments usoL UsHQ
Fees usot usHQ
Interfaces usoL usHg
AP Transactions us0L UsHQ
GL Transactions uso1 UsHQ
CASA Reconcliation usoL usHQ
Conversion Accounts UsoE usHQ
uso1L usHQ
usoL UsHQ
usoL UsHQ
usoL UsHQ
> Collections usot usHo
> WP (LT UsHQ
usoL UsHQ
> Tools T o
> Setup |

e

Search Customer Service | Review Request (Pending: 0)

Customer 1d ssn Identification # [ submit
[ Auorin [ [ B NextAccount
(1) Gpen Account
Freeze iDetach v @

Account £ Date Title Broduct Status ::‘Y‘Z""E"EV Amount Due S;:::d‘”g Producer
2151200011060 12/10/2015 NATHNATH LOANVEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND) +
MISI00L1331  12/18/2015 MADELLA SURESH  LOAN VEHICLE (FR) ACTIVE:DELQ 1 147182 2503000  CA-00002:RANDY |
151200012331 12/10/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND'
0151200012348 12/17/2015 SOF SOF LOAN VEHICLE (FR) PENDING 0 0.00 0.00 AK-00001 ¢ FELL
DI51200012612  12/18/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND'
2015100012894 12/24/2015 ASHOK PADMA LOAN VEHICLE (FR) ACTIVE 2 0.00 20,000.00  CA-0001: DEMO
DISI00L3008  12/30/2015 ume LOAN VEHICLE (FR) ACTIVE -1 0.00 100,000.00  CA-D0DS : HARR"
0160100013092 01/06/2016 SPARROV/ MARYY  LOAN VEHICLE (FR) ACTIVE 20 0.00 S0,000.00  CA-00001: DEMO
160100013216 01/14/2016 JONES ANGELINA  LOAN VEHICLE (FR) ACTIVE 16 0.00 S0,000.00  CA-00001:DEMO
0160100013274 01/18/2016 RANADE SHWETA  LOAN VEHICLE (FR) ACTIVE 31 0.00 500,000.00  CA-00001 : DEMO
DI60100013414  01/19/2016 DALE ALAN LOAN VEHICLE (FR) ACTIVE a1 0.00 42,000.00  CA-00002: RAND'
0160100013963 01/20/2016 0 LOAN VEHICLE (FR) ACTIVE -3 0.00 15,000.00  GA-D00D2 : ADVAT
0151200014064 12/17/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND'
MDI60100014149  01/20/2016 HEGDE SUBHASH /... LOAN VEHICLE (FR) ACTIVE 24 0.00 15,000.00  GA-D00D2 : ADVAT
160100014206 01/20/2016 HEGDE SUBHASH f... LOAN VEHICLE (FR) ACTIVE 24 0.00 15,000.00

i

GA-00002 : ADVAM +
3

4. On the Search Results screen, view the following information for each account:

In this field:

View this:

Company

The company of the account.

Branch

The branch of the account

Account #

The account number

Date

The date the account was created.

Title

The primary and other applicant(s) attached to the account.

Product

The Lease product of the account.

Status

The status of the account.

Delinquency days

The number of days the account has been delinquent.

Amount Due

The total amount due for the account.

Outstanding Balance

The total outstanding balance for the account.

Producer

The producer of the account.

Secured

If selected, indicates the account is secured and may only be
loaded by authorized users.

5. On the Results screen, select the application you want to retrieve and click Open

Account.
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234

The system loads the account under the Customer Service tab
ORI, e oviliog s g

b o Customer Service x @ close
> origination Search  Customer Service: 2015100011054 Review Reuest (Pencing: 0)
Servicing
aietig Account(s): 20151000011054: K NAVIN Elvien |[ Pt
Customer Service View - Format v [ Freeze EfiDetach  odl Wrap W & @ cument O showAll O Group Follow-up
Securiization Company Eranch Sub Unit Account = Days Past Due Currency Pay Off At Amount Due Status Oldest Due Ot
:a:ﬁwg“ﬁm ization usox usrg UNDEFINED 2015100011054 LOAN VEHICLE (FR) 207 UsD 51462 0.00 ACTIVE 100172015,

Escrow Transactions

S SSummary | Customer Service || Account Details || Customer Details | Transaction History | Pt Modes || Bankruptcy || RepojForeclosure | Deficiency || Colateral || Burea || Cross/Up Sell Activities

Collateral Management
Reports Alerts

Conditions
Producers
Vendors Alerts Conditions
Alert Condition Start Ot Followup Dt
TesT o data to dispay
Intesfaces
4P Transactions
GL Transactions
CasA Reconciiation
‘ Account Details Other Information
Conversion Accounts ‘<
Dues Collateral Information
Description Ientification = Year AssetTpe  SubType
000 000 000 0.00 000 o 0
o 0 i i
Delg Due 0.00 Total Due 2000 Future Pt Dt 10/01/2016 o 0 x i
LCDue 0.00 Todays Payoff 4531462 Oldest Due Dt 10/03/2015
F Due 2000 Future Payoff 537630 Amt paid Excess 0.00 2
Other Due 0.00 Future Payoff Date 02/27/2016 Customer Information
: ) Customer e Relation S5 Bith Dt Gender
Delinquency Information #
@ 20 10 180 Category Da 000000... KAVINK PRINARY 008677 02/12/1967
0 0 0 0 0 0 0 27 000000... RICHARD MURRAY IR PRIMARY 00009332 12/08/1585 UNDEFINED
»
ee(ife) 0 nsk(ufe) 1 Collector DEMOCOLL
ep(vear) 0 NSF(tear) 1 Email Privacy Opt Out Y
e Language ENGLISH Active taltary Duty 1
= lvities Marital Status top N Time Zone
jicoleions Ade ot /1072015 aop = 0000000083 Lstptant 000 conespodence
> WFP Last Activity Dt 02/17/2016 Paid Off Dt Charge Off Dt
Due Day 1 Effective Dt 10/12/2015 "
b okl Last Pt Dt Current Pt 3,981.80 (Adress Information
> Setup Customer Grade B Last Bll Amt 0.00 Type current PEMISH waiing address Phone. %

You are now ready to begin work on the account.

You can view the accounts pending for your review by selecting Receiver in the Review
Request tab.

Search Using Business Details

To search and load an account with specific business using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

1. Select Business as the search option.

ORACLE"
Financial Services Lending and Leasing

@8 Customer Service [ Close.
Search | Customer Service | Review Request (Pending: 0) | Queue Assignment 2
5
> DashBoard > Quick Search
> Origination
Servicing Search Criteria
Sesrch Options: € Account(®) Customer @) Business
Servidng
S & Resetciitera | @ Search
Seauritization
Transaction Authorization View = Fomat> | B} e oo L |
Post Date Checks Griteria Comparisan Operator Value
Escrow Transactions BUSINESS # LIKE =
Account Documents BUSINESS NAVE Le [x]
Colateral Management e — =
Reports START DATE GREATER THAN OR EQUAL [+] £
Producers 4 E
— PrONE NUVBER cqun &
Batch Transactions I CODE L =
Advances
Payments =
Open Accaunt
Fees Loe
Interfaces
Search Results
2P Transactions .
e View~ Formatv Freeze ffi Detach Wrap ®
Conversion Accounts Business = Business Name Tax1d StartDt PhoneNumber  Zp
o data to cispiay.
> Collections
> WFp View v Format v | Ep Freeze  {oft Detach wrap @
Compan Branch Account Product Curreng Pay OFF Amt Amount Due Status Oldest Due Dt
> Tools pey ¥ 4
o data to dispiay.
> Setup

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find the business type. You can click Reset Criteria at any time to clear
the Comparison Operator and Value columns.
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3. Click Search. The system locates and displays all the records that meet your search
criteria on ‘Search Results’ section.

ORACLE’
Financial Services Lending and Leasing
T e— @ dose
Search Results i
View ¥ Format v Frezze i Detach ap
> DashBoard & H @
- Business # Business Name Tax1d Start Dt Phone Mumber  Zp
» Origination oooo021005 oFsiL 55236 02/08/2010 (co0y000-0000 01152
Servicing
Servidng
Customer Service Ven v Fomatv [ Frezze i Detach wep | @
Searttzaton g s
i ompany Branch Account # Product Currency Pay Off Amt Amount Due: Status Oldest Due Dt
A Al uso1 usHg 170200029956 LOAN VEHICLE (FR) usn 10,000.00 0.00 AcTIvE 03/15/2017
Past Date Checks
Escrow Transactions
Aczount Documents =
Business
Collateral Management
Reports
Producers i Business Details
Vendors Elew
Batch Transactions
Advances View v Format~ P Freeze i Detach Wrap W
Payments
B Organizaton Type  Type ofBusiness  Business Category  Mame of the Business LegalName TaxD = StartDt #ofEmployess(cur) = of
Interfaces coore CORPORATE CORPORATE oFsLL = 3000005236 02/08/2010 20
2P Transactions « n v
6L Transactions
Conversion Accounts Addresses | Telecoms || Partners || affiiates || Tracking Atrbutes
i vew
ST TS Address Information ) B
o view ™ Formatv [ Freeze Efipetach | o wirsp 5}
0
Address Type Current Country Address = aty state Postal Type strestpre Strest Name StrestType sm
7 Tools WORK Y UNITED STATES SPRINGFIELD MASSACHUSETTS ~ NORMAL ADDRESS
> Setup g i C

You can view the view the following information for each business record:

In this field: View this:

Business # The registered business number of the company.
Business Name The name of the business.

Tax ID The taxation identity number of the business.
Start Dt The date when the business was initiated.
Phone Number The contact number of the business.

Zip The zip code where the business is established.

4. Onthe Results screen, select the business type of your interest. The sub section displays
the accounts associated with the selected business with the following details:

In this field: View this:

Company The company of the account.

Branch The branch of the account

Account # The account number

Product The Lease product of the account.

Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.
Amount Due The total amount due on the account.

Status The status of the account.

Oldest Due Dt The oldest payment due date on the account.
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Also the ‘Business’ section below displays the Business Details along with Addresses,
Telecoms, Partners, Affiliates and Tracking Attributes. You can click ‘View’ to display the
details in each section.

5. Select the required account and click Open Account. The system loads the account
associated with the business type in the Customer Service tab

ORACLE'

Financial Services Lending and Leasing

> DashBoard

> Origination

Servicing

Senvidng

Customer Service
Securitization
Transaction Authrization
Post Date Checks.
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors

GLTransactions
CAsA Reconciliation

Conversion Accounts.

> Collections
> WP

> Tools

> Setup

Customer Service x

Search |

: 2015100001054

quest (Pending: 0)

Account(s): 20151000011054: K NAVIN

View v Fomat~ B
Company
usor

Branch
ust
Summary
Alerts
Alerts

Alert
TeST

Account Details

Dues
000 000
Delq Due 0.00
LCDue 0.00

NSF Due 2000
Other Due 0.00

Delinquency Information

Late
o o o 0
Bp(Life) 0
BP(Year) 0
Activities

Active Dt 12/10/2015
Last Activity Dt 02/17/2016
Due Day 1
LastPmt Dt
Customer Grade B

Customer Service | Account Details

Freeze &t Detach ¢l wrap ®

Sub Unit
UNDEFINED

Customer Detalls

Total Due 20.00
Todays Payoff 4531462
Future Payoff 45,376.30

Future Payoff Date 02/27/2016

w0 1w

0 0 o
NSF(Life) 1
NsF(vear) 1

App # 0000001013

Paid Off Dt
Effective Dt 10/12/2015
Current Pt 398180
Last Bill Amt. 000

Transaction History

&  ©curent

a8 show All

7 Product
2015100001054 LOAN VEHICLE (FR)

Pt Modes | Bankruptey

Future Pmt DE 10/01/2016
Oldest Due DE 10/01/2016
Amt Paid Excess 000

Category Days
227

Callector DEMOCOLL

Last Pt Amt. 0.00
Charge OFf Dt
[

Group Follov-up

Days Past Due Currency
227 UsD.

Repo/Foredosure | Deficiency

Conditions

Conditions
Condition
o data to display.

Other Information
Collateral Information
Description
0
0
0
Customer Information
Customer

000000... NAVIN K

Collateral

000000... RICHARD MURRAY JR

Email
Language ENGLISH
Marital Status

Address Information

The  Curent P

(3] Close
Blyen || Paust
Pay Off At Amount Due Status Oldest Due Dt
31362 0.00 A 10012016
Bureau || Cross/Up Sell Activities
startot Followp Dt
‘
Uentfication s Year  AssetClass  AsetTipe  SubType
0 N 1c 1
0 1 1
0 i 1
Relation ssi Bith Dt Gender
PRIMARY 0008677 02/12/1967
PRIMARY o332 12/08/1985 UNDEFINED
»
Prvacy OptOut Y
Sp N Active titary Duty N
stop N Time Zone
Correspondence
Adiress Phone z

Mailing
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2.1

2.2

2. Dashboards

Introduction

This document is designed to help acquaint you with the features of Dashboard, on the
landing screen of Oracle Financial Services Lending and Leasing. Information from multiple
products is integrated and displayed as Dashboard on home screen of the application.

This manual explains the functionality of Dashboard facility and various Dashboards present
in the system. Since this section details the general dashboard options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing. Besides providing these details, the manual also provides a brief description of
other features associated with Dashboard link. The Dashboard main Menu further provides
links to the following screens:

e Dashboard

e Users Productivity
e System Monitor

e Producer Analysis

Dashboards

Dashboards are the tiny windows displayed on landing screen of the Application. Dashboard
renders quick and crisp information of specific transactions or tasks mapped to the ‘User
Role’, who logs on to the system.

The system facilitates integration of Information from different levels and displays it as
Dashboard on home screen, also called the landing screen of the application.

Navigating to Dashboards
Click Dashboard > Dashboard > Dashboard.

ORACLE. i ) 5 Welcome, PRAKRRAO ~  Accessibilty =)
Financial Services Lending and Leasing

DashBoard 38 Close

Origination Setup Admin

My User Queues Product Expiring in Next One Month Critical Batch Job Status
Count. Product End Date Batch Job Status
No data to display. No data to display. No data to display.

My Pending Review Requests By Applications
App = Priority
No data to display.

My Pending Review Requests By Priority
Priorty Gount
No data to display.

Servicing Producer Vendor

Number of Queues Hard Assigned A~ Producers Count By Status ‘Vendors Count By Status
Queue Description Count. Status Count Status Count
No data to display. ACTIVE 82 ACTIVE 35

Number of Accounts Producers Expiring in Next One Month Vendors Expiring in Next One Month
ueue Description Count Producer End Date me £nd Date
No data to display. No data to display.

My Pending Review Requests By Accounts
Acc = Priority
No data to display.

> Origination My Pending Review Requests By Priority ”
> Servicing | Priority Count.

> Collections

> WFP

> Tools

> setup

Features

Following are the features of Dashboard:
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2.3

2.4

e The system organizes Dashboards to provide comprehensive and consolidate snapshot
in tiny windows, to access information easily. Thus, helping to; analyze, monitor and
make better decisions which in turn help save time and cost.

e The screen is designed to display six Dashboards, distributed in two rows with three
Dashboards per row, without scroll bars.

e The height and width of all Dashboards are fixed; however, you can expand or collapse
the Dashboards. Click the arrow heads at the top left corner of the Dashboard windows
to expand or collapse the dashboard windows.

e Each section in Dashboard is hyperlinked to home screen of the respective section. The
main screen will present descriptive information of details shown in Dashboard only.

e Each window in the dashboard is provided with a Refresh button and clicking on the
same would fetch the latest status of the dashboard being viewed.

User Productivity

Oracle Financial Services Lending and Leasing User Productivity Setup screen is a
supervisor feature that allows you to monitor the daily performances of users completing
origination and servicing tasks.

These tasks are categorized as The system updates these details on daily basis.
Using the User Productivity Setup screen, you can review the following daily tallies:

This chapter explains how to use the User Productivity Setup screen to view this information.

Navigating to User Productivity Screen
1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > User Productivity.

2. The system displays the User Productivity screen. You can view the tasks related to:
e Underwriting/Funding
e Customer Service/Collection

System Monitor

The System Monitor screen is the one stop place to check all the activities in and around the
system. It maintains the progress of;

e Batch Jobs

e Jobs

e Services

e Database Server Log Files
e Parked Transactions

e Users

Navigating to System Monitor

On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor.
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241 Monitoring Batch Jobs

The system tracks the success of each batch process on the Batch Job. If either a set of batch
jobs or specific batch job should fail, you can resubmit it on this screen and review the results
in Request Details section.

The Monitor Batch Jobs screen is only a display screen that contains the following sections:
e Batch Job Sets
e Batch Jobs
e Batch Jobs Threads
e Request Details
e Request Results
To Monitor Batch Job
1. Click Dashboard > Dashboard > System Monitor > Batch Jobs.
2. Inthe Batch Job Sets section, you can view the following information

ORACLE" ) . # Welcome, PRAKRRAO +  Accessibilty (=]
Financial Services Lending and Leasing

it Close.
A System Monitor 5 B[
4 DashBoard, | BatchJobs | Jobs | Services  Database Server Log Files | Parked Transactions | Users
Board
Users Productivity
System Monitor Batch Job Sets
Producer Analysis Vieww Formatw [} Fresze i Detach Wrap T BB Re-submit Job Set
Process Files Set Code Job Set Description  Status Frequency Frequency Value  Start Time Encbled Critical Last Run Dt Next Run DI
SET-AAL ACOOUNT CREATL.. READY DAILY DAILY 10:00 AM N N 08/08/2003 08/03/2003 A
SET-ACR ACCRUALS AND D... READY DALY DAILY 10:30 PM N ¥ 08/07/2003 08/08/2003 W
< >
Batch Jobs
Vieww Format~ [ Fresze [fiDetach | ¢ Wrsp ) BB re-submit Job
Seq Job Type Job Code Status Job Description Threads Commit Count Errors Allowed Weskend Holiday
1 PROCEDURE AAIPRC_BJ_100_01 COMPLETED APPLICATION TO. 1 100 50Y Y
2 PROCEDURE TXNACT_E]_100_01 COMPLETED ACCOUNT ACTIVA 1 100 50Y Y
< >
Batch Job Threads
§ vews Fomate B Freze FliDetsch | lwep | @)
Thread Status Errors. Records Trace Level Enabled
1 IDLE o
Request Details
View ~ Format+ [ Fresze ) Detach Wrap (5]
Request Type Status Start Dt End Dt Run Start Dt Run End Dt Process Dt
No data to display.
< >
Request Results
Viewv Fomaty B Frezze | Detach Wrap W
Requast Result Description
> Origination No datz to display.
> Servicing
> Collections
> WEP
> Tools
> Setup

A brief description of the fields is given below:

Field: View this:

Set Code Displays the code for batch job set.

Job Set Description | Displays the description for batch job set.

Status Displays the job set status.
Frequency Code Displays the frequency at which the job set is to be executed.
Frequency Value Displays the value of frequency code chosen for the job set.

Start Time Displays the start time for the job set.
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Field: View this:

Enabled Displays if the job set is enabled or not.

Critical Displays if this job set is critical or not.

Last Run Dt Displays the date of last run of the job set.

Next Run Dt Displays the next run date for job set.

Parent Displays the preceding job set.

Dependency Displays the type of dependency on predecessor.

To resubmit a batch job set

Whenever a batch job set fails, it is best to resubmit it after correcting the errors that caused
the failure. Resubmitting a set causes system to re-perform the batch job set and dependent
batch jobs.

e Inthe Batch Job Sets section, choose the batch job set to resubmit (only a batch job
set with a status of FAILED can be resubmitted), then click Resubmit Job Set button.

The Batch Job screen also allows you to resubmit jobs which are in READY or COMPLETED
or FAILED status if you have access key privileges define for your user responsibility. If
provisioned, then a ‘Force Re-Submit Job Set’ button is available instead of ‘Resubmit Job
Set’ button to resubmit the jobs with above status.

The Batch Jobs section lists the batch jobs within a job set. The status, threads, commit
count, dependencies, enabled indicator and the holiday and weekend runtime indicators are
shown for each job.

A brief description of the fields is given below:

Field: View this:

Seq Displays the batch job sequence number.
Job Type Displays the batch job request type.

Job Code Displays the batch job request code.
Status Displays the job status.

Job Description

Displays the batch job description.

Threads

Displays the number of threads used by the job.

Commit Count

Displays the number of rows after which auto-commit is
triggered.

Errors Allowed

Displays the number of errors allowed.

Weekend Displays if the batch job will execute job on weekend or
not.

Holiday Displays if the batch job will execute job on a holiday or
not.

Enabled Displays if the job is enabled or not.

24 ORACLE




Field: View this:

Parent Displays the preceding job.

Dependency Displays the type of dependency on predecessor.
Command Displays the command line for the job.

Rollback Segment Displays the rollback segment for job.

To resubmit a batch job
Whenever a batch job fails, it is best to resubmit it after correcting the errors that caused
failure. Resubmitting a set will cause system to re-perform the batch job.

e Inthe Batch Jobs section, choose the batch job to resubmit (only a batch job with a
status of FAILED can be resubmitted), then choose Resubmit Job Set.

e The Batch Job Threads section displays the status of individual threads.

A brief description of the fields is given below:

Field: View this:

Thread Displays the name of thread.

Status Displays the status of thread.

Errors Displays the number of errors in the thread.
Records Displays the number of records in the thread.
Trace Level Displays the SQL trace level (0, 1, 4, 8, 12).
Enabled Displays if the job thread is enabled or not.

The Request Details section displays the status and runtimes for each time the selected job
ran.

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Start Dt Displays the job request is valid from this date and time.

End Dt Displays the job request is valid till this date.

Run Start Dt Displays the date and time on when the job run started.

Run End Dt Displays the date and time at which the job run ended.

Process Dt Displays the transaction is posted with this General Ledger effec-
tive date.

Description Displays the job request description.
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If a particular job requires that a result message be created, then that message appears in the
Request Results section. A message is usually created in the event of an error.

A brief description of the fields is given below:

Field: View this:

Request Results | Displays the result of job request.

Description Displays the result details.

2.4.2 Monitoring Jobs

The Monitor Jobs screen provides another view of monitoring all system processes, including
credit bureau requests and payment posting. This screen displays the data in reverse
chronological order of the Run Start Date/Time, whereas the Monitor Batch Jobs screen
provides the historical data about each job and job set.

To Monitor Job Details
1. Click Dashboard > Dashboard > System Monitor > Jobs.

ORACLE'
Financial Services Lending and Leasing

‘System Monitor 3 [ Close
BatchJobs | Jobs  Services | Datsbase Server logFies | ParkedTransactions | LUsers iz

Batch | Back Ground || Credit Request

Job Details

View ~ Format~  [Er Freeze i Detach frap ) Viewlsst ©@ 1Day() 1Week(© IMonth(ByDate StartDt End Dt @ View © Failed @ All

Valid Execution
Request Type Status Job Set Job Description Thread Errors Records Run Start Date/Time Run End Date/Time  Process Dt Period Start

Date/Time
PROCEDURE 'COMPLETED SET-TPE TXNDDT_BJ_100_... TXNDDT_BJ_100_.. x 0 2 09/19/2017 11:52:... 09/19/2017 11:52:... 09/20/2017 09/19/2017 11:52:
PROCEDURE compLETED SET-TPE TXNDDT_B)_100_... TNDDT_BJ_100_ 1 o 8 09/19/2017 11:40:... 09/13/: ... 09/20/2017 08/19/2017 11:40:
PROCEDURE COMPLETED SETQRT QUSPRC_83_100_... QCSPRC_B)_100._ 1 0 2 0/19/2017 03:31:.. 09/19/2017 09:31:... 09/20/2017 09/19/2017 09:31:

4 PROCEDURE COMPLETED SET-QRT QCSPRC_BJ_100_... QCSPRC_BJ_100_. 1 o 2 09/19/2017 08:31:... 09/19/2017 08:31:... 09/20/2017 09/19/2017 08:31:

PROCEDURE compLETED SET-QRT QUSPRC_BI_100_.. QCSPRC_B)_100._ L 0 2 0/19/2017 07:31:... 09/19/2017 07:31:... 09/20/2017 05/19/2017 07:31:
PROCEDURE compLETED SET-QRT QUSPRC_BI_100_.. QCSPRC_B)_100._ L o 2 0/19/2017 06:31:... 09/19/2017 06:31:... 03/20/2017 09/19/2017 06:31:
« 0 S

Job Detail Description
TXNDOT_B1_100_01. TXNDDT_B]_100_01(6006)

Job Results
View = Format~ Freeze i Detach Wrap o)

RequestResut  Description

et

2. Onthe Job screen, you can select any of the following type of jobs which are available in
separate tabs:

Select: System Displays:

Batch Batch jobs (used primarily for the nightly processes).

Back Ground User submitted requests, such as reports and payment posting.
Credit Request Credit bureau requests.

3. Inthe Job Details section, select the time frame based on elapsed days. You can select
any of the following options:

Select: System Displays:

1 Day All the types of jobs selected in Jobs Type section in last one-day.

1 Week All the types of jobs selected in Jobs Type section in last one-week.
1 Month All the types of jobs selected in Jobs Type section in last one-month.
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Select: System Displays:

By Date All the types of jobs selected in Jobs Type section for specific duration.
You can specify a date range (within 3 months) in ‘Start Dt’ and ‘End Dt’
fields using the adjoining calendar and click ‘Search’.

4. If you select Failed option in the View section, the system displays failed jobs on the type
and time frame you have selected.

5. In the Job Details section, you can view the following information about jobs matching
the contents of Job Type, View Last and Failed boxes:

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.
Status Displays the job request status.

Job Set Displays the job set code.

Job Displays the job description.

Thread Displays the job thread.

Errors Displays the number of errors.
Records Displays the number of records processed by the job.
Run Start Date/Time Displays the job run start date time.
Run End Date/Time Displays the job run end date time.
Description Displays the job request description.
Process Dt Displays the job process date.

Valid Execution Period

Start Date/Time Displays the job start date/time.

End Date/Time Displays the job end date time.

6. Inthe Job Results section, you can view the following information about the Job selected
in Job Details section:

A brief description of the fields is given below:

Field: View this:
Request Type Displays the job request type.
Description Displays the job request description.
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Monitoring Services

The Services screen allows you to track and maintain the system’s processing services,
including credit bureaus, fax-in and batch job scheduler. The system administrator can start
or stop the service on this screen using the action buttons respectively.

To stop, start or refresh a processing service
1. Click Dashboard > Dashboard >System Monitor > Services.

2. Inthe Services section, you can view the following information about the system’s
processing services:

ORACLE’

Financial Services Lending and Leasing

3 Wekome, PRAKRRAG +  Accessbilty =)

DashBoard
DashBoard
DashBoard
Users Preductivity
System Monitor
Producer Analysis
Process Files

» Origination
> Servicing
> Collections
> WEP

> Tools

» Setup

System Monitor x

Batch Jobs | Jobs

Services

View = Format~ [ Freeze g4 Detach Wrep W @sttus st Olstop

Service
csv
sV
csv
15C
v

[ Close

Services  Datsbase Server Log Files | Parked Transactions | Users

Company Branch Description
ALL ALL 'CREDIT BUREAU SERVICE (EFX TEST FILES) STOPPED

ALL AL UREAL SERVICE (EXP TEST FILES)
ALL ALL

Ll ALL !
AL ALL JOB SERVICE STOPPED

A brief description of the fields is given below:

Field: View this:

Service Display the service name.
Company Display the service company.
Branch Display the service branch.
Description Display the service description.
Status Display the service status.

3. Inthe Action section, select the processing service you want to work with and choose
one of the following commands in Action section.

Choose:

System:

Status

Refreshes (updates) the status of service. The Service screen does
not update the status in real time. You must choose Status after
choosing Start or Stop to perform that command.
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Choose: System:

Start Starts the job service.

Stop Stops the job service.

Database Server Log Files

Various processes in the system create reports in different log files with regards to what tasks
they performed and what they encountered (for example, errors, failures, erroneous data and
so on). The Database Server Log files tab lists and describes all such log files within the
system on the database server.

To view a log file on the database server
1. Click Dashboard > Dashboard > System Monitor > Database Server Log Files.

ORACLE" | " > Yy g sgnowt &
Financial Services Lending and Leasing
&  System Monitor (3] Close
BatchJobs  Jobs | Services  Database Server Log Files | Parked Transactions | Lisers =
DashBoard
DashBoard = Database Server Log Files
ashBoar W € il Start Ot End Dt View ©) Alert(® Debug @ Interfaces
Ao Ve 1Day & 1 Week @ 1 Month & By Date iy T
asi
Users Productivity -
View = Format = Freeze i Detach Virap ISUstFies [ Download File =
System Monitor ew T roma & o W = Ge
prodices Anaals 3 File Name: File Type File Size File Time
o 7 xaeprc_em_100_02_FMW116_7033906.log fie 159179 08/31/2017 02:28:52 AM -
JSVPRC_EN_000_01_DB12102_6574056.log fie 171338 08/28/201707:42:07PM [
JSVPRC_EN_000_01_DB12102_7283863.Jog fie 19897 09/10/2017 10:39:59 AM
g XAEUPD_EM_100_02_FMW116_7203940.log fie 46704 03/07/2017 03:50:43 AM
RDNLOG_EW_100_01_FMW116_7284144.log fie 1108 09/08/2017 06:00:34 AM -
> Origination FleLontent
View = Format v Freeze i Detach Nirap @ Beginning ©) End  # ofLines 50 Show File
> Servicing it 50} =
- Text
i Calertions 08/31/2017 12:35:32: cmnini cl 000 0i.initialize svc -
> WEP :32: cmnsyp_cl get_syp paramever value parameter: XAEPRC EM 100 02 _DEBUG_LEVEL
5 Tools :32: xaeprc_em submit for BApp No:
: User code: INTERNAL
> Setup -
:32: 1v_statement - SELECT ptc_cur currency code FROM xae ptc_svw WHERE PTC COMBANY = :bl 1

2. In the Database Server Log Files section, you can sort the list of logs to be displayed
based on following options:

e Select the ‘View Last’ option to display the logs based on elapsed days by selecting 1
Day /1 Week /1 Month / By Date. If ‘By Date’ option is selected, you can specify a date
range (within 3 months) in ‘Start D’ and ‘End Dt’ fields using the adjoining calendar.
Click ‘Search’.

e Select the ‘View’ option to further filter the list based on the type of logs to be displayed
by selecting Alert / Debug / Interfaces.

3. Click on = List Files button to view the list of logged files. A brief description of the fields
are given below

Field View this:
File Name Displays the name of file.
File Type Displays the type of file.

File Size Displays the size of file.

File Time Displays the date and time stamp of file.

4. To extract a local copy of debug details, click & Download File button and save the file.

5. Inthe File Content section you can view the content of the file selected in the Database
Server Log Files by clicking & Show File button.
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6. To sort the view of file contents, select the order as either ‘Beginning’ or ‘End’ and specify
the value for ‘# of Lines’ to be displayed (default 50).

Parked Transactions

Transactions which are posted when the end of day (EOD) batch job process is running,
receive a temporary status of HOLD. Once the EOD batch process is complete, the system
posts the transactions on hold. These transactions can be thought of as “parked” transactions.
They are waiting to be processed after the EOD batch process. The status of such
transactions can be viewed in the Parked Transaction screen.

To Monitor parked transactions

1. Click Dashboard > Dashboard > System Monitor > Parked Transactions

ORACLE’
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# welcome, ABSHEKAR ¥ Accesshiity 1§ Sonout O

System Monitor x 3] Qose

Batch Jobs || Jobs || Services | Datsbase Server LogFies | Parked Transactions || Users

Transaction Details
view v Format v [ Freez= i Detach firap ) ViewLast © 1Day © 1Week® 1Month © By Date  startDt End Dt ) View ©) Failed @ Al

Date Account # : Title Transaction

a Status Monetary
No data to dsplay.

Transaction Results
view v Formatv [ Freeze  EfiDetach Wirap ®
Transaction Frocessing Detals
¥ Nodata to display.

2. Inthe screen’s View Last section, sort the list of transactions to be displayed based on
elapsed days by selecting 1 Day / 1 Week / 1 Month / By Date. If ‘By Date’ option is
selected, you can specify a date range (within 3 months) in ‘Start Dt and ‘End Dt fields
using the adjoining calendar. Click ‘Search’.

3. Ifyou select Failed in the View section, system displays the failed transactions of the time
frame you have selected.

4. In the Transaction Details section, you can view the following information about the
parked transactions meeting the criteria of the View Last and Failed sections.

A brief description of the fields is given below:

Field: View this:

Date Displays the transaction date.

Account #: Title | Displays the account number and title.

Transaction Displays the transaction

Status Displays the status of transaction

Monetary Displays if the transaction is a monetary transaction
or not.

5. In the Transaction Results section, view the results of transaction in Transaction
Processing Details field.
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2.4.6 Monitoring Users

The Users Logins section allows you to view all users who have logged on to the system,
along with the log on time stamp and logout time stamp. The information appears in reverse
chronological order of the log on time stamp.

To monitor users who have logged on to the system

1. Click Dashboard > Dashboard >System Monitor > Users.

ORACLE’
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System Monitor x [ Close
Batch Jobs || Jobs  Services  Datbase Server Log Files | Parked Transactions | Users E
User Logins
View > Formatv Freere  fiDetach Wrap ) ViewLast @ 1Day(© 1Week © 1Month ) By Date  Start Dt End Dt @ View User ) Current User @ Al Users
User User Name: Detaiis Login Date and Time L0224t and
SURABHI SURABHI DESAT 09/20/2017 04:56:... 12/30/4000 12:30
SURABHI SURABHI DESAT 09/20/2017 04 ... 12/30/4000 12:30
ABSHEKAR ANAND SHEKAR 09/20/2017 04:38:... 12/30/4000 12:30:
PRITAM PRITAM JENA 09/20/2017 04:30:... 12/30/4000 12:30
sksk sarsk 09/20/2017 03:54:... 12/30/4000 12:30
¥ PRITAM PRITAM JENA 09/20/2017 03:47:... 12/30/4000 12:30: -
MAVEEN NAVEEN REDDY 09/20/2017 03:47:... 09/20/2017 04:55
JAYANTA JAYANTA C 09/20/2017 02:37:... 12/30/4000 12:30:...
SKSK SALSK 09/20/2017 02:35:... 12/30/4000 12:30: ..
NAVEEN NAVEEN RECDY 09/20/2017 02:08:... 12/30/4000 12:30:...
PRITAM PRITAM JENA 09/20/2017 01:45:... 12/30/4000 12:30:...
IAYANTA JAYANTAC 09/20/2017 01:45:... 09/20[2017 02:37:...
PRITAM PRITAM JENA 09/20/2017 01:27:... 12/30/4000 12:30:...
Svsv SHRIVATS SINGH 09/20/2017 01:20:... 12/30/4000 12:30:...
NAVEEN NAVEEN RECDY 09/20/2017 01:14:... 12/30/4000 12:30:
NAVEEN NAVEEN RECDY 09/20/2017 12:39:... 12/30/4000 12:30:
ABSHEKAR ANAND SHEKAR 09/15/2017 11:45:... 12/30/4000 12:30:
PHACHCDA PHANINDRA CHODA 09/19/2017 11:37:... 12/30/4000 12:30:
NAVEEN NAVEEN RECDY 09/19/2017 11:32:... 12/30/4000 12:30:
NAVEEN NAVEEN RECDY 09/19/2017 11:21:... 09/19/2017 11:3% i

2. Inthe User Logins section, sort the list of records to be displayed based on elapsed days
by selecting 1 Day / 1 Week / 1 Month / By Date. If ‘By Date’ option is selected, you can
specify a date range (within 3 months) in ‘Start D’ and ‘End Dt’ fields using the adjoining
calendar. Click ‘Search’.

A brief description of the fields is given below:

Field: View this:

User Displays the user ID.

User Name Displays the user name.

Details Displays the details.

Login Date and Time | Displays the login date time for the user.

Logout Date and Time | Displays the logout date time for the user.

2.5 Producer Analysis

The Producer analysis screen enables you to view and know the status of all applications
sourced by different Producers.
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Navigating to Producer Analysis
Click Dashboard > Dashboard > Producer Analysis.

ORACLE" 2 Welcome, PRAKRRAO »  Ac

Financial Services Lending and Leasing

Producer Analysis 5

oard

Select Criteria
Users Productivity
System Monitor Company ALL [] Territory =2 Funder ALL ]
Producer Analysis Branch ALL[¥] Salles Agent ALL [v] Status >
Process Files

Region AL [v] Undenwriter ALL [v] zp -
Producers | Terrtories Activity | Volume || Mix
> Dealer

Recent Activity
No data to display. e Roiad Approved Funded
No data to display.

Recently Approved Applications
Applicant Name  Application # Amt. Collateral Desc
No data to display.

Recently Funded Applications
Applicant Name Application # Amt Collateral Desc
No data to display.
4

Recent Comments
& Detach
Date Comment Desc
o data to display.

> Origination
> Servicing
> Collections
> WEP

> Tools

> Setup

B submit

Comments

You can filter producer details based on any or all of the following criteria:

e Company

e Branch
e Region
e Territory

e Sales Agent
e Underwriter
e Funder

You can select the values from the adjoining drop-down list. Click ‘Submit’ button. System

displays the Producer details satisfying the criteria, you selected.

The following details are displayed under Producer Details section:

e Producer #
e Name

e Company
e Branch

e Type

Select the producer you need to view the statistics. The system displays the statistics under

‘Summary’ sub tab and the status and sub status of various applications under ‘Applications’

sub tab, of the selected producer.

The system displays the following details under ‘Summary’ sub tab:

e Year
e Total Apps
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Approved
Conditioned
Rejected
Withdrawn
Funded
Amount

The system displays the following details under ‘Applications’ sub tab:

Company
Branch
App #
Date

Title
Product
Status

Sub Status

Process Files

The Process files screen allows you to view the incoming and outgoing files exchanged
between OFSLL and other interfaced systems for processing and also perform a bulk upload
of required files.

The Process files interface also provide information on the type of files uploaded along with
other attributes. In-order to facilitate the process files handling, the following parameters has
to be enabled in Setup > Administration > System > System Parameters screen. For more
information on enabling system parameters, refer to ‘System Parameters’ section in Setup
Guides.

CMN_FILE_PROCESS_TO_LOB

On enabling the above parameter, system stores the incoming / outgoing documents in
the relevant tables and not in the file system.

UIX_INCOMING_FILE_PATH
UIX_OUTGOING_FILE_PATH

On enabling the above two parameters, the incoming and outgoing file path of
application server need to be defined to the required folder path by updating the
‘Parameter Value’ which by default is ‘SETME’. (For example: /tmp)

If both the parameter ‘CMN_FILE_PROCESS_TO_LOB’ and ‘OUTBOUND_CALL_Q’
are enabled (status ='Y"), system automatically handles upload/download of files from
Weblogic configured process files.

Depending on the CLOB parameter option, if set to Y’ the incoming/outgoing file directories
are to be manually created in Web Logic server. For details of directories, refer to ‘Creating
Application Home directory’ section in Database Installation Guide.
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Incoming Process File

The incoming process file screen displays the list of files being shared from an external
system along with other attributes such as directory path, file name, type, size, date and
status. You can select the file required and upload it into the system for immediate processing.

ORACLE’
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y 1§ sgnour O

SHEKAR ~

Process Files

Incoming Process File  Outgeing Process File

Incoming Process File

View ~ Format = %
¢n

Select Al [

Freeze  FfiDetach

Directory Name

" uploaded Files
View * Format~  [E

File Name

SampleR esponseAssets.json
SampleResponseAssets. json
LookupResponseWithLookupDescPassedAs_CALC.json
LookupRespanselithLookupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json
LookupResponseWithLookupDescPassedAs_CALC.json
LookupResponseWithLookupDescPassedAs_CALC json
LookupResponseWithl okupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json

Freeze  EfiDetach

@

2= List Files

File Name

[} Jscratchfwork_area/DEV/DE. . callactivity_test XV.tet

B upload

File Type

W) Viewlast © 1Day®) 2Days@ 5Days@ Al Days

Fie Type

FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA UPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD

File Dt

08/14/2017 12:41:17 PM
08/14/2017 12:39:22 PM
08/04/2017 01:07:23 PM
08/04/2017 11:45:18 AM
08/04/2017 01:26:24 AM
08/04/2017 01:20:29 AM
08/03/2017 09:37:30 PM
08/03/2017 09:34:58 PM
08/03/2017 02:23:56 AM
08/03/2017 02: 18:27 AM

[E@ Download Bad Data
Status
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED

File Siz=(bytes)

3 08/12/2016 05:23:01 AM NONE

[ Download Log Data

File Date

[®] Close

)

Status

User
INTERNAL INT %
INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT =

View the list Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming

files.

A brief description of the fields is given below:

Field:

Description:

Select All

Select this option to select all the listed files.

Directory Name

View the directory path where incoming file is stored.

File Name

View the name of the file.

File Type

View the type of incoming file. The file type is auto populated
based on ODD (Output Data Definition) details maintained for
the specific file type in INCOMING_FILE_TYPE_CD lookup.

File Size(bytes)

View the size of incoming file.

File Date

View the date and time when the incoming file was placed in

the directory.

Status

View the status of the file.

Upload Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming
files. You can click L2l to refresh the grid data.

3. Select the check box adjacent to the required file and click Upload. You can also click

Select All check box to perform a bulk upload of all the listed files.
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2.6.2

The uploaded files are listed in below ‘Uploaded Files’ section and the status of the files
are changed from ‘Generated’ to ‘Uploaded’. In case of a processing error, the status of
the file is indicated as ‘Processed Error’.

Uploaded Files

The uploaded files section displays the list of incoming files uploaded into the system. You
can sort and view the list of files depending on the number of days based on Last 1 Day / 2
Days / 5 Days / All Days. You can click 2 to refresh the grid data.

On selection, you can view the following information:

Field: Description:

File Name View the name of file uploaded.

File Type View the type of file uploaded.

File Dt View the date and time when the file was uploaded.
Status View the status of upload.

User View the login ID of User who performed the file upload.

In the Uploaded Files section, you can do the following:

e Click Download Bad Data to download the list of uploaded files which had processing
errors due to bad data.

e Click Download Log Data to download a log of all the files uploaded.

Outgoing Process File

The outgoing process file section displays the list of files being shared for upload to other
system for processing and allows you to download the required file for inspection.

Financial Services Lending and Leasing
Process Files » [®]Cose
Incoming Process Fle | Outgoing Process File =
Outgoing Process File
View v Format~ & Freeze L Detach o] irap @R G Download  ViewLast © 1Day (@ 2Days(D) 5Days(@ Al Days
selectal ] File Name File Type File Date File Sizz(bytes) Status
] customer_ach OUT PUT DATAFILE 07/10/2017 05:209:20 PM 533 GENERATED &
customer_ach OUT PUT DATAFILE 07/10/2017 05:26: 19 PM 533 GENERATED A
E customer_ach OUT PUT DATAFILE 07/10/2017 05:29:18 PM 533 GENERATED 1
customer_ach OUT PUT DATAFILE 07/10/2017 05:29:17 PM 533 GENERATED
[} customer_ach OUT PUT DATAFILE 07/10/2017 05:29:15PM 533 GENERATED A
M (& customer_ach OUT PUT DATAFILE 07/10/2017 05:29:15PM 533 GENERATED
[ data_change_lien_07102017_172914.dat OUT PUT DATAFILE 07/10/2017 05:20: 14PM 0 GENERATED
B customer_ach OUT PUT DATAFILE 07/10/2017 05:29: 13PM 533 GENERATED
E customer_ach OUT PUT DATAFILE 07/10/2017 05:20: 12 PM 533 GENERATED
customer_ach OUT PUT DATAFILE 07/10/2017 05:20: 11 PM 533 GENERATED -
History
View = Format~ [ Freeze fiDetach ol Wrap 0}
User Download Dt
DILEEP GRANDHI 08/10/2017 06:42:22 PM
DEMO SUPERUSER 07/31/2017 03:28:20 PM -

You can sort and view the list of files depending on the number of days based on Last 1 Day
/ 2 Days / 5 Days / All Days.
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On selection, you can view the following information:

Field: Description:

Select All Select this option to select all the listed files.

File Name View the name of upload file.

File Type View the type of file shared for upload. The file type is auto pop-

ulated based on ODD (Output Data Definition) details main-
tained for the specific file type in OUTGOING_FILE_TYPE_CD

lookup.
File Date View the date and time when the file was shared for upload.
File Size(bytes) View the size of upload file.
Status View the status of upload file.

Download Outgoing Process File

1. Click Dashboard > Process Files > Outgoing Process File.

System displays the list of files shared for upload. You can click 3 to refresh the grid
data.

2. Select the check box adjacent to the required file and click Download. You can also click
Select All check box to download all the listed files.

History

The history section displays the following details:
Field: Description:
User View the login ID of User who downloaded the file.
Download Dt View the date and time when the file was downloaded.
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4. Customer Service

Introduction

After an application has cycled through the Lease origination process, it becomes an account.
Account maintenance and collections tasks can be performed with Oracle Financial Services
Lending and Leasing’s Customer Service screen.

The Customer Service screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using Funding main tab or
convert from a legacy system. You cannot activate an account using the Customer Service
screen.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen. You cannot post and
reverse the payment in Customer Service screen. (For more information, see the Payment
Processing chapter).

Account Mask

After an application completes the Lease origination cycle and is funded or is ported into the
system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Quick Search section

Conditions and Queues

During the Lease application process, Accounts do not have sub statuses; instead, accounts
use conditions. Conditions further define the status of an account; for example: delinquent,
bankruptcy, scheduled for charge off, Do Not Charge Off. Conditions can be applied
automatically by the system based on set up, and manually by the system users using
Customer Service screen.
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The system can assign accounts to specific users by way of queues. Queues are a work flow
management tool that allow the users to work on accounts sequentially from a prioritized list,
rather than having to manually search for and load them. Queues are created and sorted
during nightly processing. Examples of customer service queues include due date change
requests, delinquent accounts, deferment requests, and title and insurance follow-up.

Account conditions serve as default queues; that is, an account’s condition determines which
queue the account is in.

In the following example, account has a condition of DELINQUENT, noted in the Conditions
section and Status field. The account was loaded from delinquent queue, DELQ (D).

A queue can be associated with only one condition. In the following example, the Delinquent
queue is associated with the Delinquent condition. However, an account can have more than
one condition, so an account can be in more than one queue. Multiple queues can be created
for a single condition. Account attributes (such as number of days delinquent and product
code) can be used for assigning accounts to a queue and sorting accounts within a queue.

You can quickly load an account from a queue using Next Account button in the Quick
Search section.

Customer Service screen

Most of the screens on Customer Service screen contain Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in Account(s) and Customer(s) sections, open Customer Service
screen and load the account you want to work with.

On Customer Service screen’s Account(s) section, view the following information: The
system filters and displays information based on your selection:

Command

Button: Action Performed:

Current Displays the current search account only. It does not matter how that
account was searched like using account search screen or selected
a queue from drop-down and pressed ‘Next’ button or account num-
ber was directly pasted in Acc# text box and pressed Submit but-
ton.This is the default option.

Show All Displays the related accounts based on current selected customer’s
customer Id. To view the details of account number(s) other than
current account, select the account in Account(s) section and click
Submit.
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Command
Button:

Action Performed:

Group Follow-
up

Displays the set of accounts that share same account condition as
the selected account and bear same Customer Id. Other than hav-
ing same account condition and Customer Id, the queue currently
selected should have the Group Follow-up Indicator enabled in
queue setup and follow-up date should fall in range of organization
level system parameter UCS_GROUP_FOLLOWUP_DAYS.

In Account(s) section, click View to view the following information:

In this field: View this:

Company The company of the account.

Branch The branch of the account.

Account # The account number.
Note: This can also be the external reference number in case of
conversion accounts if the value of system parameter
AUTO_GEN_ACC_NBR_CONV is set to ‘N'.

Product The product for the account.

Days Past Due

The total number of days elapsed past due date.

Currency

The currency for the account.

Pay Off Amt

The current payoff amount for the account.

Amount Due

The current delinquent amount due for the account.

Status

The account’s status.

DLQ Reason

The delinquency reason that gets auto updated by the system as
one of the following when the account is marked delinquent.

- 1st Payment Delinquency, when the first payment is delinquent.

- NSF Delinquency, when the payment amount on due date results
in NSF (non sufficient funds) in the account.

- Matured Delinquency, when account reaches the ‘Maturity Date’
with some delinquency amount.

Note: System automatically removes the delinquency reason on the
account if the payment is received. However, if the same payment is
reversed, the conditions are posted back.

Oldest Due Dt

The oldest due date.

The system allows quick search of an account through Quick Search section in the right hand
side of screen irrespective of the customer service screen on which you are working on. This
is available in addition to the Quick Search section available in Results tab.

For more details on Quick Search refer ‘Search Functions’ chapter.
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Comments can be added using Add Comment section in the right hand side of screen
irrespective of screen you are working on. This is available in addition to the Comments sub
tab available under Customer Service tab. This facilitates quick and easy reference.

For details on Comments refer Comments sub tab section in this chapter.

Call Activity functionality can be performed using Add Call Activity section in the right hand
side of screen irrespective of the screen you are working on. This is available in addition to

the Call Activities sub tab available under Customer Service tab. This facilitates quick and

easy reference.

For details on Call Activity refer Call Activities sub tab section in this chapter.
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4.3

Customer Service screen’s Summary tab

Open Customer Service screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.
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Alerts section

Any comment posted as an alert, are displayed in the alert section of Summary tab.

Conditions section

You can view any conditions like Bankruptcy, Repossession, Foreclosure etc posted on an
account. The condition is posted in the account with a start date which is the effective date
and follow up date which indicates the next follow-up date for further process.

Dues section

Unpaid dues and the dates are displayed in a tabular form. Details of payment amount due,
fee due, payoff are also displayed.

In this field:

View this:

Delq Due

The total delinquent amount that is due so far in the account.

LC Due

The total amount of non-sufficient fee due in the account.

NSF Due

The non sufficient funds fee due.

Other Due

The total of any other dues pending in the account.

Total Due

The total of all dues including payment amount and all applicable
fees.

Today’s Pay-
off

If the account is to be paid off as per the current date and the
amount payable by the borrower.

Future payoff

The total Amount due on a future date. The borrower can know the
total pay off amount for a future date, say 10 days from today.
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In this field:

View this:

Future Payoff
Date

The date on which the future payoff is due.

Future Pmt Dt

The date till which the future payoff quote is valid.

Oldest Due Dt

The due date.

Amt Paid
Excess

The excess amount paid.

Memo Excess

The excess amount paid towards the membership fee.

Amount

Paid Term The total count of paid dues.

Remaining The total count of remaining outstanding dues to be paid.
Term

Days to Time
Bar

View the total number of days remaining to reach the time bar end
date.

Delinquency Information Section

View the following information in the Delinquency Information section:

In this field: | View this:

Late Total number of times the account was delinquent for less than 30 days
since start date.

30 Total number of times the account was delinquent for over 30 days
since start date.

60 Total number of times the account was delinquent for over 60 days
since start date.

920 Total number of times the account was delinquent for over 90 days
since start date.

120 Total number of times the account was delinquent for over 120 days
since start date.

150 Total number of times the account was delinquent for over 150 days
since start date.

180 Total number of times the account was delinquent for over 180 days
since start date.

Category The delinquency category.

Days The number of days delinquent. A negative number in this fields
denotes the number of days until a payment is due.

Broken Total number of broken promises since the account start date.

Promises

(Life)
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In this field: | View this:

Broken Total number of broken promises since this year.
Promises
(Year)

Kept Prom- | Total number of fulfilled promises since the account start date excluding
ises (Life) Broken and Cancelled Promises.

Kept Prom- | Total number of fulfilled promises since this year excluding Broken and
ises (Year) Cancelled Promises.

NSF (Life) Total number of non sufficient funds since the account start date.

NSF (Year) Total number of non sufficient funds since this year.

Collector The default collector working on the account.

Activities Section

View the following information in the Activities section:

In this field: View this:

Active Dt The date account was made active.

Last Activity Dt | The date on which most recent activity was performed in the
account.

Due Day The due day for payment.

Last Pmt Amt The last payment amount.

Customer The customer grade.

Grade

App# The application number from which this account was created.

Producer The producer through which the account was sourced.

X-ref The cross reference number of third party origination system.

Paid Off Dt The date on which account was paid off.
Note: Filed has value only if account has Paid-off condition.

Effective Dt The date account became effective.

Current Pmt The current payment amount.

Last Bill Amt The last bill amount.

Last Pmt Amt The last payment amount.

Chargeoff Dt The Date on which account was charged off.
Note: This is applicable only if account has Charged-off condition.
Else, no value displayed.
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In this field: View this:

Military Duty If selected, indicates that at the time of billing, the customer was in
active military duty and qualifies for rates in accordance with Ser-
vice members Civil Relief Act (SCRA) of 2003.

Customer Score | The customer score.

Behaviour The behavior score.
Score

Due Date Change section

The Due Date Change section displays the remaining number of transactions available for the
account in the Summary tab. You can view the following information under Due Date Change
section.

In this Field: Do This:

Last Txn Dt The last date on which the due date was changed.

Rem. Txn. Limit | Remaining number of due date changes allowed till account clo-
(Life) sure.

Rem. Txn. Limit | Remaining number of due date changes in the account for current
(Year) calendar year.

Extensions section

The Extensions section displays the remaining number of transactions available for the
account in the Summary tab. You can view following extension details as per the conditions
maintained in the contract.

In this Field: Do This:

Rem. Txn. Limit | Remaining number of extensions in the account for current calen-
(Year) dar year.

Rem. Txn. Limit | Remaining number of extensions in the account till closure.
(Life)

Last Txn Dt The date when last extension was made.

Exten. Gap The number of months remaining before you can post Extensions
Rem. (Months) for an account.

Contract Information

You can view the contract information recorded during the funding process. It's a display only
version of the same information found on the Funding screen’s > Contract screen.

In this Field: Do This:
Contract Dt View the contract funded date.
Term View the contract term.
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Rate

View the interest rate.

Maturity Dt

View the contract maturity date.

Adjusted Cap
Cost

View the adjusted capitalization cost considering any rebates,
trade-ins or down payment.

Settlement Information

You can view the account settlement details as recorded in Account Details when the
‘Account Settlement Transaction’ is posted.

In this Field:

Do This:

Effective Dt

View the settlement agreement start date.

Good Through
Dt

View the settlement agreement expiry date.

Agreed Amt

View the settlement amount agreed by customer to the lender.

Paid Till Dt

View the total amount paid by the customer and allocated to
account balances during the agreed period (between effective date
and Good through date).

Collateral Information section

You can view the Collateral Information in this section:

In this field: View this:
Primary If selected. indicates that this is the primary collateral.
Description A brief description on the collateral.

This is a hyper-link which when clicked opens Collateral Manage-
ment screen with relevant collateral details.

Identification #

The identification number of the collateral.

This is a hyper-link which when clicked takes you to the collateral
management screen with the relevant asset details.

Year

The year of manufacture of the collateral.

Asset Class

The asset class of the collateral.

Asset Type

The type of collateral.

Sub Type

The sub type of the collateral.
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Customer Information section

On Customer Service screen’s Customer Information section, select the record you want to
work with and view the following information:

In this field: | View this:

Customer # | Customer identification number (unique customer identifier).

Name Customer’s full name.
Relation Customer’s relationship to the account.
SSN Customer’s social security number.

If the organizational parameter UIX HIDE RESTRICTED DATA is set to
Y, this appears as a masked number; for example, XXX-XX-1234.

National ID Customer’s national identification number.

Birth Dt Customer’s date of birth.
Gender Customer’s gender.
Email Customer’s e-mail address.
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Customer Details section

In this field: | View this:

Email Customer’s e-mail address.

Language Language spoken by the customer.

Marital Sta- | Customer’s marital status.

tus

Disability Customer’s disability indicator If selected, this indicates that the cus-
tomer is disabled.

Skip Customer’s skip indicator. If selected, this indicates that the customer is
a skip debtor. This is selected using the Maintenance screen.

Stop Corre- | Stop correspondence indicator. If selected, Oracle Financial Services

spondence Lending and Leasing will not send correspondence to customer. This is
selected using the Maintenance screen.

Privacy Opt- | Privacy opt-out indicator. If selected, indicates that customer does not

Out want the FI to share his /her information with any other body, other than
regulatory requirements. (optional).

Active Mili- Customer’s Active Military Duty indicator. If selected, this indicates that

tary Duty the customer is serving Military Duty. This is selected using the Mainte-
nance screen.

Time Zone Customer’s time zone.

Address Information section

In this field: | View this:

Type Address type.

Current If selected, indicates that this is the current address.
Permission | If selected, indicates that you can contact the customer.
to Call

Mailing If selected, indicates that this is the mailing address.
Address Address details.

Phone Phone number.

Employment Information section

The details defined in Customer Service > Customer Details > Employments tab are

populated here.

In this field: | View this:
Type Type of Employment as PART TIME, FULL TIME and so on.
Current If selected, indicates that this is the current employer.
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Permission | If selected, indicates that you can contact the employer.
to Call

Employer Employer Details.
Next Pay The next payment day of the month.
Day

Frequency Frequency of the payment.

Address Address details.

Phone Phone number.

Telecom Information Section

In this field: | View this:

Type The type of phone contact such as Home / Office / Car / Mobile phone.

Current If selected, indicates that this is the current phone contact.

Permission Permission as either Yes ‘Y’ or No ‘N’ to contact the customer over
to Call phone.

Phone The customer’s phone number.

Extn The customer’s phone extension.

Time Zone The customer’s time zone.

Best day to | Preferred day of the week to contact the customer, if specified.
call

Best Time Preferred time to contact the customer, if specified.
To Call

Outbound Call History

Displays outbound call statistics with following references:

In this field: View this:
Today The total number of outbound calls as of today.
Last 7 days The total number of outbound calls in the past 7 days.

Last 30 days The total number of outbound calls in the past 30 days.
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Work Order Details

Displays work order details as indicated below:

In this field: View this:

Work Order # View the work order number.

Case # View the case number if associated with the work order.
Work Order Type | View the type of work order.

Vendor View the vendor to whom the work order is assigned.
Status View the status of work order.

4.4 Customer Service screen’s Collections tab

The Collections tab in the Customer Service screen displays the collection-related account
information required for a collector to work on the account. It is a quick snap-shot of the
payment dues and promises along with other account details maintained in the system.
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The Collections tab consists of the following sub sections:

Dues & Promises

This section displays the details of unpaid dues and promises on the selected customer
account.

e Total Amt Due - Indicates the total amount due on the account.
e Arranged - Indicates the amount agreed as Promise to Pay (PTP).
e Unarranged - Indicates the difference between total amount due and Promise to Pay.

The adjacent section display the following details depending on the account status:
e ‘Historical’ due amount on the account from previous dues.
e Last 4 unpaid dues with the Due Date and Due amount.

e ‘Late Fee’ amount charged on the account.
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e ‘NSF Fee’ charged on the account.

e ‘Other Fee’ charged on the account.

e Consolidated amount agreed as PTP (Promise to Pay).

e ‘Unarranged’ indicates the total outstanding due excluding the Promise to Pay amount.

e Each bucket display the consolidated due amount with current and previous dues (if
any).

Note

When a due is partially paid and the Payment Received flag = N, system displays only the
remaining due amount and not the full due amount.

Account Details

This section displays the summary of account-related information maintained in the system.
Since some of the sections are already detailed in the above ‘Customer Service screen’s
Summary tab’ the same have been referenced in required instances.

Customer Information

Displays the customer's information starting with primary customer. For detailed information,
refer to ‘Customer Information section’.

Address Information

Displays corresponding address information of the customer selected in ‘Customer
Information’ section. For detailed information, refer to ‘Address Information section’.

Employment Information

Displays the corresponding Employment information of the customer selected in ‘Customer
Information’ section. For detailed information, refer to ‘Employment Information section’.

Telecom Information

Displays the corresponding Telecommunication details of the customer selected in ‘Customer
Information’ section. For detailed information, refer to ‘Telecom Information Section’.

Collateral Information

Displays the corresponding collateral details maintained in Customer Service > Collateral tab
for the selected customer account. For detailed information, refer to ‘Collateral Information
section’.

Reference & Other Contacts
Displays the following details maintained in Customer Service > References tab.

e Relationship

e Name
e Phone1l
e Phone2

e Comment

For detailed information, refer to ‘References sub tab’.
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Customer Preferences

This section displays the details of customer communication preferences maintained in
Customer Service > Customer Preferences tab.

In this field: | View this:

Communi- The mode of communication preferred by customer such as Email or
cation Mode | Phone.

Value Communication details such as email ID or phone number.

Type Preferred type of communication in case of ADHOC TELECOM.

Time Zone Customer’s time zone.

Best day to | Preferred day of the week to contact the customer, if specified.
call

Best Time Preferred time to contact the customer, if specified.
To Call

Calendar

This section displays the dues and payment related activities on account for the current month
in Calendar format. By default, the calendar is displayed in Monthly format and can be
changed to view by ‘Day’ on clicking &1 icon. The navigation buttons (4 and p ) facilitates to
move to Previous or Next Month/Day depending on the selection. However, clicking ‘Today’
button reverts the selection to the current Month/Day.

The following events are highlighted in the Calendar on specific dates:

e The next payment due date as ‘DUE’.

e The next payment day as ‘PAY DAY’ (displayed only for Primary Customer of the
account with Current indicator as ‘Y’ and for latest record in Employments tab).

e Paid Date as ‘PAID’.
e Promised to Pay Date as ‘PTP’.
e Current Date.

When multiple events occur on the same day, the same is indicated with the count along with

a link to view the events. Also depending on the time zone configured, an event may be
extended and highlighted to two days in the calendar when there is an overlap.

Eligibility

This section displays the customer account eligibility to take an ‘Extension’ for payment due
date and if ‘Due Date Change’ (DDC) is allowed on the account. If yes, the same is indicated
with a «# (tick mark).

Activities

This section displays the dues and payment related activities on account for 36 activities
starting from AO1 up to A36.
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4.5

4.5.1

4.51.1

Customer Service screen’s Customer Service tab

Open the Customer Service screen and load the account you want to work with. Click the
Customer Service tab to view the sections under it.

Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

Each action and result has a code and description. The code for the call action and call result
is what appears on the Call Activity sub screen. The Call activity action codes (Action field)
and call activity results codes (Results field) are user-defined.

The Call Activities sub tab displays all the call activities defined by users in both “Customer
Service > Call Activities tab” and in “Right Hand Splitter > Add Call Activity section”.

Recording a Call Activity

To record a call activity
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.
The system displays the following screen.

ORACLE
Financial S
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3. You can complete the following optional fields:

4. Perform any of the Basic Operations mentioned in Navigation chapter.

In this field: Do this:

Dt System defaults the current date.

Action Select the action performed from the drop-down list.

Result Select the result of the action from the drop-down list. Depending on

the action selected, filtered results are displayed for selection.

Contact Select who person you contacted from the drop-down list.
Reason Select the reason for the communication from the drop-down list.
Promise Date Select the promise date from the adjoining calendar.
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4.51.2

In this field: Do this:

Promise Amt Specify the promise amount.

Condition Select the condition or queue type from the drop-down list.

The list displays a combination of all the possible conditions
depending on the action and result selected along with any open
conditions applicable on the account. You can select ‘None’ if there
are no specific conditions.

Appointment Check this box to take an appointment.

If Appointment is checked, then system allows you to select date
and appointment time as per customer request. If appointment flag
is not checked, then you can only enter the date with date picker.

Followup Dt Specify the next follow-up date. Based on this date, system auto-
matically adds the account in queue for follow-up.

Time Zone Select the time zone of the customer.

Group Followup | Check this box to enable group followup.

Comment Specify additional information of the call activity, if any.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Click to Save and Add to add a new record. Click to Save and Return to return to the
main screen. The system creates two entries on Customer Service screen for the call
activity.

The codes for Action and Result appear as a record on the Customer Service screen, under
Call Activities tab. The description for Action and Result appear as a system generated
comment on the Customer Service screen, under Comments tab. If the account is delinquent,
then the delinquency days is also appended in the system generated comment.

Making an Appointment

The Appointment box on Call Activities section enables you to schedule an account to
appear in a particular queue at a future date and time. When you make an appointment,
account will appear in the front of queue listed in the Conditions field at the time listed in the
Follow Up Dt field.

In order to view the account, you must be working in that queue at follow up time. Refer the
‘Recording a Call Activity section’.

To make an appointment
1. Open Customer Service screen and load the account you want to work with.
2. Click Customer Service sub tab and then click Call Activities tab under it.

3. Click Add and specify the field details on Call Activities section (Refer, Recording a call
activity section).

4. In Condition field, select the condition for queue you want the account to appear in.

In Follow Up Dt field, select the date and time you want account to appear using the
calendar. This can be either current day or a day in future.

6. Select the Appn’mt box.
7. Click Save And Add / Save And Return.
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4.51.3

4514

If account is not worked within the queue on day of the appointment, nightly jobs will cancel
the appointment. If the account’s queue condition changes during nightly batch jobs, the
outstanding appointments are cancelled.

Cancelling an Appointment

Using the Call Activities screen, you can cancel an appointment for an account. The account
will still appear in the queue on follow up date, but no longer receive a priority.

To cancel an appointment

1. Open Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Call Activities tab under it.

Click Add. The system displays Call Activities screen. If you need to change time for the
appointment, create a new entry on account’s Call Activities section with the same condition,
but enter a new follow up date. If you need to cancel the appointment, create a new entry on
account’s Call Activities section with same condition, but don’t check the Appointment
check box.

(To create a new entry, refer Recording a Call Activity section.)

3. Click Save.

Recording a Promise to Pay

If you record an action on Call Activities screen as a ‘promise to pay’, it appears as a record
on the Account Details screen’s Promises section. The Promises section enables you to
quickly view these actions without searching for them individually.

To record a promise to pay
1. Open Customer Service screen and load the account you want to work with.
2. Click Customer Service sub tab and then click Call Activities tab under it.

3. Click Add. The system displays the Call Activities screen. In Action field, select the
action which is already performed, such as DC - DEALER CALLED

4. Inthe Result field, select a result involving a promise to pay, such as PP - PROMISE TO
PAY.

5. You can complete the following optional fields:

In this field: | Do this:

Contact Select the contact type. (Who was the person you communicated
with?).
Reason Select the reason, as stated by the contacted person. (What is the

reason for this contact?).

6. Inthe Promise Dt field, record date when the person you spoke with promises to make
payment.

7. Inthe Promise Amt field, record amount of payment the person you spoke with promises
to pay.

8. Inthe Condition field, select the condition or queue type.

9. Inthe Follow up Dt field, enter next follow-up date for the promise-to-pay or accept the
default date.

10. Click Save. The system automatically notes this information as an entry on the Promises
and Comments sub screens.
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Note

If payment amount is within the tolerance limit, promise is considered to be kept. If the pay-
ment amount is not within tolerance limit, promise is considered to be broken.

4.5.1.5 Cancelling a Promise to Pay

4.5.1.6

4.5.2

Oracle Financial Services Lending and Leasing enables you to cancel promises to pay using
the Account Detail’'s screen Call Activities section. You might do this when a customer
informs you prior to the promise date that he or she cannot make the payment.

To cancel the existing promise to pay

1. Open the Customer Service screen and load the account you want to work with.
2. Click Customer Service sub tab and then click Call Activities tab under it.

3. Click Add. The system displays the Call Activities screen.

4. Select the call activity entry for the promise to pay you want to cancel.

Click the Cancel box. The promise is marked as cancelled and will not be considered when
processing promises; in other words, it will not be counted as either satisfied or broken.

Posting Offline Call Activities

The system facilitates posting of offline call activities against an account.

To Post Offline Call Activities:

1. The source file is provided in CSV format (pre-determined for fields & size). Each field in
the file is separated by a comma (,) and each line is separated by return (New Line).

2. A batch job Offline call activity posting, loads the provided flat file in the specified format
and system will process it line by line.

3. Foreachline, the system posts Call Action Code and the corresponding Call Result Code,
for a given account number with SYSDATE.

4. The system will perform respective call activities and sets the follow-up date as SYSDATE
+ Follow up Days (As provided in the feed file)

5. During offline call activity, you can specify comments, if any, in the comments field. The
system defaults comments received from offline call activity in the comments section sub
tab under Customer Service screen.

6. During offline call activity, you can also include the alert flag as Y’ or ‘N’ for a comment
as the last parameter (i.e. after comments and separated by a comma). Oracle Financial
Services Lending and Leasing recognizes this comment as an alert and displays in
Customer Service > Summary Tab, in Alerts section.

Maintenance sub tab

The Customer Service screen’s Maintenance screen acts as a single command stations that
enables you to post a wide array of monetary and non monetary transactions for any given
account. Transaction available is based on the account’s Lease produce and the user’s
responsibility. This section explains how to complete the following tasks:

Monetary tasks

Lease:

e Apply, adjust, or waive servicing expenses
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e Adjust or waive late charges

e Adjust or waive non-sufficient funds

e Apply, adjust, or waive repossession expenses
e Apply, adjust, or waive bankruptcy expenses

e Apply or adjust phone pay fees

e Change an index/margin rate

e Apply, adjust, or cancel financed insurance

e Generate a payoff quote

e Payoff an account

e Charge-off an account/Do Not Charge-Off an account.
e Close an account

e Account Settlement Transaction

e Change a due date

e Apply, adjust, or waive a disposition fee

e Apply, adjust, or waive a termination fee

e Record selling an asset

e Apply, adjust, or waive an excess usage fee

e Apply, adjust, or waive other fees and taxes

Non-Monetary tasks

Lease:

e Update a customer’'s name

e Maintain customer details

e Mark a customer as a skipped debtor

e Change a customer’s Privacy Opt-Out indicator
e Stop correspondence

e Modify financed insurance information

e Start or stop an ACH

e Reprint a statement (batch only)

e Add or stop servicing of accounts with post dated checks as a repayment method
e Re-order coupon books

e Adjust Dealer Compensation

The system enables you to post a monetary transaction immediately or submit it for nightly
processing. The transaction is identified as either a ‘real-time’ or nightly batch transaction in
Oracle Financial Services Lending and Leasing’s transaction setup codes. The system also
enables you to cancel the future dated transactions or transactions those have been
submitted for nightly processing. All activities in the account, including who performed it, date
and time stamp, are captured in the audit trail.

4.5.2.1 Creating Monetary and Non monetary Transactions

All monetary and non monetary tasks listed in the appendix Transaction Parameters are
available for use on Maintenance screen. Each task requires a Transaction value and a
Parameter value.
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To use the Maintenance screen to complete monetary transaction
1. Open Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Maintenance tab under it.
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Financial Services Lending and Leasing

=z Close
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Past Date Checks <
Escrow Transactions:
Account Documents
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Vendors
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Fees Date Monetary Transaction Status Baich
Iiarfaces 02/01/2016 ¥
49 Transactions
ot 7’5"555“”‘”5 Transaction Batch Information
‘caSA Reconciliation
Save and Add Save and Stay || [ Save and Retum Retum
Conversion Accounts | 4 d = d « | s S R
Dete 02/01/2016 $Trasisacion v Status
= Menetary ] ik @
Parameters
View v Fomate [ Freeze G Detach Wirap 3]
Parameter Value Required
No data to display.
Result
View v Format~ [ Freeze [ Detach Wrap (55
Transaction Processing Details
No data to display.
> Collections
> WFP
> Tools
> Setup

3. On the Maintenance screen’s Action section, click AddIn the Transaction Batch
Information Section section:

— Select the Monetary box to complete a monetary transaction.
-Or‘-
— Clear the Monetary box to complete a non monetary transaction.

4. Inthe Transaction field, select transaction for the task you want to complete. Transaction
availability depends on the type of Lease account, whether the transaction is monetary or
non monetary, and user responsibility.

Note that, during set up, all transactions are configured to be processed either in real
time or as a batch transaction. Accordingly, the ‘Batch’ check box is selected only if the
selected transaction is to be performed through batch execution.

5. Click Load Parameters.

6. Specify all the required parameter values and click Post.
The system displays result (success or failure) in the Results section.

You can cancel a transaction by selecting the record and clicking Void. The parameter
‘TPE_TXN_POST_DEFAULT_GLDATE’ is used to default the transaction date to GL date. If
the ‘Default Transaction Date to GL Date’ is Yes, then GL date will be defaulted as transaction
date. If the value is ‘No’, then the transaction date will not be defaulted and you can specify
the transaction date manually.

When transaction date is not equal to or less than the system date, transaction is considered
to be back dated. System Date is ‘OFSLL System Date’ which is the GL Date. When user
posts the back dated transaction, system displays warning message as “Confirm to post the
back dated transaction” with YES/NO. If user selects 'Yes', then transaction proceeds. If user
selects 'No', then the transaction gets cancelled.
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4.5.3

4.5.3.1

System displays back dated posting warning message only if the parameter
‘TPE_SHOW_BACKDATE_WARNING' is set to 'Y’

When an ‘ON MILITARY DUTY TRANSACTION' is posted in an account:

e The system restricts users from bankruptcy /repossession/foreclosure conditions.

e System posts DO NOT CHARGE OFF condition on that account to exclude the account
from Auto Charge Off process.

e The DO NOT CHARGE OFF condition is removed when 'OFF Military Duty' transaction
is posted.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record/delete comments on
the Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.

All the user added Comments in either Customer Service > Comments tab or in Right Hand
Splitter > Add Comment section, are displayed in the Comments sub tab including system
generated comments.

Recording an Additional Comment

To record an additional comment
1. Open the Customer Service screen and load the account you want to work with.
2. Click Customer Service sub tab and then click Comments tab under it.

3. Click Add. The system displays the Comments screen.

ORACLE
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Interfaces
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SYSTEM GENERATED SYSTEM GENERATED CMLSCE_DEC_FAX JOB REQUEST ID: 10465) PRITAM 06/02/2016 02:33:50 PM

=

THIS APPLICATION IS COPIED FROM APPLICATIONZ

SYSTEM GENERATED SYSTEM GENERATED 0000001193, PRITAM 06/02/2016 02:30:21 M
[ 0oRertions DECISION LETTER GENERATED. (CORRESPONDENCE:
> WFP L , SYSTEM GENERATED SYSTEM GENERATED CNLSCE_DEC_FAX JOB REQUEST ID: 10461} PRITAM 06/02/2016 01:40:40 PM
> Tools 4
> Setup

4. If you want to tag this comment as important, select the Alert box. If selected, the
comment appears on Customer Service screen’s Alerts section, after Save.

In the Type field, select what type of comment you are adding.
In the Sub Type field, select what sub type of comment you are adding.

In the Comment field, specify your comment.

® N o ou

Click Save and Add to add a new record. Click Save and Return to return to the main
screen.
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Comments can be viewed under the Comments tab View the following:

In this field: View this:

Alert If selected, Oracle Financial Services Lending and Leasing to recog-
nizes this comment as an alert and displays in Customer Service >
Summary Tab, in Alerts section.

Type The type of comment.

SubType The sub type of comment.

Comment The text message entered in the Add Comments section.

Comment By

The user ID of person who entered comment in the Add Comments
section.

Comment Dt

The date on which comment was entered in the Add Comments sec-
tion.

4.5.3.2 Deleting Comment(s)

4.5.4

You can delete ‘REGULAR’ type comments displayed in the Comments sub tab.

To delete a comment

1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Comments tab under it.

3. Select the row which consists of the comment and click Delete from the actions.

4. Click ‘Yes’ to confirm delete in the warning message displayed.

Promises sub tab

The system automatically updates promise to pay request information as an entry under the

Promises sub tab based on value defined in parameter at setup level.

In this field:

View this:

Promise Amt

The amount promised.

Promise Dt The date by which customer promises to pay the said
amount.

Taken By The user who took promise.

Taken Dt The date promise was taken.

Collected Amt

The amount collected against the promise.

Broken ind

If °Y’, indicates that this is a broken promise.

Cancelled

If °Y’, indicates that this is a cancelled promise

If a call was recorded as a PROMISE TO PAY on the Call Activities section, it will appear

under the Promises sub tab. The Promises sub tab enables you to quickly view details about

the call and subsequent actions and displays 25 most recent promises to pay.

A promise is considered to be broken in either of the following conditions:
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o If system does not receive the promised amount ‘ON or Before’ the promised date.

e If a payment is received but the paid amount is not up to the tolerance limit, as defined
in Setup > Contract screen.

System automatically updates the consolidated status of all promises in Customer Service >
Summary tab, ‘Delinquency Information’ section. View the following information in the
Promises sub tab.

Create Multiple Promises

In the Promises sub tab, you can capture more than one Promise at a go and track all
promises, instead of adding multiple call activities to capture multiple promises.

To record multiple promises related to call activity, Click Create Multiple Promises. The

system displays the ‘Promises’ section with the following fields:

In this field: View this:

Action Select the type of action from the drop-down list.

Result Select the required result of action from the drop-down
list. The Result field drop-down list displays only
“Promise to Pay” related results based on the action
selected.

Contact Select the type of person you contacted from the drop-
down list.

Reason Based on the account condition and the reason stated

by the contact, select the appropriate reason from the
drop-down list.

Promise St Dt

Select the date from which the first promise is made
from the adjoining calendar icon.

Frequency

Select the frequency of payment from the drop-down
list.

Promise Amt

Specify the amount promised by the contact. Ensure
that you do not enter zero or a decimal value.

No. of Prom-
ises

Specify the total number of promises made by the con-
tact. A minimum of one promise need to exist.

Appointment

Select the check box if a prior appointment is to be
taken for future follow-up.

Comment

Specify additional details of the promise, if any.

Click Create to record the promise details. Based on the number of promises, equivalent

records are created in the section below with the following information:

In this field:

View this:

Promise Dt

The first record indicates the promise start date and
subsequent records will have dates incremented
based on frequency and number of promises.

Promise Amt

View the amount promised.
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4.5.5

4.5.5.1

In this field: View this:

Reason Indicates the reason stated by the contact.

Contact Indicates the contact selected.

FollowUp Dt Indicates the followup date which is auto calculated by

the system by adding 2-3 additional days from the
promise date.

Appointment

Indicates if a prior appointment is required for future
follow-up.

Comment

Specify additional details of the promise, if any.

If required, You can further modify the details of each record.

Click Save and Return. The recorded promises are populated in Call Activities tab for

tracking.

For more information on Call Activities, refer Customer Service > Call Activities sub tab

section.

Checklists sub tab

In this field:

View this:

Promise Amt

The amount promised.

Promise Dt The date by which customer promises to pay the said
amount.

Taken By The user who took promise.

Taken Dt The date promise was taken.

Collected Amt

The amount collected against the promise.

Broken

If selected, indicates that this is a broken promise.

Cancelled

If selected, indicates that this is a cancelled promise

Oracle Financial Services Lending and Leasing enables you to use checklist to ensure that
procedures are followed to complete various tasks. This instructional information appears
under the Checklist sub tab.

Completing a Checklist for an Account

To complete a checklist for an account

1. Open the Customer Service screen and load the account you want to work with.
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4.5.6

2.

Click Customer Service tab, Click Checklist sub tab.
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In the Check List Type field, select the type of checklist you want to complete and then
click Load Checklist. The system loads checklist in the Checklist and Checklist Action
sections.

Under Action - Regular tab, Click Edit. In the Action field, select an action you want to
complete.

Under Action - Document tab, Click Edit. In Document tab, you can track documents
pertaining to the checklist type and update the status.

Note your work with the Yes/No/NA option buttons. You can also add comments to each
action on the checklist in the Comment column.

Click Save and Add to add a new record. Click Save and Return to return to the main
screen.

Tracking Attributes sub tab

The Tracking Attributes screen enables you to link information to an account that is not
tracked by default in the system, but is part of your company’s business practices; for

exa

mple, the location of important documents, how customers receive pay checks, or the hint

questions for remembering a PIN. Such attributes are defined during system setup.

To use the Customer Service screen’s Tracking Attributes screen

1.
2.

Open the Customer Service screen and load the account you want to work with.

Click the Customer Service tab, then click Tracking Attributes sub tab.
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4.5.7

3. Click Load Tracking

ORACLE'
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. The system loads the tracking parameters.
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4. Complete Tracking section by entering the requested parameter in the Value field.

5. Save any changes you made to the account.

Field Investigation Sub Tab

The Field Investigation sub tab allows you to record the field investigation details for further
processing. Field investigation primarily consists of verifying cusotmer’s contact points and
the other details to be verified such as address, employment, asset etc through a specific

verifying agency.

To record field investigation and create work-order

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click Field Investigation sub tab.
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3. In Field Investigation section, perform any of the Basic Operations mentioned in
Navigation chapter.
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4.5.8

A brief description of the fields are given below:

Field

Do this

Customer

Select the customer attached to the account from the adjoining
drop-down list

Verification Type

Select the field verification type from the adjoining drop-down list.

Verification Agency

Select the verification agency from the adjoining drop-down list.

Status Select the field verification status from the adjoining drop-down
list.

Spoke to Specify the name of the person contacted during field verification.

Call Dt Select the date when the customer was contacted from the adjoin-
ing calendar.

# of Attempts Specify the number of attempts made to contact the customer.

Result Select the field verification result from the adjoining drop-down list

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In Verification Details section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields are given below:

Field

Do this

Remarks

Specify remarks, if any regarding the field verification.

Verification Match

Check the box if the verification has matched.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

References sub tab

The References sub tab enables you to view/add/edit references attached to the account
during Lease origination cycle.

To use the Customer Service screen’s References screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click References sub tab.
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3. Click Add.

Financial Services Lending and Leasing
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Relationship Referee's relationship with borrower.

Name Referee's name and details in the following fields.

Status Select the status of the reference as either ‘Active’ or ‘Inactive’ from
the drop-down list.

Country The country.

Address The address line.

Zip The zip code.

Zip Extn The zip code extension

City The city.

State The state.

Years Number of years that the reference is known by the borrower.

Months The number of months that the reference is known by the borrower.

Phone The reference’s primary phone number.

Extn The reference’s primary phone extension.

Permission to
call

Check this box if customer has provided permission to contact
through the specified phone number.

When selected, system auto validates this option against the phone
number specified. Atleast one phone number should have the per-
mission to call for successful pre-qualification of the account. Else, an
error message is displayed.

Phone

The reference’s secondary phone number.

Extn

The reference’s secondary phone extension.
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In this field: Specify this:

Permission to Check this box if customer has provided permission to contact
call through the specified phone number.

When selected, system auto validates this option against the phone
number specified. Atleast one phone number should have the per-
mission to call for successful pre-qualification of the account. Else, an
error message is displayed.

Comment The comments regarding the reference.

4. Click Save and Add to add a new record. Click Save and Return to return to the main
screen.

Note

You can also post a non-monetary transaction to add or modify contact reference details.
For more details, refer to Appendix - ‘Transaction Parameters’ chapter. For references up-
dated through the Customer Service screen, system automatically appends a comment as
'Direct Update' while posting the respective transactions.

459 Correspondence sub tab

Ad-hoc correspondence enables you to include information from accounts in document
templates you create yourself without manually transferring the data. Ad-hoc documents can
be generated as either Microsoft Word or PDF files.

Ad-hoc correspondence can be viewed on the Correspondence screen when you have
opened an account. The screen enables you to generate a new letter or view a previously
generated letter.

To generate an ad hoc correspondence
1. Open the Customer Service screen and load the account you want to work with.
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2. Click the Customer Service tab, then click Correspondence sub tab.
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In the Correspondence section, click Add. In the Correspondence section, use

Correspondence field to select type of correspondence you want to generate. The
system displays following information in the Correspondence screen for selected type of

correspondenc

e

In this field:

View this:

Id

The correspondence id.

Correspondence

The correspondence which is to be generated.

Date

The correspondence generation date.

4.

of documents available for the type of correspondence you selected.

5.

In this field:

View this:

Document Id

The document Id.

Document

The document description.

Recipient

The recipient description.

E-Form
Source

The e-form source.

Source Type

The source type.

Generated

'Y’ indicates that Oracle Financial Services Lending and

Leasing generated the document.
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In this field: View this:

Selected 'Y’ indicates that this document is selected to be included in
the correspondence.

6. Inthe Documents section, select the correspondence you want to view.

7. The Document Elements section displays elements of the system used to generate

correspondence.

8. Click All to view all elements in the correspondence.

_Or_

9. Click User Defined, to view user-defined elements in the correspondence. In the

Document Elements section, view the following information:

In this field: Do this:

Element Type View the document element type.
Element View the element description.
Content Enter/view value of the element.

10. In the Document Elements section, click User Defined and complete Content fields for
Element fields you want to include in the correspondence.

11. In the Document Elements section, click Save.

12. In the Document Elements section, click View.
The system displays a PDF of the ad hoc correspondence.

Recipient Details Sub Tab

The recipient details sub tab facilitates you to send ad-hoc correspondence to Customers,
Producers, and Others as an email.

To add recipient details

1. Open the the Customer Service screen and load the account you want to work with.
2. Click Correspondence > Recipient Details.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others
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Field: Do this:

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:
- Fax
- Email

Type Based on the recipient selected, the following type of correspond-

ence is listed for selection:

When the recipient is selected as Customer / Producer, the Type
is defaulted as ‘Email’ and associated email ID is selected for cor-
respondence. You can also change the Type to ‘Adhoc’ and spec-
ify the required email ID.

When the recipient is selected as ‘Others’ you can specify the
email ID in Type field for correspondence.

FAX/Email View the status of FAX/Email selected.

Comments Specify additional information as comments.

4. In the Recipient Details section, click Save.

5. Click Send to email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details::

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

4510 Letters sub tab

The Oracle Financial Services Lending and Leasing Customer Service screen’s
correspondence address matters regarding customer service and collections for accounts.
They also enable financial organizations to manage bulk mailings. The Letters screen enables
you to create and view the following types of correspondence:

—  Welcome letter
— Paid in Full letter
— PayOff quote letter
— Rate change intimation letter
— PDC renewal letter
e Collection:
— Collection Letter - 1
— Collection Letter - 2
— Collection Letter - 3
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You can view format of all the above letter types by clicking ‘View Letter’ button. In case, the
correspondence to a particular customer has been stopped using the Maintenance, ‘View
Letter’ button will not be displayed and only Letters screen will be available.

To use the Letters screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click Letters sub tab.

BRACLE

Financial Services Lending and Leasing

> DashBoard
> Origination

Servicing

> Collections
> WFP
> Tools
> Setup

Summary | Customer Service | Account Details | Customer Details | Transaction History | Pmt Modes | Bankruptey | RepojForecosure | Deficiency | Collateral | Bureau | Cross/Up Sell Actvties

PR — o
Customer Service x (38 Close
Search | Cu - w Request (Pending: 0)
Account(s): 20120200010231: YUTAKA OZAKA / AKANE Eyiew | & audit
Views Format~ Ep (| Freeze f Detach wop | @ & © Coment O showall O Group Followup
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
ustt USRL UNDEFINED 0120200010231 (EASEVEHICLE auso 000 0.00 ACTIVE 02102015

Call Activities || Maintenance || Comments | Promises || Checkists | Tracking Attributes || References || Correspondence | Letters) | Document Tracking

Letters

Vie Freeze [ Detach oo B [ View Letter
Correspondence Type
co LETTER 1
CHISCE_CoL LTR2 CoLLECTION LETTER 2
CNLSCE_COL_LTR3 COLLEC LETTER 3 o
CNSCE_PDC_LTR PDC RENEWAL LETTER
Recipient Details dradd | Zgie || Eview | o auir
Views Formatv [ | [ Freeze B Detach o @ Elsend
Mode Type FAX/Email Sent Indicator Comments

Redpient
No data to display,

Recipient Details

In the Recipient Details section, you can maintain the recipient details to whom the letter
should be sent. You can specify the following recipient details:

Field:

Do this:

Recipient

Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

Mode

Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax

- Email

Type

Based on the recipient selected, the following type of correspond-
ence is listed for selection:

When the recipient is selected as Customer / Producer, the Type
is defaulted as ‘Email’ and associated email ID is selected for cor-
respondence. You can also change the Type to ‘Adhoc’ and spec-
ify the required email ID.

When the recipient is selected as ‘Others’ you can specify the
email ID in Type field for correspondence.

FAX/Email

View the status of FAX/Email selected.
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4.5.10.1

4.5.10.2

Field: Do this:

Comments Specify additional information as comments.

3. Inthe Recipient Details section, click Save.

4. Click Send to email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details:

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

Collections: Collection letter 1

The predefined Collection letter 1 is automatically sent a configurable number of days after
an account becomes delinquent (receives a condition of active: DELQ on the Customer
Service screen).

The Collection letter 1 is available for Lease fixed and variable rate).

To generate the Collection letter 1
1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click Letters sub tab.
3. On the Letters section, select Collection Letter - 1.
4

Click View Letter to generate Collection Letter - 1.

Collection Letter ORACLE’
Financial Services Lending and Leasing

DEMO BANK USA

LINE1

LINE2

MINNEAPOLIS MN 55344 7255
Phone: ###s##4888444 Exin: 101
Fax:  #psspsmppan

Account number : 20150900014275
Amount past due: USD 7,527 .99

nnnnnnnnn

Collections: Collection letter 2

The predefined Collection letter 2 is automatically sent after a configurable number of days
for a delinquent account (one with a condition of active: DELQ on the Customer Service
screen).

The Collection letter 2 is available for Lease (fixed and variable rate).

To generate the Collections letter 3
1. Open the Customer Service screen and load the account you want to work with.
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2. Click the Customer Service tab, then click Letters sub tab.
3. On the Letters section, select Collection Letter - 3.

4. Click View Letter to generate Collection Letter - 3.

Collection Letter ORACLE’
Financial Services Lending and Leasing

DEMO BANK USA

LINE1

LINE2

MINNEAPOLIS MN 55344 7255
Phone: s#ssssssteass Frm: 101
Fax: s

Date:2/9/2016

INTERSHELL INTERNATIONAL CORP

100 CORPORATE N PL STE 404 ANX E# 160
FAIRGATE

CANTON MA 02021

Account number: 0150900014267
Amount past due: USD 5,329.00

Dear SHARP,

Qur records indicate that you are past due on your loan in the amount of USD 5,329.00. This
amount includes monthly payments together with al applicable fees due pursuant to your
contract.

Several attempts have been made to contact you conceming this matter. In an effort to assist you
in attaining a current status on your account, we would ke to speak with you immediately. Please
contact our office at #HAHHAHFEE Exdn: 101 to make suitable amangements fo bring your
account current

Thank you in advance for your anticipated cooperafion.

Sincerely,

DEMO BANK USA

4.5.11 Document Tracking sub tab

You can view the documents attached to a particular account by loading the account on
Customer Service screen, then clicking the Document Tracking sub tab. You can also open
the Document Tracking screen and select from a list of all accounts with documents attached
on the Document Tracking screen.

To use the Document Tracking screen

1. Open the Customer Service screen and load the account you want to work with.
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2. Click the Customer Service tab, then click Document Tracking sub tab.

. Wekome, CFSLUSER ¥ pcessiicy 1§ Sign 0t &
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Senvidng

Senicng
Customer Sen

Account(s): 20160100010626: KALLAM NAVEEN

Viens Fomat~ [

Feee Foeitn ol g

B & ®curet O stousl O soupalomp

[® cose
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U1 UsHy UNDEFINED 2)160100010626  LEASE VEHICLEL 25 USD 926200 0.0 ACTIVE 025016
Summary | Customer Service | Account Detals| Custorer Cecals| | Transacicn Histoy | Ot Moces | Jurkuplcy | RepolForecosure | Jeficency | Collteral | Buresu | CrosjLp Sel Actvtes

Account Documents

ColiteralHaragemert Cal Aduities | Paintenence | Conmerts | Promses | Checkists| Trackng Attibutes | Refeences Comesaondence  Letters Document Tracking

Reparts

Poducers

Ventrs Documents Elven | it

Batch Transactions Viewe Fomity B [|Feere {fDetich wep @

s Documet T Commants

Pamerts Nodae odisphy.

Fees

Int=rfaces

Views Forate B [[Feere fDetach iep ) B View Documert
Comersen e Docuret e Dncument b Tipe Vasion  Fags £ Decanst File Tipe Status Trader £ Dndet 2 Loation RewiedDt  Efatied Eoiplt Comer
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Account Document Details
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JnaumentSub Tipe Sttus Receiied Ot
Version Trecars Efatie D:
Pege s Doceet 2 Zpiy 0
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A ElYen | o it

3. Inthe Documents section, select the document you want to view and view the following

information:

In this field:

Do this:

Document
Type

View the document type.

Comment

Specify comment.

4. In the Account Document Details section, select the document you want to view and
click Show in the Details column.

5. Inthe Account Document Details section, click View to view the following information:

In this field:

Do this:

Document Type

View the document type.

Document Sub Type

View the document sub type.

Version

View the version. Version numbers will be incremental by batch
job, first version will start with 1.0.

Page #

View the page number. In multiple paged documents, choose 1
in the Page # field on Account Document Details section to
view all the pages in the document.

Choose a specific page number to view only that page.

Document File Type

View the document file type.

Status

View the status of the document.

4-37 ORACLE



4.5.12

In this field: Do this:

Tracker # View the tracking number of the document.
Docket # View the docket number of the document.
Location View the location of the document.
Received Dt View the received date of the document.
Effective Dt View the effective date of the document.
Expiry Dt View the expiration date of the document.
Comment Specify comment.

6. Click View Document. The system opens a File Download dialog box.
— Click Open to view the document in the browser screen
-or-
— Click Save to download the document to a location of your choice.

7. If you want, add comments to the Comments field in the Documents and Account
Document Details sections.

8. Save your entry.

Access History

The Access History tab in Customer Service screen displays the list of users who have
accessed a particular account in Oracle Financial Services Lending and Leasing application.

Irrespective of the action performed on the account or the way through which the account is
accessed such as using search, queue/conditions, review requests and so on, system
records every access and displays the user details in ‘Account Access History’ section.

Starting with the last user, the Account Access History section displays the list in descending
order along with their logged-in User ID (Accessed By), date and time (Access Dt) of login in
separate columns.

To view the account access history

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click Access History sub tab.

ORACLE"
Financial Services Lending and Leasing

@ Customer Service x [ Close
Search | Customer Service: 20160700010076 | Review Request (Pending: 0) | Queve Assigrment =
> DashBoard
> Onigination Account(s): 20160700010076: MILLEN JOHN Elten | 2 audit
Cernun View = Format~ B Freeze i Detach Wrap @ & ©curent showAlD Group Folow-up
Company Branch Sub it Account = Praduct Days Past Due Currency Pay Off Amt Amount Due St
Servicing N0z MHQ UNDEFINED 2016070010076 LOAN VEHICLE (FR) 23 ER 50,089.31 oo}
Customer Service , = = :
Searitization E
Transaction Authorization B
Summary || Customer Service | AccountDetails | Customer Detais  Transaction Hstory | PmtModes | Bankruptcy | RepofForecosure | Defidency | Colatersl | Bureau | CrossfUp SelActh » ¥
Post Date Checks
Escrow Transactions = < mance || Comments | Promises | Cheddists | Tracking Attributes | Field Investigation | References | Correspondence | Letters || DocumentTracking || Scenario Analysis | Access History b
Account Documents ‘
Colateral Management
Reports Account Access History
Producers View~ Formatv Freeze Ll Detach rap [}
vendors Accessed By Access Dt
Batch Transactions ABSHEKAR, 08/08/2016 0513405 AM -
Advances RIMACHARL 08/08/2016 05:23:25 AM
Payments MAHESHP 08/08/2016 04:31:32 AM 0
Feea = PRIVAS 08/08/2016 01:28:53 AM
 Collections RMACHARL 08/08/2016 01:17:46 AM
RMACHARL 08/05/2016 01:17:38 AM
e v 08/05/2016 01:08:55 AM
> Tools RMACHARL 08/07/2016 11:43:57 PM
> Setup LMANGALA 08/05/2016 09:23:23 AM
RMACHARL 08/05/2016 07:20:38 AM o
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4.6

4.6.1

4.6.2

You can click (refresh) to fetch the latest data.

Customer Service screen’s Account Details tab

Open the Customer Service screen and load the account you want to work with. Click the
Account Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.

In the Account Information section click View.

ORACLE’

Financial Services Lending and Leasing

y 18 Senout ©

> DashBoard
> Origination

Securitization
Transaction Authorization
PostDate Checks

Escron Transactions
Account Documents
Colateral Management

Reports

Conversion Accounts

Customer Service

Account(s): 20150600011696: DATE DUE

.

Summary | Customer Service = Account Details | Customer Details

i

Transaction History | PmtModes || Bankruptcy | RepofForedosure | Deficency | Collateral | Bureau | CrossfUp Sell Actuit > ~

Account Details | Statements | Rate Schedule | Insurances || Condition History | Contract Information

Extn and Due Dates Maturity Dt 05/02/2016 Expiry Date
# of Extensions (fear) 0
# of Extensions (Life) 0 Recourse Details Others

# of Extension Term (Year) 0
# of Extension Term (Uife) 0

# o0 Due Day changes(Year) 0
#of Due Day changes(Uife) 0

Recourse ¥
Recourse Type PARTIAL
Recourse Reason PARTIAL

Max Recourse % 60.00

Servicing View~ Fomat~ | [ Freeze i Detach Wrap W & © Curent© Show Al D) Group Folow-up
Servicng Company Branch Sub Uit Account # Product Days Past Due Currency Pay Off Amt Amount Due Sta
Clishiae SSoe Uso1 USHQ SUBUNITL 20150600011696  LEASE VEHICLE 376 IR 27,3%.13 27,014.13 AC

: Vien Audt
eoilscers Account Information 3 Elen || o A
R View v Format~ B Freeze  ffiDetach W
Batch Transactions #ofExtensons  # of Extensions = of Extension Term # of Exctension Term #of Due Day #0fDue Day

Advances (rear) (ife) (fean) Wf)  changes(ear) changes(Life) 125t X Ot Do Day Crange B TR

Payments Ll el 0 ] [} 0 2

o m 5 =

Fees ‘
Interfaces

AP Transactions Account Information

@L Transactions GaRewn

[l cose

Elyen | o Audt

b

Stmt preference Mode  PHYSICAL

Time Bar Details

> Collections LastExHiDE AccRecourseAmtCur 0,00 StartDate 6/2f2015
L Due Day Change Dt EndDate 6/1/2114
» Tools Additional Details Cure Letter Days to Time Bar 35,751
Total Term 12
5 Setup :
PaidTerm 1 Start Date A

View the following information for Lease servicing product.

Statements sub tab

The Statements screen contains three display only sections. The Statements section
displays a list of all statements generated during life of the account. The Transaction section
displays monetary transactions applied to the account from closing date of the previous
statement through closing date of the current statement. The Messages section displays
user-defined message that appears in the statement.

To view the Statements screen
1. Open the Customer Service screen and load the account you want to work with.
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2. Click the Account Details tab, then click

ORACLE’
Financial Services Lending and Leasing

Statements sub tab.
_ h, Welaome, VAVAIONA ~ - nccesiity - RN ©

i Close
e Customer Service £l
> Origination Search | Customer Service: 2015120001284 Reviey Request (Pending: 0)
Servicing
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Post Date Checls
Escrow Transactions
Summary | Customer Service | Account Details || Customer Detais  Transaction History | PmtModes | Bankuptcy  RepojForecosure | Deficiency | Collateral | Bureau | Cross/Up Sel Aciites
Account Documents
e Hatmgeik Accout Detals| Statements | Rate Schedule | Insurances | ContractInformation
Reports
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Adances Closing Bt Due Dt Generation Dt
Payments Mo data to display.
Fees q
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Mo datato display.
- Collections
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7 Tools
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3. In the Statements section, click View.

4. View the following information:

In this field:

View:

Closing Dt

The statement closing date.

Due Dt

The statement due date.

Generation Dt

The statement generation date.

In the Statements Details section, select the statement you to view and click View.

5. View the following:
6. Click Transactions sub tab and click View

7. View the following information:

In this field:

View:

Txn Dt

The transaction effective date.

Transaction
Type

The type of transaction.

Amount

The transaction amount.

Click Messages sub tab and click View.

8. View the following information:

In this field:

View:

Sequence

The sequence number.
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4.6.3

In this field

: View:

Message

The message.

Rate Schedule sub tab

The Rate Schedule section contains information about rate adjustments, such as the
sequence and number of adjustments.

To view the Rate Schedule screen

1. Open the Customer Service screen and load the account you want to work with.
2. Click the Account Details tab, then click Rate Schedule sub tab.

ORACLE'
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Amourt Due Status Oldest Due Dt
0,00 ACTIVE 01/2/2016

The Rate Schedule section only applies to variable rate loans.

3. In Rate Schedule section, click View.

4. View the following information:

In this field:

View this:

Seq

The sequence number for rate adjustment.

Adjustment
Type

Frequency The rate adjustment frequency type.

Period

The rate adjustment period for the frequency.

# of Adjustments

The number of rate adjustments for the frequency.
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4.6.4

Insurances sub tab

If insurance information was entered on Funding screen during Lease origination, you can
view financed insurance information on the Customer Service screen’s Insurances screen.
The Insurances screen displays the details of all financed insurances, including cancellation
and refund information whenever applicable. It also displays the insurances that were
financed after funding of Lease using the Customer Service screen’s Maintenance screen.

To view the Insurances screen
1. Open the Customer Service screen and load the account you want to work with.

2. Click the Account Details tab, then click Insurances sub tab.

ORACLE"
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3. On the Insurances screen, view the following information in Insurance Information
section:

In this field: View:

Contractual If selected, indicates that the insurance policy is required by
contract.

Insurance The insurance type.
Type

Company The insurance company.

Policy# The insurance policy number.

Effective Dt The insurance effective date.

Premium Amt | The insurance premium amount.

Term The insurance term.

Status The insurance status.
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Click View and view the following information:

In this field:

View:

Policy Information secti

on:

Contractual

If selected, indicates that the insurance policy is
required by contract.

Insurance Type

The insurance type.

Insurance Plan

The insurance plan.

Company

The insurance company.

Policy#

The insurance policy number.

Effective Dt

The insurance effective date.

Premium Amt

The insurance premium amount.

Commission Rule

The rule of commission.

Primary Beneficiary

The primary beneficiary of the insurance.

Secondary Benefi-
ciary

The secondary beneficiary of the insurance.

Status

The status.

Sub Status

The sub status.

Insurance Mode

The insurance mode.

Phone The insurance company’s primary phone number.
Phone 2 The insurance company’s alternate phone number.
Itemization The contract itemization.

Expiry Dt The insurance expiry date.

Term The term of insurance.

Commission Amt

The insurance commission amount.

Comments

The comments regarding the insurance policy.

Cancellation/Refund section:

Policy Cancellation Dt

The insurance cancellation date.

Refund Allowed

If selected, a refund is allowed. A selected box indicates
that the insurance premium can be rebated to the cus-
tomer in case of early payoff.

tion Fee Allowed

Grace Days Cancella-

If selected, indicates that cancellation fees during grace
period is allowed.

Cancellation Fees

View amount of the cancellation fee to be charged when
the insurance is cancelled.
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4.6.5

In this field:

View:

Complete Refund

If selected, a complete refund is allowed.

Term Remaining

The remaining term on the insurance at cancellation.

Method

Refund Calculation The refund calculation method.

Grace Days

View the number of grace days allowed for cancellation
without charging a cancellation fee.

Estimated Refund Amt | The estimated insurance refund.

Received Refund Amt | The insurance refund received.

Itemization

The contract itemization.

4. Inthe Insurance Tracking section, click Create Tracking. The system loads insurance
tracking parameters in the Insurance Tracking section.

5. If you want to reduce the list of parameters, select a sub attribute in the unlabelled Sub
Attribute box next to Create Tracking button.
If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the parameter display.

6. Click Edit and complete the Parameter and Value fields.

7. Click Save.

Condition Details sub tab

The Customer Service screen’s Condition Details tab displays the detailed log report of
Account Vs Queue configuration changes i.e. every time an account has been changed from
one queue/user/condition to another.

To view Condition Details
1. Open the Customer Service screen and load the account you want to work with.

2. Click Account Details tab, then click Condition Details sub tab.
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The Condition Details tab is further categorized into following sections:

e Condition/Queue

e Condition/Queue History
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Condition/Queue

The Condition/Queue section displays the closed Conditions, Queues and User changes
which were defined initially and later re-assigned to different Queues with Hard Assigned
Users.

A current active Condition can be opened in any of the following cases:

e When a Call Activity is posted with Conditions on account
e When Conditions are posted by specific batch events

e When Conditions are posted by specific transactions (For example, Borrower on Military
duty)

The Condition/Queue section displays the following information:
e User (Current Queue Assigned User If any)
e Responsibility (Current User Responsibility)
e Account Condition
e Queue Description
e Condition Start Dt
e Queue Start Dt
e User Start Dt

Condition/Queue History

The Condition/Queue section displays only the closed Conditions which were defined on the
account and later was re-assigned to different Queues with Hard Assigned Users.

The Condition/Queue History section displays the following information:

e User (Old Queue Assigned User If any)

e Responsibility (Old User Responsibility)

e Account Condition

e Queue Description

e Start Date

e EndDate

e Changed Date

e Change Reason

e Reason (specified in Queue Assignment tab)

In the Condition/Queue History section, select the required record and click ‘View’.

4.6.6 Contract Information sub tab

The Customer Service screen Contract sub tab enables you to view contract and truth-in-
lending information recorded during the funding process. It's a display only version of the
same information found on the Funding screen’s Contract screen.

To view an account’s contract information
1. Open the Customer Service screen and load the account you want to work with.
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4.7

2. Click Account Details tab, then click Contract Information sub tab
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If you selected a Lease account with escrow, Escrow Analysis tab is available.

3. Use the following sub tabs to view more information about the contract, if available:

e Contract

e Repayment

e Itemization

e Trade-In

e Insurances

e ESC

e Compensation

e Subvention

e Proceeds

e Disbursements

e Fees

e ACH

e Coupon

o PDC

e References

e Real Estate

For more information on the sub tabs of the Contract tab, refer the section Contracts tab in
Funding chapter of the Origination User Guide.

Customer Service screen’s Customer Details tab

Open the Customer Service screen and load the account you want to work with. Click the
Customer Details tab to view the sections under it.

Customer Details screen displays the information gathered on application entry process

regarding the customer and customer’s address, employment data, and phone numbers.
Using this screen, you can update or add to a customer’s address, employment information,

4-46 ORACLE



or phone listing. Whenever you add or edit the customer details, a system generated
comment will be posted in the account to keep record of old and new details.

Note that the ‘Edit’ option on this screen has user level security defined and based on your
responsibility, you can either edit a few or all of the fields. The difference is that, you may
either have access to edit only non-PII (Personal Identifiable Information) fields or edit all
possible fields as per the customer maintenance transaction.

The list of possible editable fields in both these scenarios is given below:

Edit non-PlIl fields

All editable fields

Marital Status

Birth Date

Language Marital Status
Education Language
Mother's Maiden Name Education

Class Type Mother's Maiden
Email Class Type
Stop Correspondence Email

Disability Stop Correspondence

Skip Disability

Privacy opt out Skip

Existing CIF Privacy Optout
Existing CIF

Identification Details like

Passport

Issue Date

Expiry Date

Visa #

Nationality

National ID

SSN

License #

License State

To view or edit customer information

1. Open the Customer Service screen and load the account you want to work with.
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2. Click Customer Details sub tab.
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3. Inthe Customer Information section, click View the following information:

In this field:

View this:

Customer Information section

Customer #

Customer number.

Relation

Customer ‘s relation with the bank.

ECOA

The Equal Credit Opportunity Act code.

Name

Customer’s name.

Birth Dt

Customer’s date of birth.

Marital Status

Customer’s marital status.

Enabled

Status of the account.

Language

Customer’s language.

Education

Customer’s education.

Mother’s Maiden
Name

Customer’s mother’s maiden name.

Class Type

Customer’s class type.

Email

Customer’s e-mail address.

Stop Correspond-
ence

Customer’s stop correspondence indicator. If selected, this indi-
cates that the system will not send the customer any correspond-
ence, such as monthly statements. This is selected using the
Maintenance screen.

Disability

Customer’s disability indicator.
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In this field: View this:

Skip Customer’s skip indicator. If selected, this indicates that the cus-
tomer is a skip debtor. This is selected using the Maintenance
screen.

Bankruptcy Customer’s bankruptcy indicator.

Privacy Opt-Out

Privacy opt-out indicator. If selected, indicates that the applicant
has elected to refrain from the non-public sharing of information.

Insurance Opt Out

Insurance Opt Out indicator. If selected, indicates that the appli-
cant has elected to refrain from insurance related inquiries.

Marketing Opt Out

Marketing Opt Out indicator. If selected, indicates that the appli-
cant has elected to refrain from marketing related inquiries.

Share Credit Opt
Out

Share Credit Opt Out indicator. If selected, indicates that the appli-
cant has elected to refrain from financial information and share
credit related inquiries.

Existing CIF

If selected, indicates that the customer is an existing CIF.

Update Customer
Info

If selected, indicates that the system was allowed to override the
existing customer information with the latest address and commu-
nication details during account creation.

Identification Details

section

Passport # Customer’s passport number.

Issue Dt Passport issue date.

Expiry Dt Passport expiry date.

Visa # Customer’s visa number.

Nationality Customer’s nationality.

National ID Customer’s national identification.

SSN Customer’s social security number. If the organizational parame-
ter UIX_HIDE RESTRICTED DATA is set to Y, this appears as a
masked number; for example, XXX-XX-1234.

License # Customer’s licence number.

License State

State where the licence was issued.

Military Service

Active Military
Duty

Active military duty indicator. If selected, indicates that customer is
on active military duty and may qualify for rates in accordance with
the Service members Civil Relief Act of 2003 (SCRA).

Effective Dt

The effective date

Order Ref #

The order reference number.

Release Dt

The release date.
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4.7.1

4711

In this field:

View this:

Customer
Decease Date

The deceased date of the customer. You can also post a non mon-
etary transaction to indicate if a customer is deceased. Refer to
section Mark Customer as Deceased for more information.

When military duty transaction is posted on an account, the system does the following:

e Restricts the user from posting repossession/ foreclosure and bankruptcy activities on

the account.

e Posts “DO NOT CHARGE OFF” condition on that account to exclude the account from
Auto Charge Off process.

Customer sub tab

Click Customer to view the sections under it.

Address sub tab

Click Address sub tab to view address information for the customer in the following section:

In this field: View this:

Type The address type.

Current If selected, indicates that this is the customer’s current address.

Confirmed If selected, indicates that the address if confirmed by the cus-
tomer.

Mailing If selected, indicates that this is the customer’s mailing address.

Permission to
Call

Check this box if customer has provided permission to contact
through the specified phone number.

Atleast one phone number for every application should have
the permission to call (flagged as "Y') for the successful pre-

qualification of the application. Else, an error message is dis-
played.

Country

The country.

Postal Address
Type

The postal address type.

Address #

The address.

Street Pre

The street pre.

Street Name

The street name.

Street Type

The street type.

Street Post

The street post.

Apt #

The apartment number.

Address 1

The customer’s address.
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In this field:

View this:

Address 2 The customer’s address.
Address 3 The customer’s address.

Zip The zip code.

Zip Extn The zip code extension.

City The city.

State The state code.

Phone The phone number.

Address The address.

Census Tract/ The census tract/BNA code.

BNA Code

MSA Code The metropolitan statistical area (MSA) code.
Comment Comments regarding the address.

4.71.2 Telecoms sub tab

1. Click Telecom sub tab to View/edit the Telecom information for the customer:

In this field: Do this:

Type Select the telecommunication type.
Phone Specify the phone number.

Extn Specify the phone extension.

Current Select if this telecom number is current.

Permission to
Call

Check this box if customer has provided permission to con-
tact through the specified phone number.

Atleast one phone number per application should have the
permission to call (flagged as 'Y') for the successful pre-
qualification of the application. Else, an error message is
displayed.

Time Zone Select the applicant’s time zone.
Start Time Specify the best time to call start time.
End Time Specify the best time to end the call.
Period Specify the time period.

Best day to call

Select the preferred day of the week to contact the cus-
tomer from the drop-down list.

End Time

Specify the best time to end the call.
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In this field: Do this:

Period Select the time period for the best time to call end time, AM
or PM, from the drop-down list.

4.7.1.3 Employment sub tab

1. Click Employment sub tab, in Employment Information section, click View to View/edit
the employment information for customer in the following section:

In this field: | View this:

Current If selected, indicates that this is the customer’s current address.

Permission Check this box if customer has provided permission to contact

to Call through the specified phone number.
Atleast one phone number per application should have the permis-
sion to call (flagged as 'Y') for the successful pre-qualification of the
application. Else, an error message is displayed.

Type The occupation.

Employer The employer’s name.

Occupation The occupation.

Title The title.

Department The department of the employment.

Country The country.

Address # The address line.

Address The employer’s address.

Line 1

Address The employer’s address.

Line 2

Zip The zip code.

Zip Extn The zip code extension.

City The city.

State The state.

Phone The work phone number.

Extn The work phone number extension.

Comment Comments regarding the employment.
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In this field: View this:

Pay Day View or select the payment day of the month using the adjoining cal-
endar.

For OFSLL generated accounts, system propagates the Pay Date
defined in Origination > Application Entry > Applicant Tab > Employ-
ments Sub Tab and is editable.

For conversion accounts, you need to select the payment day.

Next Pay The next payment day is auto populated based on the Pay Day and
Day Frequency specified. When ‘Pay Day’ is selected, system posts a
non-monetary transaction - EMPLOYMENT ADDRESS MAINTE-
NANCE to calculate the next payment day after the current date has
elapsed.

Frequency Select the income frequency from the drop-down list.

4.7.1.4 Tracking Attributes sub tab

4.7.2

You can add tracking attribute information to an application at any time on the Customer
Details screen’s Customer Tracking Attributes section

In the Tracking Attributes section, click Edit

When you click Create Tracking, the system loads the tracking parameters.

e If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute
box.

e If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the Parameter display.

e specify the requested parameter in the Value field and click Save.

Save any changes you made to the account.

Business sub tab

If this is a SME Lease, information gathered on the application entry process regarding the
business and business’s address, partners and affiliates data, and phone numbers appears
on the Customer Service screen’s Business screen. Using the Business screen, you can
update or add to a business’s address, partners and affiliates information, or phone listing.

To view or edit business information
1. Open the Customer Service screen and load the account you want to work with.
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2. Onthe Customer Service screen, click the Customer Details tab and then click Business.
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3. Inthe Business Details section, click View

4. On Business screen, load the business whose information you want to view in the
Business section using First, Previous, Next, and Last buttons.

In this field: View this:

Organization Type Organization type.

Type of Business Type of the business.

Name of the Business | Name of the business.

Legal Name Legal name of the business.

Tax Id # Tax identification number.

Start Dt Business start date.

# of Employees (Curr) | Current number of employees at the business.

# of Employees Number of employees at the business after financing.

Contact Person Contact person at the business.

Business Checking Bank name of the business’s checking account.
Bank

Bank Account # Bank account number.

Avg Checking Balance | Average checking balance.

# of Locations Number of locations of the business.

Management Since Year the current management was established.
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4.7.21

Addresses sub tab

Click Addresses sub tab and then click View. In the Address section, load the address
information you want to view.

In this field: View this:

Type Address type.
Country Country code.
Address # Address number.
Postal Type Postal type.

Pre Pre

Street Name

Name of street.

Street Type Type of street.
Post Post box number.
Apt # Apartment number.
Address 1 Address.

Address Line 2

Address Line 2

Zip Zip code.

Zip Extn Zip extension.

City City.

State State.

Phone Phone number.
Ownership Ownership type.
Comment Additional comments.

4.7.2.2 Telecom sub tab

Click Telecoms sub tab and then click View. In Telecom section, view the following

information:

In this field:

View this:

Telecom Type

Telecommunication type.

Phone Phone number.
Ext Phone extension.
Current If selected, indicates that this is the current record.
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4.7.2.3 Partners sub tab

Click Partners sub tab and then click View. In the Partners section, load the business partner
information you want to view or edit using First, Previous, Next, and Last buttons.

In this field: View this:

First Name Partner’s first name.

M Partner’s middle name.

Last Name Partner’s last name.

Suffix Partner’s suffix.

SSN Partner’s social security number.

Birth Dt Partner’s birth date.

Birth Place Partner’s birth place.

Director Ind If selected, indicates that partner is the director of the business.
Networth Partner’s net worth.

Gross Income

Partner’s gross income.

Language Partner’s language.

Nationality Partner’s nationality.

Title Partner’s title.

Ownership Percentage of ownership held by the partner.
(%)

Email Partner’s e-mail.

Phone Partner’s phone.

Extn Partner’s phone extension.

4.7.2.4 Affiliates sub tab

Click Affiliates sub tab, in the Affiliates section, load the business affiliate information you
want to view using First, Previous, Next, and Last buttons.

In this field: View this:

Organization Affiliate’s organization type.
Type

Legal Name Affiliate’s legal name.

Name of the Busi- | Affiliate’s business name.

ness

Tax ID # Affiliate’s tax identification.

Ownership (%) Affiliate’s percentage of ownership.
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In this field:

View this:

# of Employees

Affiliate’s number of employees.

NAICS CODE

Affiliate’s North American Industry Classification System code.

4.8

Customer Service screen’s Customer Preferences tab

The Customer Preferences tab allows you to define the customer communication preferences
at an account level for each relation type associated with the account. The details of this tab
are populated to Customer Service > Collections tab for further action.

However, if any of the following transactions are posted on the account the defined customer
communication preferences are disabled and can be manually enabled in specific conditions:

e Customer marked as ‘Deceased’

e Changed relation to primary customer

e Disabled/enabled non primary customer relationship
e Swapped relationship

To view or edit customer preferences

1. Open the Customer Service screen and load the account you want to work with.
2. Click Customer Preferences sub tab.
ORACLE'
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3.

In the Customer Preferences section, click ‘ADD’. You can also perform any of the Basic
Operations mentioned in Navigation chapter. A brief description of the fields are given
below:

In this field: View this:

Select the account relation type from the drop-down list. The list
displays only those relationship types which are attached to
account and are enabled (excluding deceased customer rela-
tions).

Relation Type
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In this field:

View this:

Communication
Mode

Select the preferred mode of communication as one of the follow-
ing from the drop-down list.

EMAIL ADDRESS - if selected, system displays the email ID
associated with the selected contact in view mode and allows you
to enable/disable the customer preference record.

TELECOM - if selected, you can further select the type of commu-
nication option as Telecom type, Address or Employment for
which the permission to call indicator is “Y’. On selection, the other
details are auto-populated based on the details maintained in Cus-
tomer Service > Telecom, Address and Employment tabs. You can
also enable/disable the customer preference record.

ADHOC TELECOM - if selected, you can specify the following
field information.

Type

Select the preferred type of communication option from the drop-
down list. The list displays the options maintained in TELECOM_-
TYPE_CD lookup.

Phone

Specify the phone number of the selected contact.

Note: On saving the record, system updates the specified phone
number into ‘Telecom’ tab by internally posting a non-monetary
transaction ‘EMPLOYMENT ADDRESS MAINTENANCE'.

Extn

Specify the extension (if any) for the selected contact.

Permission to Call

This check box is selected by default and indicates that the cus-
tomer has provided permission to contact through the specified
phone number.

Time Zone

Select the contact’s time zone.

Best Day to Call

Select the preferred day of the week to contact the customer from
the drop-down list.

Start Time Specify the start duration after which the contact can be called.
Period Specify the time period (AM/PM).

End Time Specify the end duration before which the contact can be called.
Period Specify the time period (AM/PM).

Enabled Check this box to enable the customer preference record.

Note: You can always enable only one record of a particular com-
munication mode and for a particular relation type at any given
point.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

Clicking ‘EDIT’ in the Customer Preferences section allows you to only enable or disable
the customer preference record.
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4.9

4.9.1

Customer Service screen’s Transaction History tab

Open the Customer Service screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

ORACLE I 2 Welcome, PRAKRRAO v  Accessibility (O
Financial Services Lending and Leasing
e Customer Service x (3 Clos=
»» Origination Search  Customer Service: 20150900014283  Review Request (Pending: 0)
Servicing
Servicing Account(s): 20150900014283: RODRIGUEZ ROBINSON EMew < Audit
Customer Service View~ Fomat~ [ Freeze [ Detach Wrap W & @ curentO show Al O Group Follow-up
:E:"”t‘:wl orzatio Company Branch Sub Unit Account £ Product Days Past Due Currency Pay OF Amt.
S e uso1 UsHg UNDEFINED 2015090014289 LEASE VEHICLE 114 USD 15,158
Post Date Checks >

Escrow Transactions
Account Documents
Collateral Management
Reports

Summary | Customer Service | Account Details || Customer Details | Transaction History | Pmt Modes | Bankruptcy | RepofForeclosure | Deficiency | Collateral || Bursa > ~

Balances | Transactions | PaymentRating = Dus Date History | Repayment Schedule = Work Orders

Producers
Vendors
Batch Transactions Balance Group
Advances Balance Group Txn Period
Payments
Fees ®) Current Ealance () Deficiency Balance C) Non-Performing Balance () Terminate Balance @) 1TD/cTD O ¥TD
Interfaces View » Format~ [ Freeze pfiDetach | ol Wrep
;J;::j;‘ji:: Balancz Type Opening Balance Posted Paid [ Terminate Waived Charge Off Adjusted (-}
5 LEASE RECEIVABLE 0 16,112 1,074 o o (]
CASA Reconciliation A FEE LATE CHARGE 0 120 0 o o
Conversion Accounts i 0 0 0 0 0 ] 4
FEE ADVANCE 0 0 0 o (] ]

FEE PHONE PAY 0 (] 0 ] 0 ]

Current Balance 15,158
Total

> Collections
> WEP

> Tools

> Setup

Balances sub tab

Details of an account balance can be viewed on the Balances sub tab.

The Balance Group in Balances section consists of the following four action buttons:
e Current Balance
e Deficiency Balance
e Non-Performing Balance
e Terminate Balance

By default, the Current Balance option is selected. In case the status of an account is
‘Charged Off’, then the system defaults to ‘Deficiency Balance’ option.

Depending on which one you select, a different set of balance information appears. In all
cases, the Balance screen can be viewed in the following two transaction period modes:
e ITD/CTD (Inception-to-date/Cycle-to-date)
e YTD (year-to-date)
To view account balance information
1. Open the Customer Service screen and load the account you want to work with.
2. Click Transaction History tab, then click Balances sub tab

3. Inthe Balance Group section, select the balance you want to view.
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Current Balance displays the current balances for accounts with an status of ACTIVE.

In this field: View:

Balance Type The balance type.

Opening Balance The opening balance amount.

Posted The amount posted (in addition to the opening balance).

Paid Balance The amount paid.

Waived The amount waived.

Charged Off The amount charged off.

Adjusted (-) The amount adjusted (negative adjustments).

Adjusted (+) The amount adjusted (positive adjustments).

Balance The current (closing) balance. The total active balance of
the account is displayed at the bottom.

Deficiency Balance displays the current balances for accounts with an status of CHARGED
OFF. If you click Deficiency Balance, the following information appears:

In this field: View:

Balance Type The balance type.

Opening Deficiency The opening deficiency balance.

Chg off Posted The additional charged off amounts posted.
Recovery The amount of deficiency balance paid.
Deficiency Balance The current (closing) deficiency balance. The total defi-

ciency balance of the account is displayed at the bottom.

Non-Performing Balance displays the current balance for accounts with status as NON-
PERFORMING. Non-Performing accounts fall between CHARGED OFF accounts and ACTIVE
accounts. These accounts are treated as active when dealing with the customer, but for
accounting purposes are treated differently as they are expected to charge off in the future.
Fee and interest balances are not expected to be collected in full and therefore are not
recognized as income. If you click Non-Performing Balance, the following information
appears:

In this field: View:

Balance Type The balance type.

Opening Non-Performing | The opening non performing balance.

Paid / Terminate The amount of non performing balance paid or termi-
nated.

Paid Excess The additional non performing amounts posted.

Waived The amount waived.
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In this field: View:

Adjusted (-) The amount adjusted (Negative adjustments).
Adjusted (+) The amount adjusted (Positive adjustments).
Balance The current (Closing) non performing balance. The

total non-performing balance of the account is dis-
played at the bottom.

Terminate Balance displays the current balance for accounts with a status of TERMINATE.
Selecting Terminate Balance option displays the following account details.

In this field: View:

Balance Type The balance type.

Opening Balance The opening non performing balance.

Paid / Terminate The amount of non performing balance paid or terminated.
Waived The amount waived.

Charge Off The additional charged off amounts.

Adjusted (-) The amount adjusted (Negative adjustments).

Adjusted (+) The amount adjusted (Positive adjustments).

Terminate The balance amount to terminate.

4. Inthe Txn Period Balance section, select how you want to view the balance:
Select ITD/CTD to view transactions by Inception-to-date /Cycle-to-date:
-or-
Select YTD to view the transactions by year to date.

49.2 Transactions sub tab

The Transactions screen displays all transactions that have occurred over the life of account.
Transactions can be sorted by when the transaction was created (Post Dt) or the effective
date of transaction (Txn Dt). You can choose to view all transactions, filter System / User
posted transactions, export account transaction details to a file, or reverse certain
transactions. This information comes from the payments and advances applied to the
account, maintenance tasks, and nightly processes such as billing.

To view the transaction history of an account
1. Open the Customer Service screen and load the account you want to work with.
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2. Click Transaction History tab, then click Transactions sub tab.
ORACLE' i

Financial Services Lending and Leasing

Customer Service x

Search  Customer Service: 20170800010892  Review Request (Pending: 0)

Account(s): 20170800010892: JENA PRITAM / USE SPO

Freeze i Detach
Sub Unit
UNDEFINED

View + Format +
Branch
usHg

Company.
uso1

Summary | Collections | Customer Service | Account Details

Balances | Tramsactions | PaymentRatng | DueDate History | RepaymentSchedule

Transactions

SortBy @ Postot®) Tunot

Queve Assignment

Elview | o Audit

o G & @ Curent© Show Al O Group Folow-up
Account # Product
2017080001089 LEASE VEHICLE

Days Past Due Currency Pay Off Amt Amount Due Status Oldest Duz Dt oLQl
21 usD 34,732.50 0.00 ACTIVE 09/27/2017 1878
m = 8 3

Customer Details | Customer Preferences | Transaction History | PmtModes | Bankruptcy || RepojForedosure || Defidency || Collateral | Bureau | Timeline | CrossfpSel > ~

Wark Orders

EE

) Good Payments ©) All Payments ) Good Fees ) All Fees ) Good Txns @ Al Txns  view £ System ©) User @ Al Txns

View Options

View > Format v Freeze i Detach Wrap 5] Reverse Export to Excel
PostDt  TxnDt Description Curency  Amount Detals Bolonce Amt Payment Currency  Payment Amt PaymentType  Reference Mode  Reason  Posted By
09/06/2017 09/06/2017 BILL/DUEDATE  UISD 3,157.50 DUE BT 09/27/2017 34,732.50 USD INTERNAL
09/01/2017 09/01/2017 FIRSTPAYMEN... USD 3,157.50 LSR PD= $3,157.50 34,732,50 USD INTERNAL
08/28/2017 03/27/2017 EILLDUEDATE  USD 3,157.50 DUE DT 08/27/2017 37,890,00 USD INTERNAL
08/27/2017 U3[27{2017 LEASE RECEIVA.. USD 37,890.00 37,890.00 USD PRITAM
ACTIVE usD 0.00 0.00 UsD PRITAM

08/27/2017 08/27/2017
< L

i B

3.

In the View Options section, select type of transactions in this account’s history you want

to view on the Transactions screen.

If you select this:

The system displays:

Good Payments

All valid payments that was neither voided nor reversed.

All Payments

All transaction involving payments.

Good Fees All valid fees that was neither voided nor reversed.
All Fees All transaction involving fees.

Good Txns All transactions that was neither voided nor reversed.
All Txns All transactions.

4. Inthe View section, you can further filter the list of transactions which are posted by
System or User. Selecting ALL transactions displays all the transactions.
If you select this: | The system displays:
System All system posted transactions filtered based on View
option selection are displayed.
User All User posted transactions filtered based on View option
selection are displayed.
All Txns All posted transactions filtered based on View option
selection are displayed.
5. Inthe Sort Option section, choose Post Dt to sort entries on in Transactions section in

7.

order of when the transaction was made effective.
_Or_

Select Txn Dt to sort the entries on in Transactions section in order of when the
transaction was created.

In View Option section, click View to view the following information:

In this field:

View:

Transactions section
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49.21

In this field:

View:

Post Dt The transaction posting date.
Txn Dt The transaction effective date.
Description The transaction details.
Currency The currency of the transaction.
Amount The transaction amount.
Details The transaction details.

Balance Amt

The balance amount. This is the principal balance, not the total
balance amount.

Payment Currency

The payment currency.

Payment Amount

The payment amount.

Payment Type The payment type.

Reference The reference number associated with the transaction.

Mode The mode of the transaction.

Reason The reason for the transaction.

Posted By Indicates if the transaction is either system posted (marked as

INTERNAL) or user posted (marked with User ID)

Allocation Details

Txn

The transaction allocation details.

Amt

The transaction allocation amount.

To Reverse (or Void) a Transaction

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service screen, click Transaction History tab and then click

Transactions.

In the Transactions section, select the transaction you want to reverse.

4. Click Reverse. A confirmation dialog is displayed.

5. Click ‘Yes’ to reverse the transaction. On confirmation, the reversal is posted for

processing.

Some transactions cannot be reversed. If a transaction cannot be reversed, the Reverse
button will be dimmed when transaction is selected. If the Reverse button is unavailable, the
transaction anniversary cannot be reversed.

Access to the Reverse button can be restricted by user responsibility and account’s product
type using the PAYMENT REV transaction code (Super Group: ACCOUNT MONETARY
TXN) on the Administration screen.
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49.2.2

49.2.3

(For more information, see Txn Codes tab (Transaction Super Group screen) section of
the Administration (System) Setup chapter in the Oracle Financial Services Lending and
Leasing Setup Guide).

Voiding an Account

To void an account

Oracle Financial Services Lending and Leasing can be configured to void an account using
the Reverse button on the Transaction screen.

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service screen, click Transaction History tab and then click
Transactions.

In the Transactions section, select ACTIVE entry in the Description field.

4. Click Reverse.

On the Transactions screen, Oracle Financial Services Lending and Leasing creates an entry
of REVERSE ACTIVE and reverses all transactions. The system also changes status of the
account to CLOSED: VOID and changes status of the application to APPROVED-VOID (or
whatever the account’s last status was before funding).

To use this feature, ACTIVE REYV transaction code must be enabled and set to manual on
the Transaction Super Group screen for your user responsibility and account’s product type.
(For more information, see the Txn Codes tab (Transaction Super Group screen) section
of the Administration (System) Setup chapter in the Oracle Financial Services Lending
and Leasing Setup Guide).

Export Account Transaction Details

In the Transactions sub tab, you can export the required account transactions and allocation
details to a file.

To export account transaction details

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service screen, click Transaction History tab and then click
Transactions.

In the Transactions section, select the required transaction.

4. Click Export to Excel. The details are exported to a .xls file with options to save or open.
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49.3

Payment Rating sub tab

|IORACLE"
{  Financial Services Lending and Leasing

e Customer Service [ Glose
> Origination Search  Customer Service: 20160200010047  Review Request (Pending: 0}
Servicing
SV Account(s): 20160200010047: TEST FIRST Yiew || o Audit
Customer Service View v Format~ [ Fresze i Detach Wrap W & @ curent Show alC) Group Folow-up
Securitization Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt
Transaction Authorization uso1 UsHQ SUBUNITZ 20160200010047  LOAN VEHICLE (FR) -4 USD 50,048.51
PostDate Checks < I v
Escrow Transactions
Account Documents Summary | Customer Service | AccountDetsis  Customer Detsils  Tramsaction History | PmtModes | Bankuptcy | RepofForedosure | Defidency  Colatersl | Buresu | C© > ~
Collateral Management
Reports Balances  Transactons  Sale Transfer Transactions. PaymentRating Due Date History ~ Repayment Schedule | Work Orders
Producers
Vendt -
i Sale Transfer Transactions View | o Audit
PRt T amactos ¥ View Options @ Good Txns @) All Tans
Advances
24 5 Fresze  EfiDetach a 4
M View ¥ Format =3 reeze B Deta P o]
i PastDt Tan Ot Description Amount Previous Sub Unit New Sub Unit
Interfaces 02222016 02/22/2016 ADVANCE | PRINCIPAL-CONTRA TRAN. 50,000.00 UNDEFINED SUBUNIT2
P— 027222016 02/22/2016 ADVANCE { PRINCIPAL-SALE TRANSAC 50,000.00 UNDEFINED SUBUNIT2
e 0272212016 02/22/2016 INTEREST-CONTRA TRANSACTICN 20,79 UNDEFINED SUBLINIT2
CASA Recondiation D{LF‘ZZ‘FZD 16 02/22/2016 INTEREST-SALE TRANSACTION — 20.79 UNDEFINED SUBUNIT2
Conversion Accounts

> Collections
> WFP

> Tools

> Setup

To view the transaction history of an account
1.

2. Click Transaction History tab, then click Payment Rating sub tab.

Open the Customer Service screen and load the account you want to work with.

Days Past Due Currency
114 USD

RepofForeclosure || Deficiency

Status Description

ACCOUNT 80 DAYS PAST THE DUE DATE

ORACLE
Financial Services Lending and Leasing
R Customer Service x
»» Origination Search | Customer Service: 20150900014283  Review Request (Pending: 0)
Servicing
Servicing Account(s): 20150900014283: RODRIGUEZ ROBINSON
stiﬂmEffemCE View » Format~ [ Fre & Detach ) Wrap W & @ curentO show AlC Group Follow-up
;E“‘”“_’g"“l U Company Branch Sub Unit Account # Product
I e Us01 UsHQ UNDEFINED 20150900014283  LEASE VEHICLE
Post Date Checks <
Escrow Transactions
Account Documents
Collateral Management Summary = Customer Service | Account Details | Customer Details | Transaction History = PmtModes | Bankruptcy
Reports B —
i Balances || Transactions | Payment Rating | Dus Date History || Repayment Schedule || Work Orders
Vandors
Batch Transactions Payment Rating
Advances
Payments
Fo Pt Rating Rating Description Acc Status
Interfaces 3 90-119 DAYS PAST DUE DATE 80
AP Transactions
GL Transactions Morith/Year 01/2016 122015 11/2015 10/2015
CASA Reconciliation Rating 3 2 1 o
1
Conversion Accounts Month/Year
Rating
MonthyYear
Rating
MonthYear
Rating
> Collections
> WEP
> Tools
> Setup

[ Cose

B vew | o audt

Pay Off Amt
15,158.10
>

Collatersl | Burea > *

The Payment Rating section displays month and year of payment and rating reported to
credit bureaus through Metro 2 file for the past 24 months, including the following:

In this field: View this:

Pmt Rating

The payment rating.
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49.4

In this field: View this:

Rating Description The payment rating description.

Acc Status The credit bureau account status.

Status Description The credit bureau account status description.
Month/Year Rating The month/year of payment rating.

Due Date History sub tab

The Due Date History tab provides a delinquency history, by payment, by displaying a history
of all due dates, along with when actual payment was made for that due date and the

subsequent balance. If a payment was delinquent, Due Date History section
number of days the customer was delinquent against each due date.

displays the

Due Date History sub tab displays all the dues that have crossed the system date and also
the history that is currently available in Transaction History > Due Date History sub tab.

1. Open the Customer Service screen and load the account you want to work with.

2. Click Transaction History tab, then click Due Date History sub tab.

ORACLE
Financial Services Lending and Leasing

o ow

Ielcome, PRAKRRAG =  Accessibilty (O

DashBoard Customer Service x

> origination Scarch | Customer Service: 20150900014283 | Review Request (Pending: 0)

Account(s): 20150900014283: RODRIGUEZ ROBINSON

View -~ Format~  [Ep Fresze i Detach =p & ® currentO show Al O Group Fallow-up
Company Branch Sub Unit Account # Product Days Past Due Currency
usoL usHQ. UNDEFINED 2015090004283 LEASE VEHICLE 114 UsD
<

Summary || G

Balances yment Rating | Due Date History | Repayment Schedule | Work Orders

Due Date History

View~ Fommat~ | [ Freeze £l Detach rap w0
Due Dt Due Amt Last Pmt Dt Pt Amt Balance Amt
02/05/2016 1,074 [} 1,074
01/05/2016 1,074 o 1,074
12/05/2015 1,074 o 1,074
q 11/05/2015 1,074 o 1,074
10/05/2015 1,074 ] 1,074

Due Date History

> Collections
> WFP
> Tools

> Setup

Transaction History | PrmitModes  Bankruptcy | Repo/Foreclosure || Deficiency || Collatersl | Burea > ~

[3€) Close

Elvew || 2 auie

Pay Off Amt
15,158

e

Pt

Days PastDue PTE

< Retum

In Due Date History section, click View

View the following:

In this field: View this:

Due Dt The due date.

Due Amt The due amount.

Last Pmt Dt The last payment date.

Pmt Amt The payment amount.

Balance Amt The balance amount.
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4.9.5

In this field: View this:

Days Past Due | The days past due.

Pmt Received | If selected, indicates the payment was received.

Repayment Schedule sub tab

The Repayment Schedule section contains information about schedule of repayment such

as the date and payment amount.

1. Open the Customer Service screen and load the account you want to work with.

2. Click Transaction History tab, then click Repayment Schedule sub tab.

ORACLE’
Financial Services Lending and Leasing

Welcome, PRAKRRAO »  Accessibility o

Customer Service 5

AP Transactions
GL Transactions Repayment Schedule
(CASA Reconcilistion
Conversion Accounts
B
Date
# of Pmis

Repayment Schedule Details
View » Format- [ freere EfiDetach | ol wrep ®

Date Payment Amt Principal Amt Interest
No data to display.

> Caollections
> WFP

> Tools

> Setup

[ Close
[El vew || < audit
Days Past Due Curmrency Pay Off Amt
11% usD 15,158.10

RepofForedlosure | Deficiency | Collateral | Burea > ~

DashBoard
> Origination Search  Customer Service: 20150900014283  Review Request (Pending: 0)
Servicing
Servicing Account(s): 20150900014283: RODRIGUEZ ROBINSON
Custamer Senvice View v Format~ [ Freeze i Detach J Wrap B & @ arentO show Al O Group Follow-up
;H“”“f;"”l — Company Branch Sub Unit Account # Product
e e usot sty UNDEFINED 2015030014283 LEASE VEHICLE
Post Date Checks <
Escrow Transactions
Account Documents
Collateral Management Summary || Customer Serviee | Accourt Details | Customer Defails | Transaction History | PmtModes || Bankruptcy
Reports
e Balances || Transactions | Payment Rating || Dus Date History  Repayment Schedule | Work Orders
Vendors
<h Ti s
Beich Traneact on Repayment Schedule
Advances 2 N
o View v Format~ [ Freeze £} Detach Wrap (5]
Fees Seq Date £ of Pmits Pt Amt Generated
T No data to display.

P

G Betum

(5] view || < audit

Balance Principal

View the following information:

In this field: View this:

Repayment Schedule section

generated.

Seq The payment sequence number.

Date The repayment date.

# of Pmts The number of payments.

Pmt Amt The payment amount.

Generated If selected, indicates that the repayment schedule has been

Repayment Schedule Details section
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4.9.6

In this field:

View this:

Date

The repayment date.

Payment Amt

The payment amount.

Principal Amt

The amount paid to principal.

Interest

The amount paid to interest.

Balance Princi-
pal

The balance of the principal.

Work Order sub tab

To expedite repossessions and foreclosures, the display only Vendor Work Order screen
enables you to view all the work orders issued to different vendors for an account.

To view the vendor work order screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click Transaction History tab, then click Work Order sub tab.

ORACLE"
Financial Services Lending and Leasing

lcise

8 Customer Service 5
Sesrch  Customer Service: 0160700010513  Review Request (Fending: 0) | Queus Assignment

> DashBoard

> Origination Account(s): 20160700010513: SECURED ACCOUNT LEASE / SPOUSE BANKO Bl view || o Audit
Tt View v Format~ [y Freeze i Detach ap W & @ curent© Show Al D Group Fallow-up
Company Branch Sub Uit Account # Product Days Past Due Currency Pay OFf Amt Amount Due St
Seve uso1 USRHQ UNDEFINED 2016070010513 LEASE VEHICLE 21 UsD 15,360.00 0.00 A&t
Customer Service . - = — e L -

Securitzaton
Transaction Authorization
Post Date Checks

Escrow Transactions

Summary | Customer Service || AccountDetails | Customer Details | Transaction History | PmtModes | Bankruptcy | RepojfForedosure | Defiency | Collateral | Bureau || CrossfUpSell Aci » ~

m

Balances || Transactions | PaymentRating | Due Date History || Repayment Schedule | Work Orders

i

Account Documents 4
Colateral Management

Reports
Froducers
Vendors
Batch Transactions
Advances
Payments
Fees -
> Collections
> WEFP
> Tools

> Setup

Vendor Work Order

View v Format~ [ Freeze i Detach Wrap @ o create work Order
WorkOrder Type  Case % Chamnel Reason ot Estmated
No data to display
« v
Total Amt
Vendor Work Order
Cakeum
\Work Order Type Reason Vendor
Case # Dt Status
Channel Estimated Total Amt.

Elvew || o2 audit 4

In the Vendor Work Order section, click View

View the following display only information:

In this field:

View this:

Work Order
Type

The assigned work order type.

Dt

The assignment date.

Estimated

The estimated dollar amount of work order.

Vendor

The vendor number and name.

Status

The assigned status.

Total Amt

The total estimated dollar amount of all work orders.

You can create/view and maintain vendor work orders related to an account.
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4.10

4.10.1

e To create and maintain vendor work orders, click Create Work Order. The system
opens Vendor Management screen. You can perform tasks and record additional
information, such as changing the work order’s status and adding comments in the Work
Orders section.

If vendor screen is already opened in the main screen and user tries to create new work order
or open an existing work order, system displays the warning message as “Vendor
management screen is already open. Please close it and retry”.

e To view more detailed information about vendor work order, select the work order you
want to view and click View Work Order. The View Work Order button appears faded
if the responsibility does not allow access to the Vendor Work Order screen.

3. Click Close on the Vendor Management screen to return to the Customer Service screen.

For more information about using the Vendor Management screen, please refer to the Vendor
chapter in the User Guide.

Customer Service screen’s Pmt Modes tab

Open the Customer Service screen and load the account you want to work with. Click the
Pmt Modes sub tab to view the sections under it.

ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click Pmt Modes tab, then click ACH sub tab.

ORACLE i . P —— =
Financial Services Lending and Leasing

ACH Information

View ~ Format~ [ Freeze  Efi Detach rap ®
Refe e

ACH Information
B saveand add || B save and stay || i Seve and Return || 3 Retum

> Collections

> Tools
> Setup

The system displays the ACH details depending on the following option selected:
e Recurring - Select ‘Recurring’ to display all the Recurring ACH details.
e One-Time Phone - Select this option to display one time ACH details.
e All - Select ‘All’ to display both recurring and one-time phone ACH details.

If you have selected ‘Recurring’ or ‘One-Time Phone’ option, you can further Add, Edit, or
Copy the details and perform any of the Basic Operations mentioned in Navigation chapter.
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On save, the system will automatically post the transaction capturing the current transaction
date along with a comment as 'Direct Record Update' for the particular ACH transactions.

If you have selected ‘Recurring’ option, the following fields are displayed:

In this field:

View this:

Reference #

The unique reference number.

Bank Name The bank name.

Bank City Specify the city where the bank exist.

Bank State Select the state where the bank exist form the drop-down list.

Routing # The routing number.

Account Type | The type of account.

Name On Specify the name of the account.

Account

Account # The account number. If the organizational parameter UIX HIDE RE-
STRICTED_DATA is set to Y, this appears as a masked number; for
example, XXXXX1234.

BIC Select the Business ldentifier Code from the drop-down list. The list
displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is used
for identifying bank accounts across national borders with a minimal of
risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based on
modulo 97. On save, system automatically validates the IBAN number
length based on country code, characters, white spaces, and check-
sum. Validation is also done during posting non-monetary transaction
(ACH Maintenance).

You can maintain the IBAN length and other details required as per the
country code in the user defined table (Setup > Administration > Sys-
tem > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is defined by
default with length of IBAN as 18.

Sequence System displays the current Sequence Type of the selected account.

Type Depending on the nature of direct debit, the sequence type can be one
of the following:

- First - First time direct debit

- Recurrent - Subsequent repayments after first direct debit

- Final - Final repayment

- One-off - One time bullet contract repayment

However, during the life cycle of the payment processing, the direct
debit sequence type for an account can change.

Pmt Day The payment day.
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In this field:

View this:

Pmt Amt The Payment amount.
Pmt Amt The excess payment.
Excess
Pmt Freq The payment frequency.
Fee Amt The amount charged as fees.
Direct Debit If selected indicates that the fees is debited directly.
Fee
Start Dt The date the system began using ACH payments for this account
End Dt The ACH end date.
Default If selected indicates that this ACH is the default ACH for the account.
Status The status of the account.
Note

This information can be edited using the Maintenance screen and the non monetary trans-

action ACH MAINTENANCE.

If you have selected ‘One-Time Phone’ or ‘All’ option, the following fields are displayed:

In this field:

View this:

Reference #

The unique reference number.

Bank Name The bank name.

Bank City The bank city.

Bank State List of available states.

Routing # The routing number.

Account Type | The type of account.

Name On The account name.

Account

Account # The account number. If the organizational parameter UIX HIDE RE-
STRICTED DATA is set to Y, this appears as a masked number; for
example, XXXXX1234.

BIC Select the Business Identifier Code from the drop-down list. The list

displays the BIC codes defined in the system.
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In this field: View this:

IBAN Specify the IBAN (International Bank Account Number). IBAN is used
for identifying bank accounts across national borders with a minimal of
risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based on
modulo 97. On save, system automatically validates the IBAN number
length based on country code, characters, white spaces, and check-
sum. Validation is also done during posting non-monetary transaction
(ACH Maintenance).

You can maintain the IBAN length and other details required as per the
country code in the user defined table (Setup > Administration > Sys-
tem > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is defined by
default with length of IBAN as 18.

Sequence System displays the current Sequence Type of the selected account.

Type - First - First time direct debit
- Recurrent - Subsequent repayments after first direct debit
- Final - Final repayment
- One-off - One time bullet contract repayment
However, during the life cycle of the payment processing, the direct
debit sequence type for an account can change.

Debit Dt The debit date.

Pmt Amt The Payment amount.

Direct Debit If selected indicates that the fees is debited directly.

Fee

Secret Ques-
tion

Select the secret question from the drop down list.

Provided To The person to whom the ACH is concerned.
Whom
Reference Additional reference if any.

Drawer Rela-
tion Type

The withdrawer relation to ACH.

Drawer Name

The name of withdrawer.

Drawer Address of withdrawer,
Address1

Drawer Address of withdrawer,
Address2

Drawer City City of withdrawer,

Drawer State

State of withdrawer,

Drawer Zip

Zip of withdrawer,
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In this field: View this:

Status The status of the account.

Note

This information can be edited using the Maintenance screen and the non monetary trans-
action ACH MAINTENANCE.

Copying ACH Details

You can copy and maintain ACH details from Pmt Modes sub tab of Customer Service
screen. Copy option is available only when you have selected the ACH option as either
Recurring or One-Time Phone.

To copy the ACH details
1. Select a record and click Copy.

2. A confirmation message is displayed as ‘Do you want to Copy ACH Record?’. Click OK
to copy and create a new record.

On confirmation, the system creates a new row with new reference number, Status as ‘Active’,
Default as ‘N’, Start Dt as ‘System Dt + Pre note days’ and all the other details as maintained
in the copied record. When a new record is created using the Copy function, the system will
post a ‘New ACH Transaction’ capturing the current transaction date along with a comment
as 'Direct Record Update'.

Coupon sub tab

The Coupon section displays information regarding coupons associated with the account.

To view the coupon screen
1. Open the Customer Service screen and load the account you want to work with.

2. Click Pmt Modes tab, then click Coupon sub tab.

ORACLE
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View the following:

In this field: View this:

Order If the coupons are ordered for the selected account.

Coupon Start- | The starting number of coupon ordered for the customer.
ing #

Order Date The order date of the coupon.

# of Coupons | The total number of coupons ordered for the customer.

Ordered By The person who ordered the coupons

4.10.3 Post Dated Checks sub tab

The Post Date Check section enables you to view any post dated check information for the
account, if PDC is a method of repayment.

To view the post dated checks details screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click Pmt Modes tab, then click Post Dated Checks sub tab.
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View the following:

In this field: | View this:

PDC Type The type of post dated check in use.

Status The status of the post dated check.

Check # The check number of the post dated check.

Check Dt The check date of the post dated check.

Check Amt The check amount of the post dated check.

Bank Name | The bank name of the post dated check.

Account The account type of the post dated check.
Type
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In this field: | View this:

Account # The account number of the post dated check.

Comments Additional information as comments, if any.

4.10.4 Payment Arrangement sub tab

The Payment Arrangement section enables you to define and calculate the payment amount
for the account with status Charge-off. An alert message will be displayed in the Customer
Service screen when the user tries to view the payment arrangement for account other than
charged off status.

To view the Payment Arrangement details screen
1. Open the Customer Service screen and load the account you want to work with.

2. Click Pmt Modes tab, then click Payment Arrangement sub tab.

ORACLE P—
Financial Services Lending and Leasing

Byen | P aud
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> wep
> Tools
> setup

The Payment Arrangement section is enabled only when the Payment Arrangement Batch job
is posted.

3. Inthe Payment Arrangement section, click View to view the following details:

In this field: Do this:

Frequency Displays the payment frequency.

Start Date Enter the start date from when the customer pays.

Terms Enter the number of payments. Note that if the term is speci-

fied as zero “0”, an error message is displayed.

End Date View the end date of the payment.

Plan Amount View the payment amount which the customer plans to pay.
Outstanding View the outstanding amount.

Amount
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4. In the Details section, click View to view the following details:

In this field: | View this:

Date View the start date of the payment plan.

Frequency View the payment frequency.

Plan View the planned payment amount.

Amount

Paid View the paid amount.

Amount

Satisfied Indicates that the customer done the payment arrangements.

Ind

Broken Ind Indicates that the customer did not make the payment arrangement.

Enabled Ind | Indicates that the arrangement is active

On Clicking Deactivate, the account will be deactivated.

To add a new payment rearrangement plan, previous plan has to be manually deactivated
otherwise the system displays an error message. This condition applies to the payment
arrangement previous plan even when the 'Broken Indicator' is selected.

Only one Payment arrangement plan can exist at a time. If a schedule broken by the customer

make another payment arrangement, the first payment arrangement has to be deactivated
and only then, the other payment can be added.

Customer Service screen’s Bankruptcy tab

The Bankruptcy screen enables you to record the details of a bankruptcy. This information
usually is supplied from the customer or customer’s attorney. You can track each stage of the
bankruptcy process based on its follow-up date and record information using the Details and
Tracking sections.

As there are occasions when a borrower files bankruptcy more than once during tenure of the
Lease, you can record information for multiple bankruptcies. The Add button enables you to
create a new bankruptcy record with different start and end dates. You can also use the
Bankruptcy screen to view previous bankruptcy record using Next and Previous buttons in
Detail section. The Current box in Detail section indicates the current bankruptcy details.

When a Bankruptcy condition is opened on an account, the system defaults a detailed
tracking record with ‘Current’ field enabled and ‘Follow up date’ defaulted to system date. The
‘Disposition’ is defaulted as ‘NEWLY RECEIVED’. The system only adds a new detail tracking
record. No processing will be done with respect to detail tracking record when the bankruptcy
condition is closed.

To enter bankruptcy details for an account

1. Open the Customer Service screen and load the account you want to work with.
2. Click Bankruptcy tab.

3. Inthe Bankruptcy Details section, select the bankruptcy record you want to work with.
_Or_
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4. Select Add to refresh the Bankruptcy screen to create a new record.
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5. In the Bankruptcy Details section, enter, view or edit the following information:

Field:

Do this:

Current

Select to indicate this is the current bankruptcy record.

Follow up Dt

Enter the follow-up date for the bankruptcy.

Disposition

Select the bankruptcy disposition.

Type

Select the bankruptcy type.

Customer Select the customer from the drop-down list
Relation The system displays relation of the customer
Comment Enter a comment.

File Received Dt

Select the file received date for the bankruptcy.

Bankruptcy Start
Dt

Select the bankruptcy start date.

Bankruptcy End
Dt

Select the bankruptcy end date.

6. Click Save.

parameters.

In the Tracking section, click Load Tracking. The system loads the bankruptcy tracking

If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute field.

If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in parameter display.
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9. Complete the Create Tracking section by entering information regarding bankruptcy in
the Value field for each corresponding Parameter, click Save on the Bankruptcy screen.

Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

For details on how to Record a Call Activity, refer Call Activities sub tab section in “Customer
Service screen’s Customer Service tab” section.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record comments on the
Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.

For details on how to Record a Comment, refer Comments sub tab section in “Customer
Service screen’s Customer Service tab” section.

Due Date History sub tab

The Due Date History tab section provides a delinquency history, by payment, by displaying
a history of all due dates, along with when actual payment was made for that due date and
the subsequent balance. If a payment was delinquent, Due Date History section displays the
number of days the customer was delinquent against each due date.

For more details, refer Due Date History sub tab section in “Customer Service screen’s
Transaction History tab” section.

Customer Service screen’s Repo/Foreclosure tab

The Repossession/Foreclosure screen enables you to record information regarding
repossessions/foreclosure in a manner similar to how bankruptcies are recorded on the
Bankruptcy screen. You can track each stage of repossession/foreclosure process based on
the follow-up date and record information using the Details and Tracking section.

Repossession sub tab

On occasion, a lender performs multiple repossessions for the same Lease. The Create New
Repossession button on the Repossession screen enables you to create a new repossession
record for a different collateral and different start and end dates. You can also use the
Repossession screen to view previous repossession information using the Next and Previous
buttons in the Details section. The Current box in Details section indicates the current
repossession record for each asset.

This tab will be available only when the collateral type associated with the Lease account is
a Vehicle.

You can update the current record, but previous records cannot be modified.

When the REPO call activity is posted, system defaults the primary collateral details and
current status will be checked.

When a Repossession condition is opened on an account, the system defaults a detailed
tracking record with ‘Current’ field enabled and ‘Follow up date’ defaulted to system date. The
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‘Disposition’ is defaulted as ‘NEWLY RECEIVED’. The system only adds a new detail tracking
record. No processing will be done with respect to the detail tracking record when the
repossession condition is closed.

To Specify repossession details for an account

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Repol/Foreclosure sub tab, then click Repossession.

3. Inthe Repossession Details section, select the repossession record you want to work

with.
_Or_

4. Click Add to refresh the Repossession screen to create a new record.
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5. In the Details section, add view or edit the following information:

In this field:

Do this:

Current

session record.

Select the check box to indicate if this is the current repos-

Followup Dt

adjoining calendar.

Specify the follow-up date for the repossession from the

Type Select the repossession type.
Collateral Select the collateral involved in the repossession.
Disposition Select the repossession disposition.

File Received
Dt

Select the file received date for the repossession.

Repo Dt Select the repossession start date.
Repo End Dt Select the repossession end date.
Comment Specify a comment.

Case Repo Details - This section displays the following details based on the
case response received from the interfaced third party system.
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In this field:

Do this:

Case#

Displays the case number of the repossession.

National For-

If checked, indicates that National Forwarder carrier is

Report Recd Dt

warder equipped in the repossession.

Condition If checked, indicates that the condition report exist.
Report Status

Condition Displays the date when condition report was received.

Mileage Displays the mileage of the vehicle.

Key Status Indicates if the vehicle key(s) is available.

Field Agent Displays the name of the field agent involved in the repos-
Name session.

Address Displays the address of the field agent.

Phone Displays the contact number of the field agent.

Storage Loca-
tion

Displays the location where the vehicle is currently stored.

Repo Location

Displays the repossession location.

Police Dept
Name

Displays the name of police department involved in repos-
session.

6. Inthe Tracking section, click Load Tracking. The system loads the repossession
tracking parameters.

7. If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.
If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the parameter display.

8. Complete the Tracking section by entering information regarding repossession in the
Value field for each corresponding Parameter, then click Save.

Foreclosure sub tab

The Foreclosure screen enables you to record information regarding foreclosure in a manner
similar to how bankruptcies are recorded on the Bankruptcy screen. You can track each stage
of the repossession process based on follow-up date and record information using Details and
Tracking section.

A lender can perform multiple foreclosures for the same Lease. The Create New Foreclosure
button on the Foreclosure screen enable you to create a new foreclosure record for a different
collateral and different start and end dates. You can also use the Foreclosure screens to view
the previous foreclosure information using Previous and Next buttons in Details section. The
Current box in Details section indicates the current foreclosure record for each asset.

This tab will be available only when the Collateral type associated with the Lease account is
home.

You can update the current record, but previous records cannot be modified.
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To enter foreclosure details for an account

1.

Open the Customer Service screen and load the account you want to work with.

2. Click the RepolForeclosure sub tab, then click Foreclosure.

3.

_O r‘_

In the Foreclosure Details section, select the foreclosure record you want to work with.

4. Click Add to refresh the Foreclosure screen to create a new record.
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5.

In the Foreclosure Details section, enter view or edit the following information:

In this field:

Do this:

Current box

Select to indicate this is the current repossession/foreclosure
record.

Followup Dt

Select the follow-up date for the repossession/foreclosure.

Disposition

Select the foreclosure disposition.

Type

Select the foreclosure type.

Collateral

Select the foreclosure asset.

File Received Dt

Enter the file received date for the foreclosure.

Foreclosure Start
Dt

Enter the foreclosure start date.

Foreclosure End
Dt

Enter the foreclosure end date.

Comment

Enter a comment.

6.

parameters.

In the Tracking section, click Load Tracking. The system loads the foreclosure tracking
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7. If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.
If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the parameter display.

8. Complete the Tracking section by entering information regarding foreclosure in the Value
field for each corresponding Parameter, then click Save.

Analysis sub tab

The Analysis screen enables you to create and analyze possible scenarios for re marketing
and sale of the asset. This enables you to calculate the possible gain or loss in the sale of an
asset. Expenses already incurred on the asset are displayed on Expenses sub screen. You
can change the numbers if you expect more expenses by the time asset is sold. You can have
up to three Repo/Foreclosure and three Sales analyzes on each Analysis screen.

To complete a repossession/foreclosure analysis or sales analysis for an account

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service screen, click Repo/Foreclosure tab and then click Analysis.

3. Inthe Analysis section, select the analysis record you want to work with and click Load.
_or_

4. Click Add to refresh the Foreclosure screen to create a new record.
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5. In the Analysis section, select the Current box if you wish to indicate that this is current

analysis worksheet.

6. Inthe Analysis section, use the Level field to select analysis level you want to use,
ACCOUNT or ASSET.

— Select Account if you want analysis to use value of the entire account.

_Or_

— Select Asset if you want analysis to use the value of a particular asset.
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7. In the Analysis section, enter, view, or edit the following information:

In this field: Do this:

Current Ind Current Indicator. Select the check box if analysis is current.

Level Select the Analysis level from the drop down list.

Balance % Specify balance allocation percentage.

Analysis Dt View the analysis date.

Current View the asset current total value.

Value

Asset If you want to perform an analysis for a particular asset, select the asset.
Comment Specify comment associated with the analysis.

8. Specify all the required information in Analysis or Bid section, depending on the type of
incident you are analyzing.

9. Complete the details in Expenses and Refunds sub screens, corresponding to analyze
or bid number on the Analysis screen. The data here is loaded to the analysis and bid
columns as ‘expenses’ and ‘refunds’.

— To complete the Expenses sub screen:

In this field: Do this:
Expense Type Select the expense type.
Manual Indicates that the expense was entered manually.

Analysis1 Amt

Specify the expense amount for analysis1.

Analysis2 Amt | Specify the expense amount for analysis2.
Analysis3 Amt | Specify the expense amount for analysis3.
Bid1 Amt Specify the expense amount for bid1.
Bid2 Amt Specify the expense amount for bid2.
Bid3 Amt Specify the expense amount for bid3.

— To complete the Refunds sub screen:

In this field:

Do this:

Refund Type

Select the refund type.

Manual Indicates that the refund was entered manually.
Analysis1 Specify the refund amount for analysis1.

Amt

Analysis2 Specify the refund amount for analysis2.

Amt

Analysis3 Specify the refund amount for analysis3.

Amt
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In this field: Do this:

Bid1 Amt Specify the refund amount for bid1.
Bid2 Amt Specify the refund amount for bid2.
Bid3 Amt Specify the refund amount for bid3.

10. Select the Corresponding Analysis/Bid to Load details Maintained in the Expense and
Refund sections.

11. Repeat steps 4 to 8 with information regarding other repossession/foreclosure or sales
analysis.

12. In Status field, select status of the analysis: APPROVED or REJECTED.

13. When you have decided which analysis or which sale bid you want to approve, select your
choice in either the Final Analysis or Final Bid section.

Note

You can approve only one analysis. Based on Analysis approved on ‘Save And Return’
Corresponding Radio button will be enabled in the Final section of Analysis details.

14. Click Save.

Remarketing sub tab

In the Remarketing sub tab you can trigger remarketing request and auto generate resale
work orders. A collateral remarketing request is an instruction to the vendor of third party
auctioning system to pick-up the repossessed asset from the storage location and proceed
with auction.

In the Remarketing sub tab, you can do the following:

e Define Remarketing request
e View Remarketing Proceed Details
e Maintain Status History, Tracking Attributes, Expenses and Refunds.

For detailed information about the process of collateral remarkeing, refer to ‘Remarketing’
chapter in Collections User Guide.

Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

For details on how to Record a Call Activity, refer Call Activities sub tab section in “Customer
Service screen’s Customer Service tab” section.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record comments on the
Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.
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For details on how to Record a Comment, refer Comments sub tab section in “Customer
Service screen’s Customer Service tab” section.

Due Date History sub tab

The Due Date History tab section provides a delinquency history, by payment, by displaying
a history of all due dates, along with when actual payment was made for that due date and
the subsequent balance. If a payment was delinquent, Due Date History section displays the
number of days the customer was delinquent against each due date.

For more details, refer Due Date History sub tab section in “Customer Service screen’s
Transaction History tab” section.

Customer Service screen’s Deficiency tab

The Deficiency screen enables you to record information about deficiency accounts i.e.
accounts that are no longer collectable. You can create and track specific details on status of
the charged-off account for timely follow-up and analysis. You can also track each stage of
the deficiency process based on its follow-up date and record information using the Details
and Tracking sections.

The Add button enables you to create a new deficiency record with different start and end
dates. You can also use the Deficiency Details screen to view deficiency information. The
Current field in Deficiency Details section indicates the current bankruptcy details. To view
the balance of a charged off account, click the Transaction History tab on Customer Service
screen, then click Balances. On the Account Details screen’s Balance Group section, click
Deficiency. For more information on Deficiency Balance, see Balances sub tab section in this
chapter.

When a Deficiency condition is opened on an account, the system defaults a detailed tracking
record with ‘Current’ field enabled and ‘Follow up date’ defaulted to system date. The
‘Disposition’ is defaulted as ‘NEWLY RECEIVED’. The system only adds a new detail tracking
record. No processing will be done with respect to the detail tracking record when the
deficiency condition is closed.

To enter deficiency details for an account

1. Open the Customer Service screen and load the account you want to work with.
2. Click Deficiency tab.

3. Inthe Deficiency Detail section, select the deficiency record you want to work with
-Or-
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4. Click Add to refresh the Deficiency screen to create a new record.

ORACIl_E' ) ! ) # Welome, VAVAIDYA ¥ pccesgilty (w]
Financial Services Lending and Leasing
i Close
 DashBoard Customer Semvice x. @
 Origination Search  Customer Service: 2012100001088 Review Request (Pending: 0)
Servidng
Saiig Account(s): 20121000010588: BROWN PAUL / PAULA E_lylﬂf“ o hudit
} Customer Service Viewy Fomatw [ Freeze Hfivetacn  Jwap @) B @ Curent O Showll O Group Followup
Secuitization Company Branch Sub Unit Account £ Product Days Past Due Currency Pay OFf At Amount Due Status Oldest Due Dt
Transaction Authorization UsoL UsR1 UNDEFINED. 2017000010588 LEASEVEHICLE 1139 UsD 1633310 BELER] ACTIVEDELQ: SCHEDULED... BSIUEH
Fost Date Checks
Escron Transactons .
Summary | Customer Service | Account Details | Customer Detals  Transaction Hstory | Pt Modes | Bankuptey  Repo/Foreclosure | Deficiency  Collteral | Bureau  CrossfUp SellActities
Account Documents
Collteral Management
Repots Deficiency Details Fraid | /et | [Fvien | o it
:wﬂ“te" Views Fomety [ []Fece Hietach  dwap @)
Vendors
Curent Follovp Dt Dispostion Tipe Comment Fie Received Dt Charge OFF Dt Defiiency End Dt
Batch Transactions " i,
Advances
Payments
Fees Deficiency Details
4
Interfaces A sveandadi | [ swveand sty | | saveandRetun | Cagetun ‘
AP Transactions
6L Transadtions * Curent @ Comment
CASA Reconlia
ceondlston Folompot 1231000 B
Conversion Accounts. #
* Disposii v
il File Received Dt B
Te L Charge OFF Dt
Deficiency End Dt B
Tracking At | Evew | o audt
Views Fometv [ [lFecz Efietach  dwap @) o LoadTrading
Sub Parameter Parameter Value
o data to display,
 Collections
> WEP
> Tools Call Activities  Comments  Due Date History
> Setup v

5.

In the Deficiency Detail section, enter, view, or edit the following information:

In this field:

Do this:

Current

Select to indicate this is the current deficiency record.

Followup Dt

Specify the follow-up date for the deficiency.

Disposition

Select the deficiency disposition.

Type

Select the deficiency type.

Comment

Specify a comment.

File Received Dt

Specify the file received date for the deficiency.

Charge Off Dt

Specify the deficiency start date.

Deficiency End
Dt

Specify the deficiency end date.

Click Save.

In the Tracking section, click Load Tracking. The system loads deficiency tracking
parameters that track actions taken to collect on the account.

If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute
field. If your system has been configured to use the Sub Attribute field, only attributes in
a particular group appear in the parameter display.

Complete the Tracking section by entering information regarding deficiency in the Value
field for each corresponding Parameter, then click Save.
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Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

For details on how to Record a Call Activity, refer Call Activities sub tab section in “Customer
Service screen’s Customer Service tab” section.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record comments on the
Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.

For details on how to Record a Comment, refer Comments sub tab section in “Customer
Service screen’s Customer Service tab” section.

Due Date History sub tab

The Due Date History tab section provides a delinquency history, by payment, by displaying
a history of all due dates, along with when actual payment was made for that due date and
the subsequent balance. If a payment was delinquent, Due Date History section displays the
number of days the customer was delinquent against each due date.

For more details, refer Due Date History sub tab section in “Customer Service screen’s
Transaction History tab” section.

Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The
Collateral screen contains the Home and Seller sub tabs. To view the collateral details

1. Open the Customer Service screen and load the account you want to work with.
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2. Click Collateral tab. System displays the following screen:
If the account’s collateral is a vehicle, the Collateral screen opens at Vehicle tab:
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— If account’s collateral is neither a vehicle nor a home, the Collateral screen opens
at the Other Collateral:
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Clicking on Asset # in the Vehicle sub tab takes you to Collateral Management screen
opening respective collateral. You can modify the details on Collateral management screen
by clicking on ‘Edit’ and saving the record.

The system displays a warning message if the Collateral Management screen is already
open.

4141 Valuation sub tab

With the Valuation sub screen, you can view the collateral or asset valuation for an account.

To view the collateral or asset valuation for an account
1. Open the Customer Service screen and load the account you want to work with.

2. Click Collateral tab and then Valuation.

3. Click the Valuation sub tab to view the following information:

In this field: View this:

Value section

Current Select if this is the current valuation.

Valuation Dt The valuation date of the vehicle.

Source The valuation source.

Edition The valuation edition.

Supplement The valuation supplement.

Wholesale section
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In this field:

View this:

Wholesale Base

The wholesale value.

Usage

The usage. This pertains to Lease and usually is entered as the cur-
rent mileage.

Retail section

Retail Amt

Specify the retail base value.

Addons Amt (+)

The add-ons value.

Usage Value
Amt (+)

The usage value; that is, the monetary effect that current mileage
has on the value of vehicle.

Total Amt (=)

The total value.

Addons section

Addons/Attrib- Select the add-on/attribute.
utes
Value The value of the attribute.
Amount The add-on amount.

Note

Assets can have exactly one current valuation.

Tracking sub tab

With the Tracking sub screen, you can view collateral or asset tracking details to an account,
such as the location of title, liens, and insurance information.

To view the collateral or asset tracking for an account

1. Open the Customer Service screen and load the account you want to work with.

On the Customer Service screen, click Collateral tab.

2
3. On the available screen (Vehicle, Home, or Other), click the Tracking sub tab.
4

On the Tracking sub screen, enter, view, or edit the following information:

In this field:

View this:

Tracking Items section

Select

If selected, indicates that this is the current record.

Tracking Item

The tracking type.

Disposition The disposition.
Start Dt The tracking start date.
End Dt The tracking end date.
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In this field: View this:
Followup Dt The next follow-up date.
Comment Comments if any.

Tracking Item D

etails section

Enabled Select to track the information from start date in the Start Dt field.
Parameter The parameter.
Value The tracking parameter value.

4.14.3 Seller sub tab

The Collateral link’s Seller Details screen enables you to view seller details of the collateral of
Lease. You cannot edit or modify details of the seller.

1. In Seller Details section, click View.

2. View the following:

In this field:

View this:

Seller Details

Seller Type The seller type.

Seller Name The seller name.

Nationality The nationality of the seller.

National Id The national Id of the seller.
Authorized Signatory The authorized signatory of the seller.

3. In Seller Address section click View.

4. View the following:

Seller Address

Mailing If selected, indicates that this address is the
mailing address.

Current If selected, indicates that this address is the
current address.

Country The seller’s country name.

Address # The seller’s address.

City The seller’s city name.

State The seller’s state name.
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Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with the account that were pulled during servicing for account. You can also use
the Bureau screen to create and pull additional credit bureau reports and view the results as
a text only file.

To view an existing credit bureau report
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click Bureau tab.

3. Inthe View Report section:
— Click Servicing to view credit reports generated with the Customer Service screen.
-or-
— Click Origination to view credit reports generated during Lease origination.

4. In the Bureau Details section, select the report you want to view. The system displays
report as a text file in the Text Report section.

To request a manual credit bureau report

1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click Bureau tab.

3. Click Add to open New Request section.
4

Complete the following fields:

In this field: | Do this:

Customer Select the available customer from the drop-
down list.

Spouse Select the applicant’s spouse from the drop-
down list.

Bureau Select the credit bureau from the drop-down
list.

Report Select the credit bureau report type from the
drop-down list.

5. Inthe New Request section, click Create Request. The system displays this information
in the Bureau Details section and further information about customer in Customer Detail
section.

Note

If you are requesting a report from Experian Credit Bureau for Premier Attribute Consumer
report, you can do so without impacting the consumer FICO score. To facilitate the same,
the ‘Soft Pull’ check box is to be selected in Bureau Details section. This option is available
only when the system parameter ‘EXP_PA_SOFT_PULL_IND’ is enabled in the System
Parameters screen and Bureau is selected as ‘EXP’ with Report as ‘PREMIER ATTRIB-
UTE’ in the Bureau Details section.

6. If you want to receive a copy of a previously pulled credit bureau report, enter credit
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details
section.
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7. Click Save.

You can print the report by selecting the report and clicking on Print Report.

Customer Service screen’s Timeline tab

The Customer Service screen’s Timeline tab provides a graphical representation of specific
events on an account over a period of time, The events mainly include Transactions
(Monetary/Non Monetary), Payments and Call Activities that are posted on the account.

To view account timeline

1.

Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service screen, click Timeline tab.
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The Timeline Details section facilitates and displays the following options:

The timeline ranges from 1 month before the account start date till 1 month after the
current date.

Each activity in timeline is arranged as per the transaction date on the account.

The account activities are categorized as Monetary, Non-Monetary, Payments, and Call
Activities. You can filter to view them by selecting the required option or select ‘ALL’ to
display all the activities related to the account. By default, system displays ‘Monetary’
transactions.

On selecting ‘Monetary’ and ‘Payments’ options, timeline displays only good monetary
transactions and good payments. More details of these transactions can be viewed in
Transaction History > Transactions tab by selecting ‘Good Txns’ and ‘Good Payments’
option.

On selecting ‘Call Activities’ timeline displays all the call activities posted to the account.

The Zoom bar @ 11111 % has options to view the timeline based on Hours, Days, Weeks,
Months, Quarters and Half Years.

On hovering over the timeline, the arrows « and * helps you to scroll through the
timeline.
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Customer Service screen’s Cross/Up Sell Activities
tab

The Customer Service screen’s Cross/Up Sell Activities tab enables you to view and edit all
the captured marketing trigger based events for respective customers linked primary
accounts.

Oracle Financial Services Lending and Leasing Application has been integrated with a third
party database marketing solutions provider to receive monitoring triggers related to
marketing based call activities. Primarily the active customer details are shared through an
input file and corresponding monitoring triggers data within the processed customer input file
are uploaded back into designated location of OFSLL database through an automated
interface.

The Customer Service screen’s Cross/Up Sell Activities tab displays the first 10 marketing

trigger based call activities with the opportunity details and follow-up requirements. You can
select View All check box to view all the ‘active’ and ‘closed’ call activities.

Edit Cross/Up Sell Activity
To edit a reported Cross/Up Sell Activity

1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click Cross/Up Sell Activities tab.

3. Select the record which you want to update and click Edit.
4

Complete the following fields:

In this field: Do this:

Trigger Dt View the date on which the activity has been recorded.
Product Select the product from drop-down list.

Trigger Action View the trigger action captured.

Trigger Description | View the description of the action.

Result Select the result of the action from the drop-down list.
Reason Select the desired reason for the result selected.
Appn'mnt Select the check box to indicate if a prior appointment is required

for next communication.

Followup Dt Select the agreed follow-up date from the adjoining calendar
icon.

Close If there is no follow-up and the opportunity is closed, you can
select this check box indicating the status of call activity as
closed.

Time Zone Select the time zone of the contact from the drop down list.

Comments Specify additional information, if any.

5. Click Save and Stay or any other save option as explained in Basic Actions section.
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Create Simple Application

You can use the call activity data and directly initiate the Lease Origination process from
Cross/Up Sell Activities tab.

To create simple application
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click Cross/Up Sell Activities tab.

3. Select the required call activity record and click Create Simple Application.

The system opens Origination > Simple Application Entry screen with Application
section capturing the details of call activity.

You can enter/edit the required details and continue creating credit application data into
Oracle Financial Services Lending and Leasing Application.

For detailed information, refer to Simple Application Entry chapter in Lease Origination User
Manual.

Close Opportunity

You can close an opportunity based on the response received from customer and if there are
no follow-ups required. However, you can close an opportunity and de-link the same from an
account only when all the records are closed.

To close an opportunity
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click Cross/Up Sell Activities tab.

3. Ensure that all the records are marked as closed and click Close Opportunity.

Customer Service screen’s External Interfaces tab

The Customer Service screen’s External Interfaces tab displays the account specific
information derived from external system.

Oracle Financial Services Lending and Leasing has been integrated with a third party system
to explicitly fetch the account specific information through an input data file. A set of
automated batch jobs which are scheduled at regular intervals pulls the data shared by
external system and populates in the respective account in Customer Service > External
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Interfaces tab. For more information on available Batch Jobs, refer to Setup Guide >
Administration > System > Batch Jobs section.
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In the External Interfaces tab, each input data file either new or an update to existing
information is displayed as individual record in the Interface section and the column definition
details (as sorted in Setup > Data Files screen) are displayed in Interface Details section.

In this field: View this:

Interface section

ID Unique case identification number.

Interface Name Name of the external interface.

File Name Input data file name appended with New (IBN) or Existing (IBU)
file identifier convention.

Status Current status of the record (None, Accepted, or Rejected).

Creation Dt Date when the record was created.

Action Taken By User who has modified the record status.

Action Dt Date when the action was performed on the record.

Interface Details section

Parameter Name of header used in input data file corresponding to the
account information such as First Name, Last Name, Address
and so on.

Value Data fetched from external system for each header/parameter.

Along with the account specific updates, the records may also contain bankruptcy details
which needs you attention. You need to verify those details and confirm the authenticity by
either accepting or rejecting the bankruptcy information. If Accepted, system posts the
bankruptcy details on the corresponding customer accounts.
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Accept or Reject Bankruptcy Details

In the External Interfaces tab you can Accept or Reject information of those records which are
specific to bankruptcy update and marked with status as ‘None’.

e To accept the bankruptcy details, you need to create a new record with tracking
attributes and then proceed with steps explained below.

e Toreject a record, you can select the record and click ‘Reject’ in the external interface
tab.

Post update, the status of record is marked as ‘Accepted’ or ‘Rejected’.
To Accept Bankruptcy Details

1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click External Interfaces tab.

3. Inthe Interface section, select the bankruptcy record with status ‘None’ for which action
has to be performed.

4. Verify the details displayed in Interface Details section.
Once confirmed, navigate to Customer Service screen > Bankruptcy tab.

6. Create a Bankruptcy record and load the tracking attributes as explained in ‘Customer
Service screen’s Bankruptcy tab’ section.

7. Click Accept in the action section and click ‘Yes’ in the confirmation dialog to accept
changes.

On confirmation, system updates the bankruptcy details based on either ‘SSN’ for new
bankrupt accounts or ‘Case Number’ for existing bankrupt accounts.

Review Request

The Review Requests screen is primarily a work flow tool used to flag an Account for the
attention of another Oracle Financial Services Lending and Leasing user and ask for review /
feedback. It allows the system users to send and receive requests (including e-mail)
commenting on a specific Account. The Review Request tab supports iterative review of
selected Account and also to process the review with multiple reviewers.

In this chapter, you will learn how to compete the following tasks:

e Filter and View Review Requests
e Create and Send Review Request
e Reviewing a Request

e Responding to Review Request

e Reassign Review Request

e E-mailing Review Request

e Closing Review Request

e Complete Review Request

Note

You can complete the above tasks for an Account Review Request using Review Request
tab in the Customer Servicing screen.
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4.19.1 Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:

The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are
created, reviewed, closed and completed by that user.

You can further filter the review request based on the following:

Query .

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.

Receiver Displays the records of all the active review requests received by the
selected User.

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.

Forwarded Displays all the review requests records which are forwarded by the

Only selected User to another user for review.

Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review
request.

Action Options Descriptions

Open Account Displays the Customer Service screen with the Account details
assigned for review.

Send Request Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response | Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.
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Action Options

Descriptions

Close Request

Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Complete
Request

Changes the status of review request to COMPLETED and can be
viewed by selecting ‘View All' option in the ‘Query’ section.

Remove Filter

Removes the selected filters applied to narrow the view of review
request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.

Email Section

The Email section enables you to send an email to either originator or receiver of the review

request if an ema

il setup is configured. However, note that a review request cannot be

responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

The ‘Review Requests’ section in Customer Service screen displays the following information

for each record:

Fields Descriptions

Request # View the system generated review request number. The same
can be used to query and track the review requests.

Originator The user id of the review request originator.

Priority The request priority: HIGH, NORMAL, or LOW.

Receiver The recipient of the review request.

Phone Applicant’s phone number in the review request.

Address Applicant’s address in the review request.

Email Applicant’s email in the review request.

Status The current status of review request. Following status are
tracked in this column:
WAITING FOR RESPONSE - when request is sent to reviewer
RETURN TO ORIGINATOR - when reviewer has responded to
request
CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.
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Fields

Descriptions

Account #

The Account number which needs review.

Days Past Due

Total number of days elapsed past the due date.

Total Outstanding
Balance

Displays either ‘Account outstanding principal balance’ for active
accounts, or ‘Deficiency balance’ for charge-off accounts.

Customer

Primary / Secondary (spouse) name associated to the account.

Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an Account
review request is forwarded to multiple reviewers and is reviewed or completed by second or
third person other than the one assigned by originator.

In the Comment History section, you can view the following details of the selected review

request:

Comments From

Descriptions

Type

View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.

Sub Type

View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.

Comment

View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request # FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By

View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt

View the Date and time when the comment was posted.

4.19.2 Create and Send Review Request

The review request tab primarily allows you to flag an Account for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.
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To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE'
Financial Services Lending and Leasing

Customer Service

Review Requests

Request # 12003
Originator
*Priority | HIGH

*Receiver ANAND SHEKAR

Cemment REVIEW ACCOUNT BALANCES

Comment History
View~ Fomat+ b

No data to dispiay.

[=

eze i Detach
Type Sub Type

Hsaveandadd | [ saveandstay | [ save and Retum

Caetum

Sender Days Past Due 0
* Account # | 2000010011520 -
*Reason REVIEW BALANCES =]

Total Quistanding Balance. 330
Customer ALIVE PRI / DEA SPO
Phone 9728663378
Address HOME - ADD&.
Status JNEWYORK, MASSACHUSETTS, 34038
Date 09/18/2017 12:23:33 AM Email EDW.SIRSI@GMAIL.COM
Send Request [

Comment Comment By Comment Dt

2. In the Review Requests section, select ‘Originator’.

3. Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field:

View this:

Request #

View the system generated request number.

Originator

View the requester’s user ID auto generated by system upon
creating the request.

Priority

Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver

Select the user ID of the reviewer from the drop-down list.

Comment

Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender

View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Account #

Select the Account to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Days Past Due

Total Outstanding Balance
Customer

Phone

Address

Email

Reason

Select the purpose for request from drop-down list.
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4.19.3

In this field:

View this:

Status View the status of review request auto updated by system
upon creating the request.
Date View the date and time when the request was created. Sys-

tem appends the current date by default.

Send Request

(Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

Reviewing a Request

4. Perform any of the Basic Actions mentioned in Navigation chapter.

The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in
DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Account # link opens the Review Request tab.

ORACLE’
Financial Services Lending and Leasing

bity 1§ Sonout O

Customer Service x  DashBoard x
Origination

My User Queues
Description
No data to display.

My Pending Review Requests By Applications

A =
0000001044

My Pending Review Requests By Priority
Priority
Servicing

Number of Queues Hard Assigned

@

Queue Description
No data to dsplay.

Number of Accounts
Queue Desaription
Mo data to display.

My Pending Review Requests By Accounts
£

[ Cose

Setup Admin

Product Expiring in Next One Month Critical Batch Job Status

] @

Product End Date Batch Job Status
o data to display. No data to display.

i

Producer Vendor

Producers Count By Status ‘Vendors Count By Status

W ]

Status Count Status Count

ACTIVE £ ACTIVE 7
Producers Expiring in Next One Month 1= vendors Expiring in Next One Month

@ G}

Producer End Date Company Name End Date
No data to display. No data to display

Producers Count By ACH Status
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To review requests

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE'
Financial Services Lending and Leasing

Customer Service 3] Close:
Search | Customer Service Review Request (Pending: 1) | Queue Assgrment =
Review Requests
dpadd | Zedt | [Fuew || of audt
Query Email
User | © Originator @ Receiver ©1Both  view Al [7] Forwarded Only [7] £ Origrator Recever
Views Fomatv By | [[[Freeze EliDetach w @ (Dopen Account s st [ sendResponse [ Close Request [ Complete Request
Request Criginator Priority Receiver Phore Address Emal Reason
8002 PRITAM JENA HIGH HARISH MACHA 9728663378 HOME - ADD& newyork,... EDW.SIRSIGGMAIL,COM  REVIEW ACCOUNT L
< i 8 Sl
Comment History B vew
view v Formatv [ Freeze i Detach » @
Trpe Sub Type Comment Comment By Comment Dt
REVIEW REQUEST CRIGINATOR TESTFWD PRITAM 09/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER FWD SURABHI 09/06/2017 09:33:45 AM
REVIEW REQUEST SYSTEM GENERATED REVIEW REQUEST : 8002 FORWADED FROM SURABHI DESAL TO NAVEEN REDDY  INTERNAL 09/06/2017 09:33:45 AM
REVIEW REQUEST RECEIVER P SURABHI 09/06/2017 09:34:31 AM
REVIEW REQUEST SYSTEM GENERATED REVIEW REQUEST : HA INTERNAL 09/06/2017 09:34:31 AM

2. In the Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Click ‘Open Account’. The Account details are displayed in Customer Service > Summary
tab.

4. Review the details in particular to the details specified in the comment (if any).

Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.

However, system also allows your forward the same request to another reviewer in case of
additional clarifications.
To respond to review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.

SRACLE.
Financial Services Lending and Leasing

PRAKRUTI nA0
<

rRequests
Save and adg || save and sty || & save and iewurn || <Ga et

> Collecrions
> wee

> sotup.

Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
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box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.

Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.

When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as ‘INTERNAL'.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.

To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed and click Edit.

Review Requests
[ save andstay | [ saveandRetun | CaReturn

Request # 8002 Sender NAVEEN REDDY Days PastDue 0
Originator PRITAM JENA Account # 2000000011820 Total Qutstanding 28,806.94
Priority HIGH Reason REVIEW ACCOUNT Patnce
et (AT T AT = Customer  ALIVE PRI / DEA SPO
Phone 9728663378
Status WAITING FOR RESPONSE
omment s Address HOME - ADD&
Ente. ARRIGENHF DO LN NEWYORK, MASSACHUSETTS, 34038
Send Request [T Email EDW.SIRSIGGMAIL.COM

Comment History

View v Formatv G Freeze i Detach wrap @)
Type Sub Type Comment CommentBy Comment Dt
REVIEW REQUEST ORIGINATOR TESTFWD PRITAM 09/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER FwD SURABHI  03/06/2017 09:33:45 AM
[REVIEW REQUEST SYSTEM GENERATED REVIEW REQUEST : 8002 FORWADED FROM SURABHI DESAL TO NAVEEN REDDY  INTERNAL  09/06/2017 09:33:45 AM
REVIEW REQUEST RECETVER FWD SURABNL  09/06/2017 03:3%:31 AM

4. Select the required reviewer from ‘Receiver’ drop down list.

(Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

6. Select the ‘Send Request’ check box to reassign review request immediately on update.

In case of any further changes, retain the check box unselected and save the details. The
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419.7

4.19.8

reassignment can later be completed by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING
FOR RESPONSE.

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.

To e-mail a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. In‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator
field.

_0 r'_

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.
The system emails the details of selected record to e-mail address recorded in user setup.

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request tab.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Close Request’.
The system assigns the request as CLOSED and removes it from your Review Request

record. The closed review requests can be reviewed anytime by selecting View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.

To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.

3. Inthe Action section, click ‘Complete Request’.
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4.20.1

The system assigns the request as ‘COMPLETED’ and removes it from your Review Request
record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Queue Assignment

The Queue Assignment tab in Oracle Financial Services Lending and Leasing application
allows you to search and view the hard assigned customer service queues maintained in the
system. You can also view the queue assignment details with option to reassign users in a
hard assigned queue and track activity status posted on the account.

Customer Service Queues are maintained in Administration’s setup screen (Setup >
Administration > User > Queues > Customer Service). For more information on hard assigned
queues, refer to section “Using the Hard Assigned feature” in setup guide.

Navigating to Queue Assignment

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Queue Assignment.

ORACLE . _ . \ SSHEKAR y g Sanout ©
Financial Services Lending and Leasing
o Dechnoad Customer Service @ Qose
Cignoamaton Search | Customer Service || Review Request (Pending: 0) | Queue Assignment 2
Servicing
Servidng - Search Criteria
Customer Service
S itizatic
Scuntzaton Queue Acc # Responsibility User Search List By
Transaction Authorization E
DEF B 2 ¥ @ Queue O User
Post Date Checks
Escrow Transactions
Account Documents Queues
Collateral Management L
View ~ Format ~ Fresze i Detach 1 Wrap E
Reports N & o @
Producers Queue name Queue Desc Account Condition Priority Company  Branch Hard Assigned
Vend
e DEF DEFICIENCY QUELE : NEWREQUESTS  DEFICIENCY 1 ALL AL Y
Batch Transactions
Advances
Payments .
) Queue Assignment
T == View v Format~ [ Fresze {4 Detach \irap ot} 483 Undate Queue
> Collections Select [F]
e W Usertame Account # Replacement Lser  Queuie Name  Queue Desc Responsibilty Company  Branch D2
T [] CSMAMAGER21 2015050010045 ~ DEF DEFICIENCY QUEL... CUSTOMER SERVL... USOL usHQ 0z
5 Set CSMANAGER3 3 20150500010136 x| DEF DEFICIENCY QUEU... CUSTOMER SERVI... US01 UsHQ 0=
up - L .
q i = | =

In this section, you will learn how to compete the following tasks:

e Using Queue Search

e Filter Queues in Queues sub tab

e Define criteria in Criteria sub tab

e View options in Queue Assignment sub tab
e Reassign Users in Queue

e Filter Accounts based on Queue Criteria

e View Accounts in Sort Order Sequence

e Track Activity Status

Using Queue Search

In the Search Criteria section, you can primarily use the ‘Search List By’ filter to search based
on either ‘Queues’ or ‘Users’ maintained in the system. Depending on the option selected, you
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can further filter your search using the following list of parameters and query the database by
providing one or more parameter values.

Field: Do this:

Hard Assigned | Select the queue name from the drop-down list. The list displays both
Queue ‘Enabled’ and ‘Hard Assigned’ customer servicing queue definitions.
Acc # Specify the account number to which the queue is assigned.

Responsibility | Select the user/queue responsibility from the drop-down list. The list
displays various user responsibilities as defined in Setup >
Administration > User > Queues > User Groups tab.

User Select the ‘User’ from the drop-down list. The list displays all the hard
assigned users maintained in the system.

Note

You need to specify a minimum of one parameter for the search to retrieve queues from
the database. Else system displays an error message.

Click ‘Search’. The search results for Queues are displayed in both the Queues & Queue
Assignment section. Whereas, the search results for a ‘User’ (selected in Search List By
option) is displayed in Queue Assignment section.

You can also click ‘Reset’ to clear the filters specified in Search Criteria.

Remove Account Filter

While searching for queues using Account number as the Search Criteria, the Queue
Assignment section displays the filtered search results along with the ‘remove Filter’ option in
the header.

Clicking on ‘remove Filter’ button will remove the account number filter and displays all the
accounts belonging to the selected queue.

Queues sub tab

The Queues sub tab displays the search results for the specified search criteria and contains
‘Enabled’ and ‘Hard Assigned’ customer servicing queues with the following details:

e Queue name

e Queue Desc

e Account Condition
e Priority

e Company

e Branch

e Hard Assigned

e Group Follow-up Ind
e Near Real-Time

e Dialer Extract

e Enabled
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4.20.3 Criteria sub tab

The Criteria sub tab allows you to define account selection criteria and sort order to filter the
accounts displayed in Queue Assignment section.

1. In the Criteria Definition section, click ‘ADD’. You can also perform any of the Basic
Operations mentioned in Navigation chapter. A brief description of the fields are given

below:

Field: Do this:

Name Specify a unique name to identify the criteria.

Description Specify the required description for the criteria.

Hard Assigned Queue Select the queue name from the drop-down list. The list
displays all the ‘Enabled Hard Assigned’ customer
service queues.

Enabled Check this box to enable the criteria.

The Criteria sub tab further consists of ‘Selection Criteria’ and ‘Sort’ tabs.

2. Inthe ‘Selection Criteria’ section, you can define the account selection criteria with the
following fields. Perform any of the Basic Operations mentioned in Navigation chapter. A
brief description of the fields are given below:

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list. The list

displays all the ‘Enabled’ attributes maintained in user
defined table which has both ‘Queue Assignment’ fields
and 36 activities defined in Queues > Activity Tracking
tab for selection.

Comparison Operator Select comparison operator from the drop-down list.
Criteria Value Specify criteria value.

) Specify right bracket.

Logical Expression Specify logical operator from the drop-down list.
Enabled Check this box to enable the selection criteria.

3. Click ‘Check Criteria’ to validate the correctness of the SQL statement generated and to
resolve errors, if any.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

In the ‘Sort’ section, you can define the order to sort the account selection criteria with the
following fields. Perform any of the Basic Operations mentioned in Navigation chapter. A
brief description of the fields are given below:

Field: Do this:

Seq Specify sequence number.
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Field: Do this:

Sort field Select the sort field from the drop-down list. The list contains both
the ‘Queue Assignment’ fields and 36 customer call activities
defined in Queues > Activity Tracking tab for selection.

down list.

Order Select sort order as either Ascending or Descending from the drop-

6. Perform any of the Basic Actions mentioned in Navigation chapter.

4.20.4 Queue Assignment sub tab

The Queue Assignment section, displays the user accounts associated with the selected

queue and consists of the following details:
e User Name
e Account #
e Replacement User
e Queue Name
e Queue Desc
e Responsibility
e Company

e Branch
e Date
° Title

e Products

e Status

e Delinquency Days

e Amount Due

e Outstanding Balance
e Producer

e Secured

e Reason

In the Queue Assignment section, you can do the following:

e Reassign Users in Queue

e Filter Accounts based on Queue Criteria
e View Accounts in Sort Order Sequence
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Track Activity Status
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4.20.5 Reassign Users in Queue

4.20.5.1

4.20.5.2

In the Queue Assignment tab, you can reassign a different user for a queue either individually
or in bulk and reassign the hard assigned queues. While doing so, you can state the reason
for change which later gets appended and displayed in the account conditions history log
(Customer Service > Account Details > Condition Details sub tab).

Replace User in Queue

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Queue Assignment.

Search for the required Queue or User using the parameters in Search Criteria. The
search results are displayed in the Queues & Queue Assignment section.

In the Queue Assignment section, click on the ‘Replacement User’ drop-down list against
the required user and select the new user from the list. You can also use the ‘Search’
option within the list to search for the required user.

Specify the reason for change in the Reason column against the user selected.
Click Update Queue.

Bulk Replace Queue Users

5.
6.

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Queue Assignment.

Search for the required Queue or User using the parameters in Search Criteria. The
search results are displayed in the Queues & Queue Assignment section.

In the Queue Assignment section, click ‘Select All’ check box.

Click on the ‘Replacement User’ drop-down list on the header and select the new user
from the list. You can also use the ‘Search’ option within the list to search for the required
user.

Specify the reason for change in the Reason field on the header.
Click Update Queue.

On successful user replacement, a system generated comment is posted on the account with
the following details:

Alert flag as ‘N’

Type
Sub Type
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e Comment Format QUEUE USER CHANGED FROM XXX TO YYY BECAUSE OF
<<REASON>> ON <<DATEFORMAT>>

Filter Accounts based on Queue Criteria

To filter the list of accounts in Queue Assignment section, select the required option in ‘Sort
Order Type’ drop-down list and click ‘Submit’. The list is populated based on the defined
Queue Criteria. You can also click ‘Reset’ to remove the filter and display all the account
associated to the queue.

View Accounts in Sort Order Sequence

In the Queue Assignment section the ‘Account # column is enabled with a link to directly
navigate and view the account details in the Customer Service screen.

To view the next account in the same sequence as listed, click ‘Filtered Account’ button in the
Queue Assignment section header. The details are displayed in Customer Service screen’s
> Summary tab.

On reviewing the account details, you can further navigate to the subsequent accounts in the
sequence by clicking ‘Filtered Account’ button in Right-Splitter window > Quick Search
section. Successively, clicking ‘Filtered Account’ button displays all the accounts and when
the last account is reached, a message is displayed indicating ‘There is no account in this
queue’.

Track Activity Status

All the customer service call activities defined and enabled in setup screen (Setup >
Administration > User > Queues > Customer Service > Queue Activity tab) for the selected
Queue are listed against each account in separate columns. These activity fields are auto
updated with call activity results and gives a quick snap shot of all the activity status scheduled
and performed on the account.

Note

The activity status fields are available only when the accounts are populated from a Queue
search by selecting the ‘Search List By’ option as ‘Queue’.

When a particular call activity is posted on the account, the respective activity status field is
marked with a ' indicating that the activity is complete.

However, in case the activity duration has expired based on the ‘Activity Expiry Days’ defined

in Queue Activity tab, the activity field is disabled and status is not updated in Queue
Assignment section.
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5.1

5.2

5.2.1

5. Collections

Introduction

After an application has cycled through the Lease origination process, it becomes an account.
Account maintenance and collections tasks can be performed with Oracle Financial Services
Lending and Leasing’s Collection screen.

The Collection screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using Funding main tab or
convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Lease origination cycle and is funded or is ported into the
system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load customer details on the Collections screen.

e Use the Search screen by selecting Customer Centric option(s).
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e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in Account(s) and Customer(s) sections, open the Collections
screen and load the account you want to work with.

For details on this screen refer Customer Service screen section in Customer Service
chapter.

Customer Service screen’s Summary tab

Open the Collections screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

oracLe

Financial Services Lending and Leasing

e Callections x [®chose
> Origination Search Customer Service  Review Request (Pending: 0)
> Servicing
cillestions Account(s) [Elview | o avdt
o Views Fomatw B[] Frecze i Detach wp @ 8 current () showall © Group Follov-up
Collecions Company ranch Sub Unit Account # Froduct Days Pest Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Bankuptey o data to display,
Repossession
Deficency Summary | CustomerSenice | Account Details | Customer Details | Transaction History | Pt Modes | Bureau | Crosg/Up Sel Acivites
Reports
Producers
v‘” d““‘ Hlerts Conditions
endors
Alerts Conditions
Aert Condition Start Ot Followup Dt
Ho data to display. Mo datato display.
4 Account Details Other Information
4
Dues .
Customer Information
Mo data to display. Customer i, e Relation ssh Bitth Dt Gender
o data to display.
Delg Due Total Due Future Pt Ot 5
L Due Todays Fayoff Oldest Due Dt
NSF Due Future Payoff Amt Paid Excess
Other Due Future Payoff Date Email Disabilty rivacy Opt Out
i S Language shp Active tiltary Duty
Delinquency Information Vaital Status Stop Time Zone
e 30 [} ) 00 150 180 Cteguy Das Correspondence
o data to display.
BP(Lf2) HSF{Life) Collector Address Information
BP(Year NSF(Year) 3 Permissi |,
Tipe Curent * 1 Wailing Address Phone
Activities Ho datato display.
Adive Dt A Last Pt At
5 WEP Last Actiity Dt Paid Off Dt Charge Off Dt Employment Information
Due Day Effective Dt ilitary Duty Permissi
> Ty & it - Employe Address Ph
o Last Pt Ot Curtent Pt Customer Score bicd YT ol | i ik
> Setup Customer Grade Last il Amt Behaviour Score Mo data o display. -
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5.5.0.1

5.6

5.6.1

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter.

Customer Service screen’s Customer Service tab

Open the Collection screen and load the account you want to work with. Click the Customer
Service tab to view the sections under it.

Recording a Call Activity

To record a call activity
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.
The system displays the following screen.

"ORACLE"
Financial I Services Lending and Leasin g

xxxxxxxxx

nnnnn

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter.

Customer Service screen’s Account Details tab

Open the Collections screen and load the account you want to work with. Click the Account
Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.
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In the Account Information section click View.

ORACLE
Financial Services Lending and Leasing

e Collections x ez
> Origination Search | Customer Service: 2015090014283 | Review Request (Pending: 0)
> Servicing
T Account(s): 20150900014283: RODRIGUEZ ROBINSON Elyew | oAt
View v Format~ [ freeze fffiDetach | ol wrap W@ & © Current Show Al Group Follow-up
Company Branch  SubUnit  Acc Dav= RSt cumrency  Pay OFf Amt Amount Due Status Oldest Due Dt
usor  UsiQ  UNDEFL. 20 114 UsD 15,158.10 4,295.60 ACTIVE:DELQ  10/05/2015
Summary y || Customer Account Details | Customer Details | Transaction History || PmtModes || Collateral | Burcau Cross/Up Sel Activities
Account Details | Statements || Rate Schedule < | Contract Informaton
Account Information Elven || < Audt
Vew~ Format~ B Freeze  ffiDetach wrap
#ofExtensons = ofExtensions * of Extension Term = of Extension Term # of Due Day Zofbuebay | o e ey o e
Crear) wife) (vear) i) changes(Year) changes(uife) L5t Extn Dt D= Day ChangenE Total T
o o o o o o 15
Pl i
<

Account Information

Extn and Due Dates Additional Details
) 0 Total Term 15

Maturity Dt 11/05/2016

> wre
> Tools
> Setup Ly

For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter.

Customer Service screen’s Customer Details tab

Open the Customer Service screen and load the account you want to work with. Click the
Customer tab to view the sections under it.

Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on the Customer Details screen.
Using the Customer Service screen’s Customer Details tab, you can update or add to a
customer’s address, employment information, or phone listing. All the information about the
customer can be changed using Maintenance screen.

To view or edit customer information
1. Open the Customer Service screen and load the account you want to work with.
2. Click Customer Details sub tab.

ORACLE
Financial Services Lending and Leasing

> DashBoard it ] Bl e
* Orlgination Search | Customer Service | Review Request (Pendng: D) -
> Servicng -
FE—— Account(s) | Elview || o audit
W - Fresze BR urap 3, @ Curent® Show Al ©) Group Folo-u
Calections View > Format 53 eeze i Detach W & 3 & P P
Collections Company Branch  Sublnit  Account % Product D2VE P2t Gurrency  Pay OFF Amt Amount Due Status Oldest Due Bt
Barkruptey No data to display.
Repossession 9 - i
Deficency
Reports
ProdicS Summary | Customer Service || Account Detals | Customer Details | Transaction History || PmtModes || Bureau || Cross/Up Sel Actiities
Vendors
Customer | Business
Customer Information 3
2 Edit = vie: o Audit
vew s Fomatv | B | [llFee= fMoelcn | Jdwap | @
Customer # Relation £COA Name ssn Birth Dt Marital Status Enabled Lang
“ Ne data to dsplay.
P e — v N
Customer Information
Save and Stey || [ Save and Return || {aRetun
Customer
Identification Details xve
Customer =
Relation Passport Reference #
CoA Tssue Ot status
Name Expiry Dt
Birth Dt Visa # FATCA
Marital Status Nationaiity .
Enabled National ID P tiplce
= - 8irth Country
Language s
Education License # Permanent US Resident Status
Mother's M License State
we Mother's Maiden Niame T —
Class Type I FouerelAtomay
ilitary Service
> Tools Email Pawer of Attarney —
Stop C: dence _
> Setup e E;D;” ir":e Active Miitary Duty __ Hﬂ‘dﬁ‘jjﬂme I
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5.9

5.9.1

For details on this screen refer Customer Service screen’s Customer Details tab section in
Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Customer Service screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Customer Service screen and load the account you want to work with. Click the
Pmt Modes sub tab to view the sections under it.

ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen
1. Open the Customer Service screen and load the account you want to work with.
2. Click Pmt Modes tab, then click ACH sub tab.

ORACLE"
Financial Services Lending and Leasing

Close
e Collections £

> Origination Search | Customer Service: 20150900014267 | Review Request (Fending: o)

> Servicing

Account(s): 20150900014267: SIGG MARK [El view || o Audit
View v Format~ | B Freez= i Detach = W L&, @ Corrent© Show Al © Gronp Fallow-n
Company Branch  SubUrit  Account & Product &
usol  USHQ 20150300014267 LOAN VEHICLE (FR)

ncy  Pay OFf Amt. Amount Due Status Oldest Due Dt
usD 19,397.24 5,209.00 ACTIVE:DELQ  10/01/2015

Summary | Custamer Sarvies | AccountDatais | Customer Datads | Transschion History | PmtModes | Collstersl | Burssu | Cross/Up Sel Actvities

AcH | Coupon || PostDated Checks || Payment Arrangement

ACH Information

e On Account

> WEP
> Tools
> Setup

For details on this screen refer Customer Service screen’s Pmt Modes tab section in
Customer Service chapter.
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Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The
Collateral screen contains the Home and Seller sub tabs.

To view the collateral details
1. Open the Customer Service screen and load the account you want to work with.
2. Click Collateral tab. The system displays the following screen:

ORACLE'
Financial Services Lending and Leasing

e Close
> DashBoard o o4 ®
> Origination Search  Customer Service: 20150900014283  Review Request (Pending: 0 -
> Servidng
oot Account(s): 20150900014283: RODRIGUEZ ROBINSON [Elview || o udit
View v Format v [ Freeze i Detach Wirap 5,  © current(® show All ©) Group Follow-up
Collections & o = @ &
Colections Company Branch  Sublnit Account # Product Bays pDajé Currency  Pay OFf Amt. Amount Due Status Oldest Due Dt
zi;::si':;nn USOl  USHQ  UNDEFL. 2015030014283 LEASE VEHICLE 114 USD 15,158.10 4,296.60 ACTIVEDELQ  10/05/2015
« 0 v
Deficency
Reports
Producers Summary | Customer Service || AccountDetails || Customer Detals | Transaction History || PmtModes Collateral | Bureau | Crass/Up Sell Activities
Vendors
Vehicle = seler
Vehicle
e add | Edit -] Vie < Audt
View = Formatv [ Freeze  DfiDetach | o Wrap 5]
Primary Desaription Status Asset Type Lien Status LienEventDate  Second Lien Holder  Comments Lien Release Entity  En
¥ 2015 AUDI A4 ACTIVE VEHICLE UNDEFINED
# 7 i ' “
Vehicle
[ saveandstay || [ SaveandRetum | GaRetum
Tupe &Description [ Description 2015 AUDI A4 Exrel2
Total 24
Condition GOOD CONDITIONED -
Primary ¥ =l Charge 200,00
Substitution _ ;
ewtd THD Lien Details i
* Asset Class | NEW VEHICLE [+l s
Lien Status UNDEFINED [= ooy e =
* AssetType VEHICLE [l Lien Event Dat B
DR County NORFOLK [=]
*SubType CAR ) secondtien Holder
: Address # 480 NEPONSET ST
*Registration # UNDEFINED e
Status ACTIVE Address Line 1
Lien Release Entity - . o
Select Make and Model = Bl esine: Tmenesr
> WFP P Entity Name Zp 02019 -
btk Make ALDI —_—e ZpExn
> Setup Model A4 City BELLINGHAM 15

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with account that were pulled during Lease servicing for the account. You can also
use the Bureau screen to create and pull additional credit bureau reports and view the results
as a text only file.

To view an existing credit bureau report

1. Open the Customer Service screen and load the account you want to work with.
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2. On the Customer Service link bar, click Bureau.

ORACLE’
Financial Services Lending and Leasing
Collecti (W glose
> DashBoard il
> Origination Search  Customer Service: 20150900014267  Review Request (Pending: 0}
> Servicing
Collections Account(s): 20150900014267: SIGG MARK (S view || o audit
View v Format v Freeze Detach Virap 5, © Current® Show All ©) Group Follow-up
Collections & o < @ &
Collections Company Branch  SubUnit  Account # Product B pDausé Currency  Pay Off Amt Amount Due Status Oldest Due Dt
zi’;l“;gm usor  UsHQ 2015090014267 LOAN VEHICLE (FR) 118 UsD 18,397.24 5,208.00 ACTVEDELQ  10/01/2015
« I v
Deficency
Reports
Producers Summary || Customer Service || AccountDetais || Customer Details | Transaction History  PmtModes  Colatersl  Bureaw | CrossjUp Sel Activities
Vendors
Bureau Details dpadd | AEdt | 5 vew || o Audt
IMPORTANT: Actess to credit reparting agency systems i for authorized users and only for permissible purposes, Unauthorized access is prohibited under the Fair Credit Reporting Act and is punishable by
$2500 fine andfor 1 year in Federal prison per occurrence
View v Format~  [5 Freeze  giDetach ol Wrap B [0 submitRequest  ViewReport @ Servidng ©) Crigination
Type Bureau = Status Dt Report S;‘jﬁ;‘f“
No dats to dsplay.
] 0 v
4
4
Applicant/Customer Detail
View v Formatv (B Freeze i Detach ol Wrap 5]
Type First Name I Last Name: Status Birth Dt SN Suffix Address Type Country
No data to dsplay.
| r— 1 = »
Bureau Report
View Repart @) Text(®) POF
View v Format~ [ Freeze pfiDetach | ol Wrap B B PrintReport
Text
No data to dsplay.
> WFP
> Tools
> Setup

3. For details on this screen refer Customer Service screen’s Collateral tab section in

Customer Service chapter.

Review Request

The Review Requests screen is primarily a work flow tool used to flag
attention of another Oracle Financial Services Lending and Leasing us

an Account for the
er and ask for review /

feedback. It allows the system users to send and receive requests (including e-mail)

commenting on a specific Account. The Review Request tab supports

iterative review of

selected Account and also to process the review with multiple reviewers.

In this chapter, you will learn how to compete the following tasks:
e Filter and View Review Requests
e Create and Send Review Request
e Reviewing a Request
e Responding to Review Request
e Reassign Review Request
e E-mailing Review Request
e Closing Review Request
e Complete Review Request

Note

You can complete the above tasks for an Account Review Request
tab in the Customer Servicing screen.

using Review Request
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5.12.1 Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:

The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are
created, reviewed, closed and completed by that user.

You can further filter the review request based on the following:

Query .

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.

Receiver Displays the records of all the active review requests received by the
selected User.

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.

Forwarded Displays all the review requests records which are forwarded by the

Only selected User to another user for review.

Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review
request.

Action Options Descriptions

Open Account Displays the Customer Service screen with the Account details
assigned for review.

Send Request Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response | Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.
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Action Options

Descriptions

Close Request

Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Complete
Request

Changes the status of review request to COMPLETED and can be
viewed by selecting ‘View All' option in the ‘Query’ section.

Remove Filter

Removes the selected filters applied to narrow the view of review
request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.

Email Section

The Email section enables you to send an email to either originator or receiver of the review

request if an ema

il setup is configured. However, note that a review request cannot be

responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

The ‘Review Requests’ section in Customer Service screen displays the following information

for each record:

Fields Descriptions

Request # View the system generated review request number. The same
can be used to query and track the review requests.

Originator The user id of the review request originator.

Priority The request priority: HIGH, NORMAL, or LOW.

Receiver The recipient of the review request.

Phone Applicant’s phone number in the review request.

Address Applicant’s address in the review request.

Email Applicant’s email in the review request.

Status The current status of review request. Following status are
tracked in this column:
WAITING FOR RESPONSE - when request is sent to reviewer
RETURN TO ORIGINATOR - when reviewer has responded to
request
CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.
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Fields

Descriptions

Account #

The Account number which needs review.

Days Past Due

Total number of days elapsed past the due date.

Total Outstanding
Balance

Displays either ‘Account outstanding principal balance’ for active
accounts, or ‘Deficiency balance’ for charge-off accounts.

Customer

Primary / Secondary (spouse) name associated to the account.

Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an Account
review request is forwarded to multiple reviewers and is reviewed or completed by second or
third person other than the one assigned by originator.

In the Comment History section, you can view the following details of the selected review

request:

Comments From

Descriptions

Type

View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.

Sub Type

View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.

Comment

View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request # FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By

View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt

View the Date and time when the comment was posted.

5.12.2 Create and Send Review Request

The review request tab primarily allows you to flag an Account for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.
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To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE
Financial Services Lending and Leasing

Customer Service x [® Cose

Review Requests
[ Seve and add || [ Save andstay || [ Save andRetum || mRetum

Request # 12003 Sender Days Past Due 0
Originator. *Account # | 20000100011820 - Total Qutstanding Balance 330
*priority HIGH [=] *Reason | REVIEW BALANCES =1 Customer ALIVE PRI / DEA SPO
*Recsiver ANAND SHEKAR > A:::S: :Z;:“};Dﬁ&
S ‘NE\‘r‘rO:.K,MASSACHLISEWS.E%BE
Comment. REVIEW ACCOUNT BALANCES Date 09/18/2017 12:23:39 AM Email EDW.SIRSI@GMAIL.COM
Send Request [

Comment History ] ve
Vew~ Fomat [ [ Freeze EfiDetach wer | @
Type Sub Type Comment Comment By Comment Dt
No data to display.

2. In the Review Requests section, select ‘Originator’.

3. Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field: View this:
Request # View the system generated request number.
Originator View the requester’s user ID auto generated by system upon

creating the request.

Priority Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver Select the user ID of the reviewer from the drop-down list.

Comment Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Account # Select the Account to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Days Past Due

Total Outstanding Balance
Customer

Phone

Address

Email

Reason Select the purpose for request from drop-down list.
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In this field:

View this:

Status View the status of review request auto updated by system
upon creating the request.
Date View the date and time when the request was created. Sys-

tem appends the current date by default.

Send Request

(Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

Reviewing a Request

4. Perform any of the Basic Actions mentioned in Navigation chapter.

The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in
DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Account # link opens the Review Request tab.

ORACLE’
Financial Services Lending and Leasing

bity 1§ Sonout O

Customer Service x  DashBoard x
Origination

My User Queues
Description
No data to display.

My Pending Review Requests By Applications

A =
0000001044

My Pending Review Requests By Priority
Priority
Servicing

Number of Queues Hard Assigned

@

Queue Description
No data to dsplay.

Number of Accounts
Queue Desaription
Mo data to display.

My Pending Review Requests By Accounts
£

[ Cose

Setup Admin

Product Expiring in Next One Month Critical Batch Job Status

] @

Product End Date Batch Job Status
o data to display. No data to display.

i

Producer Vendor

Producers Count By Status ‘Vendors Count By Status

W ]

Status Count Status Count

ACTIVE £ ACTIVE 7
Producers Expiring in Next One Month 1= vendors Expiring in Next One Month

@ G}

Producer End Date Company Name End Date
No data to display. No data to display

Producers Count By ACH Status
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To review requests

1.

4.

On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE' a
Financial Services Lending and Leasing

Search | Customer Service  Review Request (Pending: 1) | Queue Assigrment

Review Requests
dp add || Zeat || [Elvew |[ o audt

fs Email
User = Originator @ Recsiver ©Both  View Al [] Forwarded orly [ £ Orignator Receiver
View ~ Format~ [P Freeze pfiDetach rap ®  E0pen Account est [ SendResponse [ CloseRequest [ Complete Request
Request = orignator Priority Recever Phone Address Emal Reason
L PRITAM JENA FIGH HARISH MACHA 9728663378 HOME - ADD& newyork,... EDV.SIRSIGGMAIL,COM  REVIEW ACCOUNT
« i - y
Comment History & view
View v Formatv B Fresze i Detach » @
Type Sub Type Comment Comment By Comment Dt
REVIEW REQUEST CRIGINATOR TESTRWD PRITAM 09/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER SURABHL 09/06/2017 09:33:45 AM
REVIEW REQUEST SYSTEM GENERATED REQUEST : 8002 FORV/ADED FROM SURABHI DESAI TO NAVEEN REDDY  INTERNAL 09/06/2017 09:33:45 AM
REVIEW REQUEST RECEVER SURABHD 09/06/2017 09:34:31 AM
REVIEW REQUEST SYSTEM GENERATED REVIEW REQUEST : 8002 FORWADED FR( TOHARISHMACHA  INTERNAL 09/06/2017 09:34:51 AM

Customer Service x 3 Gose

In the Query section, click ‘Receiver’. System displays all open review request you have

received.

Click ‘Open Account’. The Account details are displayed in Customer Service > Summary

tab.

Review the details in particular to the details specified in the comment (if any).

Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.

However, system also allows your forward the same request to another reviewer in case of
additional clarifications.

To respond to review request

1.

2.

On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

In the Query section, click ‘Receiver’. System displays all open review request you have

received.
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3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.

o Tools

Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.

Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.

When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as ‘INTERNAL'.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.

To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.
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3. Inthe Review Request section, select the record that you have reviewed and click Edit.

Review Requests

Request # 8002
Originator PRITAM JENA
Priority HIGH

*Receiver HARISH MACHA -

Comment

Comment History

view v Format > Fresze  fDetach irap
Type Sub Type
REVIEW REQUEST ORIGINATOR

REVIEW REQUEST RECEIVER

Comment
TESTFWD
FWD

REQUEST SYSTEM GENERATED

REVIEW REQUEST : 8002 FORWADED FROM SURABHI DESAI TO NAVEEN REDDY

Sender MAVEEN REDDY
Account # 20000100011820
Reason REVIEW ACCOUNT

Status  WAITING FOR RESPONSE
Date 09/06/2017 02:32:11 AM

send Request [7]

[ save andstay | [ Save andReturn | {aReturn

Days PastDue 0
Total Qutstanding  28,806.94
Balance
Customer ALIVE PRI f DEA SPO

Phone 9728663378

Address  HOME - ADD&.

MNEWYORK, MASSACHUSETTS, 34038
Email EDW.SIRSI@GMAIL.COM

CommentBy Comment Dt
PRITAM 09/06/2017 09:32:30 AM
SURABHL 09/06/2017 09:33:45 AM

INTERNAL 09/06/2017 09:33:45 AM

REVIEW REQUEST RECEIVER,

FWD

SURABHL 09/06/2017 09:3% 31 AM

4. Select the required reviewer from ‘Receiver’ drop down list.

(Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

6. Select the ‘Send Request’ check box to reassign review request immediately on update.
In case of any further changes, retain the check box unselected and save the details. The
reassignment can later be completed by selecting the record and clicking on ‘Send

Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING

FOR RESPONSE.

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.

To e-mail a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. In‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator

field.

_0 r'_

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close

a review request, the system removes it from Review Request tab.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.

5-15

ORACLE



5.12.8

3. Inthe Action section, click ‘Close Request’.

The system assigns the request as CLOSED and removes it from your Review Request
record. The closed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.

To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Complete Request’.
The system assigns the request as ‘COMPLETED’ and removes it from your Review Request

record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

5-16 ORACLE



6.1

6.2

6.2.1

6. Bankruptcy

Introduction

After an application has cycled through the Lease origination process, it becomes an account.
Account maintenance and collections tasks can be performed with Oracle Financial Services
Lending and Leasing’s Bankruptcy screen.

The Bankruptcy screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using the Funding main tab
or convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Lease origination cycle and is funded or is ported into the
system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load the customer details on the Bankruptcy screen.

e Use the Search screen by selecting Customer Centric option(s).
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e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in the Account(s) and Customer(s) sections, open Bankruptcy
screen and load the account you want to work with.

On the Customer Service screen’s Account(s) section, you can view the information based
on your selection.

For details on this screen refer Customer Service screen section in Customer Service
chapter.
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6.5

6.5.1

6.5.1.1

Customer Service screen’s Summary tab

Open the Bankruptcy screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

oracie

Financial Services Lending and Leasing

S Collections 5 (@] close
>
> Origination Search  Customer Service | Review Request (Pending: 0)
> Senvicing
Collections Account(s) Elvien | 2 auit
e Views Fomatw B[] Freeze i Detach wap @ & O cument O showal O GroupFollovup
Collecions Company ranch Sub Unit Account # Froduct Days Pest Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
e o data to display,
Repossession
Deficency Summary | Customer Senice | Account Details | Customer Details | Transaction History| Pt Modes | Bureau | Cross/Up Sel Acivites
Reports
Producers
V‘E d“” Nerts Conditions
endors
Alerts Conditions
Aert Condition Start Ot Followup Dt
o data to display. Mo data to display.
4 Account Details Other Information
4
Dues .
Customer Information
Mo data to display. Customer ;e Relation ssh Birth Dt Gender
o data to display.
Delq Due Total Due Future Pmt Dt b
L Due Todays Payoff Oldest Due Dt
NSF Due Future Payoff AmtFaid Bxcsss
ez Future Payoff Dt Email Disabilty Privacy Opt Out
Ji formati Languzge Skip Active Hiltary Duty
Delinquency Information Marital Status Stop Time Zone
Late 30 60 %0 120 150 180 Category Days Correspondence
No data to display.
BP(Life) NsF(Life) Collector Address Information
BP(Year NSF{Year) " permissi |
Type Cument (") Mailng. Address Phone
Activities Mo datato display.
Adive Dt A Last Pt At
5 WEP Last Actiity Dt Paid Off Dt Charge Of Employment Information
K Due Day Effective Dt ilitary Duty Permissi
pufuels Last Pt Dt Current Pmt Customer score e et |y ol AT e e
> Setup Customer Grade Last Bill Amt Behaviour Score lio data to display. v

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter.

Customer Service screen’s Customer Service tab

Open the Bankruptcy screen and load the account you want to work with. Click the
Customer Service tab to view the sections under it.

Call Activities sub tab

With Call Activities section, the system enables you to record the details of all actions you
performed regarding this account. This includes calls from the customer, calls you make
regarding the account, or changes to condition of the account. Entries in the Call Activities
section are listed in reverse chronological order of follow-up date and are user defined.

Each action and result has a code and description. The code for call action and call result is
what appears on the Call Activity sub screen.

Recording a Call Activity

To record a call activity

1. Open the Bankruptcy screen and load the account you want to work with.
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2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.

The system displays the following screen.
"ORACH

Le:
Financial Services Lending and Leasing

& Welcome, DEMOSUPR +  Accessbilly 4G Sign Qut O

Eaos=

Glview | Pt

mount Due Status Ocest bus ox
0.00 ACTIVE 0272072016

B saveand add [ & Save and stay

Promise Anit Condition Appn'mt Followup DU Time Zone
0.00 - @

Collections

Tools
setup

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter.

Customer Service screen’s Account Details tab

Open the Bankruptcy screen and load the account you want to work with. Click the Account
Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.

In the Account Information section click View.

ORACLE"
Financial Services Lending and Leasing

= P Collections x (3] Glos=
> Origination Search | Customer Service: 20150900014283 | Review Request (Pending: 0)
Account(s): 20150900014283: RODRIGUEZ ROBINSON Elven | Audt
View~ Format~ b Freeze BfiDetach | ol Wrap @ & © curent© Show Al Group Follow-up
Company Branch  SubUnit  Account = Product Davs et currency  Pay OFf Amt Amount Due Status Oldest Due Dt
USOL  USHQ  UNDEFL. 2015000014283 LEASE VEHICLE 114 UsD 15,158.10 4,296.60 ACTIVE:DELQ  10/05/2015
Producers Summary || Customer Service || Account Details | Customer Details | Transaction Hstory | PmtModes | Coliateral | Burcau || CrossjUp Sell Acthities
Vendors

Account Details | Statements | Rate Schedule || Insurances || Contract Information

Account Information Elvew || <2 Ausit
View - Format~ [ Freeze §#iDetach Virap @
#ofExtensions  * of Extensions = of Extension Term # of Extension Term # of Due Day * of Due Day
it e oy o5 ey Zof Due B2 Last Extn OF Due Day Change Dt Total Term
o o o o [ 15

Account Information

Additional Details
# of Due Day chang ) o Total Term 15
= of Due

Maturity Dt 11/05/2016

> WEP

> Tools
> Setup I}

3. For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter.

Customer Service screen’s Customer Details tab

Open the Bankruptcy screen and load the account you want to work with. Click the
Customer tab to view the sections under it.
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Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on the Customer Details screen.
Using the Customer Service screen’s Customer Details tab, you can update or add to a
customer’s address, employment information, or phone listing. All the information about the
customer can be changed using Maintenance screen.

To view or edit customer information
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Details sub tab.

ORACLE
Financial Services Lending and Leasing

ollection: Close
> DashBoard L 24 C
> Origination Search = Customer Service | Review Request (Pending: 0) 2
> Servicing
| Elview || < Audt
e Account(s) _ By 2 Aux
iRietine view v Format~ [y Freeze Efivetmch ol wiap W & O curent® Show Al D Group Folon-up
Collections Company Branch  SubUnit  Account & Product DevsPeet Currency  Pay OFF amt Amount Due Status Oldest Due Dt
Bankruptcy No data to display.
Repossession % — 5
Deficency
Reports
Producers Summary | Customer Service | AccountDetals | Customer Details | Transaction History || Pt Modes | Bureau | Cross/Up Sell Actiities
vendors
Customer  Business
Customer Information E
& Edit =] Vie: < Audit
View  Format~ | By Freere igfiDetach | olwrap | @
Customer # Relation Ecoa niame ssn Birth Dt marital Status Enabled Lanc
“ Mo data to diplay.
T 4
< 7
Customer Information
[ saveand stay || [ save andReturn | CaRetun
Customer
Identification Details KvC
Customer #
Relation Passpart £ Reference =
Ecoa Tssue Dt Status
Name Expiry Dt
Birth Dt visa = e
Marital Status Matonzity: Birth Pk
Enabled __ National ID ikt
- Birth Country
BT Y
it S Permanent US Resident Status
M M License State
= Mother's Maiden Name P G RS
Class Type ey 5
ilitary Service
> Tools Email Power of Attorney
Stop Correspondence ;
T op Correspondence [ Holder Name L
st pl Arcemer

3. For details on this screen refer Customer Service screen’s Customer Details tab section
in Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Bankruptcy screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Bankruptcy screen and load the account you want to work with. Click the Pmt
Modes sub tab to view the sections under it.
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ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen

1. Open the Customer Service screen and load the account you want to work with.

Click Pmt Modes tab, then click ACH sub tab.

ORACLE"
Financial Services Lending and Leasing

ACH Information

> wep
> Tools
> Setup

For details on Pmt Modes tab refer Customer Service screen’s Pmt Modes tab section in
Customer Service chapter.

Customer Service screen’s Bankruptcy tab

The Bankruptcy screen enables you to record the details of a bankruptcy. This information
usually is supplied from the customer or customer’s attorney. You can track each stage of the
bankruptcy process based on its follow-up date and record information using the Details and
Tracking sections.

As there are occasions when a borrower files bankruptcy more than once during the tenure
of the Lease, you can record information for multiple bankruptcies. The Add button enables
you to create a new bankruptcy record with different start and end dates. You can also use
the Bankruptcy screen to view the previous bankruptcy record using Next and Previous
buttons in the Detail section. The Current box in Detail section indicates the current
bankruptcy details.

To enter bankruptcy details for an account
1. Open the Customer Service screen and load the account you want to work with.
2. Click Bankruptcy tab.

3. Inthe Bankruptcy Details section, select the bankruptcy record you want to work with.
-Or-
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4. Select Add to refresh the Bankruptcy screen to create a new record.

ORACLE’
Financial Services Lending and Leasing
Close:
o aoal Bankruptcy x [E3)
"> origination Search  Customer Service: Review Request (§ g: 0)
\ > Servicing
: : view Audt
st Account(s): 20150900014267: SIGG MARK ) By & A
o View v Format = Freeze i Detach urap W & © curent® show Al @ Group Folow-up
Colections Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt. Amount Due §
Bankruptcy so1 UsHQ 0150800014267  LOAN VEHICLE (FR) 118 USD 19,357.24 5,208.00 ¢
Repossession 4] b
Defigency
Reports Summary | Customer Service = AccountDetails = Customer Detsils  Transaction History =~ PmtModes Bamkruptcy Collateral Bureau = Cross/Up Sell Activities
Producers
Vendors
Bankruptcy Details g add || AEdt || B o7 Audt
Vew v Fomat [ Freee GfDetach wep @
Folowup Bt Disposition Type Customer Relation Comment FieReceived Dt Bankruptcy Start Dt Bankruptcy €
Ho data to display
< 0 v
Bankruptcy Details
[ saveandstay || [ SaveandRetun | {aRetun g
Current _ Relation
Folowup Dt Comment
Disposition
Tie File Received Dt
Hstomer Bankruptcy Start D
Bankruptcy End Dt
Tracking =] Vies < Audit
View ~ Format ~ | B Freeze §fiDelach | olwen | @R
Sub Parameter Parameter Value
Mo data to display.
Call Activities | Comments | Due Date History
> WFP
> Tools
> Setup

For details on this screen refer Customer Service screen’s Bankruptcy tab section in
Customer Service chapter.

6.11

Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The Collat-
eral screen contains the Home and Seller sub tabs. To view the collateral details

1. Open the Customer Service screen and load the account you want to work with.

Click Collateral tab. The system displays the following screen:

Financial Services Lending and Leasing
X Collection [ Close
 DashBoard 2
- Orgmation Search  Customer Service: 2150900014283 Review Request (Pendng: 0) a
> Servicing
Collertions Account(s): 20150900014283: RODRIGUEZ ROBINSON S view || < audit
e View v Format v [ Freeze i Detach 1l wirap W & @ curent® Show Al© Group Follow-up
Colections Company Branch  Sublnit Account # Product Bays PDE:; Currency  Pay OFf Amt. Amount Due Status Oldest Due Dt
2‘:2:’5“;?:Dn USOL  USHQ  UNDEFL. 20150900014283 LEASEVEHICLE 114 USD 15,158.10 4,296.60 ACTVEDELQ  10/05/2015
4 i ] v
Deficency
Reports
Producers Summary || Customer Service || Account Details || Customer Detals | Transaction History || Pmt Modes | Collateral | Bureau | Cross/Up Sel Activities
Vendors
vehicle  Seller
Vehicle
qpadd | SEit | S o Audit
View = Format~  [Ep Fresze L Detach ol Wrap ®
Primary Description Status Asset Type Lien Status Lien Event Date  Second Lien Holder  Comments Lien Release Entity ~ Ent
NDISADIAG  ACTIVE VEHICLE UNDEFINED
< i, ] » A
Vehicle
SaveandStay | [ Save andRetum || aRetum
Tupe B pescription [ Desaiption 2015 AUDI A4 Bxtra 2 L4
Total 24
Condifion GOOD CONDITIONED
Primary ¥ k=l Charge 200,00
substiution — .
Assets 14012 Ambie Address
* Asset Class NEW VEHICLE [« .
Lien Status UNDEFINED = Sy SRR =
* AssetType VEHICLE [ S ERAERS S
County NORFOLK [=
*SubType | AR [ Second ten Holder
Address # 480 NEPONSET ST
*Registration # UNDEFINED e
Status ACTIVE Address Line 1
Gedeck Miake el Mode! = Uneie Lty Ll esine: Tmenesr
NS *Year 2015 Emy e p oms ~
) Make AUDI o ZpExin
> Setup Model A4 City BELLINGHAM 15
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— If the account’s collateral is a vehicle, Collateral screen opens at the Vehicle tab:
— If the account’s collateral is a home, Collateral screen opens at the Home tab.

— If the account’s collateral is neither a vehicle nor a home, Collateral screen opens
at the Other Collateral.

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with account that were pulled during servicing for the account. You can also use
the Bureau screen to create and pull additional credit bureau reports and view the results as
a text only file.

To view an existing credit bureau report
1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service link bar, click Bureau.

Financial Services Lending and Leasing
i Close
D Collections ]
B e patata Search  Customer Service: 20150900014267 | Review Request (Pending: 0)
> Servicing
Collections Account(s): 20150900014267: SIGG MARK [Elen || o audit
W~ - Freeze Virap E, @ curent ) show All ©) Group Follow-u
Cileckine View v Format~ [ Hfipetach | o W & p p
Collections Company Branch  SubUnit  Account # Product £ais ;aus; Currency  Pay Off Amt Amount Due Status Oldest Due Dt
Barkrupte
RZ';OS“;SS“'W usor  UsHQ 20150300014267 LOAN VEHICLE (FR) 118 UsD 19,3724 520900 ACTVEDELQ  10/01/2015
« 1 v
Deficency
Reports
Producers Summary || Customer Service || Account Detaifs || Customer Detals || Transaction History | PmtModes || Collateral | Burean | CrossUp Sell Activities
Vendors
Bureau Details dpadd | AEdt | [Eview | o Audit
IMPORTANT: Access to credit reparting agency systems is for authorized users and only for permissible purposes, Unauthorized access s prohibited under the Fair Credit Reporting Act and is purishable by a
$2500 fine andjor 1 year in Federal prison per ocaurrence
View » Formatw  [E Freeze  gfiDetach Wrap (5] Submit Request  View Report @ Servidng () Crigination
Type Bureau # Status ot Repart s cas
No data to display.
PiE D v
g [
4
Applicant/ Customer Detail
View v Format~ [ Fresze pfiDetoch | o Wirap o]
Type First Name I Last Name Status Birth Dt =) Suffix Address Type Country
No data to display.
[ = m *
Bureau Report
View Report @ Text(®) POF
View » Formatw [ Freeze i Detach ol Wrap & B PrintReport
Text
No data to dsplay.
> WFP
> Tools
> Setup

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Review Request

The Review Requests screen is primarily a work flow tool used to flag an Account for the
attention of another Oracle Financial Services Lending and Leasing user and ask for review /
feedback. It allows the system users to send and receive requests (including e-mail)
commenting on a specific Account. The Review Request tab supports iterative review of
selected Account and also to process the review with multiple reviewers.
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In this chapter, you will learn how to compete the following tasks:

e Filter and View Review Requests
e Create and Send Review Request
e Reviewing a Request

e Responding to Review Request

e Reassign Review Request

e E-mailing Review Request

e Closing Review Request

e Complete Review Request

Note

You can complete the above tasks for an Account Review Request using Review Request
tab in the Customer Servicing screen.

Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:

The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are
created, reviewed, closed and completed by that user.

You can further filter the review request based on the following:

Query .

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.

Receiver Displays the records of all the active review requests received by the
selected User.

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.
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Query o

Options Descriptions

Forwarded Displays all the review requests records which are forwarded by the
Only selected User to another user for review.

Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review

request.

Action Options

Descriptions

Open Account

Displays the Customer Service screen with the Account details
assigned for review.

Send Request

Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response

Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.

Close Request

Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Complete
Request

Changes the status of review request to COMPLETED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Remove Filter

Removes the selected filters applied to narrow the view of review
request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.

Email Section

The Email section

enables you to send an email to either originator or receiver of the review

request if an email setup is configured. However, note that a review request cannot be
responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

The ‘Review Requests’ section in Customer Service screen displays the following information

for each record:

Fields Descriptions

Request # View the system generated review request number. The same
can be used to query and track the review requests.

Originator The user id of the review request originator.
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Fields Descriptions

Priority The request priority: HIGH, NORMAL, or LOW.

Receiver The recipient of the review request.

Phone Applicant’s phone number in the review request.
Address Applicant’s address in the review request.

Email Applicant’s email in the review request.

Status The current status of review request. Following status are

tracked in this column:
WAITING FOR RESPONSE - when request is sent to reviewer

RETURN TO ORIGINATOR - when reviewer has responded to
request

CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.
Account # The Account number which needs review.

Days Past Due Total number of days elapsed past the due date.

Total Outstanding Displays either ‘Account outstanding principal balance’ for active
Balance accounts, or ‘Deficiency balance’ for charge-off accounts.
Customer Primary / Secondary (spouse) name associated to the account.

Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an Account
review request is forwarded to multiple reviewers and is reviewed or completed by second or
third person other than the one assigned by originator.

In the Comment History section, you can view the following details of the selected review
request:

Comments From | Descriptions

Type View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.
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Comments From

Descriptions

Sub Type

View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.

Comment

View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request # FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By

View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt

View the Date and time when the comment was posted.

Create and Send Review Request

The review request tab primarily allows you to flag an Account for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.

To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE

Financial Services Lending and Leasing

,HMACHA ~  pccessiiity 1§ Snout &

Customer Service

Review Requests

Request # 12003
Originator
*Priority | HIGH

*Receiver ANAND SHEKAR

Comment History

Cemment REVIEW ACCOUNT BALANCES

i saveandadd | [ save an dstay || B saveand Retun || GaReturn

Sender
* Account # | 2000010001520 S Total Outster 2
[=] *Reason REVIEW BALANCES = VEPRIJDEA PO
72866337
Address HOME - ADD&:
status NEW/YORK MASSACHUSETTS, 34038
Date 09/18/2017 12:23:33 AM Email EDW.SIRSIGGMALL.COM
Send Request [¥]

View Fomatv | B Freeze  §ifiDetach wep | @
Type Sub Type Comment Comment By Comment Dt
No data to dispiay.

In the Review Requests section, select ‘Originator’.

Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field: View this:

Request # View the system generated request number.

Originator View the requester’s user ID auto generated by system upon
creating the request.
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In this field: View this:

Priority Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver Select the user ID of the reviewer from the drop-down list.

Comment Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Account # Select the Account to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Days Past Due

Total Outstanding Balance
Customer

Phone

Address

Email

Reason Select the purpose for request from drop-down list.

Status View the status of review request auto updated by system
upon creating the request.

Date View the date and time when the request was created. Sys-
tem appends the current date by default.

Send Request (Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in

DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.
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6.13.3 Reviewing a Request

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Account # link opens the Review Request tab.

ORACLE' & KAR ity 1§ sonout O
Financial Services Lending and Leasing

Customer Service  ~ DashBoard [®] Close
Origination Setup Admin
My User Queues | | Product Expiring in Next One Month Critical Batch Job Status
0] ] @
Desaription Count Product End Date Batch Job Status
Mo data to display. o data to display. No data ta display.

My Pending Review Requests By Applications

i

App = Friority
0000001044 NORMAL

My Pending Review Requests By Priority

m

|

Priority Count =

Servicing Producer Vendor
Number of Queues Hard Assigned Producers Count By Status 'Vendors Count By Status

C0] @ @

Queue Desarption Count Status Count Status Count
No data to display. acTvE 5 ACTIVE 27
Number of Accounts Producers Expiring in Next One Month |~ vendors Expiring in Next One Month

® ® @

Queue Desaription Count | Producer End Date Company Hame End Date
Ne data to display. No data to display. No data to display.
My Pending Review Requests By Accounts Producers Count By ACH Status

0 N

To review requests

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE MACHA bity 1§ Senout &
Financial Services Lending and Leasing

Customer Service x 3 Qose
Search | Customer Service  Review Request (Pending: 1) | Queue Assgrment K
Review Requests
dpadd | ZEdt | [Fvew || < At
Query Email
User ¥ Originator @ Receiver O Both view Al [[] Forwarded Only [C] Originator Receiver
view v Formatv [ Fresze  jfiDetach Wrap W  [0pen Account [B SendResponse g Close Request  [G Complete Request.
Request = orignator priortty Recaiver Phone Address Emal Reason
8002 PRITAM JENA HIGH HARISH MACHA a728653378 HOME - ADD& newyork,... EDVW SIRSIGGMAIL,COM  REVIEW ACCOUNT £
< i 8 Sl
Comment History & yiew
View v Format~ g Freeze i Detach vap @@
Type Sub Type Comment Comment By CommentDt
REVIEW REQUEST CRIGINATOR TESTFAND PRITAM 09/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER FuD SURABHT 09/06/2017 09:32:45 AM
REVIEW REQUEST SYSTEM GENERATED EQUEST : 8002 FORWADED FROM SURABHI DESAI TO NAVEEN REDDY  INTERNAL 09/06/2017 09:33:45 AM
REVIEW REQUEST RECEIVER SURABHI 09/06/2017 09:34:31L AM
REVIEW REQUEST SYSTEM GENERATED EQUEST : INTERNAL 09/06/2017 09:34:31 AM

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Click ‘Open Account’. The Account details are displayed in Customer Service > Summary
tab.

4. Review the details in particular to the details specified in the comment (if any).

6.13.4 Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.
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6.13.5

However, system also allows your forward the same request to another reviewer in case of
additional clarifications.

To respond to review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.

oOoORACLE
Financial S

ervices Lending and Leasi

;;;;;;

Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.

Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.

When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as INTERNAL'.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.

To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.
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6.13.6

6.13.7

In the Query section, click ‘Receiver’. System displays all open review request you have
received.

In the Review Request section, select the record that you have reviewed and click Edit.

Review Requests
[ save andstay | [ Save andReturn | {aReturn

Request # 8002 Sender MAVEEN REDDY Days PastDue 0

Originator PRITAM JENA Account # 2000010011820 Total Outstanding 28,806.94
Priority HIGH Reason REVIEW ACCOUNT Bolonce

ety HACE T AT = Customer ALIVE PRI / DEA SPO

Phone 3728663378

i F
o Status WAITING FOR RESPCSE S —
Bl G300 07 09252 1. NEVIYORK, MASSACHUSETTS, 34038
Send Request [ Email EDW.SIRSI@GMAIL.COM

Comment History | View

view v Format > Fresze ffDetach wap @R
Type Sub Type Comment CommentBy Comment Dt
REVIEW REQUEST CRIGINATOR TESTFWD PRITAM 09/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER FWD SURABHL 09/06/2017 09:33:45 AM
TREQUEST SYSTEM GENERATED REVIEW REQUEST : 5002 FORWADED FROM SURABHI DESAL TO NAVEEN REDDY  INTERNAL  05/06/2017 03:33:45 AM
REVIEW REQUEST RECEIVER FWD SURABHIL 09/06/2017 09:34:31 AM

Select the required reviewer from ‘Receiver’ drop down list.

(Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

Select the ‘Send Request’ check box to reassign review request immediately on update.
In case of any further changes, retain the check box unselected and save the details. The
reassignment can later be completed by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING
FOR RESPONSE.

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.

To e-mail a review request

1.

On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

In ‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator
field.

_0 r'_

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request tab.
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To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Close Request’.
The system assigns the request as CLOSED and removes it from your Review Request

record. The closed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.

To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Complete Request’.
The system assigns the request as ‘COMPLETED’ and removes it from your Review Request

record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.
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7.1

7.2

7.21

7. Repossession

Introduction

After an application has cycled through the Lease origination process, it becomes an account.
Account maintenance and collections tasks can be performed with Oracle Financial Services
Lending and Leasing’s Repossession screen.

The Repossession screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using the Funding main tab
or convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Lease origination cycle and is funded or is ported into the
system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load the customer details on Repossession screen.

e Use the Search screen by selecting Customer Centric option(s).
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e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in the Account(s) and Customer(s) sections, open Repossession
screen and load the account you want to work with.

On the Customer Service screen’s Account(s) section, you can view the information based
on your selection.

For details on this screen refer Customer Service screen section in Customer Service
chapter.
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7.4

7.5

7.5.1

7.51.1

Customer Service screen’s Summary tab

Open the Repossession screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

oracie

Financial Services Lending and Leasing

S Collections 5 (@] close
>
> Origination Search  Customer Service | Review Request (Pending: 0)
> Senvicing
Collections Account(s) Elvien | 2 auit
s Views Fomatw B[] Freeze i Detach wap @ & O cument O showal O GroupFollovup
ollections
Collecions Company ranch Sub Unit Account # Froduct Days Pest Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
e o data to display,
Repossession
Deficency Summary | Customer Senice | Account Details | Customer Details | Transaction History| Pt Modes | Bureau | Cross/Up Sel Acivites
Reports
Producers
V‘E d“” Nerts Conditions
endors
Alerts Conditions
Aert Condition Start Ot Followup Dt
o data to display. Mo data to display.
4 Account Details Other Information
4
Dues .
Customer Information
Mo data to display. Customer ;e Relation ssh Birth Dt Gender
o data to display.
Delq Due Total Due Future Pmt Dt b
L Due Todays Payoff Oldest Due Dt
NSF Due Future Payoff AmtFaid Bxcsss
ez Future Payoff Dt Email Disabilty Privacy Opt Out
Ji formati Languzge Skip Active Hiltary Duty
Delinquency Information Marital Status Stop Time Zone
Late 30 60 %0 120 150 180 Category Days Correspondence
No data to display.
BP(Life) NsF(Life) Collector Address Information
BP(Year NSF{Year) " permissi |
Type Cument (") Mailng. Address Phone
Activities Mo datato display.
Adive Dt A Last Pt At
5 WEP Last Actiity Dt Paid Off Dt Charge Of Employment Information
K Due Day Effective Dt ilitary Duty Permissi
pufuels Last Pt Dt Current Pmt Customer score e et |y ol AT e e
> Setup Customer Grade Last Bill Amt Behaviour Score lio data to display. v

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter.

Customer Service screen’s Customer Service tab

Open the Repossession screen and load the account you want to work with. Click the
Customer Service tab to view the sections under it.

Call Activities sub tab

With the Call Activities section, system enables you to record the details of all actions you
performed regarding this account. This includes calls from the customer, calls you make
regarding the account, or changes to condition of the account. Entries in the Call Activities
section are listed in reverse chronological order of follow-up date and are user-defined.

Each action and result has a code and description. The code for the call action and call result
is what appears on Call Activity sub screen.

Recording a Call Activity

To record a call activity

1. Open the Repossession screen and load the account you want to work with.
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7.6.1

7.7

2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.

The system displays the following screen.
"ORACH

Le:
Financial Services Lending and Leasing

& Welcome, DEMOSUPR +  Accessbilly 4G Sign Qut O

Eaos=

Glview | Pt
Olcest e 0
oa/20/2016

B saveand add [ & Save and stay

Appn'mt Followup DU Time Zone

Collections

Tools
setup

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter.

Customer Service screen’s Account Details tab

Open the Repossession screen and load the account you want to work with. Click the
Account Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.

In the Account Information section click View.

ORACLE"
Financial Services Lending and Leasing

= P Collections x (3] Glos=
> Origination Search | Customer Service: 20150900014283 | Review Request (Pending: 0)
Account(s): 20150900014283: RODRIGUEZ ROBINSON Elven | Audt
View~ Format~ b Freeze  EfiDetach 0 Weap @ & © curent© Show Al Group Follow-up
Company Branch  SubUnit  Account = Product Davs et currency  Pay OFf Amt Amount Due Status Oldest Due Dt
USOL  USHQ  UNDEFL. 2015000014283 LEASE VEHICLE 114 UsD 15,158.10 4,296.60 ACTIVE:DELQ  10/05/2015
Producers Summary || Customer Service || Account Details | Customer Details | Transaction Hstory | PmtModes | Coliateral | Burcau || CrossjUp Sell Acthities
Vendors
Account Details | Statements || Rate Schedule || Insurances || Contract Information
Account Information Elvew || <2 Ausit
ew's Fomats | B Freeze ffiDetach wiep @
#ofExtensions  * of Extensions = of Extension Term # of Extension Term # of Due Day ZofDueDay | o ey e e
(rear) ife) (vear) wife) changes(rear) changes(uife) L5t xtn Dt Due Day Change Dt Total T
o o o o [ [ 15
5
“
Account Information
Gagetun

Additional Details
# of Due Day chang ) o Total Term 15
= of Due

Maturity Dt 11/05/2016

> WEP
> Tools
> Setup

For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter.

Customer Service screen’s Customer Details tab

Open the Repossession screen and load the account you want to work with. Click the
Customer tab to view the sections under it.
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7.9

Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on Customer Details screen. Using
the Customer Service screen’s Customer Details tab, you can update or add to a customer’s
address, employment information, or phone listing.All the information about the customer can
be changed using Maintenance screen.

To view or edit customer information
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Details sub tab.

ORACLE
Financial Services Lending and Leasing

ollection: Close
> DashBoard L 24 C
> Origination Search = Customer Service | Review Request (Pending: 0) 2
> Servicing
| Elview || < Audt
e Account(s) _ By 2 Aux
iRietine view v Format~ [y Fresze i Detach W & O curent® Show Al D Group Folon-up
Collections Company Branch  SubUnit  Account & Product DevsPeet Currency  Pay OFF amt Amount Due Status Oldest Due Dt
Bankruptcy No data to display.
Repossession % — 5
Deficency
Reports
Producers Summary | Customer Service | AccountDetals | Customer Details | Transaction History || Pt Modes | Bureau | Cross/Up Sell Actiities
vendors
Customer  Business
Customer Information E
& Edit =] Vie: < Audit
View  Format~ | By Freere igfiDetach | olwrap | @
Customer # Relation Ecoa niame ssn Birth Dt marital Status Enabled Lanc
“ Mo data to diplay.
T 4
< 7
Customer Information
[ saveand stay || [ save andReturn | CaRetun
Customer
Identification Details KvC
Customer #
Relation Passpart £ Reference =
Ecoa Tssue Dt Status
Name Expiry Dt
Birth Dt visa = e
Marital Status Matonzity: Birth Pk
Enabled __ National ID ikt
- Birth Country
BT Y
it S Permanent US Resident Status
M M License State
= Mother's Maiden Name P G RS
Class Type ey 5
ilitary Service
> Tools Email Power of Attorney
Stop Correspondence ;
T op Correspondence [ Holder Name L
st pl Arcemer

For details on this screen refer Customer Service screen’s Customer Details tab section in
Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Repossession screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Repossession screen and load the account you want to work with. Click the Pmt
Modes sub tab to view the sections under it.
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7.10

7.10.1

ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen

1. Open the Customer Service screen and load the account you want to work with.

Click Pmt Modes tab, then click ACH sub tab.

ORACLE"
Financial Services Lending and Leasing

= Close
T Collections 1)

> Origination Search | Customer Service: 2015090001267 | Review Request (Pending: 0)
Account(s): 20150900014267: SIGG MARK Eluew || o2 audt
View v Format~ P Freeze  EiDetach wirap W B © Curenl© Shuw Al Group Follow-up
o:

Company Branch  SubUnit Account # Product. Amount Due Status Oldest Due Dt

usoi  UsHQ 20150900014267 LOAN VEHICLE (FR) 5,200,00 ACTIVEIDELQ  10/01/2015

summary || Custor Account Leta

Cross/Up sell actines

Ach || Coupon || PostDated Chedks | I

ACH Information
View - Format~ 5 Fresas [fiDetach rop ® O Reaiming @ Gne-Time Phone ©) A

Reference # Bank Name Bank City. Bank state Routing * Account Type Name On Account  Account % s1C BAN
“ No data to display.

ACH Information

> wep

> Tools

> Setup

For details on this screen refer Customer Service screen’s Pmt Modes tab section in
Customer Service chapter.

Customer Service screen’s Repo/Foreclosure tab

The Repossession/Foreclosure screen enables you to record information regarding
repossessions/foreclosure in a manner similar to how bankruptcies are recorded on the
Bankruptcy screen. You can track each stage of the repossession/foreclosure process based
on the follow-up date and record information using Details and Tracking section.

Repossession sub tab

On occasion, a lender performs multiple repossessions for the same Lease. The Create New
Repossession button on the Repossession screen enables you to create a new repossession
record for a different collateral and different start and end dates. You can also use the
Repossession screen to view previous repossession information using the Next and Previous
buttons in Details section. The Current box in Details section indicates the current
repossession record for each asset.

This tab will be available only when the collateral type associated with the Lease account is
a Vehicle.

You can update the current record, but previous records cannot be modified.

To Specify repossession details for an account
1. Open the Repossession screen and load the account you want to work with.
2. Click the RepolForeclosure sub tab, then click Repossession.

3. Inthe Repossession Details section, select the repossession record you want to work
with.
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4. Click Add to refresh the Repossession screen to create a new record.

. Welcome, VAVATOVA v ccssiilty o

ORACLE’

Financial Services Lending and Leasing

> DashBoard
 Origination
> Servidng
Collections

Collections
Callecions
Banknuptey
Repossession
Deficiency
Reports
Producers
Vendors

> WFP
> Todls
> Setup

Repossession x

seach G quest (Pendin

Account(s): 20160100013159: LI17 L117

Vieww Format v [ Freeze EfiDetach ¢l Wrap
Company Branch Sub Unit Account #
usat UshQ

g: 0)

wa

Product

® Current

2160100013158 LOANVEHICLE(FR)

show All ©) Group Fellow-up

Days Past Due Currency Fay Off Amt
“19 UsD 36,0499

Summary | Customer Service | Account Details | Customer Details | Transaction History Pt Modes = Repo/Forecosure | Collateral | Bureau | Cross/Up Sell Actvities

Repossession | Analysis

Repossession Details

Viewv Formatv [ Fresze i Detach Wrep
Curent Followup Dt Type Callatera
Y 12/31/4000 0TOYOTA COROLA

i 0203/2016  DEFAULT

Repossession Details

*Current (¥
*Folowup Dt 1273174000 By

Tipe

Tracking

View Formatv [ Freeze ffiDetach | ¢ Wrap
SubParameter  Parameter

o data o display.

Call Activities | Comments  Due Date History

Call Activities
View v Fomatv [ Freeze if) Detach rap
Action Result Contact Reason

R ORP ATTORNEY.

Disposition

CUSTOMER REDEEMED VEHICLE 02/03/2016

[ saveandadd | [ saveand stay | [ save and Retun | (i Return
‘
Repo Dt B
Repo End Dt B
Comment

* Collateral 0 TOYOTA COROLA M
* Dispasition 2
File Recelved Dt &

W b Load Tracking

Cancel Promise Dt

Promise Amt Condition
000 NONE N

File Received Dt Repo Dt

02/03/2016

Appointr Followup Dt
02/03/2016

[ Close

| Elview || 2 audt

Amount Due Status Oldest Due Dt

0.0 [T 0211/ 2016

deadd | A et | [Eview | o audit

Repo EndDt  Comment

02/29/2016

9
ZEit | [Evien | o audt

Value

daid | Aeit| Hview | o At
El

Time Zone Adj Followup Dt
02/02/2016 12:30:00

3

For details on this screen refer Customer Service screen’s Repo/Foreclosure tab section in
Customer Service chapter.

Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The
Collateral screen contains the Home and Seller sub tabs.

To view the collateral details

1. Open the Repossession screen and load the account you want to work with.
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— Click Collateral tab. The system displays the following screen:

Financial Services Lending and Leasing
ollection: Close.
> DashBoard o X =
S Ot Search  Customer Service: 2150900014283 Reviaw Request (Pendng: 0) 2
» Servicing
Colections Account(s): 20150900014283: RODRIGUEZ ROBINSON Sl view || o audt
View v Format v [§ Freeze g Detach Wrap 5, @ current(® Show All ©) Group Follow-uy
Collections & o @ & ’ "
Colections Company Branch  Sublnit Account = Product Bays PDE:; Curency  Pay Off Amt Amount Due Status Oldest Due Dt
gz’;:s“sigm USOI  USHQ  UNDEFL. 20150900014283 LEASEVEHICLE 114 USD 15,158.10 4,206.60 ACTVEDELQ  10/05/2015
« w v
Deficency
Reparts
Producers Summary || Customer Service | Account Detais | Customer Detals | Transaction History | PmtModes | Collateral | Bureau | Cross/Up Sel Actities
vendors
Vehicle | Seler
|
Vehicle
op add | Edit =] vier < Audit
View v Formatw  [Ep Freeze EffiDetach | ol Wirap ()]
Primary Desaription Status AssetType Lien Status LinEventDate  Second Lien Holder  Comments Lien Release Entity  Ent
¥ 2015 AUDI A4 ACTIVE VEHICLE UNDEFINED
d « i v A
Vehicle
[ saveandstay || [ saveandRetum | CaRetun
Type &Description [ Desaiption 2015 AUDI A4 Extra 2
Total 24
— Condifion GCOD CONDITIONED [=] PG =
Substiution _
At 3 1 Lien Details adlies
* Asset Class NEW VEHICLE =
Lien Status UNDEFINED [+ ey R =
* Asset Type VEHICLE [ Lo Event Dat S
A County NORFOLK =
SO G B secondien Hoer
Address # 480 NEPONSET 5T
*Registration # LNDEFINED s
Address Line 1
Stafiis ACTIVE Lien Release Entity | -
Select Make and Mods! £ Address Line 2 TURNPIKE 5T
> WFP et [ Entity Name Zp 02013 =
oot Make ALDI Usae Details ZpExtn
= Setup Model A4 . . City BELLINGHAM 1

— If the account’s collateral is a vehicle, the Collateral screen opens at the Vehicle
tab:

— If the account’s collateral is a home, the Collateral screen opens at the Home tab.

— If the account’s collateral is neither a vehicle nor a home, the Collateral screen
opens at the Other Collateral.

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with the account that were pulled during Lease servicing for the account. You can
also use the Bureau screen to create and pull additional credit bureau reports and view the
results as a text only file.

To view an existing credit bureau report

1. Open the Customer Service screen and load the account you want to work with.
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2. On the Customer Service link bar, click Bureau.

ORACLE’
Financial Services Lending and Leasing

Collecti (W glose
> DashBoard EERTTS
> Origination Search  Customer Service: 20150900014267  Review Request (Pending: 0}
> Servicing
Collections Account(s): 20150900014267: SIGG MARK (S view || o audit
View v Format v Freeze Detach Virap 5, © Current® Show All ©) Group Follow-up
Collections & o < @ &
Collections Company Branch  SubUnit  Account # Product B pDausé Currency  Pay Off Amt Amount Due Status Oldest Due Dt
:’;i“;gm usor  UsHQ 2015090014267 LOAN VEHICLE (FR) 118 UsD 18,397.24 5,208.00 ACTVEDELQ  10/01/2015
« I v
Deficency
Reports
Producers Summary || Customer Service || AccountDetais || Customer Details | Transaction History  PmtModes  Colatersl  Bureaw | CrossjUp Sel Activities
Vendors
Bureau Details dpadd | AEdt | 5 vew || o Audt
IMPORTANT: Actess to credit reparting agency systems i for authorized users and only for permissible purposes, Unauthorized access is prohibited under the Fair Credit Reporting Act and is punishable by
$2500 fine andfor 1 year in Federal prison per occurrence
View v Format~  [5 Freeze  giDetach ol Wrap B [0 submitRequest  ViewReport @ Servidng ©) Crigination
Type Bureau = Status Dt Report S;‘jﬁ:‘f“
No dats to dsplay.
] 0 v
4
4
Applicant/Customer Detail
View v Formatv (B Freeze ffiDetach | ofl Wrap 5]
Type First Name I Last Name: Status Birth Dt SN Suffix Address Type Country
No data to dsplay.
| r— 1 »
Bureau Report
View Repart @) Text(®) POF
View v Format~ [ Freeze pfiDetach | ol Wrap B B PrintReport
Text
No data to dsplay.
> WFP
> Tools
> Setup

For details on this screen refer Customer Service screen’s Collateral tab section in Customer

Service chapter.

Review Request

The Review Requests screen is primarily a work flow tool used to flag an Account for the
attention of another Oracle Financial Services Lending and Leasing user and ask for review /
feedback. It allows the system users to send and receive requests (including e-mail)
commenting on a specific Account. The Review Request tab supports iterative review of
selected Account and also to process the review with multiple reviewers.

In this chapter, you will learn how to compete the following tasks:

e Filter and View Review Requests
e Create and Send Review Request
e Reviewing a Request

e Responding to Review Request

e Reassign Review Request

e E-mailing Review Request

e Closing Review Request

e Complete Review Request

Note

You can complete the above tasks for an Account Review Request using Review Request

tab in the Customer Servicing screen.
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7.13.1 Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:

The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are
created, reviewed, closed and completed by that user.

You can further filter the review request based on the following:

Query .

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.

Receiver Displays the records of all the active review requests received by the
selected User.

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.

Forwarded Displays all the review requests records which are forwarded by the

Only selected User to another user for review.

Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review
request.

Action Options Descriptions

Open Account Displays the Customer Service screen with the Account details
assigned for review.

Send Request Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response | Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.
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Action Options

Descriptions

Close Request

Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Complete
Request

Changes the status of review request to COMPLETED and can be
viewed by selecting ‘View All' option in the ‘Query’ section.

Remove Filter

Removes the selected filters applied to narrow the view of review
request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.

Email Section

The Email section enables you to send an email to either originator or receiver of the review

request if an ema

il setup is configured. However, note that a review request cannot be

responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

The ‘Review Requests’ section in Customer Service screen displays the following information

for each record:

Fields Descriptions

Request # View the system generated review request number. The same
can be used to query and track the review requests.

Originator The user id of the review request originator.

Priority The request priority: HIGH, NORMAL, or LOW.

Receiver The recipient of the review request.

Phone Applicant’s phone number in the review request.

Address Applicant’s address in the review request.

Email Applicant’s email in the review request.

Status The current status of review request. Following status are
tracked in this column:
WAITING FOR RESPONSE - when request is sent to reviewer
RETURN TO ORIGINATOR - when reviewer has responded to
request
CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.
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Fields

Descriptions

Account #

The Account number which needs review.

Days Past Due

Total number of days elapsed past the due date.

Total Outstanding
Balance

Displays either ‘Account outstanding principal balance’ for active
accounts, or ‘Deficiency balance’ for charge-off accounts.

Customer

Primary / Secondary (spouse) name associated to the account.

Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an Account
review request is forwarded to multiple reviewers and is reviewed or completed by second or
third person other than the one assigned by originator.

In the Comment History section, you can view the following details of the selected review

request:

Comments From

Descriptions

Type

View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.

Sub Type

View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.

Comment

View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request # FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By

View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt

View the Date and time when the comment was posted.

7.13.2 Create and Send Review Request

The review request tab primarily allows you to flag an Account for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.
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To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE
Financial Services Lending and Leasing

Customer Service x [® Cose

Review Requests
[ Seve and add || [ Save andstay || [ Save andRetum || mRetum

Request # 12003 Sender Days Past Due 0
Originator. *Account # | 20000100011820 - Total Qutstanding Balance 330
*priority HIGH [=] *Reason | REVIEW BALANCES =1 Customer ALIVE PRI / DEA SPO
*Recsiver ANAND SHEKAR > A:::S: :Z;:“};Dﬁ&
S ‘NE\‘r‘rO:.K,MASSACHLISEWS.E%BE
Comment. REVIEW ACCOUNT BALANCES Date 09/18/2017 12:23:39 AM Email EDW.SIRSI@GMAIL.COM
Send Request [

Comment History ] ve
Vew~ Fomat [ [ Freeze EfiDetach wer | @
Type Sub Type Comment Comment By Comment Dt
No data to display.

2. In the Review Requests section, select ‘Originator’.

3. Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field: View this:
Request # View the system generated request number.
Originator View the requester’s user ID auto generated by system upon

creating the request.

Priority Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver Select the user ID of the reviewer from the drop-down list.

Comment Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Account # Select the Account to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Days Past Due

Total Outstanding Balance
Customer

Phone

Address

Email

Reason Select the purpose for request from drop-down list.
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In this field:

View this:

Status View the status of review request auto updated by system
upon creating the request.
Date View the date and time when the request was created. Sys-

tem appends the current date by default.

Send Request

(Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

Reviewing a Request

4. Perform any of the Basic Actions mentioned in Navigation chapter.

The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in
DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Account # link opens the Review Request tab.

ORACLE’
Financial Services Lending and Leasing

bity 1§ Sonout O

Customer Service x  DashBoard x
Origination

My User Queues
Description
No data to display.

My Pending Review Requests By Applications

A =
0000001044

My Pending Review Requests By Priority
Priority
Servicing

Number of Queues Hard Assigned

@

Queue Description
No data to dsplay.

Number of Accounts
Queue Desaription
Mo data to display.

My Pending Review Requests By Accounts
£

[ Cose

Setup Admin

Product Expiring in Next One Month Critical Batch Job Status

] @

Product End Date Batch Job Status
o data to display. No data to display.

i

Producer Vendor

Producers Count By Status ‘Vendors Count By Status

W ]

Status Count Status Count

ACTIVE £ ACTIVE 7
Producers Expiring in Next One Month 1= vendors Expiring in Next One Month

@ G}

Producer End Date Company Name End Date
No data to display. No data to display

Producers Count By ACH Status
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To review requests

1.

4.

On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE' a
Financial Services Lending and Leasing

Search | Customer Service  Review Request (Pending: 1) | Queue Assigrment

Review Requests
dp add || Zeat || [Elvew |[ o audt

fs Email
User = Originator @ Recsiver ©Both  View Al [] Forwarded orly [ £ Orignator Receiver
View ~ Format~ [P Freeze pfiDetach rap ®  E0pen Account est [ SendResponse [ CloseRequest [ Complete Request
Request = orignator Priority Recever Phone Address Emal Reason
L PRITAM JENA FIGH HARISH MACHA 9728663378 HOME - ADD& newyork,... EDV.SIRSIGGMAIL,COM  REVIEW ACCOUNT
« i - y
Comment History & view
View v Formatv B Fresze i Detach » @
Type Sub Type Comment Comment By Comment Dt
REVIEW REQUEST CRIGINATOR TESTRWD PRITAM 09/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER SURABHL 09/06/2017 09:33:45 AM
REVIEW REQUEST SYSTEM GENERATED REQUEST : 8002 FORV/ADED FROM SURABHI DESAI TO NAVEEN REDDY  INTERNAL 09/06/2017 09:33:45 AM
REVIEW REQUEST RECEVER SURABHD 09/06/2017 09:34:31 AM
REVIEW REQUEST SYSTEM GENERATED REVIEW REQUEST : 8002 FORWADED FR( TOHARISHMACHA  INTERNAL 09/06/2017 09:34:51 AM

Customer Service x 3 Gose

In the Query section, click ‘Receiver’. System displays all open review request you have

received.

Click ‘Open Account’. The Account details are displayed in Customer Service > Summary

tab.

Review the details in particular to the details specified in the comment (if any).

Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.

However, system also allows your forward the same request to another reviewer in case of
additional clarifications.

To respond to review request

1.

2.

On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

In the Query section, click ‘Receiver’. System displays all open review request you have

received.

7-15 ORACLE



7.13.5

3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.

o Tools

Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.

Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.

When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as ‘INTERNAL'.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.

To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.
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7.13.7

3. Inthe Review Request section, select the record that you have reviewed and click Edit.

Review Requests

Request # 8002
Originator PRITAM JENA
Priority HIGH

*Receiver HARISH MACHA -

Comment

Comment History

view v Format > Fresze  fDetach irap
Type Sub Type
REVIEW REQUEST ORIGINATOR

REVIEW REQUEST RECEIVER

Comment
TESTFWD
FWD

REQUEST SYSTEM GENERATED

REVIEW REQUEST : 8002 FORWADED FROM SURABHI DESAI TO NAVEEN REDDY

Sender MAVEEN REDDY
Account # 20000100011820
Reason REVIEW ACCOUNT

Status  WAITING FOR RESPONSE
Date 09/06/2017 02:32:11 AM

send Request [7]

[ save andstay | [ Save andReturn | {aReturn

Days PastDue 0
Total Qutstanding  28,806.94
Balance
Customer ALIVE PRI f DEA SPO

Phone 9728663378

Address  HOME - ADD&.

MNEWYORK, MASSACHUSETTS, 34038
Email EDW.SIRSI@GMAIL.COM

CommentBy Comment Dt
PRITAM 09/06/2017 09:32:30 AM
SURABHL 09/06/2017 09:33:45 AM

INTERNAL 09/06/2017 09:33:45 AM

REVIEW REQUEST RECEIVER,

FWD

SURABHL 09/06/2017 09:3% 31 AM

4. Select the required reviewer from ‘Receiver’ drop down list.

(Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

6. Select the ‘Send Request’ check box to reassign review request immediately on update.
In case of any further changes, retain the check box unselected and save the details. The
reassignment can later be completed by selecting the record and clicking on ‘Send

Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING

FOR RESPONSE.

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.

To e-mail a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. In‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator

field.

_0 r'_

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close

a review request, the system removes it from Review Request tab.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
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3. Inthe Action section, click ‘Close Request’.

The system assigns the request as CLOSED and removes it from your Review Request
record. The closed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.

To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Complete Request’.
The system assigns the request as ‘COMPLETED’ and removes it from your Review Request

record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.
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8.1

8.2

8.21

8. Deficiency

Introduction

After an application has cycled through the Lease origination process, it becomes an account.
Account maintenance and collections tasks can be performed with Oracle Financial Services
Lending and Leasing’s Deficiency screen.

The Deficiency screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using the Funding main tab
or convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Lease origination cycle and is funded or is ported into the
system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load the customer details on Deficiency screen.

e Use the Search screen by selecting Customer Centric option(s).
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e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about the customer(s) attached to the account.
The information on Customer Service screen always refers to the customer selected in this
section.

To view account details in the Account(s) and Customer(s) sections, open the Deficiency
screen and load the account you want to work with.

On the Customer Service screen’s Account(s) section, you can view the information based
on your selection.

For details on this screen refer Customer Service screen section in Customer Service
chapter
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8.5

8.5.1

8.5.1.1

Customer Service screen’s Summary tab

Open the Deficiency screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

oracie

Financial Services Lending and Leasing

S Collections 5 (@] close
>
> Origination Search  Customer Service | Review Request (Pending: 0)
> Senvicing
Collections Account(s) Elvien | 2 auit
s Views Fomatw B[] Freeze i Detach wap @ & O cument O showal O GroupFollovup
ollections
Collecions Company ranch Sub Unit Account # Froduct Days Pest Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
e o data to display,
Repossession
Deficency Summary | Customer Senice | Account Details | Customer Details | Transaction History| Pt Modes | Bureau | Cross/Up Sel Acivites
Reports
Producers
V‘E d“” Nerts Conditions
endors
Alerts Conditions
Aert Condition Start Ot Followup Dt
o data to display. Mo data to display.
4 Account Details Other Information
4
Dues .
Customer Information
Mo data to display. Customer ;e Relation ssh Birth Dt Gender
o data to display.
Delq Due Total Due Future Pmt Dt b
L Due Todays Payoff Oldest Due Dt
NSF Due Future Payoff AmtFaid Bxcsss
ez Future Payoff Dt Email Disabilty Privacy Opt Out
Ji formati Languzge Skip Active Hiltary Duty
Delinquency Information Marital Status Stop Time Zone
Late 30 60 %0 120 150 180 Category Days Correspondence
No data to display.
BP(Life) NsF(Life) Collector Address Information
BP(Year NSF{Year) " permissi |
Type Cument (") Mailng. Address Phone
Activities Mo datato display.
Adive Dt A Last Pt At
5 WEP Last Actiity Dt Paid Off Dt Charge Of Employment Information
K Due Day Effective Dt ilitary Duty Permissi
pufuels Last Pt Dt Current Pmt Customer score e et |y ol AT e e
> Setup Customer Grade Last Bill Amt Behaviour Score lio data to display. v

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter

Customer Service screen’s Customer Service tab

Open the Deficiency screen and load the account you want to work with. Click the Customer
Service tab to view the sections under it.

Call Activities sub tab

With the Call Activities section, the system enables you to record details of all actions you
performed regarding this account. This includes calls from the customer, calls you make
regarding account, or changes to condition of the account. Entries in the Call Activities
section are listed in reverse chronological order of follow-up date and are user-defined.

Each action and result has a code and description. The code for the call action and call result
is what appears on Call Activity sub screen.

Recording a Call Activity

To record a call activity

1. Open the Deficiency screen and load the account you want to work with.
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8.6.1

8.7

2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.

The system displays the following screen.
"ORACH

Le:
Financial Services Lending and Leasing

& Welcome, DEMOSUPR +  Accessbilly 4G Sign Qut O

Eaos=

Glview | Pt

mount Due Status Ocest bus ox
0.00 ACTIVE 0272072016

B saveand add [ & Save and stay

Promise Anit Condition Appn'mt Followup DU Time Zone
0.00 - @

Collections

Tools
setup

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter

Customer Service screen’s Account Details tab

Open the Deficiency screen and load the account you want to work with. Click the Account
Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.

In the Account Information section click View.

ORACLE"
Financial Services Lending and Leasing

= P Collections x (3] Glos=
> Origination Search | Customer Service: 20150900014283 | Review Request (Pending: 0)
Account(s): 20150900014283: RODRIGUEZ ROBINSON Elven | Audt
View~ Format~ b Freeze BfiDetach | ol Wrap @ & © curent© Show Al Group Follow-up
Company Branch  SubUnit  Account = Product Davs et currency  Pay OFf Amt Amount Due Status Oldest Due Dt
USOL  USHQ  UNDEFL. 2015000014283 LEASE VEHICLE 114 UsD 15,158.10 4,296.60 ACTIVE:DELQ  10/05/2015
Producers Summary || Customer Service || Account Details | Customer Details | Transaction Hstory | PmtModes | Coliateral | Burcau || CrossjUp Sell Acthities
Vendors

Account Details | Statements | Rate Schedule || Insurances || Contract Information

Account Information Elvew || <2 Ausit
View - Format~ [ Freeze §#iDetach Virap @
#ofExtensions  * of Extensions = of Extension Term # of Extension Term # of Due Day * of Due Day
it e oy o5 ey Zof Due B2 Last Extn OF Due Day Change Dt Total Term
o o o o [ 15

Account Information

Additional Details
# of Due Day chang ) o Total Term 15
= of Due

Maturity Dt 11/05/2016

> WEP

> Tools
> Setup I}

For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter

Customer Service screen’s Customer Details tab

Open the Deficiency screen and load the account you want to work with. Click the Customer
tab to view the sections under it.
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8.9

Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on Customer Details screen. Using
the Customer Service screen’s Customer Details tab, you can update or add to a customer’s
address, employment information, or phone listing. All the information about the customer can
be changed using Maintenance screen.

To view or edit customer information
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Details sub tab.

ORACLE
Financial Services Lending and Leasing

ollection: Close
> DashBoard L 24 C
> Origination Search = Customer Service | Review Request (Pending: 0) 2
> Servicing
| Elview || < Audt
e Account(s) _ By 2 Aux
iRietine view v Format~ [y Fresze i Detach W & O curent® Show Al D Group Folon-up
Collections Company Branch  SubUnit  Account & Product DevsPeet Currency  Pay OFF amt Amount Due Status Oldest Due Dt
Bankruptcy No data to display.
Repossession % — 5
Deficency
Reports
Producers Summary | Customer Service | AccountDetals | Customer Details | Transaction History || Pt Modes | Bureau | Cross/Up Sell Actiities
vendors
Customer  Business
Customer Information E
& Edit =] Vie: < Audit
View  Format~ | By Freere igfiDetach | olwrap | @
Customer # Relation Ecoa niame ssn Birth Dt marital Status Enabled Lanc
“ Mo data to diplay.
T 4
< 7
Customer Information
[ saveand stay || [ save andReturn | CaRetun
Customer
Identification Details KvC
Customer #
Relation Passpart £ Reference =
Ecoa Tssue Dt Status
Name Expiry Dt
Birth Dt visa = e
Marital Status Matonzity: Birth Pk
Enabled __ National ID ikt
- Birth Country
BT Y
it S Permanent US Resident Status
M M License State
= Mother's Maiden Name P G RS
Class Type ey 5
ilitary Service
> Tools Email Power of Attorney
Stop Correspondence ;
T op Correspondence [ Holder Name L
st pl Arcemer

For details on this screen refer Customer Service screen’s Customer Details tab section in
Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Deficiency screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Deficiency screen and load the account you want to work with. Click the Pmt
Modes sub tab to view the sections under it.
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8.9.1 ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen
1. Open the Customer Service screen and load the account you want to work with.

Click Pmt Modes tab, then click ACH sub tab.

ORACLE"
Financial Services Lending and Leasing

= Close
T Collections 1)

> Origination Search | Customer Service: 2015090001267 | Review Request (Pending: 0)

Account(s): 20150900014267: SIGG MARK [Elten || 2 rudt
View v Format~ B Freeze  Efi Detoch wrap W G © Cunent© Shuw AlO Group Fullow-u
o

Company Branch  SubUnit Account # Product. e Amount Due Status Oldest Due Dt

usoi  UsHQ 20150900014267 LOAN VEHICLE (FR) 5,200,00 ACTIVEIDELQ  10/01/2015

summary || Custor Account Leta

Cross/Up sell actines

Ach || Coupon || PostDated Chedks | I

ACH Information
View - Format~ 5 Fresas [fiDetach rop ® O Reaiming @ Gne-Time Phone ©) A

Reference # Bank Name Bank City. Bank state Routing * Account Type Name On Account  Account % s1C BAN
“ No data to display.

ACH Information

> wep

> Tools
> Setup

For details on this screen refer Customer Service screen’s Pmt Modes tab section in
Customer Service chapter.

8.10 Customer Service screen’s Deficiency tab

The Deficiency screen enables you to record information about deficiency accounts i.e.
accounts that are no longer collectable. You can create and track specific details on the status
of the charged-off account for timely follow-up and analysis. You can also track each stage of
the deficiency process based on its follow-up date and record information using the Details
and Tracking sections.

The Add button enables you to create a new deficiency record with different start and end
dates. You can also use the Deficiency Details screen to view the deficiency information.
The Current field in the Deficiency Details section indicates the current bankruptcy details.

Note

To view the balance of a charged off account, click the Transaction History tab on Custom-
er Service screen, then click Balances. On the Account Details screen’s Balance Group
section, click Deficiency. For more information on Deficiency Balance, see Balances sub
tab section in this chapter.

To enter deficiency details for an account
1. Open the Customer Service screen and load the account you want to work with.
2. Click Deficiency tab.

3. Inthe Deficiency Detail section, select the deficiency record you want to work with
_Or_
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4. Click Add to refresh the Deficiency screen to create a new record.

RACLE
Financial Services Lending and Leasing

> DashBoard AT 3 Close
> Origination Search | Customer Service | Review Request (Pending: 0)
> Serviding -
Colletions Account(s) EEE
o View~ Fomat~ B Freeze Hfivetach | odwap | @ & Current (3 Show All ) Group Follov-up
Colletions Company Branch Sub Unit Account = Product Days Past Due Currency Pay Off At Amount Due Status Oldest Due 0t
oyt o data to display
Repos
Deiciency Summary || Customer Service | Account Detals || Customer Details || Transaction History || Pt todes | Deficiency | Bureau || Cross/Up sell Activities
Reports
Producers
o Deficiency Details b add || Lt | 5 vew | 2 avit
View~: Fornet v | B | D Freee Elivetsy | dwro | @
Current Followup bt Disposition e Comment Fie Received Dt Charge OFFDt  Deficency End Dt
¥ 1213174000
Deficiency Details
B saveandadd | [ Save andStay | [ Save and Retum | Return
* current @ Comment
*Followup Dt 12/31/4000 By y 0
sposition NEWLY RECEIVED P—— B
Tipe v Charge off ot
Deficiency End Dt )
Tracking Zedt | [ vew | auit
Viewv Formatv P Freeze EfiDetach  ¢J wrap ® o Load Tracking
Sub Parameter Parameter Value
o data to display.
Call Activities | Comments | Due Date History
> WFP
> Tools
> Setup

For details on this screen refer Customer Service screen’s Deficiency tab section in
Customer Service chapter.

Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The
Collateral screen contains the Home and Seller sub tabs.

To view the collateral details

1. Open the Repossession screen and load the account you want to work with.

e Click Collateral tab. The system displays the following screen:

ORACLE'

Financial Services Lending and Leasing

- DashBoard
> Origination
> Servicing
Collections

Collections
Collections
Bankruptcy
Repossession
Deficency
Reports
Producers
Vendors

> WP
> Tools
> Setup

Collections [ Close
Search  Customer Service: 20150900014283  Review Request (Fending: 0] .
Account(s): 20150900014283: RODRIGUEZ ROBINSON S view || < audit
View = Format~ [ Freeze  Ef Detach 1 wrap @ & @ curent® Show AllQ) Group Follow-up
Days Past
Company Branch  SubUnit  Account # Product ue Curency  Pay Off Amt Amount Due Status Oldest Due Dt
USDL  USHQ  UNDEFL. 2015030014283 LEASE VEHICLE 114 UsD 15,158.10 4,296.60 ACTIVEDELQ  10/05/2015
7] 0 ] b
Summary | Customer Service | AccountDetails || Customer Detals | Transaction History || PmtModes Collateral | Bureau | Cross/Up Sell Activifies
Vehicle  Seler
Vehicle
qeadd | A Edit | [ Ve o Audit
view ~ Formatv  [5p Fresze EfiDetach 1] virap ®
Primary Desaription Status Asset Type Lien Status LienEventDate  Second Lien Holder  Comments Lien Release Entity  Enf
v 2015 AUDI A4 ACTIVE VEHICLE UNDEFINED
. m . ' q
Vehicle
Save andStay || [ Save andRetum || CaRetum
Type & Description % Desaription 2015 AUDT A4 Extra 2 4
Total 24
Condition GOOD CONDITIONED
Primary ¥ & Charge 200,00
Substitution . :
Assets 14012 e Address
* Asset Class NEW VEHICLE [
Lien Status  UNDEFINED [+ * Country | UNETED STATES =
* AssetType VEHICLE = Lien Event Dat Y
i} A County NORFOLK =
e o B Second tien Hoder
Address = 480 NEPONSET ST
*Registration ¥ UNDEFINED o
Adgess Line 1
Status ACTIVE F—— =
Seleck ke ard Model %) Glbgsel Address Line 2 TURNPIKE ST
N Entity Name Zp 018 =
Make ALDI Usage Details o
Model A4 City BELLINGHAM e
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8.13

— If the account’s collateral is a vehicle, the Collateral screen opens at Vehicle tab:
— If the account’s collateral is a home, the Collateral screen opens at Home tab.

— If the account’s collateral is neither a vehicle nor a home, the Collateral screen
opens at Other Collateral.

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with the account that were pulled during Lease servicing for the account. You can
also use the Bureau screen to create and pull additional credit bureau reports and view the
results as a text only file.

To view an existing credit bureau report
1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service link bar, click Bureau.

Financial Services Lending and Leasing
i Close
D Collections ]
B e patata Search  Customer Service: 20150900014267 | Review Request (Pending: 0)
> Servicing
Collections Account(s): 20150900014267: SIGG MARK [Elen || o audit
W~ - Freeze Virap E, @ curent ) show All ©) Group Follow-u
Cileckine View v Format~ [ Hfipetach | o W & p p
Collections Company Branch  SubUnit  Account # Product £ais ;aus; Currency  Pay Off Amt Amount Due Status Oldest Due Dt
Barkrupte
RZ';OS“;SS“'W usor  UsHQ 20150300014267 LOAN VEHICLE (FR) 118 UsD 19,3724 520900 ACTVEDELQ  10/01/2015
« 1 v
Deficency
Reports
Producers Summary || Customer Service || Account Detaifs || Customer Detals || Transaction History | PmtModes || Collateral | Burean | CrossUp Sell Activities
Vendors
Bureau Details dpadd | AEdt | [Eview | o Audit
IMPORTANT: Access to credit reparting agency systems is for authorized users and only for permissible purposes, Unauthorized access s prohibited under the Fair Credit Reporting Act and is purishable by a
$2500 fine andjor 1 year in Federal prison per ocaurrence
View » Formatw  [E Freeze  gfiDetach Wrap (5] Submit Request  View Report @ Servidng () Crigination
Type Bureau # Status ot Repart s cas
No data to display.
PiE D v
g [
4
Applicant/ Customer Detail
View v Format~ [ Fresze pfiDetoch | o Wirap o]
Type First Name I Last Name Status Birth Dt =) Suffix Address Type Country
No data to display.
[ = m *
Bureau Report
View Report @ Text(®) POF
View » Formatw [ Freeze i Detach ol Wrap & B PrintReport
Text
No data to dsplay.
> WFP
> Tools
> Setup

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Review Request

The Review Requests screen is primarily a work flow tool used to flag an Account for the
attention of another Oracle Financial Services Lending and Leasing user and ask for review /
feedback. It allows the system users to send and receive requests (including e-mail)
commenting on a specific Account. The Review Request tab supports iterative review of
selected Account and also to process the review with multiple reviewers.
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8.13.1

In this chapter, you will learn how to compete the following tasks:

e Filter and View Review Requests
e Create and Send Review Request
e Reviewing a Request

e Responding to Review Request

e Reassign Review Request

e E-mailing Review Request

e Closing Review Request

e Complete Review Request

Note

You can complete the above tasks for an Account Review Request using Review Request
tab in the Customer Servicing screen.

Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:

The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are
created, reviewed, closed and completed by that user.

You can further filter the review request based on the following:

Query .

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.

Receiver Displays the records of all the active review requests received by the
selected User.

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.
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Query o

Options Descriptions

Forwarded Displays all the review requests records which are forwarded by the
Only selected User to another user for review.

Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review

request.

Action Options

Descriptions

Open Account

Displays the Customer Service screen with the Account details
assigned for review.

Send Request

Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response

Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.

Close Request

Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Complete
Request

Changes the status of review request to COMPLETED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Remove Filter

Removes the selected filters applied to narrow the view of review
request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.

Email Section

The Email section

enables you to send an email to either originator or receiver of the review

request if an email setup is configured. However, note that a review request cannot be
responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

The ‘Review Requests’ section in Customer Service screen displays the following information

for each record:

Fields Descriptions

Request # View the system generated review request number. The same
can be used to query and track the review requests.

Originator The user id of the review request originator.

ORACLE



Fields Descriptions

Priority The request priority: HIGH, NORMAL, or LOW.

Receiver The recipient of the review request.

Phone Applicant’s phone number in the review request.
Address Applicant’s address in the review request.

Email Applicant’s email in the review request.

Status The current status of review request. Following status are

tracked in this column:
WAITING FOR RESPONSE - when request is sent to reviewer

RETURN TO ORIGINATOR - when reviewer has responded to
request

CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.
Account # The Account number which needs review.

Days Past Due Total number of days elapsed past the due date.

Total Outstanding Displays either ‘Account outstanding principal balance’ for active
Balance accounts, or ‘Deficiency balance’ for charge-off accounts.
Customer Primary / Secondary (spouse) name associated to the account.

Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an Account
review request is forwarded to multiple reviewers and is reviewed or completed by second or
third person other than the one assigned by originator.

In the Comment History section, you can view the following details of the selected review
request:

Comments From | Descriptions

Type View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.
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Comments From

Descriptions

Sub Type

View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.

Comment

View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request # FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By

View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt

View the Date and time when the comment was posted.

Create and Send Review Request

The review request tab primarily allows you to flag an Account for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.

To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE

Financial Services Lending and Leasing

,HMACHA ~  pccessiiity 1§ Snout &

Customer Service

Review Requests

Request # 12003
Originator
*Priority | HIGH

*Receiver ANAND SHEKAR

Comment History

Cemment REVIEW ACCOUNT BALANCES

i saveandadd | [ save an dstay || B saveand Retun || GaReturn

Sender
* Account # | 2000010001520 S Total Outster 2
[=] *Reason REVIEW BALANCES = VEPRIJDEA PO
72866337
Address HOME - ADD&:
status NEW/YORK MASSACHUSETTS, 34038
Date 09/18/2017 12:23:33 AM Email EDW.SIRSIGGMALL.COM
Send Request [¥]

View Fomatv | B Freeze  §ifiDetach wep | @
Type Sub Type Comment Comment By Comment Dt
No data to dispiay.

In the Review Requests section, select ‘Originator’.

Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field: View this:

Request # View the system generated request number.

Originator View the requester’s user ID auto generated by system upon
creating the request.
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In this field: View this:

Priority Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver Select the user ID of the reviewer from the drop-down list.

Comment Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Account # Select the Account to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Days Past Due

Total Outstanding Balance
Customer

Phone

Address

Email

Reason Select the purpose for request from drop-down list.

Status View the status of review request auto updated by system
upon creating the request.

Date View the date and time when the request was created. Sys-
tem appends the current date by default.

Send Request (Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in

DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.
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8.13.3 Reviewing a Request

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Account # link opens the Review Request tab.

ORACLE' & KAR ity 1§ sonout O
Financial Services Lending and Leasing

Customer Service  ~ DashBoard [®] Close
Origination Setup Admin
My User Queues | | Product Expiring in Next One Month Critical Batch Job Status
0] ] @
Desaription Count Product End Date Batch Job Status
Mo data to display. o data to display. No data ta display.

My Pending Review Requests By Applications

i

App = Friority
0000001044 NORMAL

My Pending Review Requests By Priority

m

|

Priority Count =

Servicing Producer Vendor
Number of Queues Hard Assigned Producers Count By Status 'Vendors Count By Status

C0] @ @

Queue Desarption Count Status Count Status Count
No data to display. acTvE 5 ACTIVE 27
Number of Accounts Producers Expiring in Next One Month |~ vendors Expiring in Next One Month

® ® @

Queue Desaription Count | Producer End Date Company Hame End Date
Ne data to display. No data to display. No data to display.
My Pending Review Requests By Accounts Producers Count By ACH Status

0 N

To review requests

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE MACHA bity 1§ Senout &
Financial Services Lending and Leasing

Customer Service x 3 Qose
Search | Customer Service  Review Request (Pending: 1) | Queue Assgrment K
Review Requests
dpadd | ZEdt | [Fvew || < At
Query Email
User ¥ Originator @ Receiver O Both view Al [[] Forwarded Only [C] Originator Receiver
view v Formatv [ Fresze  jfiDetach Wrap W  [0pen Account [B SendResponse g Close Request  [G Complete Request.
Request = orignator priortty Recaiver Phone Address Emal Reason
8002 PRITAM JENA HIGH HARISH MACHA a728653378 HOME - ADD& newyork,... EDVW SIRSIGGMAIL,COM  REVIEW ACCOUNT £
< i 8 Sl
Comment History & yiew
View v Format~ g Freeze i Detach vap @@
Type Sub Type Comment Comment By CommentDt
REVIEW REQUEST CRIGINATOR TESTFAND PRITAM 09/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER FuD SURABHT 09/06/2017 09:32:45 AM
REVIEW REQUEST SYSTEM GENERATED EQUEST : 8002 FORWADED FROM SURABHI DESAI TO NAVEEN REDDY  INTERNAL 09/06/2017 09:33:45 AM
REVIEW REQUEST RECEIVER SURABHI 09/06/2017 09:34:31L AM
REVIEW REQUEST SYSTEM GENERATED EQUEST : INTERNAL 09/06/2017 09:34:31 AM

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Click ‘Open Account’. The Account details are displayed in Customer Service > Summary
tab.

4. Review the details in particular to the details specified in the comment (if any).

8.13.4 Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.
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However, system also allows your forward the same request to another reviewer in case of
additional clarifications.

To respond to review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.

oOoORACLE
Financial S

ervices Lending and Leasi

;;;;;;

Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.

Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.

When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as INTERNAL'.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.

To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.
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8.13.7

In the Query section, click ‘Receiver’. System displays all open review request you have
received.

In the Review Request section, select the record that you have reviewed and click Edit.

Review Requests
[ save andstay | [ Save andReturn | {aReturn

Request # 8002 Sender MAVEEN REDDY Days PastDue 0

Originator PRITAM JENA Account # 2000010011820 Total Outstanding 28,806.94
Priority HIGH Reason REVIEW ACCOUNT Bolonce

ety HACE T AT = Customer ALIVE PRI / DEA SPO

Phone 3728663378

i F
o Status WAITING FOR RESPCSE S —
Bl G300 07 09252 1. NEVIYORK, MASSACHUSETTS, 34038
Send Request [ Email EDW.SIRSI@GMAIL.COM

Comment History | View

view v Format > Fresze ffDetach wap @R
Type Sub Type Comment CommentBy Comment Dt
REVIEW REQUEST CRIGINATOR TESTFWD PRITAM 09/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER FWD SURABHL 09/06/2017 09:33:45 AM
TREQUEST SYSTEM GENERATED REVIEW REQUEST : 5002 FORWADED FROM SURABHI DESAL TO NAVEEN REDDY  INTERNAL  05/06/2017 03:33:45 AM
REVIEW REQUEST RECEIVER FWD SURABHIL 09/06/2017 09:34:31 AM

Select the required reviewer from ‘Receiver’ drop down list.

(Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

Select the ‘Send Request’ check box to reassign review request immediately on update.
In case of any further changes, retain the check box unselected and save the details. The
reassignment can later be completed by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING
FOR RESPONSE.

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.

To e-mail a review request

1.

On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

In ‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator
field.

_0 r'_

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request tab.
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To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Close Request’.
The system assigns the request as CLOSED and removes it from your Review Request

record. The closed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.

To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Complete Request’.
The system assigns the request as ‘COMPLETED’ and removes it from your Review Request

record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.
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9. Remarketing

9.1 Introduction

Remarketing in auto financing space refers to re-sell of customer asset(s) through auctioning.
To recover bad debt, Auto-Lending institutions integrate with external auctioning service
providers to manage vehicle remarketing portfolios of repossessed customer asset(s).

OFSLL provides a generic interface to support remarketing with middle layer integration
between Auto Lending institutions and auctioning service providers. Starting from initiating a
remarketing request till invoice validation, processing, status updates, and refunds tracking,
all correspondence with the third party auctioning systems are handled within OFSLL.

Third Party

-

OFSLL

Remarketing Screen

L
OFSLL Adapter
Jsydepy Ayled pay |

I Invoice Details

Following are the stages of collateral remarketing:

Assignment Allocation

— Define Vendor Assignment Criteria

— Vendor Assignment Allocation

Remarketing Request

— Interfacing Remarketing Details with Third Party Auctioning System
Invoicing

— Post Transaction

— Business Rules for Invoice Validation

9.2 Pre-requisites

Following are the pre-requisites while working with Collateral Remarketing.

A Lookup code GAI (GENERIC AUCTION INTERFACE) has to be available under
VENDOR ASSIGNMENT CHANNEL CODES (VENDOR_ASG_CHANNEL_CD) in
Setup > Administration > System > Lookups to identify all the channels used for third

party auctioning system.

A Lookup code REM (RE SALE) has to be available under VENDOR ASSIGNMENT
TYPE CODES (VENDOR_ASG_TYPE_CD) in Setup > Administration > System >
Lookups.

The current and next status are to be defined in the cycle setup definition
(COL_REMA_DISP_STATUS) in Setup > Administration > System > Collection cycles
screen.
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9.3

9.4

9.4.1

Navigation

The link to access remarketing screen is available under Collection module in the LHS menu.

ORACLE" . . ABSHEKAR ¥ Accessbiity 1@ SgnOut O
Financial Services Lending and Leasing
@8 Remarketing x [ giose
Search  Customer Service  Review Request (Pending: 0)  Queue Assignment
Zibetibonrd Quick Search
> Origination
Customer Id SSN Identfication # [ Submit
Queue/ Condit [ astorin [ et Account.
> Search Criteria
(21 0pen Account
1 Search Results
View v Format v i petach 3]

Company Branch

Deinquency . ipue OuStandng o
lays Balance
No data to display.

> WFP
 Tools
> Setup

Click Collections > Remarketing. The page by default opens with Customer Service > ‘Search’
tab. Search for the required account which is already repossessed using the search options.
For more information on using Search, refer to ‘Searching for an Account and Customer’
section.

On loading the account you want to work with, navigate to Customer Service > Repo/
Foreclosure > Remarketing tab.

Assignment Allocation

The first step in collateral remarketing is to define a Vendor assignment criteria and add
vendors to the defined criteria using the Assignment Allocation screen. This section consists
of the following:

e Define Vendor Assignment Criteria
e Vendor Assignment Allocation

Define Vendor Assignment Criteria

A criteria here refers to the combination of options selected in ‘Vendor Assignment Criteria’
section. Based on the criteria, system can filter and displays only those available vendors who
provide remarketing service in that territory.

The below examples illustrate the vendor selection process in remarketing screen.

Example 1:

Channel | Work Reposs Sort Vendor
Vendor Sub Order Country | ession Order Selection for

Code Type State Remarketing
Vendor A | GAl RE SALE | USA Florida 0 Default selected
Vendor B | GAI RE SALE | USA Florida 1 Listed
Vendor C | GAl RE SALE | USA Florida 2 Listed
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Example 2

Channel | Work Reposs Sort Vendor
Vendor Sub Order Country | ession Order Selection for
Code Type State Remarketing
Vendor A | GAl RE SALE | USA Florida 0 No Vendor is
selected by
Vendor B | GAI RE SALE | USA Florida 0 default, but
X listed as per
Vendor C | GAl RE SALE | USA Florida 0 "Yendor creation
sequence id' for
selection.

From the LHS menu, navigate to Collections > Vendors > Work Order > Assignment
Allocation screen. Click ‘Add’ in the Vendor Assignment Criteria section and specify the
required field details.

The ‘Vendor Assignment Criteria’ section by default consists of Channel, Work Order Type,
Company and Branch fields for selection. For defining Remarketing criteria, select the
Channel which has sub code as ‘GAI’ and Work Order Type as ‘RE SALE’.

ORACLE"
Financial Services Lending and Leasing

@8 Remorketing x| Vendors [ Cose
Vendors | Assignment Allocation | Work Orcers | Folowup | Invaiees =
> DashBoard
> Oriowiation Vendor Assignment Criteria dpadd | SEdt | [ vew
e View + oot~ | B | [DFreeze Glveech | clwes | @
Channel Work Order Type Company Sranch Enzb
Collections
Collctions GENERIC RECOVERY INTERFACE IMPOUND TNVOLUNTARY RE... DEMO BANK USA US HEAD QUARTERS
Callections GENERIC AUCTION INTERFACE RE SALE DEMO BANK USA US HEAD QUARTERS
Bankruptey INTERNAL BANRLPTCY DEMO BANK USA US HEAD QUARTERS
Repossession GENERIC AUCTION INTERFACE RE SALE DEMO BANK USA US HEAD QUARTERS L
Deficency GENERIC AUCTION INTERFACE RE SALE DEMO BANK USA US HEAD QUARTERS 3
Remarketing 4 GENERIC AUCTION INTERFACE RE SALE DEMO BANK USA US HEAD QUARTERS
Reports 1 I} ’
Producers
Vendors Vendor Assignment Criteria
H saveand add || [ saveand ey || [ save andRewm | GaRetm
*Channel GENERIC AUCTION INTERFACE  [=]  * Company SA03 &= REPO. |INITED STATES = * enabled ]
i Storage
*Work |pE SALE E  *5ench samo [ conty
Qrder Type
Repo R ORIDA [+
Storage
> WFP St
> Tools
> Setup Vendor Assignment Allocation SEat | Elven || «F audt
e Ercona DHnatarh | alwesn | B8 ki

On selection, two additional fields - ‘Repo Storage Country’ and ‘Repo Storage State’ are
enabled for selection. Details in these two fields indicates the current location of the
repossessed asset. This facilitates to identify vendor based on repossession (storage) - State
and Country while creating remarketing request.

For more information on field selection, refer to ‘Vendor Assignment Criteria’ section in
Vendors chapter.

Vendor Assignment Allocation

In the Vendor Assignment Allocation section, you can add vendors to the defined Vendor
Assignment Criteria. Unlike other vendor assignment criteria, on selecting a remarketing
criteria, an ‘Add’ button is enabled in ‘Vendor Assignment Allocation’ header allowing you to
add Vendor(s) and define the Sort order.
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Note

For remarketing criteria (Channel sub code= ‘GAI’) system does not auto-populate the
vendor list with Assigned Cases and % Allocation. Also the option to define the weightage
for each vendor is disabled.

ORACLE ) o v s ity 16 Sign out &
Financial Services Lending and Leasing

@8 Vendors [ Close
View ¥ Formatv & Freeze i Detach | Wrap 50} =
= Channel Work Order Type Company Branch Encb
Gl GENERIC RECOVERY INTERFACE IMPGUND INVOLUNTARY RE... GEMO BANK USA US HEAD QUARTERS
> Origination GENERIC ALCTION [NTERFACE RESALE DEMO BANK N NLHEAD QUARTERS
> servicng GENERIC AUCTION INTERFACE RE SALE DEVO BANK SA SAREGION 1
- INTERNAL BANGRLFTCY DEMO BANK USA US HEAD QUARTERS
Cntecior GENERIC AUCTION INTERFACE RE SALE DEMO BANK USA US HEAD QUARTERS
Collections GENERIC AUCTION INTERFACE RE SALE DEMO BANK USA US HEAD QUARTERS
Collections GENERIC AUCTION INTERFACE RE SALE DEMO BANK USA US HEAD QUARTERS
Bankruptcy GENERIC AUCTION INTERFACE RE SALE DEMO BANK USA US HEAD QUARTERS
Repossession GENERIC AUCTION INTERFACE REPOSSESSION DEMO BANK N L HEAD QUARTERS
Defidncy < m ’
Remarketing 4
Reports
Producers ‘Vendor Assignment Allocation e add | PEdt | [EVew | o Audt £
vendors Vew v Fomat~ B Frecze ifiDetach wen | RS
Vendor = Name e Enabled Sort
11ALTO_IMS-TEST-AUTOIMS " .
FL-03020-TEST_VENDOR_AUTO_IMS
‘Vendor Assignment Allocation IL-11881-ATM5 VENDOR2
PR-03016-TEST-AUTG-IMS-01 [Hsaveandadd | [ saveandstay | [ saveandRetun | CaRetum
Search.
2R *vendor - * Enabled (7]
> Tools
*Sort [0
> Setup =

The Vendor drop-down list is populated based on the selected Channel, Work Order Type,
Company, and Branch. For every Vendor Assignment Criteria you can add a Vendor(s) and
define the sort order irrespective of repossession State and Country.

Remarketing Request

Through the remarketing screen, you can trigger remarketing request and auto generate re-
sale work orders. A collateral remarketing request is an instruction to the vendor of third party
auctioning system to pick-up the repossessed asset from the storage location and proceed
with auction.

In an integrated environment, a remarketing request to third party auctioning system is always
triggered though a Work Order and contains the following details:

e Collateral details where you want to remarket the asset.

e Vendor who needs to be allocated for servicing the request.

To proceed with creating remarketing request, navigate to Customer Service > Repo/
Foreclosure > Remarketing tab and click ‘Add’.

ORACLE’ | S ity g signout &
Financial Services Lending and Leasing

& Remarketing 5, [®Close:
Summary || Customer Service | AccountDetalls | Customer Detals || TransactionHistory | PmtModes | Baniruptcy | Repo/Foreclosure | Deficency | Collateral | Bureau | Tmeine | CrossipSels > = 4
¥ Andlysis
> Origination
> servicing Remarketing Faid | Pt | e | Lot
Collections View v Format~ Freeze {fiDetach wen | @
Collections Curent Remarketing #  ExtenalRef= Dt Status Status Dt Priority LastUpdated Dt Workorder = Work Order Status
Colections ¥ UNDEFINED 06/06/2017 06/06/2017 06/06(2017 UNDEFTNED
Bankruptey ¥ 0000002017 IR TEST 2 06/01/2017 NEW 06/01/2017 NORMAL 06/01/2017 WO:0008104 GRIFAILED
Repossession <[ ) C
Deficency
Remarksting 4 Remarketing = | 13
Reports [ seveandadd | [ SaveandStoy || [ SaveandRetum | CaRetun A
Producers
Vendors *Current [ Collateral Details Storage Location Work Order
Remarketing = UNDEFINED *AssetDesc 2014 [+ Address Workorder # UNDEFINED
External Ref # Identification # Country UNITED STATES *Channel | GENERIC AUCTION IN[=]
Dt 06/06/2017 Vear 014 Zp 32003 Workorder Type RE SALE
*Status | NEW [=] Vake S, FLONIDA *Vendor FL-03018-TESTL =
=
Status Bt 06/06/2017 Model e Work Order Status OPEN
Phane
S WEP * Priority NORMAL =] S
> Tooks Last Updated Dt 06/06/2017
Comment  x( INT, NUMBER.
> Setup st |
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To record a remarketing request, populate the following details:

Field:

Do this:

Current

This check box is auto-selected and indicates if this is the current
enabled collateral remarketing record in the account.

Though OFSLL support multiple auctions of single collateral, only
one of them is enabled with current indicator for each collateral in an
account. If a second record is added for same collateral, previous
record is marked as 'N' automatically indicating that there can only
be one Current record at any give instance.

However, system does not allow to add remarketing record if the
Collateral status is SOLD.

Remarketing #

Indicates OFSLL auto generated reference number for remarketing
record.

External Ref #

Indicates remarketing external reference number generated in third-
party auction interface.

Dt Current date selected as Remarketing creation date.

Status Indicates the current status of remarketing request which is NEW by
default. The status is based on cycle setup defined in Remarketing
Collection Cycle. For details on all the available status, refer to
‘Remarketing Status List’ section.

Status Dt Indicates the date when the status was last updated.

Priority Select the Priority of remarketing request from the drop-down list.

The available options are NORMAL (default), HIGH, and LOWER.

Last Updated Dt

Indicates the date when any of the remarketing attributes were last
updated.

Comment

Enter additional information, if any.

Note that during status changes (either done manually or auto), sys-
tem auto updates a comment with old status in Status History tab. In
case a comment is updated manually without any status changes,
the same is not updated into Status History.

Collateral Details:

Details of this section are auto updated from repossession tab.

Asset Desc

Select the repossessed asset from the drop-down list.

Identification #

Indicates the collateral identification number.

Year Indicates the year when the collateral was manufactured.
Make Indicates the manufacturing company of the collateral.
Model Indicates the collateral model.

Storage Location:

Location where the repossessed asset is currently available.

Address

Storage location address.

Country

Storage location Country.

ORACLE



Field: Do this:

Zip Storage location zip code.

State Storage location State.

Name Contact person name at storage location.

Phone Contact person contact number at storage location.
Fax # Contact person fax number at storage location.

Work Order: Details of the work order for remarketing request.

Workorder # Indicates the work order number which is auto generated by the
system. On successful work order creation, the same is enabled
with a link and clicking on the same opens Vendors > Work Orders
tab with details.

Channel Select the remarketing channel from the drop-down list. This list
consists of only those vendor channels with sub code ‘GAI’.

Workorder Type | Indicates the work order type as RE SALE.

Vendor Select the vendor who should serve the remarketing request from
the drop-down list. The list is populated based on storage location of
the repossessed asset and vendors who provide auction service in
that territory. System auto generates the list based on the defined
Vendor Assignment Criteria.

Work Order Sta- | Indicates the current status of work order and by default is OPEN for
tus new remarketing request.

On updating all the required parameters, click ‘Save and Stay’ or any of the Basic Actions
mentioned in Navigation chapter.

On successful update, a Work Order with the specified details is created. The same can be
viewed by clicking on the Workorder#.

ORACLE
Financial Services Lending and Leasing

& Vendors x [3¢] Close
Work Order G
[ saveandstay || [ saveandReturn | CaRetum
> DashBoard
> Origination Work Order Work Order Details
Dt 06/06/2017 Collateral Details

> Servicind
- Viork Order # W0:0009187 Status Dt 06/06/2017

Collections Case # UNDEFINED Currency USDOLLAR Colisteral Description. 2014
Colections Channel GENERIC AUCTICN INTERFACE Estmated 0.00 Identificaton =

Collections Work Order Type RESALE Biled Amt 0.00 Texr iy
Bankruptey Account  20170400011133:GAGGAR DEVANSHY Paid 0.00 Makea
Repossession Model

Company US01 Reference #
:Eﬁual-: q Branch USHQ Assigned By ABSHEKAR
Smarketng * Vendor 11AUTO_IMS-TEST-AUTOIMS = |

Reports
Producers Override Reason =
Nealors Status OPEN Account Status ACTIVE:DELQ:REPO

Charged offDt

Vendor Information
Followup Dt

Account Information Contact

Phone

Resson
Extn

E|| Due Amt 4280.48

[cotecto
Total Outstanding 50030 Fax

Balance
Total Due 8590.96
Due Dt 06/30/2017
DaysPastDue 33
Service Address

Comment

> WFP
> Tools
> setup

The Work Order screen allows you to change the selected Vendor, select ‘Override Reason
(if any) and also select the ‘Collector’. For more information on updating Work Order details,
refer to Vendors > Work Orders section.

The Remarketing screen consists of the following sub tabs:
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9.5.1

9.5.1.1

9.5.1.2

e Remarketing Proceed Details
e Status History sub tab

e Tracking Attributes sub tab

e Expenses sub tab

e Refunds sub tab

Interfacing Remarketing Details with Third Party Auctioning System

The following types are interfaces are supported between OFSLL and third party auctioning
system:

e JMS notification

e Web services

JMS Notification

On every manual status change in collateral remarketing, a JMS (Java Message Service)
notification is sent to third party auctioning system to act upon the notification.

For example, after the remarketing request is created with work order details, the same is to
be registered in third party auctioning system for further action. A JMS natification is sent with
status as ‘NEW’ and subsequently when the status of Remarketing request is changed to
‘SEND TO AUCTION’, another notification is sent with this status.

However, it is upto the discretion of third party auctioning system to accept/reject and
acknowledge the notifications. When accepted, an auction is created in third party auctioning
system and a reference number for the same is shared as acknowledgement. This is then
appended to the remarketing request as External Ref # and status is updated as ‘AUCTION
ACCEPTED'. The external reference number can be used for further interactions.

When there are subsequent changes to the existing remarketing request in OFSLL, the same
is updated in Remarketing/ Work Orders screen and status of remarketing request is changed
to ‘UPDATE TO AUCTION'. Another JMS notification is triggered for updating the details in
third party auctioning system and response as either UPDATE ACCEPTED / REJECTED are
tracked back into the system.

Similarly, if there are any changes to auction in third party auctioning system, the details are
updated in OFSLL and the status of the remarketing is updated to “RECEIVED UPDATE’.

For details on all the available status, refer to ‘Remarketing Status List’ section.

A sample instance of JMS notification is indicated below:

root

& ACC_MNBR=20170300015178
L REM_ STATUS CD=Ui

@ REQUEST _TYPE=QUTBOUND
® REM_NBR=0000005115

@ SUB_TYPE=GAI

Web Service Request / Response

To support collateral remarketing, the following web services are hosted by OFSLL to
interface with third party auctioning system:

e Get Remarketing - to receive latest remarketing details from OFSLL.

e Put Remarketing - to update remarketing request details from third party auctioning
system into OFSLL.

&7 ORACLE



9.5.1.3

e Get Invoice - to receive invoice details from OFSLL to third party auctioning system.

e Post Invoice - to create invoice details in OFSLL Vendors > Invoice screen.

For details about each web services with sample request and response files, refer to
‘Collection web services’ document in OTN library. (http://docs.oracle.com/cd/E82458 01/

webservice.htm).

Remarketing Status List

Following are the status available for collateral remarketing. Based on each status, there can
be interaction between OFSLL and third party auctioning system. Ensure that the ‘Current’
and ‘Next’ status are defined in cycle setup definition (COL_REMA_DISP_STATUS) in Setup

> Collection Cycles screen.

Note that the status indicated as (manual) in the below table are to be updated manually in

OFSLL Remarketing screen.

Status

Description

NEW (Manual)

New remarketing request created in OFSLL.

SEND TO AUCTION (Manual)

Remarketing request sent from OFSLL to third party
auctioning system.

AUCTION ACCEPTED

Response from third party auctioning system indi-
cating that the remarketing request is accepted.

AUCTION REJECTED

Response from third party auctioning system indi-
cating that the remarketing request is rejected.

UPDATE TO AUCTION (Manual)

Changes to remarketing request sent from OFSLL
to update in third party auctioning system.

UPDATE ACCEPTED

Response from third party auctioning system indi-
cating that the changes to remarketing request are
accepted.

UPDATE REJECTED

Response from third party auctioning system indi-
cating that the changes to remarketing request are
rejected.

RECEIVED UPDATE

Response from third party auctioning system on
updates to the remarketing request.

HOLD (Manual)

Hold remarketing request sent from OFSLL to third
party auctioning system (Ex: payment/updates from
customer).

HOLD ACCEPTED

Response from third party auctioning system indi-
cating that Hold remarketing request is accepted.

HOLD REJECTED

Response from third party auctioning system indi-
cating that Hold remarketing request is rejected.

VOID (Manual)

Void (decline) remarketing request sent from OFSLL
to third party auctioning system.

VOID ACCEPTED

Response from third party auctioning system indi-
cating that Void remarketing request is accepted.
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Status Description

VOID REJECTED Response from third party auctioning system indi-
cating that Void remarketing request is rejected.

REDEEM (Manual) Redeem (pull back) remarketing request sent from
OFSLL to third party auctioning system.

REDEEM ACCEPTED Response from third party auctioning system indi-
cating that Redeem remarketing request is
accepted.

REDEEM REJECTED Response from third party auctioning system indi-
cating that Redeem remarketing request is rejected.

INVOICING Implicit status updated in OFSLL on receiving
Invoice from third party auctioning system.

INVOICE REJECTED Implicit status updated in OFSLL if the Invoice
received from third party auctioning system is
rejected.

COMPLETED Implicit status updated in OFSLL to indicate as

remarketing complete.

Remarketing Proceed Details

Subsequent updates of collateral auctioning are tracked and updated in the Remarketing
Proceed Details section against the remarketing request. This tab gives insight on individual
collateral re-sale proceeds that are provided by the third party auctioning system and the total

percentage of debt recovered for each asset re-sale.

Following are the Remarketing Proceed Details updated:

Remarketing Proceed Details

Sales Indicates the Gross Sales Amount.

Expense Indicates the total expense incurred in sales.

Refunds Indicates the Refunds arising post the sales.

Net Proceeds Indicates the Gross Sale Amount (Total Expense + Total Refunds).

Balance Indicates the Payoff Quote of Account when payment is posted.

Net Gain/Loss Indicates the profit or loss of sales (Net Proceeds - Balance).

Recovery % Indicates the total recovery percentage which is calculated as
((Net Proceeds - Balance) / Balance)x100
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9.5.3

9.5.4

9.5.5

9.5.6

Status History sub tab

The Status History sub tab records all the status updates (both manual and auto) of a
particular remarketing request. This tab consists of the following details:

Field: View:

Status Previous status before the current update.

User User who updated the status.

Start Dt Status change start date.

End Dt Status change end date.

Comments Comments recorded in remarketing comments field.

Tracking Attributes sub tab

Tracking attributes allows you track and update the details of each integration element
between OFSLL and third party auctioning system, and notify the same with status change in
the remarketing request along with a comment.

In the Tracking Attributes sub tab, you can load all the available tracking attributes and define
the parameter value for various parameters listed.
1. Click ‘Load Tracking’ button and select the required parameter from the list.

2. Click ‘Edit’ and update the required details.

Expenses sub tab

The Expenses sub tab records all the expenses received as part of Invoice. This tab consists
of the following details:

Field: View:

Expense-Type Work Order service name.

Currency Expense currency.
Amt Payment amount charged by vendor.
Refunds sub tab

When customer has opted for an extended warranty or have insured the collateral and the
same has been re-sold within the warranty period, then there is a refund to be paid to the
customer. However, note that only the details of the refund are recorded in the system and
the process of refunds settlement to customer account and accounting are to be handled
manually.

In the Refunds sub tab, click ‘Add’ and update the following details:

Field: Do this:
Refund Select the type of refund from the drop-down list.
Currency Select the refund currency from the drop-down list.
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Field: Do this:

Refund Amt Specify the refund amount to be paid to customer.

Manual Checked by default indicating that all refunds are settled manually.

Save the refund details clicking ‘Save and Stay’ or any of the Basic Actions mentioned in
Navigation chapter.

Invoicing

When a repossessed asset is sold by the third party auctioning system, an invoice is created
in OFSLL (through POST INVOICE web service) with the total value of sale and the additional
cost incurred. For more information, refer Web Service Request / Response section.

Unlike other invoices where one invoice is generated for each asset, those received for
Channel sub code ‘GAI’ will have details of multiple assets sold in any given auction. Hence
the invoice would be on per-auction basis with details of all the vehicles auctioned.

The invoice received in OFSLL will have the following two components:

e Incoming payment (Proceed)- An amount generated for resale of the asset to be added
into the system.

e Vendor Fees (Invoice Details) - Cost that the vendor has charged for the service such
as service fee, vehicle repair and so on.

To view the invoice information, navigate to Collections > Vendors > Invoices tab.

ORACLE
Financial Services Lending and Leasing

@ Vendors [l ciose
Invoice Information dpadd | Pedt | G vew || of audt -
View Options AL [z] vewlast @ 1Day© 1w th & By Date Start Dt End Dt &
el Vew v Fomat+ B Freeze g Detach 1 Wrap c ] 5 Rstia
> Origination Vendor  Company Branch Invoice s ExtemalRef#  InvoiceDt Status Channel
> Servidng FL0301. USDL  UsHQ 0000005088  00D000S0SS  08f07/2017  06/06[2017  APPROVED GENERIC AUCTION INTERFACE .
T FLOBL. USDL  USHQ 0000005105 0ODODOSIOS  06f07/2017  0B/07[2017  APPROVED GENERIC AUCTION INTERFACE E|
{1AUTO.. USDL  UsHQ 1591017 100833 06/06/2017  06/06/2017 FORAPPROVAL  GENERIC AUCTION INTERFACE
Ogecicns 11AUTO.. USDL  USHQ 199145 100443 06/06/2017 FOR APPROVAL  GENERIC AUCTION INTERFACE
Colections 1IAUTO.. USDL  USHQ 3176 66565 06/06/2017 L REJECTED GENERIC AUCTION INTERFACE
i LIAUTO.. USOL  USHQ 456 66665 06/06/2017  06/06/2017  REJECTED GENERIC AUCTION INTERFACE
Repoession LIAUTO.. USOL  USHQ 5307 0083 06/05/2017  05/06/2017 FOR APPROVAL  GENERIC AUCTION INTERFACE
Defidency 11AUTO... USOL USHQ 53307 0093 06/08/2017 FOR APPROVAL  GENERIC AUCTION INTERFACE
Remarketing “ 11AUTO.. USO1 UsHQ 53807 00953 06/06/2017 FOR APPROVAL  GENERIC AUCTION INTERFACE
Reperts {AUTO.. USDE  USHQ 53307 00853 06/06/2017  0B/062017 FOR APPROVAL  GENERIC AUCTION INTERFACE -
Producers
Kesiors Details  Proceeds || Trackng Attibutes
Invoice Details FEdt || Eview || & audt
View~ Formatv [ Freeze  EfiDetach rap 2]
Work Order # Estimated Invoice Amt Agreed Amt Paid Amt Twn Post Dt Status Status Dt Authorized By Authorized Dt Colec
WO:0009204 2017. 0.00 90.00 50,00 50.00 06/07/2017 APPROVED 05/07/2017 SURABHI 06/07/2017 N
> WFP ‘ i r
> Tools
0 et Related Invoice/Work Orders | Txn Results

On selecting an invoice received from channel sub code ‘GAI’, the invoice screen will have a
rearrangement of following sub tabs:

e Details sub tab

e Proceeds sub tab

e Tracking Attributes sub tab
Before posting the invoice details, system auto validates the invoice information against
specific pre-defined Business Rules. For more information on the Business Rules, refer to
‘Business Rules for Invoice Validation’ section.

It is mandatory for every invoice to satisfy all the pre-defined business rules. Else, the invoice
is either marked for approval or is rejected. However, auto-update of status is controlled by
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9.6.1

the ‘Current/Next’ status definition defined in Cycle Setup screen and an invoice can also be
rejected when cycle setup is not configured.

Post the validation, the invoice is categorized into the following status:

e FOR APPROVAL - Auto-update for manual approve/reject.

e APPROVED - Auto-update if auto validation succeeds.

e REJECTED - Auto-update if auto validation fails.

e IN PROCESS - Auto-update if transaction posting onto the account fails.

Note the following details in the invoice information screen:

Field: View this:

Invoice Type PAYABLE or PAYMENT RECEIVED.

Indicates if the invoice is already paid or a payment to vendors is to be
initiated from OFSLL.

Funds Indicates the date on which the invoice amount is received from third

Received Dt party auctioning system. This date is used to post payment transac-
tion on the account from Invoice screen, when the status is
APPROVED.

This field is also editable if the invoice type is PAYABLE.

Total Gross Indicates the total of Gross Proceed Amount recorded at each Work
Proceed Amt Order.

Total Net Pro- Indicates the total of Net Proceed Amount recorded at each Work
ceed Amt Order.

Total Expense | Indicates the total Invoice Amount at individual invoice details
Amt expenses.

Actual Net Indicate the difference in Total Gross proceed Amount - Total Net
Proceed Amt Expense Amount.

For more information about other options available in Invoices screen, refer to Vendors
chapter.

Post Transaction

Once the invoice details are approved, you can post a transaction for the approved invoice
through the Invoice screen by clicking on ‘Post Txns’ button. The button is enabled only for
invoice with status APPROVED and IN PROCESS.

Before posting the transaction, verify the status of ‘Collectible’ in Invoice Details section.
During auto invoice validation, the Collectible field is automatically marked as ‘Y’ if the same
combination of a service and work order status matches with the state specific rule defined in
Setup > Administration > System > Vendors > Invoice Rules tab.

If the Collectible field is ‘Y’ then the transaction is posted as ‘Expense’ onto the account based
on the setup. Else, if the Collectible field is ‘N’ accounting for the same needs to be manually
handled.

On clicking ‘Post Txns’ button in invoice screen, the following transactions are initiated:
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9.6.2

1. Sale of Asset transaction - indicates the amount received after selling the asset. Also

while posting this transaction, system calculates the Spread based on matching spread

in Spread Matrix or from Contract Spread.

2. Expense transactions. indicates the additional charges incurred by vendor to sell the

asset and corresponding association of those transactions which are in-turn posted on to

the account.

Depending on the Vendor Services setup defined in Setup > Administration > System >
Vendors > Vendor Services > Work Order Types tab, specific transactions are posted.
However, the same is configurable.

ORACLE" | " - ABSHEKAR shiity 1§ sgnout O
Financial Services Lending and Leasing
@8 Vendors | Colection Cydes » Vendors x [ Cose
Cydes  VendorServices Vendor Fees  Invoice Rules
> DashBoard
> Origination Senvioes
55 Servidng View v Format~ Freeze  Efi Detach 1] wrap 5]
= B Service Type Enabled
> Collections TR %
> WFP AUCTION/SALE REPRESENTATION CHARGES ¥ |
o Teile AUCTION/SALE CHARGES ¥
SEARCH BMV/DMV RECORDS ¥
Setup B BOND CHARGES ¥ =
Events E
Batiiabs Vendor Groups  Work Order Types
Producer Cyde -
Vendors =
Collection Cych Work Order Types apadd | ZEdt || 5] vew || o Audit
Reports View v Format~ [ Freeze  fiDetach rap o)
Error Message: Work Order Type Transaction
Translations BANKRUPTCY LEGAL BANKRUPTCY EXPENSES
Seed Data OLLECTION REPOSSESSION EXPENSES
User RESALE REMARKETING EXPENSES
C e

All the transactions posed on the account are recorded and listed in the Collections >
Customer Service > Transaction History > Transactions tab.

ORACLE'
Financial Services Lending and Leasing

Search | Customer Service: 2017030001530 Review Request (Pending: 0) | Queus Assignment

> DashBoard

> Origination Account(s): 20170300015300: Elview | o audit
Eore View ¥ Formatv & Freeze i Detach Wrap W & @ curent® Show AlO Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status
Sepvcing 8 Us0L UsHQ UNDEFINED 2017030015300 LOAN VEHIGLE (FR) 67 USD 50,502,40 12,847.05 ACTIVEX
Customer Service T - — — [ = -~ J ;

Securitization

Transaction Authorization
Summary | Customer Service | AccountDetsils | Customer Detsils  Transaction History | PmtModes | Bankruptcy | RepofForecosure | Defidency | Collteral | Buresu | Timeine  CrossipSel > ¥

Post Date Chedks.
Esceni fronnicioos =| Bolonces | Transactions | Sake Transfer Transactions  Payment Rating || Due Date History || Repayment Schedue || Work Orders
Account Documents q
Collateral Management
Reports Transactions i i i ) Byen | o audt
Producers SortBy @ PostDt@ TxnDt View Options (O Good Payments () All Payments (0 Good Fees ) All Fees © Good Txns @ All Txns
Vendors
B T View v _Format~> [ Freeze [ Detach irap ) @D reverse | Exporttobxcel
f -, PostDE Tan Dt Description Currency Amount Detais Balance Amt Payment Currency Payment Amt P
Payments 06/08/2017 06/07/2017 SALE OF ASSET (Y) usp 500.00 ADV PD= $500.00 POSTED ON 06/. 50,000.00 USD -
Fees o 06/08/2017 06/07/2017 REMARKETING EXPENSES usp 85.00 50,000.00 USD
> Collections 06/08/2017 06/07/2017 REMARKETING EXPENSES usp 95.00 50,000.00 USD
06/08/2017 06/07/2017 REMARKETING EXPENSES usD 90.00 50,000.00 USD
> WEp 06/08/2017  06/02/2017  BILL/DUE DATE UsD 3,282.35 DUE DT 06/02/2017 50,000.00 USD
> Tools 06/08/2017 05/12/2017 LATE CHARGE usp 30.00 50,000.00 USD
o 06/08/2017  05/02/2017  BILL/DUE DATE usp 4,282.35 DUE DT 05/02/2017 50,000.00 USD
06/08/2017  04/12/2017  LATECHARGE usp 30.00 50,000.00 USD

@8 Customer Service x [l close

Note

The posted transaction can be reversed in the Transactions tab, but this does not impact/

change the status of Invoice or Remarketing.

Business Rules for Invoice Validation

The pre-defined business rules facilitate to validate all incoming invoices. For all the invoices

received for collateral remarketing should have an invoice type as ‘PAYMENT RECEIVED’.

Following are the pre-defined business rules in the system and every incoming invoice need
to satisfy the below rules for auto updating the invoice status as APPROVED. Else, the same

is marked FOR APPROVAL / REJECTED.
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Rule 1: Each work order that is part of the invoice should have the status as OPEN and
Work Order type as RE SALE. Else, the invoice is updated as REJECTED.

Rule 2: Validate invoice for the status of ‘Collectible’ in Vendors > Invoice tab > Invoice
Details section.

During invoice processing, if the combination of Service, Work Order Status and State
matches with any of the state specific rule defined in Setup > Administration > System
> Vendors > Invoice Rules tab, the ‘Collectible’ check box is selected and invoice is
allowed to process the next business rule.

In case the above combination does not exist in Invoice Rules tab, the ‘Collectible’
check box is NOT selected and the invoice is still allowed to process the next business
rule.

Rule 3: Validate invoice details based on Estimated and Invoiced amount and update
the corresponding status in Invoice Details sections of Vendors screen.

— If the Invoice Amount is ‘Less than or equal to’ Estimated amount, the status of
Invoice Details is updated to ‘APPROVED’.

— Ifthe Invoice Amount is ‘greater than’ the Estimated amount, then the invoice details
need manual approval and the status of Invoice is updated ‘FOR APPROVAL'.

Rule 4: Validate Invoice Proceed based on the difference between Net and Gross
Proceeds to sum of Invoice amount received at invoice details per work order.

If the difference is zero, Proceed is auto APPROVED. Else, marked FOR APPROVAL.

Rule 5: Based on the Invoice Details status and Invoice Proceed status, the status of
Invoice, Work Order, and Remarketing are auto updated as indicated below:

Invo_lce Invoice Invoice Work Order | Remarketing
details Proceed
status Status status

status status

APPROVED | APPROVED | APPROVED INVOICING | INVOICING

REJECTED REJECTED REJECTED OPEN INVOICE
REJECTED

FOR FOR FOR INVOICING | INVOICING

APPROVAL | APPROVAL APPROVAL

In the above table, the status is updated based on the below consideration:
— APPROVED - if all the other status are APPROVED.
— REJECTED - if atleast one of the status is REJECTED.

— FOR APPROVAL - if atleast one of the status is FOR APPROVAL and the rest are

APPROVED.
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9.6.3 Details sub tab

The Details sub tab displays the Invoice details received from the third party auctioning
system, and allows to Approve or Reject the invoice with status marked FOR APPROVAL. An
invoice is auto-updated to status FOR APPROVAL based on the business rule validation.

ORACLE"
Financial Services Lending and Leasing
@ Vendors [ Qose
> DashBoard Invoice Information Fpadd | PEdt | Fven || ofaudt
> Origination \View Options  OPEN [z] Viewlast @ 1Day@ 1Week® 1Month @By Date StartDt End Dt &
e - |EA Freeze bl Detach Wrap Vaidate Invoice
S View v Format ~ B eze [ Detad 5] 9
e ¢ oosonnsnss
ot vendor Company _Branch Invoice ¥ ExtemalRef# InvoiceDt  DueDt Status charnel
= EC : D”; FLON0IST.. USOL  USHQ 0000005099 0000005093 0G06/2017  06/06[2017 FORAPPROVAL  |GEMERIC AUCTION INTERFACE
olectons
Bankruptey 3
—- Details | Proceeds | Tracking Atbutes =
Deficiency
Remarketing Y Invoice Details ZEdt || [ view || o Audit
R View = Format~ B Freeze jfiDetach we @ P Accent FRReject
Producers
e Work Order # Estimated Invoice Amt Agreed Amt Paid Amt Ta Post Dt Status Status Bt AuthorizedBy  Authorzed Dt Colec
endors 00008205 2017. 0.00 .00 50,00 90,00 06/07/2017 FOR APPROVAL  08/07/2017 N
« i W G
Invoice Details
Jagetm
> WP Work Order # W0:0009205 201703000150 11 ATTORNEY FEE Agreed Amt 90.00 StatusDt 06/07/2017
Case # Paid Amt 0,00 Authorized By
ook Estimated 0.00 TanPostDt 06/07/2017 Authorized Dt
7 Setup Inveice Amt 50.00 Status Collectible _

To Approve/Reject an invoice, ensure that you have the necessary access rights assigned to
your login. Select the required invoice record and click ‘Accept’ or ‘Reject’ in the Invoice
Details section. Click ‘Yes’ to confirm the action and refresh to view the status updates.

9.6.4 Proceeds sub tab

The Proceeds sub tab helps the financial institutions to know the Net amount that remains in
the account post the re-sale of all assets in the auction. The Proceed Details sub tab displays
the following information:

e Work Order #
e Status

e Gross Amt

e Net Amt

e Fee Amt

e Authorized By
e Authorized Dt

The Net amount is the total amount paid by the third party auctioning system with the close of
auction.

The following tabs are available under Proceed Details sub tab:

e Related Invoice/Work Orders
e Txn Results
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The Transaction Results tab records all the errors (if any) for the posted transaction.

Detals | Proceeds | Tracking Attributes

Proceed Details Sl view || o Audt

View v Format~ By Fresze i Detach 1 Wrap 5]
Work Order #
W0:0009213 20170300015134

Status Status Dt Gross Amt Net Amt
APPROVED 06/07/2017 500.00 230.00

Invoice Details ~ Txn Results

Txn Resuits
View v Format= [ Freeze i Detach tirap 5]
Transaction Processing Details
*==+*Transaction Posting Successful ===

9.6.5 Tracking Attributes sub tab

In the Tracking Attributes sub tab, you can load all the available tracking attributes and define
the parameter value for various parameters listed. For more information, refer to Tracking
Attributes sub tab section.

9.7
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10.1

10. Tools

Depending on the type of product you are working with during origination, the Tools screens
enable you to calculate Lease and Vehicle value details.

Tools in the main menu are standalone and information calculated using them can only be
viewed.

Lease Calculator

The lease calculator works in one of four modes, depending on which of the following options
you select in the Lease Calculator section:

e Calculate Payment

e Calculate Rate

e Calculate Residual Percent

e Calculate Gross Capitalized Cost.

The Calculate Payment mode calculates the base monthly payment using the information
provided: the gross capitalized cost, capitalized cost reduction, residual percentage, rate, and
lease term.

The Calculate Rate mode calculates the rate and the rent factor using the gross capitalized
cost, capitalized cost reduction, residual percent, lease term, and base monthly payment.

The Residual Percent mode calculates the residual percent using the gross capitalized cost,
capitalized cost reduction, rate, lease term, and base monthly payment.

The Gross Capitalized Cost mode calculates the gross capitalized cost using the capitalized
cost reduction, residual percent, rate, lease term, and base monthly payment.

Note

If you want to clear (or “refresh”) the lease calculator at any time, click Initialize in the
Lease Calculator section.
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To calculate a lease payment

1.

Calculator.

ORACLE’
Financial Services Lending and Leasing

On the Oracle Lending and Leasing home screen, click Tools > Tools > Lease

PR — k=)

Lease Calculator x

DashBoard

Origination Lease Calculator
> Servicing
> Collections Parameters

* Contract Dt 02/01/2016
*First Pmt Dt | 03/01/2016
Maturity Dt 02/01/2016

Gross Capitalized Cost 0.00

Lease Calculator
Vehicle Evaluator

Capitalized Cost Reduction 0.00

> Setup

® Calculate Payment () Calculate Rate/Rent Factor () Calculate Residual Percent ) Calculate Gross Capitsiized Cost {8 Initialize || [F] Calculate B, Print Quote
Adjusted Capitalized Cost 0.00 Rent Factor 0.000000
[?G Residual Value(-) 0.00 Total of Base Monthly Pmts (=) 0.00
(£ Residual % 0.0000 *Term 0
Depreciation Value (=) 0.00 Base Monthly Payment (=) 0.00

3¢ dlose

Rent Charge (+) 0.00
*Rate 0.0000

2. Inthe Lease Calculator section, click Calculate Payment, then click Initialize.
3. Inthe Lease Details section, complete the following fields:
Field: Do this:

Contract Dt

Enter the contract date.

First Pmt Dt

Enter the first payment date.

Maturity Dt

View the maturity date.

Gross Capitalized Cost

Enter the gross capitalized cost.

Capitalized Cost Reduction

Enter the capitalized cost reduction.

Adjusted Capitalized Cost

View the adjusted cap cost.

Residual Value (-)

View the residual value.

Residual%

Enter the residual percentage.

Rent Charge (+)

View the rent.

Rate

Enter the rate.

Rent Factor

View the rent factor.

Total of Base Monthly Pmts (=)

View the total of payments.

Term

Enter the term.

Base Monthly Payment

View the base monthly payment.
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10.1.1

10.1.2

4. In the Lease Calculator section, click Calculate.
The system calculates the Base Monthly Payment (=) field on the Lease Details section.
To calculate a rate

1. Inthe Lease Calculator section, click Calculate Rate, then click Initialize. You can refer
to the above section for updating information in the required fields.

2. In the Lease Calculator section, click Calculate.
The system calculates the Rate field on the Lease Details section.
To calculate a residual percent

1. Inthe Lease Calculator section, click Calculate Residual Percent, then click Initialize.
You can refer to the above section for updating information in the required fields.

2. In the Lease Calculator section, click Calculate.
The system calculates the Residual% field on the Lease Details section.
To calculate a gross capitalized cost

1. Inthe Lease Calculator section, click Calculate Gross Capitalized Cost, then click
Initialize. You can refer to the above section for updating information in the required
fields.

2. In the Lease Calculator section, click Calculate.
The system calculates the Gross Capitalized Cost field on the Lease Details section.

Printing a Quote

You can generate a summarised report using the calculated lease details in the format of
quote with lease details and charges.

In the Lease Calculator screen, click Print Quote. The system generates a PDF document to
the default downloads repository consisting of the following information in the respective
headers:

Lease Details

The Lease Details section consists of Contract Start Date, Contract End Date, First Payment
Date, Total Lease Term, and Rate.

Payment/Finance Charge
The Payment/Finance Charge section consists of gross capitalized cost, adjusted capitalized

cost, percentage of residual value, rent factor, base monthly payment, and total of base
monthly payments including rental charges.

Copy Calculation to Contract or Decision tab

Depending on the screen from where you have accessed the tools sub tab, you can copy the
calculated values to either Contract or Decision tab. If you are in Underwriting stage, you can
copy the values to decision tab. Similarly during Funding stage, you can copy the values to
contract tab.

1. Click Initialize and reset the calculator.
2. Click Import values. System displays basic values entered in previous tabs.

3. Select one of the following option “Calculate Payment/Calculate Rate/Calculate Residual
Percent/Calculate Gross Capitalized Cost” and click Calculate. System displays
calculated values based on selection.
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10.2

Click Copy to Contract/Decision. The calculated details are copied to the respective fields in
Contract/Decision tab.

Vehicle Evaluator

The Vehicle Evaluator screen allows you to calculate the value of a vehicle. You can use the
Vehicle Evaluator screen to calculate the value of either a vehicle you are entering as the new
collateral or vehicle currently listed as the application’s collateral.

The Vehicle Evaluator screen can be cleared or refreshed at any time by clicking Clear.

To calculate a vehicle value

1. On the Oracle Financial Services Lending and Leasing home screen, click Tools > Tools
> Vehicle Evaluator

oORACLE"
Financial Services Lending and Leasing

kUl

‘‘‘‘‘

»»»»»

msrp

> Setup < >

2. Inthe Vehicle Evaluator section, use Asset field to select the vehicle you want to
appraise. This can be either NEW COLLATERAL or a vehicle entered on the Collateral
link.

3. Inthe Vehicle Evaluator section, click Initialize. The system completes Valuation
Source, Period and Region fields.

4. If needed, you can change the default contents of the fields in Vehicle Evaluator.

If you selected a vehicle from the Collateral link in step 3, information from the Vehicle
section appears in Vehicle section in Vehicle Evaluator screen.

6. If you selected NEW COLLATERAL in step 3, complete the Identification #
-or-
Complete the fields in the Vehicle section.

7. Inthe Vehicle Evaluator section, click Evaluate.

— If you have specified the vehicle identification number, system searches for the
value of that vehicle with that identification number, then completes Vehicle
Evaluator screen with information about that exact match.

— If you completed the Vehicle section, system searches for the value of a vehicle
matching that description.

— In either case, the system displays following information about the vehicle:
— In the Vehicle section, view the returned information:
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Field: View this:

Year The asset year.

Make The asset make.

Model The asset model.

Body The asset body style.

Usage The asset usage or current mileage.
Weight The asset weight.

In the Valuation (Total Value) block, view the returned information:

Field: View this:

MSRP Manufacturer’s suggested retail price value of the asset.
Total Total value of the asset.

Usage Adjusted usage value of the asset.

In the Base and Attribute Value section, view the returned information:

Field: View this:

Base Retail Total retail value of the asset.

Base Loan Base loan value of the asset.

Base Trade Base trade value of the asset.

Retail Retail value of the asset attributes.
Loan Loan value of the asset attributes.
Trade Base trade value of the asset attributes.

10.2.1 Attributes Tab

In the Attributes section, view the following information:

Field: View this:

Attribute Asset attribute.

Retail Attribute retail value.

Loan Attribute loan value.

Trade Attribute trade value.

Standard Standard indicator. If selected, indicates that the attribute is a standard.
Package If selected, indicates that the attribute is inclusive.

Incl
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Field: View this:

Selected If selected, indicates that the attribute is selected.

If you want to re-calculate the values using other data in Total Value and Base and Attribute
Value section, do the following:

e Make the required changes to the desired parameters fields in Vehicle Evaluator and
Vehicle sections.

e Inthe Vehicle Evaluator section, click Recalculate.
The system updates the values in Total Value and Base and Attribute Value sections.

If you choose, use Attributes section to select or clear the Selected box for attributes of the
vehicle. This automatically updates the values in Total Value and Base and Attribute Value
sections. (Note: Attribute amounts within brackets reduce the amount in Totals field in the
Total Value section.)

To copy the calculated value to the Collateral link

You can copy the calculated value to Collateral link only if you have accessed the tools tab
either from Underwriting or Funding Tab. Accessing Tools from the main menu does not
support this option.

1. Complete the following steps in the section To calculate a vehicle value.

2. In the Vehicle Evaluator screen, click Copy to Asset.

The system uses calculations on the Vehicle Evaluator screen to complete Valuation sub
screen on Collateral link. Any pre-existing collateral is no longer the primary collateral.
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11. Oracle Financial Services Lending and Leasing
Reports

During day, or at end of the day, you may want to retrieve any information from several
operations that were performed during the day in your financial institution. You can generate
this information in the form of reports in Oracle Financial Services Lending and Leasing. You
can specify the values in the Report Parameters section and generate a report using that

information.
Navigation to Reports

On the Oracle Financial Services Lending and Leasing home page, click Collections >
Collections > Reports.

ORACLE.
Financial Services Lending and Leasing

11.1 Bankruptcy Log

This collection report lists bankruptcy accounts.

Parameters:
e Company/Branch

e Report Format

Example of the Bankruptcy Log report

Report oRrRACLE
Financial Services Lending and Leasing
Date
Company : US01
Branch - USHQ
ALL AMOUNT ARE IN USD
Pool Id Type Disposition Account # customer Balance Bankruptcy File Revd Follow-up
Date Date
UNDEFIN NEWLY 201512000 ANAND AJITHA 51034 65 02/04/2016
ED RECEIVED 11375
Pool Total: 51.034.65
Branch Total :  51,034.65
Company Total: 51,034 65

11.2 Collector Activity (Detailed) Log

This collection report lists collector activity details.
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Parameters:

Company/Branch
From MM/DD/YYYY
To MM/DD/YYYY

Example of the Collector Activity (Detailed) Log report

11.3

ORACLE’

Financial Services Lending and Leasing

ivity (Detailed) Log

KNLOZ
KLEQ
ALL RMOUNT ARE IN USD

Date Collector Account # Hame Call Type Action Result Type Follow-up Dt Promise Dt Promise Amt C
SHASHANE 201202001 010091 SPARROW JACK / MARYY I cC PP 12/20/2015 1,000.00 N
12/17/2015 SRIVASTAVA 12/17/3015
Accounts 1 Collector Activity Lo tor Total 1,000.00 |
wWorked count -
HARSHAL EPARROW JACK / MARYY PP 1,000.00 N
TEMZIRE 12/17/3015
SPAREOW JACK / MARYY 3 100000 N
12/34/3015
Accounts Collector Activity 2 or Total Z,000.00
wWorked count =
NUTAR 1202 10843 LEWIS JERRY / JEAN o TB ™ 12/26/2 2,000.00 N
12/23/2015 KHATRNAR 12/24/2015
Rccounts . collector activity 1 collector Total: 2,000.00 |
Worked: count :
Date Total 2,000.00
= cB 12/22/20: o.00 2]
1z/19f2015
o or Tota 0.00
Da Total 0.00

Collector Activity Log

This collection report lists collector.

Parameters:

Company/Branch
From MM/DD/YYYY
To MM/DD/YYYY
Account Number
Department

User Name

Report Format
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11.4

11.5

Example of the Collector Activity Log report

ORACLE’
Financial Services Lending and Leasing

Collector A

Date 2016 1

AM

From Date: 01/D1/1800 To Date: 010172048

Company: NLO2
Branch: NLHQ
DepartmentODD-01 ORIGINATION
Date Collector Name

206 SERVICE OFSLL
SERVICE OFSLL
SERVICE OFSLL
SERVICE OFSLL
SERVICE OFSLL

SHASHANK

SRIVASTAVA

1211772015 HARSHAL TEMGIRE

HARSHAL TEMGIRE

KIRAN GOUDU

KIRAN GOUDU

KIRAN GOUDU

KIRAN GOUDU

KIRAN GOUDU

KIRAN GOUDU

KIRAN GOUDU

1203002015 NAGAVENKATA

VINNAKOTI

SERVICE OFSLL

VARSHA VAIDYA

Collector Productivity by Queue

2012040001014
2012040001014
20120400010114
2012040001014
2012040001014
2012040001014

2012020001008

20120200010091

2012100001017

20121000010174

20121000010174

2012100001017

20121000010174

20121000010174

20120200010091

20120200010231

20120200010231

20120200010231

Action
=]
cc
cc
cc
cc
cc

cc

cc

AT

AT

AT

cc

o

oc

oc

AT

AT
AT

Result Type
HU
HU
HU
HU
HU
HU

Date Total:
PR

PH
PH
PH
PH
PH

PH

Date Total:

PH

FH
PH

Date Total:

Department Total
Branch Total:
Company:

Count

3375

Comments

ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE:
NLMNCE_STM_LTR_VR JOB REQUEST ID: 10078)
COLLECTIONT LETTER GENERATED. ([CORRESPONDENCE:
CNLNCE_COL_LTR1_VR JOB REQUEST ID- 10121)
COLLECTIONZ LETTER GENERATED. (CORRESPONDENCH
CNLNCE_COL_LTR2 VR JOB REQUEST ID: 10128)
COLLECTION3 LETTER GENERATED. (CORRESPONDENCE:
CNLNCE_COL_LTR3_VR JOB REQUEST ID: 10135)
WELCOME LETTER GENERATED. (CORRESPONDENCE:
CNLNCE_WEL_LTR_VR JOS REQUEST ID: 6141)
CUSTOMER CALLED-HUNG UF, CONTACTED: BROTHER-INLAW,
NEXT FOLLOWUP DATE: 01/22/2018

CUSTOMER CALLED-FROMISE TO PAY, CONTACTED: ATTORNEY,

FROMISES 51 nouonraac?osﬁnm 12M17/2018, NEXT
DATE

CUSTOMER CA.LLED PROM\JE TO PAf ..QNTACTEO ATTORNEY,

FPROMISES: $1.000.00 TO BE POSTED BY: 12/24/2015. NEXT

FOLLCWUP DATE: 12/27/2015
ATTORNEY/GENERAL TELEPHONED-PAYMENT IN HAND (STDRE)
CONTACTED: ANSWERING MACI
TO BE POSTED BY: 12/17/2015, " FOLLOWUP DATE: 12*2@20‘5
CUSTOMER CALLED-PAYMENT IN HAND (STORE). CONTACTED:
ANSWERING MACHINE, PROMISES: $1,000.00 TO BE POSTED
BY: 12/17/2015, NEXT FOLLOWUR DATE: 12/20:2015
CUSTOMER CALLED-PAYMENT IN HAND (STORE), CONTACTED:
ANSWERING MACHINE, PROMISES: $1,000.00 TO BE POSTED
BY: 1212412015, NEXT FOLLOWUP DATE: 12i27/2015
ATTORNEY/GENERAL TELEPHONED-PAYMENT IN HAND (STORE),
CONTACTED: ANSWERING MACHINE, FROMISES: $4,324.00
TO BE POSTED BY: 12/17/2015, NEXT FOLLOWUF DATE: 12/20/2015
CUSTOMER CALLED-PAYMENT IN HAND (STORE} CONTACTED:
ANSWERING MACHINE, PROMISES: $1,000.00 TO BE POSTED
BY: 121772015, NEXT FOLLOWUP DATE 120202015
CUSTOMER C PAYMENT IN HAND (STORE), CONTACTED:
ANSWERING MACHINE, PROMISES: $1,000.00 TO BE POSTED
BY: 12/2412018, NEXT FOLLOWUP DATE: 12/27/2015
COLLATERAL INFORMATION UPDATED - COLLATERAL TYPE: HOME.

ATTORNEY/GENERAL TELEPHONED-PAYMENT IN HAND cs‘roﬁa
CONTACTED: ANSWERING MACHINE, PROMISES:
TO BE POSTED BY: 12/30/2015. MEXT FOLLOWUR DATE: |2wzut5
ACC_STATEMENT LETTER GENERATED. (CORRESFONDENCE:
CNLSCE_STM_LTR JOB REQUEST ID: 10105}
PAYOFF QUOTE PROVIDED TO FOR AMOUNT USD 8,500.00 VALID
UPTO 123172015

This collection report lists collector productivity sorted by queue.

Parameters:

e Company/Branch
e From MM/DD/YYYY
e To MM/DD/YYYY

Example of the Collector Producti

Deficiency Log

oductivity By Queue
AM

This collection report lists deficiencies.

Parameters:

e Company/Branch

e Report Format

ity by Queue report

ORACLE’

Finar

ial Services Lending and Le

ORACLE



Example of the Deficiency Log report

ORACLE

Financial Services Lending and Leasing

fird
=

Account # Customer/Product Follow-Up Charge-Off File Rcvd Date Balance
Date ate
201202000 02/16/2012 02/16/2012 0371072012 E011.65
91 » L
201202000 DALE ALAN / JESSICA/ 02/16/2012 02/16/2012 0371072012 5011
10108 un
201201000 ANDERSON NEQ / ANNA/LOAN-  12/22/2015 12/24/2015

02/10/2012 8023

12/24/2015 12/24/2015 0271072012 8023
12/24/2015 12/24/2015 0271072012 BO23.77
12/24/2015 12/24/2015 0271072012 BO23.77
12/24/2015 12/24/2015 0371072012 7083 .58
JOSEPHINE/LOAN -UN
TOTTER HARRY / RUDY/LOAN- 12/24/2015 127/24/2015 0371072 EECERS
un
RROW JACK / 1272472015 0371072012 EECERS
MARYY /L0
DALE ALAN / JESSICA/LOAN-  12/22/2015 0371072012 EECER)
KEVIN ERNES 72272015 0371072 J983.58
JOSEPHINE /LOAN -UN
POTTER HARRY / RUDY/LOAN- 12/24/2015 0371072 J983.58
[}
DICKENS GEORGE / 12/24/2015 Da/10/201 Jo27.27
BETH/LOAN-UN
JULIAN BREDON [ 1272472015 Da/1072012 T927.27
JULIANNE/LOEN-UN
JULIAN BREDON [ 1272472015 12/24/2015 Da/1072012 T927.27
JULIANNE/LOAN-TN
Customez/Product Follow-Up Charge-Off File Rcvd Date Balance
Date
AL VE
201204000 SCHWARE ALLAN 7 12/24/2015 1272472015 05/10/2 I5758.0%
44 TRACY /LOAN
201204000 SAXTON MARTIN / 12/24/2015 1272472015 05/10/2 TEE30.61
11865 CHELSEA/LOAN-VE

12/28/2015

201204000 1272472015 0571072 15758.03
2012253_ I12/24/2015 1272472015 0771072 T3853.07

eggm TPool Total: 340,576.00

BEranch EF Eranch 230,576.00
Compansy 33 Company 290, 659.00

11.6 Delinquency Analysis by Credit and Grade

This collection report lists delinquency analysis sorted by credit grade.

Parameters:
e Company/Branch

e Producer

Example of the Delinquency Analysis by Credit and Grade report

11.7 Delinquency Analysis by Producer

This collection report list delinquency analysis sorted by producer.

Parameters:
e Company/Branch
e Product
e Producer
e Report Format

ORACLE



Example of the Delinquency Analysis by Producer report

Report: Delinquency Analysis By Producer
Date: 10/11/20123 16:00 PM

11.8 Delinquency Analysis by State
This collection report lists delinquency analysis sorted by credit state.
Parameters:
e Company/Branch
e Product
e State
e Report Format
Example of the Delinquency Analysis by State report
nalysis by State ORACI
Financial Services Lending and Leasing
it : State: ALL
= " ¥ of fc:cmm:s Amount Percent of Amount
S a0 a0 T T
Branch: w1 N
S . m— e
T T — i o T
Company- vso product : Al State: ALL

Branch: :s:‘;

11.9 Delinquency Log

This collection report lists delinquencies.

Parameters:
e Company/Branch

e Report Format

ORACLE



Example of the Delinquency Log report

11.10 Non Monetary Txns Loq

This collection report lists non monetary transactions.

Parameters:
e Company/Branch

e Account Number

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format

Example of the Non Monetary Txns Log report

o=

11.11 Collection Queue Wise Promises Report

The collection report lists queue wise promise reports.
Parameters:

e Company/Branch

e From MM/DD/YYYY

e To MM/DD/YYYY

e Report Format

e Queue Name

11-6 ORACLE



Example of the Collection Queue Wise Promise report

Queue Promises Log ORACLE
Financial Services Lending and Leas|

11.12 Payment Promise Loq

The collection report lists payment promises.
Parameters:

e Company/Branch

e Collector

e From MM/DD/YYYY

e To MM/DD/YYYY

e Report Format

Example of the Payment Promise Log report

11.13 Repossession/Foreclosure Log

This collection report lists bankruptcy accounts.

Parameters:
e Company/Branch

e Report Format

1-7 ORACLE



Example of the Repossession/Foreclosure Log report

Report : Repossession/Foreclosure Log ORACLE
Date: 3/14/2016 18:29 PM Financial Services Lending and Leasing

ALL AMOUNT ARE IN USD

Type Disposition Account # Customer/Asset Balance Repo Forc File Recvd Follow-up Date
Date Date
NEWLY 20150600010169 UNIT1 SUB 51,373.78 03/04/2016
RECETIVED 0 TOYOTA CAMRY
NEWLY 20150600010169 UNIT1 SUB 51,373 .78 03/04/2016
RECEIVED
Type Count: 2 Type Total: 102,747.56
Branch Count: 2 Branch Total: 102,747.56
Company Count: 2 Company Total: 102,747.56
Grand Count: 2 Grand Total: 102,747.56

11.14 Accounts and Listing - Lease

This report lists the accounts log.
Parameters:

e Company/Branch
e Account Status
e Report Format

Example for Accounts and Listing report

Frimcipsl BT
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12. Producer

Oracle Financial Services Lending and Leasing is capable to create and service direct as well
as indirect Lease. Indirect Lease are generated through Producer Entities like Dealerships
and Agents. It is essential to create and maintain such entities to enable incentive tracking
and business development achieved through each entity.

Applications are sent to financial institutions indirectly through producer entities like dealers
or agents on behalf of a customer. Specifying Producer details is mandatory while creating a
application since the system associates a credit application with the producer entity which
sent it, on the Application Entry, Underwriting, and Funding screens. When the credit
application is approved and funded, the system associates the account with the producer
entity.

The following three different status are defined for Producer Entities in OFSLL:

e Active: Only if Producer Status is Active, the application sourced through that Producer
Entity can be funded.

e Inactive: If the Producer Status is Inactive, the application sourced through that
Producer Entity cannot be funded.

e Temporary: If the Producer Status is Temporary, the application sourced through that
Producer Entity can only be reviewed. However it cannot be funded.

The producers are paid for their participation, either:

e Up front during funding
-or-
e Up front on a monthly basis
-or-
e When the interest is earned
-or-
e When the payment is received from customer based on the set up compensation plans.
The Producer Setup screen contains pages that enable you to maintain and administer

producer compensation, compensation payments, charge back plans, and chargeback
parameters.

While setting up Producer entities it is also essential to setup the Producer Cycles under
'Setup' in main menu. For more details, refer to Configuring Lending and Leasing guides.
While working with the Producer Setup screen, you will primarily use the following sub tabs:
1. Payment Details

Tracking Attributes

Contracts

Comments

o M w0 DN

Summary

The Producers screen, completed during setup, can be used to view and maintain producer
details.
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12.1

Producer Details

The Producer details screen allows you to record or edit basic information about the producer.
You can set up dealers or producers for a company and branch. You can also set up a default
underwriter and a default collector for a producer. The system uses this information in the
origination work flow to select a queue.

The producer number, name, contact information, company and branch to which the producer
is associated with, federal tax number, status, and license information can be stored in this
screen.

Navigating to Producer

1. On the Oracle Financial Services Lending and Leasing home screen, click Collection >
Collections > Producers.

2. The system displays the Producers setup screen.

ORACLE - s & Welcome, PRAKRRAQ +
Financial Services Lending and Leasing
Close
DashBoard e =
> Origination Producer Details oF Add | 7 Edit S| View || <7 Audit
= View ~ Format~ P Freeze  ff Detach Wrap W o
Senvicing Producer # Old Producer & Name: Company Branch Start Dt End Dt Status Enzbled
- . UNDEFINED 02/03/2016 12/31/9993 Y
Customer Servic
r:j:":m;"“e AK-00001 HELL HELL uso1 UsRL 12/22/2015 12/31/1999 ACTIVE Y "
S - CA-00001 €A-00001 DEMO [i= usHa 11/06/2012 12/31/9999 ACTVE ¥
s D‘[ clr:' e 5 CA-D0D02 CA-D000Z RANDYS AUTO SA__ USD1 USHQ 01/01/1800 12/31/4000 ACTIVE "
. o ‘1 R CA-00003 CA-00003 ACE HEADQUART.. USO1 UsHQ 01/01/1800 12/31/4000 ACTIVE ¥
S CA-00004 CA-00004 VOLKSWAGEN OF.. USO1 UsHQ 01/01/1500 12/31/4000 ACTIVE ¥
4 ‘;"" Ik ‘D_“‘"” 1% . CA-DDD0S CA-D000S AUTO JUNGLE Us01 UsHQ 01/01/1800 12/31/4000 ACTIVE ¥
Lobeie sl Morogeanchl CA-00006 CA-00006 SIMI VALLEY CHR . USO1 UsHQ 01/01/1800 12/31/4000 ACTIVE ¥
Reparts cA-00007 PHANINDRA uso1 UsHa 12/12/2010 12/31/9999 ACTIVE Y v
Producers CA-D0008 FHANINDRA PHANINDRA1 Uso1 USHQ 13/19/2012 12/31/9998 ACTIVE Y
Vendors < >
Batch Transactions et
Advances N
Mu— Producer Details
Fees [ saveendadd | Hseveandsmy | [ ssveandRetum | 3 Retum
Interfaces.
AR sions * Producar #  UNDEFINED Max Float 99,999
GL Transactions — = Country [~]
CASA Reconciliation - A
Conversion Accounts i *Name T
— [w] Adiress Linel
oot [g] Addressinez
ozj032006 B -x & .
123j9000 (B ip Bn fon Type STATEMENT V]
*Contact - " Collection mMONTHLY [v]
*Gro = = State =) Frequency
oup =Refund NONE =
e ~ *phone 1 (000)-000-0000 Disbursement Method
Extn1 *Region v
Type v g [~
= Phone 2 = Tenritos v
Status v] 2 L
%) Exin2
* Sales Agent v Li Detail
* Fax Prefix [v] E—
* Undenwriter [~
*Fax 1 (000)-000-0000 P— Y
. i
Funder = Fax Prefic? [+] *Valid To B
> Collections * Collctor [+ Fax2
> WEP =Fed Tax # UNDEFINED .
> Tools Address Details toetomre |0
Amount v
P Payment Details | Compensation | Subvention || Transactions | Holdback/Loss Reserve || Tracking Attributes || Statements | Contacts || Comments | Summary || Title Staty >~

To set up the Producer

1. In the Producer section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Producer # Based on the system setup, either:
Specify the producer number

-or-

The system generates producer number.

Producer will be activated on the next system date (current system
date + 1) and not on the start date.
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Field:

Do this:

Old Producer #

Specify the old producer number.

Name Specify the producer name.

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Start Dt Select the producer start date by clicking on the adjoining Calendar
icon.

End Dt Select the producer end date by clicking on the adjoining Calendar
icon.

Contact Specify the producer contact.

Group Select the producer contact group from the drop-down list.

Grade Select the producer grade as per business processes from the drop-
down list. The list consist of values which are used only for
categorizing at the producer level and can be changed periodically
as per business requirement.

Type* Select the producer type from the drop-down list. The Group and
Type fields help in setting up the pricing schemes on Pricing screen.

Status Select the appropriate status from the drop-down list. The contents
of this field can be linked to edits in Lease origination cycle so that
only applications from Producers whose status is 'Active' can be
funded.

Sales Agent Select the sales agent associated with this producer from the drop-

down list.

Underwriter

Select the default underwriter assigned to this producer from the
drop-down list. Only users with a responsibility for an
UNDERWRITER can be designated as underwriters for producers.

Funder

Select the users with responsibility as Funding Specialist, from the
drop-down list.

Collector

Select the default collector or agent assigned to this producer from
the drop-down list. (This will appear in the Collector field in
Delinquency Information section of Account Details screen on
the Customer Service screen).

Fed Tax #

Specify the federal tax identification number. If the organizational
parameter UIX HIDE RESTRICTED_ DATA is set to Y, this appears
as a masked number; for example, XXXXX1234.

Address section

Country

Select the country code from the drop-down list.

Address Line 1

Specify address line 1

Address Line 2

Specify address line 2
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Field:

Do this:

Zip Select the zip code from the drop-down list.

Zip Extn Specify the extension of the zip code.

City Specify the city.

State Select the state from the drop-down list.

Phone 1 Specify phone number 1.

Exnt 1 Specify phone number 1 extension.

Phone 2 Specify phone number 2.

Extn2 Specify phone number 2 extension.

Fax Prefix1 Select fax prefix number 1 from the drop-down list.
Fax1 Specify fax number 1.

Fax Prefix2 Select fax prefix number 2 from the drop-down list.
Fax2 Specify fax number 2.

E-Mail Specify the producer mail address.

Loss Reserve Specify the loss reserve amount

Amount

Max Float Specify the value of maximum float allowed for the Producer.

A Float represents the application sourced by the producer that is
Funded and awaiting 'Title perfection' from the concerned authorities
for marking lien. If you do not know the exact value but want to
provide a maximum float, then specify the value as 99999.

Remaining Float

System automatically displays the available number of floats by
calculating the remaining float value based on 'Max Float' and Title
perfections under processing.

Enabled

Check this box to enable the product.

Subvention Partici

pation Details

Subvention
Participant

Check this box to maintain the producer as subvention participant

Collection Type

Select the collection type from the drop-down list.

Collection Select the collection frequency from the drop-down list.
Frequency

Refund Select the refund disbursement method from the drop-down list.
Disbursement

Method

Region Select the region of producer from the drop-down list.

Territory Select the territory of producer from the drop-down list.
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Field: Do this:

License Details

Valid From Specify the date from when the producer’s license is valid.

Valid To Specify the date till when the producer’s license is valid.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

Oracle Financial Services Software recommends that you double-check the fax numbers
(especially the 10 digit number) and email addresses you enter on this screen, since the
system uses this information to send its system-generated underwriting decisions.

12.1.1 Payment Details

You can setup ACH as the payment mode for a dealer or producer on Payment Details sub
screen. The Payment Details sub screen stores information regarding the payment mode,
currency and producer’s bank details, such as bank’s name, routing number, account type,
account number, BIC and IBAN. Once the details are updated the same has to be verified and
approved in the payment details section before processing.

The dashboard of Oracle Financial Services Lending and Leasing displays all the producers
whose payment details are either APPROVED or WAITING FOR APPROVAL in the
‘Producers Count By ACH Status’ section. You can click on the respective links to view the
details in ‘Producers’ screen.

To complete the Payment Details
1. Click Collection > Collections > Producers > Payment Details.

2. In the Payment Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Pmt Mode Select the payment mode from the drop-down list.

Bank Specify the ACH bank name.

Start Dt Select ACH start date if payment mode is ACH. You can even
select the date from adjoining Calendar icon.

Routing # Specify the ACH bank routing number.

Account Type Select the ACH bank account type from the drop-down list.

Account # Specify the ACH bank account number.

Currency View the currency of the Producer. System defaults the

currency depending on the Company or Branch selected for
the Producer.

BIC Select the Business Identifier Code from the drop-down list.
The list displays the BIC codes defined in the system.

12-5 ORACLE



Field: Do this:

IBAN Specify the IBAN (International Bank Account Number). IBAN
is used for identifying bank accounts across national borders
with a minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during
posting non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required
as per the country code in the user defined table (Setup >
Administration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Disbursement Select the disbursement currency from the drop-down list.
Currency System defaults the currency depending on the Company or
Branch selected for the Producer.

Approval Detail section - When the payment details are approved, system
automatically populates the following fields with the approver details along with the
status as ‘Approved’. However on subsequent update, the details are reset till
further approval and status is changed to ‘Waiting for approval’.

Approved By View the user who has approved the payment details.

Approved Dt View the date and time when the payment details were
approved.

Status View the status of producer payment details.

Perform any of the Basic Actions mentioned in Navigation chapter.

To Approve Payment Details

You can verify and approve the producer payment details defined by another user in the
Producers > Payment Details section. You can either directly select the required record in the
‘Producers’ screen or sort the list of payment details awaiting approval using the Dashboard.

Before you proceed, ensure that you have approval rights assigned to your login. Else,
contact your system administrator.

1. To access the payment details to be approved, do one of the following:
e Click Collection > Collections > Producers.

e Click Dashboard and navigate to ‘Producer’ section. In the ‘Producers Count By ACH
Status’ sub section, click WAITING FOR APPROVAL. The payment details are sorted
accordingly and displayed in ‘Producers’ screen.

2. In the Producer Details section, select the required Producer. The payment details
associated with the producer are displayed in the ‘Payment Details’ section.

3. Inthe ‘Payment Details’ section, click Approve Payment Detail.
The payment details are approved and approver information is captured in Approval Detail

section. Also on approval, the Dashboard counters in ‘Producers Count By ACH Status’
section are updated.
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12.1.2 Tracking Attributes

The Tracking Attributes sub screen allows you to link information to a producer who is not
tracked in the system, by default, however is part of company’s business practices.

To complete the Tracking Attributes
1. Click Collection > Collections > Producers > Tracking Attributes.
2. In the Tracking section, you can edit the parameter and Value details.

3. A brief description of the fields is given below:

Field: View this:

Sub-Parameter View the sub-parameter details.

Parameter View the parameter details.

Value Enter the required value for the selected parameter.

4. In the Statements Transactions section, view the following information:

Field: View this:

Effective Dt | The statement transaction date.

Transaction | The statement transaction.

Account The statement account number.

Debit Amt The statement debit amount.

Credit Amt The statement credit amount.

12.1.3 Contacts

The Contacts sub screen allows you to record information regarding contacts associated with
a producer, such as employees at a dealership.

To complete the Contacts
1. Click Collection > Collections > Producers > Contacts sub tab.

2. On the Contacts sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Contact Type Select the producer contact type from the drop-down list.
Name Specify the producer contact name.

Phone Specify producer contact phone number.

Extn Enter phone number extension.

Fax Enter producer contact fax number.

Enabled Check this box to indicate this is a current contact.
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12.1.4

12.1.5

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Comments

The Comments sub screen allows you to view and enter comments regarding the producer.

To enter a comment on the Comments
1. Click Collection > Collections > Producers > Comments sub tab.

2. Inthe Comments section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Comment Enter comment.
Comment By Displays user id.
Comment Dt Displays comment date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Summary

The display only Summary sub screen allows you to view summary information regarding the
producer.

To view summary on the Summary
1. Click Collection > Collections > Producers > Summary sub tab.

2. In the Summary section, view the following information.

A brief description of the fields is given below:

Field: View this:

Year Month | The year and month.

Total Apps The application total status count.

Approved The application approved status count.

Conditioned | The application conditioned status count.

Rejected The application rejected status count.

Withdrawn The application rejected status count.

Funded The application withdrawn status count.

Amount The application funded status total amount.
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12.1.6

Title Status Summary

The Title Status Summary screen displays the various stages of titles of assets for
applications sourced by the producer. The details are available for specific periods based on
elapsed days like last 1 Day / 1 Week / 1 Month or by a specific date range.

To view Title Status Summary on the Summary

1.

Click Collection > Collections > Producers > Title Status Summary sub tab.

2. Sortthe list of statuses to be displayed based on elapsed days by selecting the ‘View Last’
option as 1 Day /1 Week / 1 Month / By Date. When ‘By Date’ is selected, you can specify
a date range (within 3 months) in ‘Start Dt’ and ‘End D’ fields using the adjoining calendar
and click ‘Search’. View the following field details.
Field: View this:
New Status Displays lien status as 'New'
Perfection Displays lien status as either Sent for Perfection/ Sent for Re-

Processing Status

perfection

Perfected Status

Displays if lien status has 'Perfected Title'

Release
Processing Status

Displays lien status as either Sent for Title Release/Re-sent for
Title Release

Released Status

Displays lien status as either Service Requested/Pending Delete

Hold Release

Displays lien Hold Release status

To be Released

Displays lien status if ‘To be released’

Closed Status

Displays lien status if ‘Deleted’

Exception Status

Displays lien status as either Pending Lien Holder/ Pending DMV

Lien Event Date

Displays lien Event Date attached against each status.
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13.1

13.1.1

13. Vendors

During the life of an account, a financial institution might require the use of specialized
services of a vendor for various purposes; for example, repossessing a vehicle, retaining an
attorney for bankruptcy court proceedings or making field calls. With the system’s Vendors
screen, you can:

e Maintain vendor information

e Maintain services offered by the vendor

e Assign tasks to the vendors and subsequently track and process those tasks
e Charge vendor expenses to customers

e Enter and update invoices raised by the vendors

e Post vendor transactions

e Process vendor payments

Once an invoice has been presented for a service performed by a vendor, you can enter

information on Vendor Management form and create a monetary transaction. You can then
choose if the customer should pay any particular expense or not.

Vendors Screen

The Vendors screen allows you to set up vendor information. You can also use the copy
feature to quickly create new vendors with the existing details. By default it will show current
address but if the vendor receives escrow disbursement at an address which is different from
current business address the information can be entered in Payment Details sub screen. Also,
the Payment Details sub screen allows you to enter number of days prior to the due date by
which payment to vendor must be processed.

Navigating to Vendor Detail Screen

1.  On the Oracle Financial Services Lending and Leasing home screen, click Collections >
Collections > Vendors.

2. The system displays the Vendor screen. The details are grouped under four tabs:
e Vendors
e Assignment Allocation
e Work Orders
e Follow-up

e Invoices
Vendors tab

1. Click Collections > Collections > Vendors > Vendors. The details in the screen are
grouped into the following tabs:

e Payment Details
e Vendor Groups
e Tracking Attributes

e Comments
2. Inthe Collections > Collections > Vendors > Vendors > Vendor Details section, you
can create or edit vendor details. While creating new, you can also use the copy feature

to copy the existing details to new vendor. The copy option in the Vendor Details screen
is controlled by the system defined parameter (UVN_VEN_NBR_SYS_GENERATED).
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Based on the valued defined for the parameter in Setup > Administration > System >
System Parameter screen, you can copy the existing vendor details in the following ways:

e If the value of the parameter is set to ‘Y’ (default), specify a new name in ‘New Vendor
Name’ field and click ‘Create Copy’.

e If the value of the parameter is set to ‘N’, specify a vendor number in ‘New Vendor #
field and click ‘Create Copy’.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE'
Financial Services Lending and Leasing

Vendors x (3 Close:
Vendors | Work Orders | Folow-up | Inveices =
> DashBoard
Origination Vendor Details Fadd || Pedt | Fvew || o audt
prr— View v Formatv B Freeze i Detach Wrap e} New Vendor # [ Create Copy
sy Vendor # Chanrel Oid Vendor # Name Status Company Branch Start Dt End Dt Contact Person
S b By PR-04001 RON TEST_RON_VENDO... ACTIVE DEMOBANKUSA  USREGION 1 08/05/2010 12/31/999 TEST -
B~ PRAO3001 INTERNAL IHON ACTIVE DEMOBANKUSA  US REGION 3 07/25(2015 12/31/9398 MILLER L
i I PR-O4002 INTERNAL TEST_DEMO AcTIvE DEMOBANKUSA  USREGION 3 07/25(2015 12/31/95%8 MILLER 1
Conckig 3 Us-123456 INTERNAL TESTVENDOR1  ACTIVE DEMOBANKUSA  USREGION 1 03/05/2000 12/31/68%8 TESTL E
3 PA-0200L INTERNAL MAC VENDOR acTiE DEMOBANKUSA  USREGION 1 01/01/2000 12/31/08%8 mAC
Appiication Retrieval
i PR06003 INTERNAL TESTVENDOR  ACTIVE DEMOBANKUSA  US REGION 1 03/04/2000 12/31/e338 TesT
4 mezass INTERNAL TEST_VEN_COPY  ACTIVE DEMOBANKUSA S REGION 1 01/01/2000 12/31/5999 A
Appication Documents -
A us-11111 INTERNAL UNDEFINED ACTIE DEMOBANKUSA  US REGION 1 08/05/2010 12/31/e3%0 TesT
. 5 - PR03002 INTERNAL TESTVENDOR  ACTIVE DEMOBANKUSA  USREGION 2 07/29/2016 12/31/9999 TesT
:Dd” PR-05001 INTERNAL RDNLVENDOR  ACTIVE DEMOBANKUSA  USREGION 2 01/01/2000 12/31/9999 A -
roducers
‘ i v
Vendors Columns Hidden 14
s Vendor Details
Retu
> Servicing Saketm
> Collections Enabled v ContactPerson TEST address = 11
> WP Vendor # PR-0400L FedTax # AddressLine 1 ADRS
> Tools Channel RON CreditDays 0 AddressLine 2 DSA
Old Vender # Phone 1 zp 00771
> Setup 2
Neme TEST_RDN_VENDOR1 Exin 1 ZpExm <

depending on the system parameter defined at setup screen.

System auto generates the vendor number when the following sys-
tem parameter is set to ‘Yes’ in Setup > Administration > System >
System Parameter screen.

- Parameter: UVN_VEN_NBR_SYS_GENERATED
- Description: VENDOR NUMBER IS SYSTEM GENERATED

Channel Select the vendor channel from the drop-down list.

Old Vendor # Displays the old vendor number if exists.

Name Specify the vendor name.

Status Select the vendor status from the drop-down list.

Company Select the vendor portfolio company from the drop-down list.
Branch Select the vendor portfolio branch from the drop-down list.

Start Dt Specify the vendor start date. You can select data even from the

adjacent Calendar icon.

End Dt Specify the vendor end date. You can select data even from the
adjacent Calendar icon.

Contact Person | Specify the vendor contact name.
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Field:

Do this:

Fed Tax # If available, enter the vendor federal tax identification number. If the
organizational parameter UIX HIDE RESTRICTED DATA is set to
Y, this appears as a masked number; for example, XXXXX1234.

Credit Days Specify the credit days for the vendor invoice. This number is used
to check that Invoice Due Date is not more than the credit days from
Invoice Date.

Phone 1 Specify primary phone number.

Extn 1 Specify the primary phone extension.

Phone 2 Specify alternate phone number.

Extn 2 Specify the alternate phone’s extension.

Fax Specify the fax number.

Fax 2 Specify the fax number 2.

Country Select the country code from the drop-down list.

Address # Specify the vendor address.

Address Line 1

Specify address line 1.

Address Line 2

Specify address line 2.

Zip Select the zip code from the drop-down list.
Zip Extn Specify the extension of the Zip code.

City Specify the city.

State Select the state from the drop-down list.
Email Specify the email address.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

13.1.1.1 Payment Details

Click Collections > Collections > Vendors > Vendors > Vendor Details > Payment
Details. The Payment Details sub tab allows you to set up automatic clearing house
information for vendors.

On the Payment Details sub tab, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Remittance section

Country

Select the country code from the drop-down list.

Address Line 1

Specify address line 1.
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Field:

Do this:

Address Line 2

Specify address line 2.

Zip Specify zip code from the drop-down list.
Zip Extn Specify extension of the zip code.

City Specify city.

State Select state from the drop-down list.

Pre-Process Days

Specify the remittance pre-process days. This is the number of
days prior to due date by which payment to the vendor must be
processed.

Currency

View the currency attached to vendor.

Payment Details section

Mode Select the mode of payment from the drop-down list.

Bank Specify the ACH bank.

Start Dt View ACH start date.

Routing # Specify the bank routing number.

Account Type Select the account type from the drop-down list.

Account # Specify the account number. If the organizational parameter UIX-
_HIDE RESTRICTED DATA is set to ‘Y’, this appears as a
masked number; for example, XXXXX1234.

BIC Select the Business Identifier Code from the drop-down list. The
list displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is

used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during post-
ing non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as
per the country code in the user defined table (Setup > Adminis-
tration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Disbursement
Currency

Select the disbursement currency for vendor payment from the
drop-down list. The list displays all the available currencies appli-
cable to the vendor.

Perform any of the Basic Actions mentioned in Navigation chapter.
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13.1.1.2

13.1.1.3

13.1.1.4

Vendor Groups

Click Collections > Collections >Vendors > Vendors > Vendor Details > Vendor Groups.
The Vendors Groups allows you to set up vendor groups.

On the Vendor Groups section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Sort Specify sort sequence.
Group Select the vendor type to which the vendor belongs from drop-down list,

based on services provided by the vendor.

Enabled Check this box to enable the vendor service.

Perform any of the Basic Actions mentioned in Navigation chapter.

Tracking Attributes

Click Collections > Collections > Vendors > Vendors > Vendor Details > Tracking
Attributes. The Tracking Attributes allows you to load tracking attributes and define the
parameter value for various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.
eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

Comments

Click Collections > Collections > Vendors > Vendors > Vendor Details > Comments. The
Comments sub tab allows you to add comments and also view comments posted through AP

interface.

On the Comments sub tab, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Comment View or add the required comment.
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13.1.2

13.1.21

Field: Do this:

Comment System automatically selects the logged in user details.
By

Comment System automatically displays the current date.

Dt

Perform any of the Basic Actions mentioned in Navigation chapter.

Assignment Allocation

The Assignment Allocation tab allows you to define criteria for selecting a specific vendor to
execute a work order. A criteria here refers to a combination of a Channel, Work Order Type,
Company and Branch associated to a vendor. If the same combination or criteria is selected
during work order creation, system selects a specific vendor or highest weighted vendor in the
list by default for the work order.

Click Collections > Collections > Vendors > Assignment Allocation. The details are
grouped under two sections:

e Vendor Assignment Criteria
e Vendor Assignment Allocation

Vendor Assignment Criteria

In the Vendor Assignment Criteria section, you can define the criteria used for vendor
selection.

1. Inthe Collections > Collections > Vendors > Work Order > Assignment Allocation,
perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE" . . L BSHEKAR y g sgnout O
Financial Services Lending and Leasing
Vendors 3 [ Close.
Vendors ~ Assignment Allocation  Work Orders  Followup  Invoices 2
Vendor Assignment Criteria dpadd | ZEdt || 5 Ve
View v Format+ [ Freeze [l Detach Wrap @
Channel Work Order Type Company Branch Enabled State Country
GENERIC AUCTIO... RESALE DEMO BANK ... US HEAD QUA. ¥ FLORIDA UNITED STATES
INTERNAL BANKRUPTCY DEMO BANK U... US HEAD QUA. ¥
GENERIC RECOVE... DOOR KNOCK (GRI) DEMO BANK U... US HEAD QUA. ¥
il GENERIC AUCTIO... RESALE DEMO BANK ... US HEAD QUA... ¥ ALASKA UNITEDSTATES =

'GENERIC RECOVE... REPOSSESSION DEMO BANK U... US HEAD QUA. Y
GENERIC RECOVE... IMPOUND INVOLUNTARY REPOSSESSION (GRI) DEMO BANK U... US HEAD QUA. ¥
GENERIC RECOVE... BANKRUPTCY DEMO BANK P 1P HEAD QUA. ¥

Vendor Assignment Allocation AEit | Hvew | o audt

View v Format~ B Freeze i Detach frap o)

Vendor # Name Assigned Cases % Allocation Assignment %
V04814 SAND CASTLE INVESTMENTS LLC o
GA-03001 FRITAM 0
V05329 RDN DEMO FLORIDA a ||z

A brief description of the fields is given below:

Field: Do this:

Channel Select the OFSLL interfaced channel from the drop-down list.

If the channel is selected as ‘GENERIC RECOVERY INTERFACE’,
the work order is processed through an external system. For more
information, refer to Appendix chapter - ‘Generic Recovery Interface
(GRIy.
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Field: Do this:

Work Order Select the work order type from the drop-down list.
Type

Repo Storage This field is available only if the channel is selected as ‘GENERIC
Country AUCTION INTERFACE'. Select the Country where the repossessed
asset is currently stored from the drop-down list.

Repo Storage This field is available only if the channel is selected as ‘GENERIC
State AUCTION INTERFACE'. Select the State where the repossessed
asset is currently stored from the drop-down list.

Company Select the Company from the drop-down list.
Branch Select the company’s Branch from the drop-down list.
Enabled Check this box to enable the vendor assignment criteria.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

13.1.2.2 Vendor Assignment Allocation

13.1.3

In the Vendor Assignment Allocation section, system fetches the list of vendors qualifying the
combination of channel, work order, company and branch selected and allows you to define
the weightage for each vendor in percentage.

By default, the allocated assignment percentage for each vendor is ‘0’. During subsequent
update, the total of assignment percentage allocation for all vendors should be equal to “100’.
A vendor with the highest weightage is selected by default during work order creation.

For ‘GENERIC AUCTION INTERFACE'’ related Vendor Assignment Criteria, you can add
vendors to the defined criteria from ‘Vendor Assignment Allocation’ section. For more
information, refer to ‘Remarketing’ chapter in Collections User Guide.

1. Inthe Collections > Collections > Vendors > Work Order > Assignment Allocation,
perform any of the Basic Operations mentioned in Navigation chapter.

Field: Do this:

Vendor # View the Vendor number. The same is either specified manually or
system generated in the Vendors tab.

Name View the name of the vendor.

Assigned Cases View the total number of cases assigned to the vendor.

% Allocation View the percentage of total cases assigned to the vendor.

Assignment % Specify the percentage allocation value (out of 100) for each vendor.
However, ensure that the total of all assignment % is equal to ‘100’.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Work Orders Tab

The Work Orders link allows you to assign an account to a vendor for a service that the vendor
provides, view the history of work order changes and define tracking attributes.
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1. Click Collections > Collections > Vendors > Work Order. The details are grouped
under three tabs:

e Services

e Work Order History
e Tracking Attributes

2. Inthe Collections > Collections > Vendors > Work Order > Work Order, sort the list
of work orders based on status using the ‘View Options’ drop down list. You can further
sort the list of work orders based on elapsed days by selecting the ‘View Last’ option as
1 Day /1 Week / 1 Month / By Date. When ‘By Date’ is selected you can specify a date
range (within 3 months) in ‘Start Dt’ and ‘End Dt fields using the adjoining calendar and
clicking ‘Search’.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE"

Financial Services Lending and Leasing

Vendors x

Work Order

View Options

View v Format~ [

Work Order # Case
UNDEFTNED

> WO:0002001 UNDEFINED
WO:0001001 UNDEFINED
W0:0001002 UNDEFINED
WO:0001003 UNDEFINED
<

Work Order

Work Order #
Case =

* Channel

Verdors | Assignment alocation | Work Orders | Folon-up | Imvoices

Fresze  Eff Detach rap o)

Charnel

GENERIC AUL
GENERIC RE
GENERIC AU
GEMERIC AU

Work Order

UNDEFINED

INTERNAL

[ Cose

viewLast © 1Day ©) 1Week® LMonth By Date StartDt End Dt @

et EZ!‘;‘;’:L” Vendor ;’::;Z:E Company  Branch Status  Reason Viork Order Type  Assigned By Reference # Fol
ABSHEKAR.
20170100010245: 2015TOYOTA CA... FL-01001-TEST-T. uso1 UsHQ OPEN RE SALE SURABHI
20170500010043:.. 2017 TOYOTACA.. VO05329-RDNDEM. uso1 UsHQ SENDTO IMPOUND INVOLU... PRITAM
. 20170500010118:... 2017 TOYOTACA... FL-D1001-TEST-IT. uso1 UsHQ OPEN RE SALE SURABHI
2170500010118, DIFTOYOTACA.. FL-01001-TESTT uso usig cren RESALE SURAGHT
" v

B saveandadd || [ saveandStey | [ SeveandRetum | GaReturn

Work order Details
Dt 08/20/2017 Collateral Details
Status Dt 08/20/2017
Currency Collateral Description [+
[=] Estimated 0.00 Tdentification #

A brief description of the fields is given below:

Field: Do this:

Work Order # Displays the work order number.

Case # Displays the case number received from third party vendor interface.

Channel Select the OFSLL interfaced channel from the drop-down list.
If the channel is selected as ‘GENERIC RECOVERY INTERFACE’,
the work order is processed through an external system. For more
information, refer to Appendix chapter - ‘Generic Recovery Interface
(GRIy.

Work Order Select the work order type from the drop-down list.

Type

Account Select account number for the work order from the drop-down list.

Company Displays the company name based on the account selected.

Branch Displays the branch based on the account selected.

Vendor Select vendor who will service the work order from the drop-down

list. The list of vendors are displayed based on the selected Chan-
nel, Work Order Type, and Account.

Override Rea-
son

In case of vendor re-assignment, select the appropriate override
reason for the selected Vendor.
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Field:

Do this:

Status

Select the work order status from the drop-down list.

If the status is selected as ‘SEND TO GRVI’, the work order is pro-
cessed through an external system. For more information, refer to
Appendix chapter - ‘Generic Recovery Interface (GRI)'.

Reason

This field is enabled only if the status of work order is selected as
PENDING ON HOLD, RLRELEASED, or PENDING CLOSE. You
can select the appropriate reason from the drop-down list.

Collector

Select the Collector from the drop-down list. The list displays all the
users defined with ‘Collector’ responsibility.

Work Order Detai

Is section

Dt Displays the date when work order was created.

Status Dt Displays the last work order status-change date.

Currency Displays the vendor company currency based on the vendor
selected.

Estimated Displays the estimated amount, which is the sum of all the services
added to the work order.

Billed Displays amount billed by the vendor for the work order.

Paid Displays amount paid to the vendor for the work order.

Reference #

Specify vendor reference details if any.

Assigned By

Displays the user who created/assigned the work order to vendor.

Followup Dt

Select the subsequent follow-up date from adjoining calendar.

Account Information section - System displays the following information depending on
the account selected for the work order in ‘Work Order’ section.

Account Status

Displays the status of the account.

Charged off Dt

Displays the date when the account was charged off.

Due Amt

Displays the due amount to be paid to the account.

Total Outstand-

Displays either ‘Account outstanding principal balance’ for active

ing Balance accounts, or ‘Deficiency balance’ for charge-off accounts.
Total Due Displays the total of all dues pending on the account.
Due Dt Displays the last elapsed due date on the account.

Days Past Due

Displays the total number of days elapsed past due date.
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Field: Do this:

Service Displays the combined details of Customer, Address Type and
Address Address based on the account selected. You can also select the
required service address from the drop-down list only while creating
work order details (i.e. when status = New).

Note: When selecting the service address for an external interfaced
channel (i.e. changing primary address), ensure to select the sec-
ondary address only. Else, system displays an error message.

Collateral Details section - This section displays the asset details associated with the

work order.
Collateral System displays the primary collateral associated with the account
Description by default. You can also select the collateral from the drop-down list.

The list displays all the assets associated with the account.

Identification # | Displays the identification number of the asset.

Year Displays the manufacturing year of the asset.
Make Displays the asset’'s manufacturing company.
Model Displays the asset’s model.

Vendor Information section

Contact Specify the vendor contact for the work order.

Phone Specify the vendor contact phone for the work order.

Extn Specify the vendor contact phone extension for the work order.
Fax Specify the vendor contact fax for the work order.

Comment Specify any comments regarding the work order.

Vendor Messages section - This section is displayed only when the selected channel is
‘GENERIC RECOVERY INTERFACE’ and allows you to add specific communication or
instructions as a message to the vendor.

Vendor Msg Select the type of vendor message from the drop-down list.

Type

Vendor Msg Specify additional information that is to be communicated to the
external interface.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
13.1.3.1 Services

In the Collections > Collections > Vendors > Work Order > Services, perform any of the
Basic Operations mentioned in Navigation chapter.

Click ‘Load Services’ button in the Services section header to load all the services associated
with the selected combination of ‘Work Order Type’ and ‘vendor (Vendor Group)'.
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A brief description of the fields is given below:

Field: Do this:

Service # Specify an unique service number for the work order.

Service Select the service type from the drop-down list (required).

Currency System defaults the currency defined in work order which is the vendor
currency.

Estimated System defaults the Estimated cost of the service offered by the vendor

as defined in vendor administration setup screen (Setup > Administra-
tion > System > Vendors > Vendor Fees > Vendor Service Fee Defini-
tion).

However, you can also modify the estimated value to the required
amount.

Billed Amt Displays amount billed by the vendor for the service.

Paid Amt Displays amount paid to the vendor for the service.
Status Select the status from the drop-down list.
Status Dt Displays the last service status change date.

Perform any of the Basic Actions mentioned in Navigation chapter.

13.1.3.2 Work Order History

The Work Order History sub tab displays the details of the selected work orders in the
sequence of the changes done i.e. last change details appear as the first record.

In the Work Order History section, select the required work order and click View.

ORACLE
Financial Services Lending and Leasing

@  Vendors x| Vendors x [ Close
Services | Work Order History | Tracking Atiributes
> DashBoard
> Origination Work Order History El
e vien ~ Format~ [ Freeze  ifiDetach rap (2]
Servicng - 4
Clmsloes SEics Work Order # Case = Channdl  Account ket Vendor et oy [P Status Reason Workore
Securitization Desaription Reason
T — \/0:0005003 UNDEFINED  RDN 20150800021534: . 2016 TOYOTA CA .. PR-0G00S-TEST uUso1 USRHQ OPEN REPOSSE
Post Date Checks W0:0005003 UNDEFINED ~ RDN 20150800021594:... 2016 TOYOTACA... PR-06009-TEST usoL USRHQ ASSIGNED REPOSSE
Escrow Transactions WO:0005003 UNDEFINED  RDN 20150800021594:... 2016 TOYOTACA... PR-06009-TEST uso1 USRHQ NEW REPOSSE
L « m :
Account Documents i
Caollateral Management
Reports Work Order History
Producers Careum =
Vendors
Batch Transactions Account Information
e Work Order Work Order Details
Payments Service Address NAVEEN KLM - HOME - AR N AR1
i v Work Order # WO0:0005003 Dt 08/10/2016 BCHN # AR2,LAS
= Case # UNDEFINED StatusDt 08/10/2016 DR PG RIEDI00771
ollections
Channel RON Currency USD
> WEP Collateral Details
Work Order Type REPOSSESSION Estimated 0.00
 Tools Account  20150800021594:KLMKLM KLM Biled Amt 0.00 Collateral Description 2016 TOYOTA CAMRY
> Setup Company US01 Paid 0.00
Branch USRHQ Reference # Vandar Tnfnrmatinn =

13.1.3.3 Tracking Attributes

Click Collections > Collections > Vendors > Work Order > Tracking Attributes. The
Tracking Attributes allows you to load tracking attributes and define the parameter value for
various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.

eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

13.1.4 Follow-up Tab

The Work Orders link lists the work orders that are not complete and hence require follow-up.

1.

2.

Click Collections > Collections > Vendors > Follow-up tab. The details are grouped

into two:
Work Order Follow-up
Assigned Services

In the Collections > Collections > Vendors > Follow-up > Work Order Follow-up,
perform any of the Basic Operations mentioned in Navigation chapter except for creating

a new record.

Vendors

Vendors | Work Orders  Follow-up || Invoices

Work Order Follow-up

View~ Format~ Freeze gf Detach ¢ Wrap
Company Branch Followup Dt Waork Order
Uso1 UsHQ /22055 W0:0001001
uso1 usHQ /142015 W0:0001003
uso1 usHQ 12/28/2015 WO:0001007
uso1 usHQ 0003004
uso1 usHQ 0001002
uso1 usHQ 0001004
uso1 usHQ 0001005
uso1 usHQ 0003003
uso1 usHQ 0004001
uso usHQ WO:0005001

Work Order Follow-up

Work Order Follow-up

Company UsiL
Branch UskQ
Followup Ot 121272015 B
Work Drder # WO:0001011
ot 1/12/2015

@

ot

/1015
12/14/2015
12/15/2015
12/19/2015
1/12/2015
12/14/2015
12/14/2015
12/19/2015
1/22/2015
1/22/2015

Account 20150100011170:ROBERT BOREN

Assigned Services

View~ Fomat~ [ Freeze i Detach

[ Close
AEit | Eview | o audit
Assignment Type  Account Vendor Status Status Dt Assigned By Estin
COLLECTION ~ 20150100011170:ROBERTBOREN PR-DL00L-PINNACLE PARTS & SERVICE NEW Ljp0ls  VEROUTHU 000
BANKRUPTCY 20120100010406:LEWIS LESLIE / JOH  1L-00005- MICHAEL D, CLARK 1142015 VINOARUM 124
SERVICING 2015120001 1333:ER00K BROOK CA-D2001-ANDREWS TOWING 1152015 VAVAIDYA 1020
SERVICING 20151200011317:CHODA PHANINDRA ... CA-04001-PHANINDRAL PHACHODA 1004
BANKRUPTCY 2015060001 1323:5MITH IOHN 11-00005- MICHAEL D. CLARK PHACHODA 1004
COLLECTION 20120100010373:4 11-00002-GRTR QUAD CITY AUTO AL... WANKAYA 000
SERVICING 2015010010023 1L-00001-DECATUR AUTO AUCTION VEHATA 000
20120100010373:ANDRE PETER | VICT... CA-04002-HARRY RECOVER VEROUTHU  0.00
BANKRUPTCY 2012010001 RE PETER / VICT... CA-02001-ANDREWS TOWING ] VINOARUM  0.00
BANKRUPTCY 20120100010406:LEWIS LESLIE / JOH  CA-04004-STAR SERVICES NEW 12/22/2015  VINOARUM 000 T

Vendor PR-01001-PINNACLE PARTS & SERVICE
* Status NEW v

Status Dt 12/12/2015

Work Order

Currency US DOLLAR
Estimated 0.00
Billed Amt 000

»

[ saveand stay | [ saveand Retum | GaRetum
Paid 0.00
Vendor Information
Contact GREGORY
Phone (973}539-4539

Bdn
Comment

4

A Eit | Elyien | o audit

A brief description of the fields is given below:

Field:

Do this:

Company

Displays the vendor company.

Branch

Displays the vendor branch.
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Field:

Do this:

Followup Dt Specify the next follow-up date. You can even select the date from
adjoining Calendar icon.

Work Order # Displays the work order number.

Dt Displays the work order date.

Account Displays the account associated with the work order.

Vendor Displays the vendor associated with the work order.

Status Select the work order status from the drop-down list.

Status Dt Displays the last work order status change date.

Work Order section

Currency Displays the currency for the work order.

Estimated Displays the estimated amount, which is the sum of all the services
added to the work order.

Billed Amt Displays amount billed by the vendor for the work order.

Paid Displays amount paid to the vendor for the work order.

Vendor Information section

Contact Displays the vendor contact name.

Phone Displays the vendor contact phone number.

Extn Displays the vendor contact phone number’s extension.
Comment Specify a comment.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

13.1.4.1 Assigned Services

In the Collections > Collections > Vendors > Follow-up > Assigned Service, perform any
of the Basic Operations mentioned in Navigation chapter except for creating a new record. A

brief description of the fields is given below:

Field: Do this:

Services Displays the service provided by the vendor.
Currency Select currency for the vendor from the drop-down list.
Estimated Specify the estimated amount for the service.

Billed Amt Specify amount billed by the vendor for the service.
Paid Specify amount paid to the vendor for the service.
Status Select the service status from the drop-down list.
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13.1.5

Field: Do this:

Status Dt Specify the last service status change date. You can even select the
date from the adjoining Calendar icon.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Invoices Tab

In the invoice tab of vendors screen, you can define invoices and process them along with
internally generated and externally received invoices. Invoice processing involves validating
the invoice information either manually or through an automated process.

Manual validation involves verifying the invoice information, accepting or rejecting the details,
updating the invoice status and indicating if the invoiced amount is Collectible.

Auto validation is supported for invoices which are in ‘OPEN’ status and generated internally
(i.e. channel = Internal). During auto validation, the invoice details are verified against specific
business rules defined in the system and corresponding status update and collectible
indicator is updated accordingly.

However, other invoices received from externally interfaced channel would get auto validated
with specific business rules when they are received and corresponding status is appended to
the invoice while listing in the Invoice Information section.

Post the validation, invoices may still have difference in estimated and invoiced amount. Such
invoices are marked with status ‘FOR APPROVAL” and requires to be manually approved.

Further in the Invoices tab, you can define Tracking Attributes, Payment Schedules and view
the Related Invoice/Work Orders (if any) in the system.

1. Click Collections > Collections >Vendors > Invoices tab. The details are grouped into
following sections:

e Details

— Payment Schedules sub tab

— Related Invoice/Work Orders sub tab
e Tracking Attributes

2. Inthe Collections > Collections > Vendors > Invoices > Invoice Information, sort the
list of invoice based on status using the ‘View Options’ drop down list. You can further sort
the list of invoice based on elapsed days by selecting the ‘View Last’ option as 1 Day / 1
Week / 1 Month / By Date. When ‘By Date’ is selected you can specify a date range (within
3 months) in ‘Start Dt’ and ‘End Dt’ fields using the adjoining calendar and clicking
‘Search’.

13-14 ORACLE



3. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

Vendors x
Vandors || Assignment Allocation
Invoice Information
View Options
View = Format~ B
Vendor

IN-D00D1-DYER AUTO AUCTION

Invoice Information

Branch

Details | Tracking Attributes

Invoice Details
View ~ Format ~ 2

Work Orders || Falow-up  Invoices

eze [ Detach Wrap W@

Invoice

* Invoice Type  PAYABLE
*Vendor IN-00001-DYER AUTO AUCTION -
Company USOL

UsHQ

*Invoice = 33453962

ze i+ Detach wirap 5] =

[ glose

ViewLast @) 1Day © 1 Week @ 1Month® By Date startDt 07/03/2017 (BhendDt 09jz0/2017 (B @B
Validate Invoice

Branch
usHQ

Company
usoL

External Ref #
4143252465

Due Dt
09/20/2017

Invoice Dt
09/20/2017

Invoice #

33453962

Status
APPROVED

Channel
INTERNAL

[ save and stay. | [ Save andReturn

{@Retum

Address P OBOX 115 DYER, IN 46311
Currency

External Ref # 414325295
*Invoice Dt 09/20f2017 (B
= “ovet oopmpory B
*Status APPROVED =

Estmated

Invoice Amt 0,00

Agreed Amt 0.00
Peid Amt 0.00

Details Channel INTERNAL

Status Dt 09/20/2017

A brief description of the fields is given below:

Field: Do this:

Vendor Select the vendor name for whom the invoice is to be created.
Company Displays the vendor portfolio company.

Branch Displays the vendor portfolio branch.

Invoice # Specify the invoice number.

The invoice number should be unique for every vendor. In case the
Invoice # already exists for Vendor, system displays a warning message.

External Ref
#

Specify the reference number which can be used for invoice tracking.

For invoice received from external system, this field is auto populated
with the reference number generated in external interfaced system.

Invoice Dt Specify the invoice date. You can even select the date from the adjoining
Calendar icon.

Due Date Select the due date. You can even select the date from the adjoining
Calendar icon.

Status Select the invoice status from the drop-down list.

Details sectio

Status Dt Displays the last invoice status change date.

Address Displays the vendor address.

Currency Select the currency from the drop-down list.

Estimated Displays the total estimated amount of all the invoices defined in ‘Invoice

Details’ sub tab.

Invoice Amt

Displays the total invoice amount.

Agreed Amt

Displays the total agreed amount.

Paid Amt

Displays the total paid amount.
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13.1.5.1

13.1.5.2

Field: Do this:

Channel Displays the Channel as ‘Internal’ for manually defined or internally gen-
erated invoice and ‘Generic Recovery Interface (GRI) for externally gen-
erated invoice.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Auto Validate Invoice

You can auto validate the invoice details in the Invoice Information section for those invoice
which are in ‘OPEN’ status. Auto validation with system defined business rules ensure that
every approved invoice comply to required processing standards and helps to quickly proceed
with further action.

1. Inthe Collections > Collections > Vendors > Invoices > Invoice Information, sort the
list of invoice with status as ‘OPEN’ from the ‘View Options’ drop down list.

2. Select the required invoice form the list and click ‘Validate Invoice’ button on the Invoice
Information section header.

The invoice details are validated and the status of the invoice is updated based on validation.
For more information on validations, refer to ‘Business Rules’ section.

Invoice Details sub tab

1. Inthe Collections > Collections >Vendors > Invoices > Invoice Details, perform any
of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Work Order | Select the work order from the drop-down list. This list displays the gen-
erated work orders. Each work order name is defined in the format which
consists of work order number, account number, service number and
service name.

Case # System displays the Case number only if there is a Case number is
associated for the selected work order.

Estimated Displays the estimated cost of selected work order as defined in Vendors
> Work Order > Services section.

Invoice Amt | Specify the invoice amount.

Agreed Amt | Specify the agreed amount.

Paid Amt Displays the paid amount.

Txn Post Dt | Specify transaction effective date. You can even select the date from the
adjoining Calendar icon.

Status Select the status from the drop-down list.

Status Dt Displays the last status change date. On edit, system updates the cur-
rent date by default.
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13.1.5.3

13.1.5.4

Field: Do this:

Authorized Displays the name of the user who verified (accepted/rejected) the
By invoice details.

Authorized Displays the date when the invoice details were verified.
Dt

Collectible Check this box to indicate if the agreed amount is collectible from the
customer. When checked, the collectible amount is posted as an
expense on the customer account.

During auto invoice validation, this check box is automatically selected if
the same combination of a service and work order status matches with
the state specific rule defined in Setup > Administration > System > Ven-
dors > Invoice Rules tab.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Accept/Reject Invoice details

In the Invoice Details sub section, you can accept or reject the details of those invoices which
are in ‘FOR APPROVAL’ status. This status is updated during invoice processing and when
there is difference in estimated and invoiced amount which needs manual approval.

1. Inthe Collections > Collections > Vendors > Invoices > Invoice Details, select the
required invoice record.

2. Click ‘Accept’ or ‘Reject’ in the Invoice Details section header and click ‘Yes’ to confirm
the action.

3. Click Refresh button to view the status update.
On Accepting or Rejecting the invoice details, the ‘Authorized By’ and ‘Authorized Dt fields
are auto updated with user name and current date. Also the status of Invoice information and

Payment Schedules are updated as either ‘CLOSE’ or ‘REJECTED’ respectively. However,
auto update of status is controlled by the ‘Current/Next’ status defined in Cycle Setup screen.

If the status of a particular invoice is updated from ‘APPROVED’ to ‘CLOSE’, system
generates a payment requisition record for payment processing.

Payment Schedules sub tab

1. Inthe Collections > Collections > Vendors > Invoices > Invoice Details > Payment
Schedules, you can maintain the payment schedules information. Perform any of the
Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Currency System displays the vendor currency.

Payment Specify the actual payment amount for the invoice.
Amt

Status Select the payment status from the drop-down list.
Payment Dt | Select the payment date from the adjoining calendar.
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Field: Do this:

Payment (Optional) Specify reference details for the payment if any.
Reference

Payable Id View the auto-generated payable ID which is the requisition ID in the AP
Transaction screen.

Payment Id View the Requisition ID generated during AP transaction.

Disburse- View the vendor disbursement currency. However, you can select the
ment Cur- vendor payment disbursement currency from the drop-down list.

rency

Account View the currency of the account selected at in ‘Invoice Details’ sub tab.
Currency

Amount in View the Invoice Currency amount equivalent of the Account Currency.
Account System displays the ‘Amount in Account Currency’ by converting Vendor
Currency Currency value to Account Currency and considering the exchange rate

as per the scheduled payment date.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

13.1.5.5 Related Invoice/Work Order Details sub tab

1. Inthe Collections > Collections > Vendors > Invoices > Invoice Details > Related
Invoice/Work Order Details, view the following details.

A brief description of the fields is given below:

Field: Do this:

Invoice # View the invoice number for the work order.

Invoice Sta- | View the status of invoice generated for the work order.

tus

Status Dt View the date on which the status of invoice is recorded.
Currency View the currency in which the invoice is generated.
WO Esti- View the estimated amount for the work order.

mated Amt

WO Agreed | View the vendor agreed amount for the work order.
Amt

WO Paid View the amount paid for the work order.
Amt

13.1.5.6 Tracking Attributes sub tab

1. Inthe Collections > Collections > Vendors > Invoices > Tracking Attributes. The
Tracking Attributes allows you to load tracking attributes and define the parameter value
for various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.
eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

13.1.5.7 Business Rules

Business rules facilitate to auto validate invoices and approve only those which comply to the
invoice processing requirements in OFSLL. Business Rules are always validated on Invoice
information, Invoice details and payment schedules which are in ‘OPEN’ status.

Business rule validation for Invoices created or generated internally can be performed in the
Vendors > Invoices tab and external invoices are auto validated before listing in Invoices tab.

For invoices received from external system, following pre-validation checks are also
performed before validating with the business rules.

e A duplicity check is performed based on External Reference number to ensure that
there are no two invoices with same details. In case the external reference number of
new and existing invoice in the system are same, the status is auto updated as
‘Rejected’ and invoice is not processed further.

e When the payment for a ‘Service’ in work order is already paid and the same work order
is again received with a new external reference number, system validates the ‘Paid’
status and if ‘Yes’, would auto update the invoice status as ‘Rejected’.

Following business rules are defined in the system for invoice validation. During the process,
if any of the business rule validation fails, system stops the validation process and updates
the status of Invoice as ‘Rejected’.

Rule 1
Every work order should have a specific closure status corresponding to the type of work

order defined. Accordingly, an invoice generated for that work order should comply with any
of the following combination of ‘Work order Type’ and ‘Work Order status’.

Work Order Type Work Order Status
Door Knock Completed
Involuntary Repossession Repossessed
Voluntary Repossession Repossessed
Impound Involuntary Repossessed
Impound Voluntary Repossessed
Involuntary Repossession Closed

Voluntary Repossession Closed
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Work Order Type Work Order Status
Impound Involuntary Closed
Impound Voluntary Closed
Skip Investigation Repossessed
Skip Investigation Closed
Rule 2

Validate invoice for the status of ‘Collectible’ check box in Vendors > Invoice tab > Invoice
Details section.

During invoice processing, if the combination of Service, Work Order Status and State
matches with any of the state specific rule defined in Setup > Administration > System >
Vendors > Invoice Rules tab, the ‘Collectible’ check box is selected and invoice is allowed to
process the next business rule.

In case the above combination does not exist in Invoice Rules tab, the ‘Collectible’ check box
is NOT selected and the invoice is still allowed to process the next business rule.

Rule 3

Validate invoice based on Estimated and Invoiced amount and updated the corresponding
status in Invoice Information, Invoice Details and Payment Schedules sections of Vendors
screen.

e If the Invoice Amount is ‘Less than or equal’ to Estimated amount, the invoice is
approved and the status of Invoice Details and Payment Schedules is updated to
‘APPROVED’.

e If the Invoice Amount is ‘greater than’ the Estimated amount, then the invoice needs
manual approval and the status of Invoice Details and Payment Schedules is updated
to 'FOR APPROVAL'.

An invoice status in Invoice Information section is auto updated to “APPROVED’ if both
Invoice Details and Payment Schedules have the same status. Else, if status is rejected in
either of the sections, the status of invoice is also updated as ‘REJECTED’ in Invoice
Information section without allowing further edits on the same.
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A1

Appendix A: Transaction Parameters

The Customer Service screen’s Maintenance sub tab enables you to post an array of
monetary and nonmonetary transactions for any given account. The transactions that are
available depend on responsibility of the Oracle Financial Services Lending and Leasing user,
nature of account, and whether the account is a Lease.

Appendix A: This appendix catalogues the baseline transaction codes and parameters
available on Customer Service screen’s Maintenance sub tab. Instructions on how to use the
Maintenance sub tab are located in Customer Service chapter of this User Guide.

Monetary Transactions

This section catalogues the transaction codes and parameters required to complete the
following monetary tasks for Lease:

Apply, adjust, or waive servicing expenses

Adjust or waive late charges

Adjust or waive nonsufficient funds

Apply, adjust, or waive repossession expenses
Apply, adjust, or waive bankruptcy expenses
Apply or adjust phone pay fees

Change an index/margin rate

Apply, adjust, or cancel financed insurance
Generate a payoff quote

Payoff an account

Charge-off an account

Close an account

Apply, adjust, or waive an extension fee

Change payment amount

Change Term

Adjust or waive a prepayment penalty

Reschedule an escrow payment

Adjust or waive an escrow payment

Adjust or waive a payoff quote fee

Place an account in a nonperforming condition
Reverse a nonperforming condition

Reschedule precomputed Lease to interest bearing Lease
Change profit rate

Refunding the payment

Non Refund GL

ACH Fee Maintenance

Adjust, charge-off, or waive the advance/principal balance
Adjust the interest balance

Stop interest accrual

Indicate a borrower as on or off active military duty
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A1.1

e Account Settlement Transaction

Late Charges

ORACLE
Financial Services Lending and Leasing
s
i Close
5 Dashﬂm% Customer Service o
 Origination Search  Customer Service: 2015100001137  Review Request Pendng: 0) -
Servicing
Senvidng Account(s): 20151000011137: K NAVIN Elven | ofauit
Customer Senvice Vewv Fomaty Freeze o Detach i @ & @curentCshow D) aroup Folonp
Securitzaton Company Branch Sub Unit Account # Product DaysPast Due Currency PayOff Amt  Amount Due Status Oldest Due Dt
Transaction Authorization Usot s UNDEFINED DISI00011137  LEASE VEHICLE 9 D 9,322.00 2,520 ACTIVE:DELG 11/12/215
Post Date Checks:
Eatrod jrasacqns Summary | Customer Service | Account Detals || Custoner Detals | Transacton Hitory | PrmtModes | Bankruptcy | RepojForedosure | Defiency | Collateral | Bureau | Crossylp Sl Actites
Account Documents
Colateral Management: 3
) Alerts  Conditions
Reports
Producers
Vendors Account Details Other Information
Batch Transactions
Advances Dues Collateral Information
Paments b 01/12/201 DS s 10127015 Desaripton Identication # AssetClass  AssetType  SubType 0
Fees 34200 84200 84200 000 00 No data o dsply.
Interfaces
AP Transactions DelqDue 2,5%.00 TotalDue 2,586.00 FutrePmtDt 11/12/2015 it il L
6L Transactions LCDue 60.00 Todays Payoff 9,322.00 OldestDue Dt 11/12/2015 uC0:1er JEDAITL
Lstomer
CAShReconclation NSF Due_0.00 Future Payoff 9,322.00 AntPaid Excess 0.00 4 Name Relaton SN Bith Dt Gender
Conversion Accounts Future PayoffDate 02/20/2016 000000... NAVINK PRIVARY T 0121587
Definquency Information 4 ] | 4
e 30 & 0 W1 B Category Days
i ¢ 2 E o o 0 Ed i Emal Disablity N Privacy Opt Qut N
Language ENGLISH Skip N Active Miltary Duty N
L) 0 NSFife) 0 Colector DEMOCOLL o sop W o
5 Collecions £R(Year) 0 N5F{fea) 0 Corespondence
WFP .
2 Activities
» Tools ActiveDt 12/10/2015 App2 000000I0I4 LastPmtAmt 842.00 Address Information
i 9/ P
) Satup Last Actvity Dt 12/22/2015 pad Offot Charge Off Dt Toe amet i addes thone v

Late charges occur when payment is not made within the grace period or by the day after
payment is due. The due date is determined by the contract.

Late charges appear in LC Due field on the Dues section of Summary tab of the Customer
Service screen. This is the first screen to appear on the Customer Service screen when you
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load an account.

ORACLE'
Finanﬁa\ Services Lending and Leasing

e Customer Service (] Close
) Origination Search Customer Service: 2015100001137 Revin Request (Pendig: 0) -
Servicing
Senvicng Account(s): 20151000011137: K NAVIN Bren | aut
Customer Senice View~ Fomatv B [[Freem Hidebd  Jw @) & @curentCshon ) Group Folowup
Seauization Company ranch Sbunt Account & Product Days Past e Currency PayOffAmt  AmountDue Status Oldest Due Ot
Tiansaction Autharzation st Uso UDEFIED  20ISI000IHT  LEASEVEHICLE D 93200 168400 ACTIVEDELQ 1jpais
Post Date Checks
Escon Transactns Summary  Customer Senvice  AccountDetais  Customer Detals  Transaction Hstory | PmtModes Bankuptcy RepofForecsure  Defidency  Colateral  Bureay  CrossiUp Sel Actvites
Account Documents
Collateral Management =
) Nerts  Conditions
Reports
Producers
Vendors Account Details Other Information
Batch Transactions
Advances Dues Collateral Information
Payments W o ms s Descrption Uertfcaton 2 Yewr AsetClass  AsetTpe  SubType I
Fees 54200 84200 84200 o o Mo datato disly.
Intefaces
AP Transactions Delglue 168400 TEELDE () s ol [emm—
6L Transactions Todays Payoff §,322.00 OdestDueDt 11/12/2015 ”CD:” sotbbln i
CASA Recundiation NSF Due 0.00 Futwe Payoff 932200 AmtPaidExcess 0.00 SO Nane Relaton s BrthDt Gender
Comersion Accounts Other Due 0.00 Futre PayoffDate 01/01/2016 S R oo 0l
Definquency Information i ] i )
We B @ 0 10 0 Cabegory Do
! ! 0 0 0 0 0 9 Enal Discbity N Privacy OptOut N
. . Language ENGLISH Sip N Active Miitary Duty N
wlf) 0 NEFLAR) O Colectr DEMOCOLL PG o i i
) Collections Belfear) 0 Ftex) 0 Corresporvence
Az Actites
) Tools ActiveDt 12/10/2015 App# 0000001014 LastPmt Amt 84200 Address Information
) Setup Last Acity Dt 121202015 Pad OfF Ot Charge OFfDt Tpe ot e g i ot -
To adjust a late charge
Transaction Parameters
Adjustment To Late Charge - Add Txn Date Amount
Adjustment To Late Charge - Subtract Txn Date Amount
To waive a late charge
Transaction Parameters
Waive Late Charge Txn Date Amount

A.1.2 Nonsufficient Fund Fees

Nonsufficient fund fees are posted when a payment does not cover the amount owed. The fee
that the system automatically applies to an account is recorded during setup.

Nonsufficient fund fees appear in the NSF Due field on the Dues section of Summary tab of
Customer Service screen. This is the first screen to appear on the Customer Service screen

A3 ORACLE



A13

when you load an account.

ORACLE'
Financial Services Lending and Leasing
i "
T Customer Service [@cese
 Origination Searc  Customer Service: 2015100001137 | Review Request (Panding: ) o
Servicing
e Account(s): 20151000011137: K NAVIN Hew | Lot
i S Vewv Fomatr B [[Fee Hioewh  Juwm ) & @ curent O sron 4 O goup Folowp
Seaitzation Company Branch SubUrit Aot # Product Days Past Due Curency Pay Off Ant Amount Due Status OldestDue Dt
Transaction Authrization st 15HQ UNDEFINED DISIO0011137  LEASE VEHICLE AU 93200 1,684.00 ACTIVEDELQ 112215
Post Date Checks
Escaow Transactions Summary | Customer Service | AccountDetals | Customer Detals | Transaction History | Pt Modes  Baricuptey  RepofForeclosre | Defidency  Collteral | Bureau  CrossfUp Sel Actvties
‘Account Documents
Colateral Management. =
Repas 7 Alerts » Conditions
Producers
Vendors Account Details Other Information
Batch Transactons
Advances Dues Collateral Information
Payments f oyijms  nfRms RNl 10 Descpton Tentficaton # Ver AsmetCoss AwetType  SubType N
Fets 84200 200 8200 000 000 No data o dply.
Interfaces
18 Transactons DeqDue 168400 Totsl Due 1,74400 Future PmtDt 11/12/2015 . )
6L Transactons LCDue 6000 Todsys Payoff 5,322.00 OdestDue Dt 11/12/2015 CUEC‘“[:::; Infofiatcn
CASA Reconciiation Future Payoff 9,322.00 AntPaid Excess 0.00 & Neme Relation SN Birth Dt Gender
Conversion Accounts OtherDue 0.00 Futre PayoffDate 01/01/2016 S N e ol
Definquency Information 4 i B »
e 0 & 0 I 10 18 Category Das
E i o o o 0 o i 0 Emal Disabilty N Privacy OptOut N
Language ENGLISH Sp N Actve Mitary Duty N
Bf) 0 NeF(ife) 0 Collector DEWOCOLL . Sop i
S Colledtions BP{Year) 0 NgF{Year) 0 Correspondznce
i Actites
) Tools ActveDt 12/10/2015 App# 0000001014 LastPmtAmt 842.00 Address Information
) Setup LastActity Dt 12J22J2015 paid OffDt Charge OFfDt T et zevrmjs\rMamng e e =
To adjust a nonsufficient funds
Transaction Parameters

Adjustment To Nonsufficient Fund

Fee - Add

Txn Date Amount

Adjustment To Nonsufficient Fund
tract

Fee - Sub-

Txn Date Amount

To waive a nonsufficient funds

Transaction

Parameters

Waive Nonsufficient Fund Fee

Txn Date Amount

Repossession Expenses

Repossession expenses include any costs incurred while obtaining the asset, including legal

fees or storage costs.
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Repossession expenses appear in Other Due field on the Dues section of the Summary tab
of Customer Service screen. This is the first screen to appear on the Customer Service screen
when you load an account.

ORACLE
Financial Services Lending and Leasing

; Dashm% Customer Service (i Cee
 Origination Search  Customer Service: 2015100001137  Revien Request (Penng: ) s
Servicing
senicng Account{s): 20151000011137: K NAVIN Hven | P auit
Customer Senvice Vewv Fomatv By [[Feee Hfidebh  Jdwen @) &  @curent(show D) GowFlowup
Searitzation Conpany Branch SubUrit Account # Product Days Past Due Currency Pay OffAnt  Amount Due Status Oldst Due Dt
Transacton Autharizaton Usot UsHo UNDEFINED IS0 EASE VEHICLE 90 UsD 93200 2,526.00 ACTVEDELQ 11/12/2015
Post Date Checks
oo revicrs Summary | Cistoner Senice| Acount Detals | CustunerDetal | Transecionisory Pt Modes  Beriuptcy  RepoForecosure  Defidency | Colaerl | Bureay | CrossfUp Sl Actvies
Account Documents
Colatera Management 3
Reprs ) Alerts I Conditions
Producers
Vendors Account Details Other Information
Batch Transactions
Advances Dues Collateral Information
Payments g 0122016 12/12015 11/12/2015 10/12/015 Description Identification # Year AssetClass AssetType  SubType ‘
Fees 84200 84200 84200 000 000 No data to diplay.
Interfaces
AP Transactions DelqDue 2,526.00 Total Due 2,586.00 FuturePmtDt 11/12/2015 .
L Tarsactons 1Chie 6000 TodarsPaaff 83200 Odthet s | CAOmer Information m
CASARecondlaton s Fture Payoff 932200 AntPadExcess 000 Cusmj N Relaton Y Brindt Gender
Conversion Accounts Future PayoffDate 02/20/2016 000000.. NAVINK PRIVARY T 0i2/1567
Definquency Information 4| 11 | }
Late 30 60 90 120 150 180 Category Days
¥ r o o 0 W el Deatity N Privacy OptQut N
Language ENGLISH Sip N Active Miltary Duty N
B 0 NGF(if) 0 Colector DEMOCOLL T sop T
 Collections BP(Year) 0 NSF{fear) 0 Correspondence
) WFP Activities
> Tools ActiveDt 12/10/2015 Appz DO0000I0I4 LastPmtAmt 842.00 Address Information
» Setup Last Activity Dt 12/22/2015 Paid Off Dt Charge Off Dt e Curent ffrr."!ﬁwmwhng Addess Phone =

The adjustments will also appear in the corresponding column of Customer Service screen’s
Account Balances screen for EXPENSE REPOSSESSION/FORECLOSURE Balance Type--
Waived, Charged Off, Adjusted (-), or Adjusted (+) -- depending on which of the following
transactions you perform.
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To post a repossession expense

Summary  Customer Service  AccountDetals | CustomerDetals  Transaction History PmtModes Bankruptcy RepofForedosure | Defidency Colateral  Bureau  Cross/Up Sell Activities

Balances ' Transactons | Sale Transfer Transactions  PaymentRating | Due Date History | Repayment Schedule  Work Orders

Balance Group
Balance Group Tan Period
: Current Balance (@) Defciency Baance JNon-Performing Balance Teminateblance @ TD/CTD )YTD
View ¥ Format v ﬁ Freeze gj' Detach Virzp EE)
Balance Type Opening Defidency Chg Off Posted Recovery Deficiency Balance
ADVANCE | PRINCIPAL 0.00 15,000.00 2,967.52 1203248
INTEREST 0.00 48 148 0.00
FEE LATE CHARGE 0.00 0.00 0.00 0.00
FEENSF 0.00 0.00 0.00 0.00
FEE EXTENSION 0.00 0.00 0.00 0.00
FEE PREPAYMENT PENALTY 0.00 0.00 0.00 0.00
FEE PHONE PAY 0.00 0.00 0.00 0.00
FEE PERIODIC MAINTENANCE 0.00 0.00 0.00 0.00
RENTAL FEE 0.00 0.00 0.00 0.00
FEE DELAY 0.00 0.00 0.00 0.00
EXPENSE BANKRUPTCY 0.00 0.00 0.00 0.00
EXPENSE REPOSESSION/FORECLOSURE 0.00 0.00 0.00 D‘M
EXPENSE SERVICING 0.00 0.00 0.00 0.00
Deficency Balance Total 12,032.48
Transaction Parameters

Repossession Expenses | Txn Date Amount

To adjust a repossession expense

Transaction Parameters

Adjustment To Repossession Expenses - Add Txn Date Amount

Adjustment To Repossession Expenses - Sub- | Txn Date Amount

tract

To waive a repossession expense
Transaction Parameters
Waive Repossession Expenses Txn Date Amount

A.1.4 Bankruptcy Expenses

Bankruptcy expenses include any costs incurred when an account holder declares
bankruptcy, such as legal fees or additional collection costs.
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Bankruptcy expenses appear in the Other Due field on the Dues section of Summary tab of
Customer Service screen. This is the first screen to appear on the Customer Service screen
when you load an account.

ORACLE
Financial Services Lending and Leasing

; Dashm% Customer Service (i Cee
 Origination Search  Customer Service: 2015100001137  Revien Request (Penng: ) s
Servicing
senicng Account{s): 20151000011137: K NAVIN Hven | P auit
Customer Senvice Vewv Fomatv By [[Feee Hfidebh  Jdwen @) &  @curent(show D) GowFlowup
Searitzation Conpany Branch SubUrit Account # Product Days Past Due Currency Pay OffAnt  Amount Due Status Oldst Due Dt
Transacton Autharizaton Usot UsHo UNDEFINED IS0 EASE VEHICLE 90 UsD 93200 2,526.00 ACTVEDELQ 11/12/2015
Post Date Checks
oo revicrs Summary | Cistoner Senice| Acount Detals | CustunerDetal | Transecionisory Pt Modes  Beriuptcy  RepoForecosure  Defidency | Colaerl | Bureay | CrossfUp Sl Actvies
Account Documents
Colatera Management 3
Reprs ) Alerts I Conditions
Producers
Vendors Account Details Other Information
Batch Transactions
Advances Dues Collateral Information
Payments g 0122016 12/12015 11/12/2015 10/12/015 Description Identification # Year AssetClass AssetType  SubType ‘
Fees 84200 84200 84200 000 000 No data to diplay.
Interfaces
AP Transactions DelqDue 2,526.00 Total Due 2,586.00 FuturePmtDt 11/12/2015 .
L Tarsactons 1Chie 6000 TodarsPaaff 83200 Odthet s | CAOmer Information m
CASARecondlaton s Fture Payoff 932200 AntPadExcess 000 Cusmj N Relaton Y Brindt Gender
Conversion Accounts Future PayoffDate 02/20/2016 000000.. NAVINK PRIVARY T 0i2/1567
Definquency Information 4| 11 | }
Late 30 60 90 120 150 180 Category Days
¥ r o o 0 W el Deatity N Privacy OptQut N
Language ENGLISH Sip N Active Miltary Duty N
B 0 NGF(if) 0 Colector DEMOCOLL T sop T
 Collections BP(Year) 0 NSF{fear) 0 Correspondence
) WFP Activities
> Tools ActiveDt 12/10/2015 Appz DO0000I0I4 LastPmtAmt 842.00 Address Information
» Setup Last Activity Dt 12/22/2015 Paid Off Dt Charge Off Dt e Curent ffrr."!ﬁwmwhng Addess Phone =

The adjustments will also appear in the corresponding column of Customer Service screen’s
Account Balances screen for EXPENSE BANKRUPTCY Balance Type-- Waived, Charged Off,
Adjusted (-), or Adjusted (+) -- depending on which of the following transactions you perform.
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To post a bankruptcy expense

Summary  Customer Service  AccountDetals | CustomerDetals  Transaction History PmtModes Bankruptcy RepofForedosure | Defidency Colateral  Bureau  Cross/Up Sell Activities

Balances ' Transactons | Sale Transfer Transactions  PaymentRating | Due Date History | Repayment Schedule  Work Orders

Balance Group
Balance Group Tan Period
: Current Balance (@) Defciency Baance JNon-Performing Balance Teminateblance @ TD/CTD )YTD
View ¥ Format v ﬁ Freeze gj' Detach Virzp EE)
Balance Type Opening Defidency Chg Off Posted Recovery Deficiency Balance
ADVANCE | PRINCIPAL 0.00 15,000.00 2,967.52 1203248
INTEREST 0.00 48 148 0.00
FEE LATE CHARGE 0.00 0.00 0.00 0.00
FEENSF 0.00 0.00 0.00 0.00
FEE EXTENSION 0.00 0.00 0.00 0.00
FEE PREPAYMENT PENALTY 0.00 0.00 0.00 0.00
FEE PHONE PAY 0.00 0.00 0.00 0.00
FEE PERIODIC MAINTENANCE 0.00 0.00 0.00 0.00
RENTAL FEE 0.00 0.00 0.00 0.00
FEE DELAY 0.00 0.00 0.00 0.00
EXPENSE BANKRUPTCY 0.00 0.00 0.00 0.00
EXPENSE REPOSESSION/FORECLOSURE 0.00 0.00 0.00 D‘M
EXPENSE SERVICING 0.00 0.00 0.00 0.00
Defidency Balance Totd 12,0324
Transaction Parameters
Legal Bankruptcy Expenses Txn Date Amount

To adjust a bankruptcy expense

Transaction Parameters

Adjustment To Bankruptcy Expenses - Add | Txn Date Amount

Adjustment To Bankruptcy Expenses - Sub- | Txn Date Amount

tract

To waive a bankruptcy expense
Transaction Parameters
Waive legal Bankruptcy Txn Date Amount
Expenses

A.1.5 Phone Pay Fees

Phone pay fees are where a borrower calls the lender and arranges for a debit to their
checking or savings account to make a payment on a Lease account.
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A.1.6

A.1.6.1

Phone pay fees appear in Other Due field on Dues section of the Summary tab of Customer
Service screen. This is the first screen to appear on the Customer Service screen when you

load an account.

ORACLE
Financial Services Lending and Leasing

5 Dashm% Customer Service (st
) Origination Search  Customer Service: 2015100001137 Revien Request (Pending: ) -
Servicing
Senvidng Account(s): 20151000011137: K NAVIN Elven | o Audt
Custoner Senvice Vewv Fomatv By [[Feee Hfidebh  Jdwen @) &  @curent(show D) GowFlowup
Sequritzation Company Branch SubUnit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transacton Authorization Uso1 UsHQ. UNDEFINED. 0151000011137  LEASE VEHICLE %0 UsD 93200 2,526.00 ACTIVE:DELQ 11/12/015
Post Date Checks
Fewan Brops s Summary | Cisomer Sevice | AccountDetabs  CustonerDetals Trarsacionistory  PntModes Bakouptey Repofforedoswre Defideney  Coliterd  Buteau | CrosslUp Sl Adsites
Account Documents
Colatera Maregement I3
Reprs ) Alerts I Conditions
Producers
Vendors Account Details Other Information
Batch Transactions
Advances Dues Collateral Information
Payments g 0122016 12/12015 11/12/2015 10/12/015 Destription Identification # Year AssetClass AssetType  SubType A
Fees 00 84200 84200 0.00 0.00 No data to display. |
Interfaces
AP Transactions DelqDue 2,526.00 Total Due 2,586.00 FuturePmtDt 11/12/2015 .
GL Transactions LCDue 60.00 Todays Payoff 9,322.00 OldestDue Dt 11/12/2015 CIRGHE Inforiciion
CASA Recondiation NGF Due 0,00 Future Payoff 9,322.00 Amt Paid Excess 0,00 Custnme; Name Relation SN Birth Dt Gender
Conversion Accounts Future PayoffDate 02/20/2016 00000, NAVINK BRIMARY ] 012197
Definquency Information { 11 }
Late 30 60 90 120 150 180 Category Days
! U L 1 0 0 0 EUN Enal Disbity N Privacy OptOut N
Language ENGLISH Sip N Active Mitary Duty N
BP(ife) 0 NSF{ife) 0 Colector DEMOCOLL Veritl Status St N Tine Zane
) Collections Blfear) 0 W6 {lea) 0 Correspondence
DI Adtiites
> Tools ActveDt 12/10/2015 App# 0000001014 LastPmtAmt 842,00 Address Information
’ Setup Last Activity Dt 12/22/2015 Paid Off Dt Charge Off Dt e Curent TEL’TSS‘CME\\\HQ Addess thone X

To adjust a phone pay fee

Transaction

Parameters

Adjustment to Phone Pay Fee - Add

Txn Date Amount

Adjustment to Phone Pay Fee - Subtract

Txn Date Amount

To waive a phone pay fee

Transaction Parameters

Waive Phone Pay Fee Txn Date Amount

Financed Insurances

In this section, you can do the following:

e Insurance Addition
e Insurance Cancellation
e Insurance Modification

Insurance Addition

You can add financed insurance to an existing account with the INSURANCE ADDITION
transaction. This transaction adds insurance premium amount to advance/principal balance
on the Lease and adjusts the Lease receivables accordingly. The transaction also triggers the
process to re-compute repayment amount for Lease. After you post the transaction Lease will
be billed for newly computed payment amount and will be considered for delinquencies and
fees calculations based on information on the Contract link’s Contract screen. The newly
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added insurance information can be viewed on Customer Service drop-down link’s
Insurances link.

ORACLE'
Fi&ancia\ Services Lending and Leasing

B Close
 DashBoard Customer Service [Ee
 Origination Search  Customer Service: 2012100010917  Review Request (Pendng: 0)

Servidng
Senvidng Account(s): 20121100010917: WRIGHT JOHN / MARTY 5] vew | o Auit
Customer Service Vieww Fomatv [ freeme fiDetad  JJwn @) & @curentOshon A0 Group Folow-p
Seauritzaton Company Branch SubUrit Account £ Product Days Past Due Curency PayOffAnt  AnountDue Status OldestDue Dt
Transaction Authorization [ uso1 USHQ UNDEFINED 2121100010917 LEASEVEHICLE 0usD 0.00 0.00 PENDING
Post Date Checks
FartaN iepeccions Sumnary | Customer Service | Accounk Detaits | Customer Detals || TransactonHistory | PmtModes | Banicupley | RepoFForedosure | Defidency || Coleteral | Bureau | Cross|Ua Sel Actvies
Account Documents
Collateral Management Account Defals | Statements | Rate Schedule  Insurances | Contract Information
Reports
Producers .
Insurance Information [5iew | o hudit
Vendors 2 o S i
Batth Transactions Ve Fomatv B [[[Fre el dve | §
Advances Contractual Insurance Type Company Polcy # Effective Dt PremumAnt  Tem Status
Paymerts 4 lodatatodspay. b
Fees
Interfaces
AP Transactions Insurance Tracking JEit | Hien | of auit
6L Transactions Vieww Fomatv B freere il Detach ) b Creste Tradeng
CASA Recondliaion Sub-Parameter Parameter Vae
Conversion Accounts No data to dsplay.
» Collections
) Wi
) Tools
 Setup
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A.1.6.2

To add financed insurance

Transaction

Parameters

Insurance addi-
tion

Txn Date

Insurance Type

Single/Joint

Insurance Mode

Insurance Plan

Company Name

Phone #1

Extn #1

Phone #2

Extn #2

Policy #

Policy Effective Date

Premium Amount

Expiration Date

Primary Beneficiary

Secondary Beneficiary

Comment

Insurance Cancellation

To cancel a financed insurance

Transaction

Parameters

Insurance Cancel-

lation

Txn Date

Insurance Type

Policy Effective Date

Insurance Refund Amount

Cancellation Reason

Current Usage

A-11

You can cancel financed insurance on an existing account with the INSURANCE
CANCELLATION transaction. When you post this transaction, the system computes premium
refund amount based on the refund method associated with insurance item.
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A.1.6.3

A7

A1.8

If you enter a value for INSURANCE REFUND AMOUNT parameter, the system overrides
calculated refund amount and adjusts advance/principal balance and Lease receivables
accordingly. The INSURANCE CANCELLATION transaction re-computes the repayment
amount for Lease based on remaining balances. After posting the transaction, Lease will be
billed for newly computed payment amount according information on the Contract tab’s
Contract sub tab. The insurance cancellation information can be viewed on the Contract link’s
Insurances sub screen.

Also if you enter a value for ‘Current Usage’, system computes the rebate amount using the
'Pro Rata (Mileage) method. However system also calculates the rebate amount using
‘Refund Calculation Method' and considers the minimum value out of both.

Insurance Modification

You may rectify possible errors resulting from incorrect information entered on the
INSURANCE ADDITION transaction (such as an incorrect premium account) with the
monetary transaction INSURANCE MODIFICATION.

When you post the INSURANCE MODIFICATION transaction, Oracle Financial Services
Lending and Leasing re-computes the repayment amount using new premium amount and
adjusts advance/principal balance on Lease and Lease receivables.

To modify financed insurance information

Transaction Parameters

Insurance Modifications | Txn Date

Insurance Type

Policy Effective Date

Premium Amount

Index/Margin Rates

You can change the current index rate type and margin rate of a variable rate Lease using the
INDEX / MARGIN RATE CHANGE monetary transaction.

To change an index/margin rate

Transaction Parameters

Index/Margin Rate Change Effective Date

Index

Margin Rate

Reason

Payoff Quotes

A payoff quote is the amount still owed on account or amount needed to satisfy the Lease. It
can be generated anytime and may be requested during a call from a customer, dealer, or
insurance agent. A payoff quote can either be generated for current or future date, but not on
a back date.
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The payoff quote appears in Results section of Maintenance screen.

ORACLE'
Financia\h'iervices Lending and Leasing

S Customer Service (s
> Onigination Search  Customer Service: 2012010001148 | Review Request (Pending: 0)
Servicing
Servidng Account(s): 20120100011488: GIARDANO NICHOLAS / MIRIAM [Eyen | & aut
Customer Senvice Viewv Formatv g [[[Frecze fiDetach i @ B @ curent© show Al O eroup Folowup
Searitzation Company Branch Sub Lnit Account Product DaysPastDue Currency Pay Off Amt  Amount Due Status Oldest Due Dt
Transaction Authorization usot usRt UNDEFINED D0100011465  LEASE VEHICLE 1262 UsD 5,05.32 E¥3UE ] ACTIVE:DELQ:SCHEDULED CHGOFE o7/10/2012
Post Date Checks
ESaun Tansscions Summary | C Customer Detals PmtModes | Bankuptcy | RepofForedosure  Defidency | Colateral | Bureau | Crossiup SellActivites
Account Dacuments
Collsteral Management Call Acthitis| Maintenance | Comments | Promises | Chedsts | Trackng Attrbutes | References  Corespondence | Letters | Document Tracking
Reports
Producers . .
i Transaction Batch Information cpadd | ZEdt | [ view || o audit
endors
Batch Transactons Vew Fomatv [ Freeze i Detach » @ S post [ Void
i Date Manetary Transacton Status gatch
Payments 4 MNodaiato dsplay ;
Fees
Interfaces
AP Trensactions Parameters
GL Transactions View~ Fomatv & Freeze i Detach Wrap W
CasAReconciiztion Parameter Vae Requred
Conversion Accounts No data to display.
Result
View v Fomatv [ Freeze i Detach wan | @
Transacton Processing Detals
S e Nodata to dislay.
> W
> Tools
> Setup

To generate a payoff quote for an account Lease

Transaction | Parameters

Payoff Txn Date
Quote

Payoff Quote Valid Up To Date

Assess Payoff Quote Fee

Payoff Quote Ltr Print

Comment

Account Paidoff

An account is automatically paid off or marked for payoff processing by the system with a
batch transaction when the account balance is $0.00. You can also manually payoff an
account with the Maintenance screen. You can also pay off an account using the Consumer
Lending (Advance and Payment) form. For more information, see the Payment Processing
chapter.

When you payoff an account, the system changes the account’s status to PAID OFF. The date
the account was paid off appears in Activities section’s Paid Off Dt field on Account Details
screen.

The system also notes the amount of the principal that was waived when account was paid
off in the Waived column on Account Balances screen.

To pay off an account

Transaction | Parameters

Paid off Txn Date

If you reverse the payoff payment using Customer Service form, then the pay-off is
automatically reversed. The system changes the account’s status from PAID OFF to ACTIVE
when you refresh the account.
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A.1.10 Account Charge Off

Charging off an account refers to when a lender decides to take a loss on an account,
signalling that attempts to recover the Lease have failed. In calculating a charge off, the
system considers the total compensation amount (up front compensation plus remaining
compensation amount). It is different from the waive off process since a waive off is a
concession offered to the customer on payment of some component, such as a late fee. The
repayment of the original Lease still continues in waive off process.

When you charge off account, the system changes the status to CHARGED OFF. The balance
on the account appears on Customer Service form’s Balance screen when you choose
Deficiency Balance in the Balance Group section.

Summary = Account Detals ~ Customer Detals  Transaction History PmtModes Bankruptcy —Repo/Foreciosure = Defidency  Bureau | Cross/Up Sel Activities

Balances | Transactions = Sale Transfer Transactions | PaymentRating = Due Date History =~ Repayment Schedule  Work Orders

Balance Group
Balance Group Txn Period
@ Current Balance ) Deficency Balance ) Non-Performing Balance () Terminate Baance @ TD/CTDC) YTD
View- Fomatv [ Freeze et wep @
Balance Type Opening Balance Posted Paid Waived Adjusted (-)
ADVANCE | PRINCIPAL 0.00 5,000.00 0.00 0.00 5,000.00 0.00
INTEREST 0.00 11.65 0.00 0.00 11.65 0.00
FEE LATE CHARGE 0.00 0.00 0.00 0.00 0.00 0.00
FEE NSF 0.00 0.00 0.00 0.00 0.00 0.00
FEE EXTENSION 0.00 0.00 0.00 0.00 0.00 0.00
FEE PREPAYMENT PE... 0.00 0.00 0.00 0.00 0.00 0.00
FEE PHONE PAY 0.00 0.00 0.00 0.00 0.00 0.00
EXPENSE BANKRUPTCY 0.00 0.00 0.00 0.00 0.00 0.00
EXPENSE REPOSESSL... 0.00 0.00 0.00 0.00 0.00 0.00
EXPENSE SERVICING 0.00 0.00 0.00 0.00 0.00 0.00
| i b
Current Balance 0.00
Total

The date of the charge off appears on Account Details screen in Activity section’s Chargeoff
Dt field.

ORACLE'
Financial Services Lending and Leasing

PR Customer Service ,  Cyces | Colection Cycks (] Close
Origination Summary | Customer Service | ActountDefalls | Customer Detals ~ TransactionHistory | PmtModes Bankruptcy RepofForecosure | Deficency  Colateral | Bureau | Crossfp Sel Actvities fa
Origination
Sleslend ) Alerts ) Conditions
Simple Application Entry
Applcation Entry
Account Details Other Information
Underwitng
Funding .
Dues Coliateral Information
Appication Retrieval
gan 040013 0y /1R 11/10/2012 10102012 Desripton Identification £ Vear AsetCass AsetType  SubTipe
I
0.00 0.00 0.00 0.00 0.00 No data to dplay.
Applcation Documents
Image Maintenance .
Repts Delg Due 0.00 TotalDue 0.00 Future Pmt Dt 03/10/2013 Gistome Tifarmation
LCDue 0.00 Todays Payoff 0.00 Oldest Due Dt 07/10/2012
Producers Fer
o N&F Due 0.00 Future Payoff 0.00 AmtPaid Excess 0.00  Name Relation SN Bith Dt Gender
Other Due 0.00 Future Payoff Date 01/03/2016 000000... EDWIN ASMITH PRIMARY Xexe-1021 0101/1560
[l Definquency Information 000000... KIMBSMITH SPOUSE XH0-1456 01/01/1980
] ‘
late X 60 90 jil 150 180 Category Days 4| Il | 3
1 1 1 1 0 0 8 180 0
Emal STEVEN@SSC.COM Disabilty N Privacy Opt Out Y
PR 0 NF(Lf) 0 Colector DAE Languzge ENGLISH S N Actve Miltary Duty N
Blfea) 0 Ner{year) 0 Mt Status Stop ¥ e Zone. AVERICA/CHICAGO
Correspondence:
Activities
ActiveDt 11/01/2012 App # (0000000450 LastPmtAmt 9,822.12
LastActiity Dt 12/24/2015 Paid OFF Dt Tharge 0Tt 1229055 | Address i |
DueDay 10 Effective Dt 02/10/2012 Miitary Duty N Type ikt ::’C’:T‘CME‘W Address Phone
 Senvicn LastPmtDt 06/18/2012 CurrentPmt 856,30 Customer Score 639 g 5 = S LR e
2 Customer Grade C Lastil Amt 7,946.70 Behaviour Score 0 & : - 1'
> Collections HOME Y Y N 23423410124 PR-00772 (000)-423-4234
Producer 1L-00003 : SAM LEMAN CHRYSLER, PLYMOUTH MAZDA
i Due Date Ch:
> Tooks ue Date Change Employment Information
LastTun Dt Rem, Tun, Limit (Life) § Permissc
) Satup Rem. Tan, Lt Year) 2 Type Curent ooy Enployer Address Phone -
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A1.11

A1.12

However, you can select the ‘Do Not Auto Charge Off’ condition to ignore few account
conditions, for the charge-off processing batch job. When an account is marked with the
condition DO NOT CHARGE OFF, then batch job will not pick the account for charge off
processing.

You can add ‘Do Not Auto Charge Off’ condition in addition to the already existing condition.

To charge off an account

Transaction | Parameters

Charged Off | Txn Date

Account Closure

The system automatically closes an account when its status changes from ACTIVE status to
PAID or VOID. It is manually closed if it has status as CHARGE OFF. Accounts marked as
CLOSED are not processed and after a period of time are purged from Oracle Financial
Services Lending and Leasing.

Summary ‘Customer Service | Account Detals | Customer Detals Transaction History ~ PmtModes  Bankruptcy | RepofForeclosure  Defidency  Collateral Buresu — Cross/Up Sell Activities

Call Acthvites ~ Maintenance = Comments = Fromises Checdists  Tracking Atirbutes  References  Correspondence  Letters  Document Tracking  Scenario Analysis

Transaction Batch Information Ak | AEdt | Even | of udt
Vien v Fomatv B} Freere i Detach W ) §otPost [ Void
Date Manetary Transaction Status Batch
02/16/2016 ¥ ACCOUNT CLOSE POSTED N
01/13/2016 N ADD CUSTOMER ADDRESS PHONE POSTED N
01/13/2016 N ASSET MAINTENANCE POSTED N
01/13/2016 ¥ PAID OFF POSTED N
01/19/2016 N ASSET MAINTENANCE POSTED N

Parameters
View ¥ Format v E Freeze ﬁ Detach lrap @g

Parameter Value Required
TX DATE 01/22/2016 ¥
Resut
View~ Fomatv B Freere HiDetach W @

Transaction Processing Details

**#** Transaction Posting Successful *=***

To close an account

Transaction Parameters

Account Close | Index Txn Date

Advance (Principal) Balance

The advance (or principal) balance is posted automatically when you fund the contract on
Funding screen. You are not allowed to post the advance with Customer Service screen.
However, you can waive, charge off or adjust the advance or principal.
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A1.13

The adjustments will appears in the corresponding column of Customer Service screen’s
Account Balances sub tab for ADVANCE / PRINCIPAL Balance Type -- Waived, Charged Off,
Adjusted (-), or Adjusted (+) -- depending on which of the following transactions you perform.

Summary  Customer Service  AccountDetals | Customer Detals  Transaction History  PmtMoces  Bankruptcy | RepofForedosure  Defidency | Colateral  Bureau | CrossiUp Sel Actvities

Balances  Transactions ;ﬂ\_di'rransfeﬂransacnons Payment Rating || Due Date History | Repayment Schedule || Work Orders

Balance Group

View ™ Format ¥ E? Freeze deerach d Wrap Gﬁ]
Opening

Balance Group

(@) current Balance () Defidency Balance | Non-Perforning Balance ) Terminate Bdlance @/ ID/CTD (YD

Tin Period

Balance Type i Posted Paid Waived  Charge Off Adijusted () Adiusted (4) Balance
ADVANCE [ PRINCIPAL (.00 100,000.00 (.00 000 0.00 0.00 0.00 100,000.00
INTEREST 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE LATE CHARGE 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEENSF 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE EXTENSION 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE PREPAYMENT PENALTY 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE PHOKE PAY 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE PERICDIC MAINTENANCE 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
RENTAL FEE 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
FEE DELAY 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
EXPENSE BANKRUPTCY 0.00 40.00 0.00 0.00 0.00 0.00 0.00 40.00
EXPENSE REPOSESSION/FORECLOSLRE 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
EXPENSE SERVICING 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00

Current Balance Total 100,040.00

To adjust the advance/principal balance
Transaction Parameters

Adjustment To Advance/Principal - Add

Txn Date Amount

Adjustment To Advance/Principal - Sub-
tract

Txn Date Amount

To charge off the advance/principal balance

Transaction Parameters

Chgoff Advance/Principal Txn Date Amount

To waive the advance/principal balance

Transaction Parameters
Waive Advance/Principal Txn Date Amount
Interest

The interest is accrued or posted automatically when you post the payment on Advance
screen’s Advance Entry tab. You cannot post the interest in the Customer Service screen;

however, you can adjust or waive interest.
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The adjustments will appears in the corresponding column of Customer Service form’s
Account Balances screen for INTEREST Balance Type-- Waived, Adjusted (-), or Adjusted (+)
-- depending on which of the following transactions you perform.

ORACLE
Financial Services Lending and Leasing
 DashBoard Customer Service jgese
Origination % Seach  Customer Service: 2015100001137  Revien Recuest (Pending: 0)
Servicing
pes Account(s): 20151000011137: K NAVIN Bren | Paudt
Customer Service View = Fomat v (B Freeze T Detach wep @ & @oret Jshon 1 aroup Felonp
Seaitzation Company Branch SubUrit Accourt & Product DaysPast Due Currency PayOffant  AmountDue Status OldestDue Ot
Transaction Authorization usot usHQ UNDEFINED 2015100001137 LEASE VEHICLE 40 UsD 93200 1,684.00 ACTIVE:DELQ 1122015
PostDate Cheds
i Summery | Customer Senice | AccountDetals | Customer Detals | Transaction History | PmtModes | Bankuptey | RepojForedosure | Defiiency | Colateral | Bureau | Cross/up Sel Actvites
Account Documents
Colateral Management Balances  Transactions ~PaymentRating ~DueDateHistory RepaymentSchedde  Work Orders
Reports
Producers
) Balance Group
oy Balance Group Txn Period
Batch Transactions
Advances i Q) Current Balance f ) Deficency Balance Non-Performing Balance ) Terminate Balance ‘é'lTD/CFD‘ )YTD
apend View v Format~ [ [[|Fresze ifiDetach e @) 1
m:;:; Baaree Type Openngalrce Posed  pod Temiste Waived hage OFF Adisted () Adusted () ol
LEASE RECEIVABLE 0.00 10,10400 842,00 0.00 0.00 0.00 0.00 9,262.00
Fion FEE LATE CHARGE 000 8000 000 000 000 000 000 800
8 fiapecion FENSE 1 20 10 20 00 o o 1)
R FEE ADIANCE 000 000 000 00 00 00 00 00
bttt FEEPHONEPAY 10 10 10 10 o0 o o o
SALES [ USAGE TAX 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
FEE DISPOSITION 0.00 000 0.00 0.00 0.00 0.00 0.00 0.00
FEE EXCESS USAGE 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
OTHER FEE ANDTAX 0.00 000 0.00 0.00 0.00 0.00 0.00 0.00
FEE EARLY TERMINATION 0.00 000 0.00 000 0.00 0.00 0.00 0.00
 Collections TERMINATION 000 000 000 0.00 0.00 0.00 0.00 0.00
INVENTORY 0.00 0.00 0.00 000 0.00 0.00 0.00 0.00
> WEP
CurrentBalance Total 9,322.00
> Tools
» Satup
To adjust the interest
Transaction Parameters

Adjustment To Interest - Add

Txn Date Amount

tract

Adjustment To Interest - Sub-

Txn Date Amount

To waive the interest

Transaction

Parameters

Waive Inter-
est

Txn Date Amount

Interest Accrual

You can start or stop interest accrual on a Lease.

On the Lease Details screens, Stop Accrual box is selected in Interest and Accruals section.

Summaryteiusmmerserw:e Account Details  Customer Detals | Transaction History | PmtModes  Bankruptcy | RepofForedosuwre | Defidency  Collateral | Bureau  CrossjUp Sel Activities

Account Details | Statements | Rate Schedule | Insurances = Contract Information

Account Information
Viewv Fomatv B if Detach Virap W
Stop Accrual Index Type Index Rate Margin Rate
N PRIME RATE

7

5.00

49

Rate Last Rate Change Dt Accrual Start Dt

599

01212016

Last Accrual Dt

01/21[2016

EE View || off Audit
Rate Startofthe  #ofRate changes  # of Rate changes #of Exte
Year (Year) (Life)
9.99 0 0
b

To remove Stop Accrual indicator, post the start ACCURAL transaction.
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To start interest accrual for an account

Transaction | Parameters

Start Txn Date
Accrual

To stop interest accrual for an account

Transaction Parameters

Stop Accrual Txn Date

Active Military Duty

The Servicemembers Civil Relief Act of 2003 (SCRA), formerly known as the Soldiers and
Sailors Civil Relief Act of 1940 (SSCRA), is a federal law that gives military members some
important rights as they enter active duty military service. The law is designed for active duty
military personnel and reservists (and their spouse -- if applicable for joint credit accounts) to
receive, as a result of military service economic hardship(s), an interest rate reduction
(currently at 6.000%) for certain consumer and mortgage-related debt that was incurred prior
to entering military service, for the period of time that the servicemember is on active duty.
Under the law, the term’s interest includes service charges, renewal charges, fees, or any
other charges (except bona fide insurance) with respect to an obligation or liability. The law
also provides protection against certain legal actions during the term of active duty military
service. The SCRA function is currently available in the system for simple interest Lease.

Any account that has been identified under SCRA requirements as eligible for the allowable
benefits of active military duty for its primary borrower/spouse will have a new interest rate
calculation based upon the 6.000% limit set by the SCRA. However, this change is subject to
exception in case of accounts that already have an interest rate less than 6.000%. In such
cases, the original interest rate that is less than 6.000% will continue.

To indicate that a borrower is on active military duty

Transaction Parameters

Borrower On Military Duty | Txn Date

Borrowers Relation With Account

Active Duty Order Reference

After you post this transaction, the Military Duty box (Account Details screen Activities
section) and Active Military Duty box (Customer Details screen Military Service section) are
selected. Oracle Financial Services Lending and Leasing changes the condition of the
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account to ON ACTIVE DUTY. Details of the transaction appear in the Military Services

section on Customer Details screen.

2
Summary Customer Service | AccountDetals  Customer Detals  Transaction History ~ PmtModes | Bankrupty | RepofForecoswe  Defidency  Colateral  Bureau | Cross/Up Sell Actvities
h/k Alerts - Conditions
Account Details Other Information
Dues Collateral Information
Desaription Tdentification = Year AssetClass AssetType  SubType
0.00 0.00 0.00 0.00 0.00 0TOYOTA COROLA 0 NEW VEHICLE CAR
DelgDue 0,00 Total Due 0,00 FutwrePmtDt 0201/2016 f 3
LCDue 0.00 Todays Payoff 36,004.99 OldestDue Dt 02012016 Customer Information
Custor
NS Due 0,00 Futue Payoff 36,0545 AntPadExcess 0.0 S e Relton sl Dt Gender
1304 -
OB 100 Folas ot OVZRAL oL 7Lz FRIVARY et UPES UDEND 3
Definquency Information < il )
Late n ] 90 1 190 180 Category Days
4 ¢ d b u 1 . i Email Disabiity N Privacy Opt ¥
- . Lanquage ENGLISH Sip N ut
BP(Life) 0 NeF{lfe) 0 Collector DEMOCOLL Vit Stets Stop Active Mitzry N
BP(fear) 0 N&F{Year) 0 Correspondence Duty
Time Zone  AMERICA/LOS_ANGELES
Activities
ActiveDt 01/12/2016 App # 0000001289 LastPmt Amt 0.00
Last Actvity Dt 01/12/2016 Paid Off Dt Charge 00t Address Information
DuzDay 1 Effectve Ot 01/12/2016 Type Curent z:rém;s'cl‘ﬂaihng Address Phone
d
LastPmt Dt CurrentPmt 3,078.22 Customer Score 0 Z09NBCHN # 2303 2 3YERMO
Customer Grade B LastBil Amt 0.00 Behaviour Score 0 HOME Y v A3 o (000)-000-0000
Producer CA-00010 : SMART DEALER SERVICES
Due Date Change Employment Information
Last Tan Dt Rem. Tam, Limit (Life) 5 Permissic
: Type Current Employer Address Phone
Rem. Txn. Limit (Year) 2 I wed T v

If the interest rate was greater than 6%, Oracle Financial Services Lending and Leasing will
change the rate to 6% and adjust the payment accordingly. The CHANGE PAYMENT
AMOUNT and RATE CHANGE transactions on the Transactions screen.

While posting an SCRA transaction for a borrower who is on 'Active Military Duty', system
processes a lower payment amount regardless of prior payment history.

To indicate the payment parameters when the borrower is on active military duty

Parameter Name - CUST_ON_MLTRY_DUTY

Transaction Parameters

Borrower On Military Duty Txn Date

Borrowers Relation With Account

Active Duty Order Reference

Payment Calculation Method

Rate

Override Rate

The Payment Calculation Method has the following options in drop-down list for selection:

e Outstanding Balance & Term - System calculates the new payment amount using
Outstanding Principal, SCRA Rate, Remaining Term.
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e Contract Balance & Term - System calculates the new payment amount using

Contract principal, SCRA Rate, Contract Term.

ORACLE’
Financial Services Lending and Leasing

y 1g senout &

(Customer Service [®] Close

Summary  Customer Service  AccountDetails | Customer Detals | Transaction History | PmtModes | Bankruptcy | Repoforecosure  Defidency | Colateral | Buresu | CrossiUp Sell Actviies > ~ &

Call Activities | Maintenance | Comments | Promises Checkists  Tracking Attrbutes || Field Investigation | References  Correspondence  Letters | DocumentTrackng | Scenario Analysis | » =

Transaction Batch Information dp add | 7 Edit ] view & Audit
View v Format~ B Freeze [ Detach Wrap 5] {3 Post  [54 void
Date Monetary Transaction Status Batch
07/01/2016 ¥ i7

Transaction Batch Information
Saveand Add || [ Save and Stay. Save andReturn || (@ Retun

A o Load Parameters
Date 07/01/2016 Transaction BORROWER ON MILITARY DUTY Status i3
Monetary ¥ Batch __
Parameters
View v Format~ [ Freeze ! Detach Wrap 50

Parameter Value Required

TXN DATE B v

BORROWERS RELATION WITH ACCOUNT PRIMARY [+ v

ACTIVE DUTY ORDER REFERENCE Enter the value

PAYMENT CALC METHOD OUTSTANDING BALANCE AND TERM [ =] v

'QUTSTANDING BALANCE AND TERM e

RATE
CONTRACT BALANCE AND TERM

OVERRIDE RATE

Note

If the borrower is delinquent during the life of loan, any outstanding balance would be paid
along with last installment amount.

OFF-Military Duty

If the borrower is off-military duty, the transaction ‘BORROWER OFF MILITARY DUTY’ is
posted to restores the interest and instalment amount for the remaining term of the loan.

To indicate that a borrower is no longer on active military duty

Transaction Parameters
BORROWER OFF MILI- TXN DATE
TARY DUTY

BORROWERS RELATION WITH ACCOUNT

SCRA OFF PAYMENT CALC METHOD

To adjust the contracted interest rate and Payment Amount, the SCRA off Payment
Calculation Method has the following options in drop-down list for selection:

e Restore Account Payment - System restores contract interest rate and instalment
amount.

— Remaining balance (if any) after ‘Restore to Account Payment’ is adjusted to the
last instalment amount as a balloon payment.

— In case if a ‘Rate Change’ transaction is posted on account before posting ‘On
Military Duty’ transaction, system calculates the remaining payment amount as per
the changed interest rate and not the contract rate.

e Calculate New Payment - System recalculates the payment amount using contract
interest rate.

After you post this transaction, the Military Duty box (Account Details screen Activities
section) and Active Military Duty box (Customer Details screen Military Service section) are
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de-selected. Oracle Financial Services Lending and Leasing changes the condition of the
account to OFF ACTIVE DUTY.

RACLE

Financial Services Lending and Leasing

> DashBoard
> Origination
Servicing
Servicng
Customer Service:
Searitization
Transaction Authrization
Post Date Checks
Escrow Transactions
Account Documents
Colateral Management
Reports
Producers
Vendors
Batch Transactons
Advances
Payments
Fees
Interfaces
2P Transactons
6L Transactions
CASARecondiiation
Conversion Accounts

> Collections
> WFP.

> Tools

> Setup

Customer Service .

Search  Customer Service | Review Request (Pending: 0)

Account(s)
Viewy Fomatv Ep | ([[|Frecze  fiDetach weo @ & Ocurment@showat© eroup Folown
Company Branch SubUnit Account = Product Days Past Due Currency
No data to dspay.
Ssummary | G tDetals | G Pt Modes
Customer | Busness
Customer Information
Vew~ Fomstv B (|Freee EiDetsch » W
Customer = Relation EcoA s Name BirthDt
No data to display.
< il
Addresses | Telecons | Employments | Trading Attrbutes
Address Information
Viewv Formatv [y Freeze [fiDetach | ¢ wrap ®
Type Current Permisson to Cal  Confirmed Waiing Country Address &
Nodata to dispay.

«

I

Pay Off Amt

Marital Status

ity

Amount Due Status

Baniquptey | RepoForedosure | Deficency | Bureau || Crossjup Sell Actvties

Enzbled

(3 Close
Elvew | o At
Oldest Due Dt
st || Blew | £ ast
Mother's Maiden
Language Educaton el ‘

o add || JEdc | Huew || Lagdt
Postal Address Type StreetPre

Street Name:

b

A.1.16 Due Date Change

You can change the due date of an account. When it is changed, the system determines next
bill date, as well as the next due date. The DUE DATE CHANGE transaction does not allow
next billing date to change such that it is less than the current billing date. The due date

change transaction has been extended to change the default ACH due day, provided that the
account due day and ACH due day match.

If a late fee is no longer applicable because of this due day change, Oracle Financial Services
Lending and Leasing will automatically remove the fee.

The new due day appears in Activities section Due Day field on the Account Details screen.

Summary ~ Customer Senvice | AccountDetais | Customer Detals ~ Transaction History  PmtModes Bankuptcy | RepofForecoswe  Deficency  Collsteral  Bureau  CrossiUp Sell Activites

 Nerts
Account Details
Dues
0.00 0.00
DelqDue 0.00
1CDue 0.00
NSFDue 0.00

Other Due 0.00

Definquency Information
e N 0 @
0 0 0 |

B[f) 0

BR(Year) 0

Activities
Active Dt 12/28/2015
Last Acthity Dt 12/28/2015
LastPmt Dt
Customer Grade A

0.00 0.00

Total Due 0.00
Todays Payoff 50,000.00
Future Payoff 50,000.00
Future Payoff Date 01/07/2015

FrA
0 0 0
NF{Lfe)

NSF(¥ear) 0

App # 0000001230
Paid Off Dt
Effective Dt 12/28/2015
CurrentPmt 1,452.80
Last Bl Amt 0.00

Producer CA-00002: RANDYS ALITO SALES

s R

0.00

Futre Pt Dt 01/01/20%6
Oldest Due Dt 01/01/2046
Amt Paid Excess 0.00

Category Days
4

Collector DEMOCOLL

LastPmtAmt 0.00
Charge Off Dt

Miitary Duty N
Customer Score 750
Behaviour Score 0

» Conditions
Other Information

Collateral Information
Desaription
2015 TOYGTA CAVRY

Customer Information

Customer
, Name

000000... ALLARTRAJESH
{

Emal
Language ENGLISH
Marital Status

Address Information
Permissic
Type Current el Maiing

HOME Y Y Y

Employment Information
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Identfication #

Relation
PRIMARY
(I}

Disabity N
Sip N

Stop N
Correspondence

Address

GF NHRF BCHN # HNF JNF INTF LAS

PIEDRAS PR00771

Year AssetClass  AssetType  SubType
D15 HEW VEHICLE CAR
SN Birth Dt Gender
Xxxu-3414 03/07/1981
}
Privacy Opt Out N
Active Mitary Duty N
Time Zone
Phone
(008)-564-8741
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The system also notes change on Lease Details screens in Extn and Due Dates section’s #
of Due Day Changes (Year), # of Due Day Changes (Life) and Due Day Chg Dt fields.

To change a due date

Transaction Parameters

Due Date Change Txn Date

Due day

Due Date

A.1.16.1 Override Due Date Change

You can override the contract ‘Due Date’ of an account to mark-up the due days limit to the
required standard business rules by posting the following monetary transaction.

To override a due date change

Transaction Parameters

DUE DATE CHANGE | TXN DATE
OVERRIDE

DUE DAY

DUE DATE

ACH DUE DATE CHANGE

On posting the transaction system ignores the following Due Day contract parameters:

e Max Due Day Change/Yr

e Max Due Day Change/Life
e Max Due Day Change Days
e Due Day Min

e Due Day Max

On successful posting of the transaction, system automatically increases the number on
counters (i.e. number of times due date change permitted) for ‘Max Due Day Change/Yr’ and
‘Max Due Day Change/Life’. The transaction is displayed in Customer Service > Transaction
History > Transactions screen.

Summary | Customer Service | AccountDetals | Customer Detals = Transaction History | PmitModes | Bankruptcy | RepofForedosure | Defidency | Collatersl | Buresu | Cross/Up Sell Activi » ™

Balances | Transactions | Sale Transfer Transactions || PaymentRating | Due Date History =~ Repayment Schedule | Work Orders

Transactions El vew || of Audit
SortBy (C)PostDt@TxnDt View Options (2 Good Payments (2 All Payments ) Good Fees (0) All Fees i) Good Txns @ All Txns
View ¥ Format ¥ B Freeze i Detach ap @ ) Reverse Export to Excel

Post Dt Twn Dt Description Currency Amount Details Balance Amount Payment Currency Pj:’nm:

I 072642016 07/26/2016 DUE DATE CHANGE OVERRIDE INR. 0.00 FROM DUE DAY= 29 TO DUE DAY 44,000.00 INR. 4
TR mE T UC AT T TR DD SR n 2,000, 00 T
07/12/2016 08/08/2016 BILL/DUE DATE INR 3,767.47 DUE DT 06/29/2016 44,000.00 INR. ‘
05/31/2016 05/09/2016 LATE CHARGE INR. 30.00 44,000.00 INR
05/31f2016 05/08/2016 BILL/DUE DATE INR 3,767.47 DUE DT 05/29/2016 44,000.00 INR =
05/31f2016 04/08/2016 BILL/DUE DATE INR 3,767.47 DUE DT 04/29/2016 44,000.00 INR.
05/31/2016 04/08/2016 LATE CHARGE INR 30.00 44,000.00 INR
05/31/2016 03/10/2016 LATE CHARGE INR. 30.00 44,000.00 INR
05/31f2016 03/08/2016 BILL/DUE DATE INR. 3,767.47 DUEDT 03/28/2016 44,000.00 INR.
05/31/2016 02/08/2016 BILL/DUE DATE INR 3,767.47 DUE DT 02/29/2016 44,000.00 INR. -
« I 5
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A.1.16.2 Reverse an Override Due Date Change

A1.17

When a posted ‘Due Date Change Override’ transaction contains error or non desired results,
you can reverse the same in Customer Service > Transaction History > Transactions screen.

Select the Due Date Change Override transaction and click Reverse.
Summary = Customer Service  AccountDetsils | Customer Detslls = Transaction History | PmtModes | Bankruptcy | RepofForedosure | Deficiency  Collatersl | Bureau  Cross/Up Sell Activi >

Balances = Transactions  Sale Transfer Transactions = PaymentRating = Due Date History | Repayment Schedule  Waork Orders

Transactions EJvew ||« Audit
SortBy ()PostDt@ TxnDt View Options (2) Good Payments () All Payments (2 Good Fees (0 All Fees () Good Twns @ All Tuns

View = Format™ [ Freeze i Detach Wrap o] Reverse Export to Excel

Post Dt Txn Dt Description Currency Amount Details Balance Amount Payment Currency Pir‘m:
07/26/2016 07/26/2016 REVERSE DUE DATE CHANGE OVERRIDE INR 0.00 FROM DUE DAY = 29 TO DUE DAY.. 44,000.00 INR

07/26/2016 07/26{2016 DUE DATE CHANGE OVERRIDE INR 0.00 FROM DUE DAY = 29 TO DUE DAY 44,000.00 INR

07/12(2016 07/08/2016 BILL/DUE DATE INR 3,767.47 DUE DT 07/29/2016 44,000.00 INR

07/12/2016 06/08/2016 BILL/DUE DATE INR 3,767.47 DUE DT 06/29/2016 44,000.00 INR =
05/31/2016 05/09/2016 LATE CHARGE INR 30.00 44,000.00 INR T
05/31/2016 05/08/2016 BILL/DUE DATE INR 3,767.47 DUE DT 05/29/2016 44,000.00 INR

05/31/2016 04/08/2016 BILL/DUE DATE INR 3,767.47 DUE DT 04/29/2016 44,000.00 INR

05/31/2016 04/08/2016 LATE CHARGE INR 30.00 44,000.00 INR

05/31/2016 03/10/2016 LATE CHARGE INR 30.00 44,000.00 INR

05/31/2016 03/08/2016 BILL/DUE DATE INR. 3,767.47 DUE DT 03/29/2016 44,000,00 INR »

] mn b

On successful posting of the transaction, system reverts (decreases) the change in the
number on counters (i.e. number of times due date change permitted) for ‘Max Due Day
Change/Yr’ and ‘Max Due Day Change/Life’.

Change Term

You can change the term of a loan account by posting the ‘CHANGE TERM’ monetary
transaction in Customer Service > Maintenance > Transaction Batch Information. When the
term is changed, system auto calculates and updates the Term and Maturity date as indicated
below:

e New Term is calculated from ACC_DUE_DT_NEXT onwards. (Say, New Terms)

e Number of terms is calculated from Contract date to ACC_DUE_DT_NEXT (Say,

Passed Terms).
e Updates ACC_TERM_CUR with sum of PASSED TERMS + NEW TERMS.

o Updates ACC_MATURITY_DT_CUR with sum of ACC_DUE_DT_NEXT + NEW
TERMS.

To change the term

Transaction Parameters
CHANGE TERM TXN DATE
PAYMENT AMOUNT

BALLOON PAYMENT AMOUNT

A.1.18 Payment Refund Transaction

Payment refund transactions allows you to refund excess payment received from the
customer during life of the Lease. The Payment Refund transaction is posted at the
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maintenance screen in servicing. The refund is posted only when the refund amount is equal
to Payment amount. Else an error message is displayed.

@mary Customer Service | Account Detais || Customer Details || Transaction History | PmtModes | Bankruptcy | RepofForedosure | Defiency | Bureau || Cross/Up Sel Activiies

Cal Activities | Maintenance || Comments | Promises || Checkists | Tracking Atiributes || References || Comrespondence || Letters | DocumentTracking | Scenario Analysis

Transaction Batch Information dradd | Pedt || [ vew || f audt
View ~ Format~  [Ep Freeze  fiDetach frap 30} i Post  [5] veid
Date Monetary Transaction status Batch
02/09/2016 Y g
13/17/2015 v PAYOFF QUOTE POSTED N
12/17/2015 Y ADIUSTMENT TO ACH FEE - ADD oPeN N
12/15/2015 Y PAYOFF QUOTE POSTED N

Transaction Batch Information
Esaveandadd || El saveandstay | [ seve andRetun || GaRetun

Date 02/09/2016 * Transaction - Status
*Monetary [¥] Batch ¥ E

Parameters

View v Format~ B Freere Givetah | clwep | @)

Parameter Value Required

No data to display.
Result

View ~ Format~ B Fresze i Detach ol Wrap W

Transaction Processing Detais
No data to display.

To refund the payment amount

Transaction Parameters

Payment Txn Date
Refund

Payment Date

Payment Amount

A.1.19 Extensions

Extension transactions allow you to extend a Lease. An extension fee may be assessed when
an account receives an extension. In case of precomputed Lease, this is generally done to
recoup the interest lost.
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The system adjusts due date on Dues section’s Oldest Due Dt field on Account Details screen

to reflect the extension.

Summary | Customer Service  AccountDetals  CustomerDetals  TransactionHistory  PmtModes  Bankruptry RepofForedoswe  Deficency  Colatersl  Bureau  CrossiUp Sell Actvities

b Alertb " Conditions
Account Details { Other Information
Dues Colateral Information
0ot 12012015 11012015 10/01/2015 09j01/2015 Description Identification % Vear AssetClass  AssetType  SubType
0.00 0.00 0.00 0.00 0.00 ( TOYOTA CAMRY 123456 783A5DFGRTY 0 NEW VEHICLE CAR
Delg Due 0,00 Total Due 0.00 Future Pmt Dt 020012016 Cust pa—
[Chus 0,00 TodaysPayef 0.00 Oldest Due Dt 0201/2016 SRRSO
Custo
16 e 000 FutrePayoft 000 ntPadExcess 000 e Relson i BithDt Genter
Ofer e .0 FurePayoffDate 201215 % ooooon.. mecku Begy PRIVERY B T L
Definquency Information s Il |
Late 0 &0 Ll pvi] 150 180 Category Days
: : : ; ! ! § g Emal Disgbilty N Privacy Opt Out N
g s ; Lanquage ENGLISH Sip N Active Miitary Duty N
Bp(fe) 1 NF{Life) 2 Collector DEMOCOLL
. X o X et Marita Status Stop N Time Zone
B (Vear) 1 N&F{fear) 2 Comespandence
Activities
Actve Dt 12{07/2015 Aop2 0000001003 LsstemtAnt 6500000 Address Information
o . e
Last Activity Dt 01/22/2016 Paid Off Dt Charge Off Dt Tie et ;rcm\rcha“mg A e
Due Day 1 Effective Dt 01/01/2015 Miitary Duty N g
LastPat Dt 01120016 CurentPrt 313435 CstymerSere 700 t N W RMOEGREORIE. (o
[rietrmer Grada A I et il At 27 707 00 Rehauinir e N HAME v v ] ESERNDADBCHN = IS EITITFHLAS 0iN0A\RRATREY

It also notes the change with an entry on the Lease Details screen in the Extn and Due Dates
section’s # of Extensions (Year), # of Extensions (Life), # of Extension Term (Year) # of
Extension Term (Life) fields.

H]ancia\ Services Lending and Leasing
i Close
 DashBoard Customer Service @,
D auin Search  Customer Service: 0150900014283 Revien Recuest (Pending: 0)
Servicing
Senvidng Account(s): 20150900014283: RODRIGUEZ ROBINSON Even | o nuit
Custormer Service: Vewv Fomatv B [[Fee gfiDdad W @) &  (©curent(shon il D) aowFolonsp
Seauritization Company Branch Sub Unit Account # Product Days Past Due Currency Pay OffAmt Amount Due Status Oldest Due Dt
Transaction Authorization usot USHQ UNDEFINED 2015000014283 LEASE VEHICLE 114 UsD 1518.10 4,296,580 ACTIVE:DELQ 10/05/2015
Post Date Chede
Esaron Transactions Summary  Customer Service  Account Details | Customer Detals | TransactonHistory ~ PmtModes  Barkruptcy RepofForecosure  Defidency  Collteral  Bureau | Cross/Up Sell Actities
‘Account Documents
Colateral Management Account Details  Statements | RateSchedue  Insurances  Contract Information
Reports
Producers -
Account Information e | o Auit
Vendors o
Batch Transactions Ve famat~ B | [[[freae ine d | R
Advances Ebissas # of Extensions (ife) SulCimsTem) o Cuecatet=m RS S 1k ey QR St e e 2 o Due Day Change Dt TotalTem Paid Term Maturty Dt
Paments i {(ea) (tea) (F)  cemgesfes)  dunges(if)
0 0 0 0 0 0 5 1 11052016 !
Fees
Interfaces
[ Account Information
L Transactons {aketum
CASA Reconciiation
Conversion Accounts Extoand Due Dates Additional Details
#of Extensions (fear) 0 #of Due Day changes(Year) 0 TotalTerm 15
# of Extensions (Life) 0 #0fDue Day changes(Life) 0 PaidTerm 1
+ ofExtension Tem (fex) 0 Last EximDt VatrityDt 11052016
#of Extension Term (Life) 0 Due Day Change Dt
7 Collections
) WP
 Tooks
> Setup
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To apply an extension

Transaction Parameters

EXTENSION Txn Date

Extension Term

Reason

Stop Accrual

While posting an extension, ensure that the minimum number of required payments, as
defined at contract level is met. Else, system displays an error message on verification. Also
while posting subsequent extension transactions, ensure that the minimum gap requirement
between two extensions is satisfied.

To adjust an extension fee

Transaction Parameters

ADJUSTMENT TO EXTENSION FEE - ADD TXN DATE AMOUNT

ADJUSTMENT TO EXTENSION FEE - SUBTRACT TXN DATE AMOUNT

To waive an extension fee

Transaction Parameters

WAIVE EXTENSION FEE TXN DATE AMOUNT

A.1.19.1 Extension Override

You can post ‘EXTENSION OVERRIDE’ transaction when you want the system to bypass
extension validations which are defined at contract level.

Note the following:

e You can post a ‘EXTENSION OVERRIDE' transaction only if you are authorized.
e There are no validations done when an extension override transaction is posted.

e Backdating an extension is allowed and also while backdating, system validates for the
number of payments as of Transaction date.

e If ‘EXTENSION OVERRIDE' transaction is posted on a backdated transaction which
has ‘TXN Date’ appearing before the transaction extension date, then all the
transactions from the date of previous extension will be reversed and re-posted. Here
again, no validation rules are checked.
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To apply an

extension

Transaction

Parameters

EXTENSION

Txn Date

Extension Term

A.1.20 Payment Amount

You can change the current payment amount of an account. The new payment amount has
to be calculated manually as Oracle Financial Services Lending and Leasing does not

perform any checks on the new payment amount.

If the transaction is backdated, due amounts for the affected periods are re-calculated. While
delinquency data could potentially change, prior statements are not to be changed. The next
ACH (if applicable) does not reflect changed payment amount if the account has already been
billed at time of posting the transaction. Payments will be re-applied causing changes to

account balances and late fees may be assessed (if applicable).

After you post the transaction, the new payment amount appears on Account Details screen

in Current Pmt field of the Activities section.

Financial Services Lending and Leasing
o Customer Service (] gose
» Origination 4
Yew | of Audt
il Account(s) _ _ _ Elten || P4
View Fomatv & Freeze i Detach wp @ & OourentCshon al Oeroup Followsp
Serviang
Company Branch SubUnit Account # Product Days Past Due Curency Pay Off Amt Amount Due Status Oldest Due Dt
Customer Service
No data to display.
Seaitzaton
Transaction Authorzation
Summary | Customer Service | AccountDetals  Customer Detals | Transactontistory | PtModes | Berknptry | RepofForecosure | Defidency | Bureau | Crosshp Sel Achvites
Post Date Chedks
Excrow Transactions
Account Documents D Alerts 7 Conditions
Collateral Management
Reparts Account Details Other Information =
Producers
Vendors
Dues .
Batch Transactons Customer Information
Mos [ Nocta todipy. OB e Reaton s Bt Gender
Payments i 7
2 No data to display.
o5 Delg Due Total Due Future Pt Dt
Interfaces ¢ 1) '
1CDue Todays Payoff Oldest Due Dt
§F e ¥ Due FuturePayoff AmtPad Excess
6L Transactons kb e Py Emal Disgbity Privacy Opt Out
CASA Recondiation . Language Sip Active Mitzry Duty
Conversion Accounts Definquency Information Vit Status Stop Tine Zone
Late k] 60 %0 10 150 180 Category Days Correspondence
No data to display.
Bp(fe) NGF(fe) Collctor Address Information
Bliea) ter(fea), T (| by kb Phone
toCal
» Collections Activities No data to display.
S WEP Actve Dt hp# Last Pt Amt
5 Tools Last Activity Dt Paid Off Dt Charge Off Dt Employment Information
DueDay Effectve Dt iltary Duty Permissid
) Setup LastPmt Dt Customer Sere Twe  Curent o Enploger Address Phone v
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To change the payment amount

Transaction Parameters

Change Payment Amount | Txn Date

Payment Amount

Payment Auto Computer

Indicator

A.1.21 Prepayment Penalty

A prepayment penalty is typically applied automatically by Oracle Financial Services Lending
and Leasing if the account is paid off prematurely.

The following transactions allow you to adjust or waive the prepayment penalty fee. The
adjustments will appears in the corresponding column of Customer Service screen’s Account
Balances screen for FEE PREPAYMENT PENALTY Balance Type-- Waive, Adjusted (-), or
Adjusted (+) -- depending on which of the following the transactions you perform.

ORACLE’
Financial Services Lending and Leasing

S Customer Service [x]Close
> Origination search| G x 1488 quest (Pending: 0)
Servicing
senvicng Account(s): 20120100011488: GIARDANO NICHOLAS / MIRIAM ) Elven | o auit
Customer Service Viewv Fomat+ [} Freeze i Detach irap W &8 ©@curentOshow a1 eroup Folowp
Seaitzation Company franch SubUnit Account # Product Days Past Due Currency Pay OFf Ant  Amount Due Status OkdestDue Dt
Transacton Autherization usot USRL UNDEFINED 2012010001488 LEASE VEHICLE 1262 USD 905032 [I3EEACTVEDELQSCHEDUED CHGOFF (o ulngi)
Post Date Chedts
EScro TPacin Summary | Customer Service | AccountDetais | Customer Detais  Transaction History | PmtModes | Bankruptey | RepofForedosure | Deficency | Colateral | Bureau | CrossjUp Sel Activities
Account Documents
Colateral Management. Balances | Transactons | PaymentRatng | Due Date Hstory | Repayment Schedue | Work Orders
Reports
Producers i B
Sendor Balance Group Tn Period
Batch Transactions
Advances @ current Balance (©) Defciency Balance (2 on fer forming Balance (©) Terminate Balance @ 1rojcrn @)
Eaments ! View v Fomat> Freeze i Detach T 1
Fees Balance Type Opering Balance Posted Paid / Terminate Waived Charge OFF Adiusted () Adiusted (+) Balance
RS LEASE RECEIVABLE 000 10699 2,080.54 00 000 000 000 8,519.%
48 T FEE LATE CHARGE 000 094 0.00 00 000 000 0.00 .94
G Trarsactans FEENSF 000 000 0.00 00 000 000 000 0.00
CASA REctn FEE ADVANCE 000 0.00 0.00 0.00 000 000 0.00 0.00
Corversen Al FEE PHONE PAY 000 000 0.00 0.0 000 000 0.0 0.00
SALES / USAGE TAX 000 0.00 0.00 00 000 000 000 0.00
FEE DISPOSITION 000 0.00 0.00 00 000 000 0.00 0.00
FEE EXCESS USAGE 000 000 0.00 0.00 000 000 000 0.00
OTHER FEE AND TAX 000 0.00 0.00 0.0 000 000 0.00 0.00
FEE EARLY TERMINATION 000 0.00 0.00 0.0 000 000 000 0.00
* Collections TERMINATION 000 000 0.00 00 000 000 000 0.00
5 INVENTORY 000 000 0.00 0.00 000 000 000 0.00
s Current Balance Total 9,050,32
> Tools
> Setup

To adjust a prepayment penalty

Transaction Parameters

Adjustment Prepayment Penalty - Add Txn Date Amount

Adjustment Prepayment Penalty - Subtract Txn Date Amount

To waive a prepayment penalty

Transaction Parameters

Waive Prepayment Penalty Txn Date Amount

A.1.22 Escrow Payment

The following monetary transactions allow you to specify escrow payment to be billed to the
customer each month. Rescheduling an escrow payment enables you to change the payment
rate (and hence rate and term) and define when change will begin. The “txn date” parameter
is when the new agreement starts.
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A.1.23

A.1.24

The following transactions allow you to adjust or waive the escrow advance.

The adjustments will appears in the corresponding column of Customer Service screen’s
Account Balances screen for ESCROW ADVANCE Balance Type-- Waive, Adjusted (-), or
Adjusted (+) -- depending on which of the following transactions you perform.

To adjust escrow advance

Transaction

Parameters

Adjustment to escrow advance - add

Txn Date Amount

Adjustment to escrow advance - subtract

Txn Date Amount

To waive escrow advance

Transaction Parameters

Waive Escrow Advance Txn Date Amount
To reschedule an escrow payment

Transaction Parameters

Reschedule Escrow Payment Txn Date Amount

Escrow balance refund

If an account is paid off resulting in a positive (greater than $0) escrow balance or the last item
being escrowed is removed resulting in a positive (greater than $0) escrow balance, then
Oracle Financial Services Lending and Leasing refunds the escrow and creates a check

requisition.

Pay Off Quote Fee

The PAYOFF QUOTE transaction on Maintenance screen includes the required parameter
ASSESS PAYOFF QUOTE FEE. If you select Y, Oracle Financial Services Lending and Leasing
assesses a payoff quote fee on Customer Service form’s Balances screen for Balance Type
FEE PAYOFF QUOTE. The amount of the payoff quote fee is based on contract setup.

The following transactions allow you to adjust or waive the pay off quote fee.
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The adjustments will appears in the corresponding column of Customer Service form’s
Balances screen for FEE PAYOFF QUOTE Balance Type-- Waive, Adjusted (-), or Adjusted (+)
-- depending on which of the following transactions you perform.

Summary | Customer Service  AccountDetals  Customer Detals  Transaction History = PmtModes  Bankruptry | RepofForeosure  Deficency  Collateral  Bureau  CrossiUp Sel Activities

Balances I%nsachuns PaymentRating  DueDateHstory  RepaymentSchedule  Work Orders

Balance Group
Balance Group Txn Period
Q) Current Balance | Defidency Balance Non-Performing Balance () Terminate Balance ~ (@/TTD/CTD YD
View ¥ Format ¥ ﬁf Freeze ﬁj‘ Detach Wrap @E}
Balance Type Opening Balance Posted Paid Balance Waived Charge Off Adjusted () Adjusted (4) Balance
ADVANCE | PRINCIPAL 0.00 30,000.00 0.00 0.00 0.00 0.00 0.00 3000000 » L
INTEREST 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 E
FEE LATE CHARGE 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
FEENSF 0.00 0.00 0.00 0.00 0.00 0.00 0.00 000z
FEE ADVANCE 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
FEE QVER CREDIT LIMIT 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
FEE MEMBERSHIP 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
FEE PHONE PAY 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
FEEDELAY 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
EXPENSE BANKRUPTCY 0.00 0.00 0.00 0.00 0.00 0.00 0.00 000 ¥
Current Balance Total 30,000.00
Promotion and Insurance Details [Een | o Audt
View ¥ Format ¥ ET Freeze fj' Detach Wrap @ﬂ

Promotion Type Rate Term Start Dt EndDt Insurance Status Sub Type
NONE NONE 0.00 0.00 2/24f015  12/31/4000

To adjust a pay off quote fee

Transaction Parameters

Adjustment to Payoff Quote Fee - Add Txn Date Amount

Adjustment to Payoff Quote Fee - Subtract | Txn Date Amount

To waive a pay off quote fee

Transaction Parameters

Waive Payoff Quote Fee Txn Date Amount

A.1.25 Nonperforming Accounts

Lease accounts can be placed in a nonperforming, or nonaccrual, condition. Once an account
is set to a nonperforming condition, the system makes the following modifications and
accounting entries:

e After the transaction date, Oracle Financial Services Lending and Leasing assesses no
late charge to this account.

e Stops general ledger entries for interest accrual.

e Transfers the existing principal balance on this account to the Non-Performing Balance
Group on Customer Service form’s Balance screen.

e Charges the unearned dealer compensation back to the dealer.

e Treats payments posted to this account as it does with a normal account; however, the
general ledger entries for allocation of these amounts towards principal and interest will
go towards the nonperforming balance.

The system’s general ledger (GL) is set up for the above items. There will be no impact on

balances of the account (principal, interest, fee and expense) as a result of the above
transactions.
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A.1.26

A1.27

To place an account in a nonperforming condition

Transaction Parameters

Account Non Performing Txn Date

Non Performing Description

The following transaction removes nonperforming condition on an account and reverses the
nonperforming transactions explained above. General ledger entries for interest accrual,
stopped during nonaccrual stage, resume.

To reverse a nonperforming condition

Transaction Parameters

Resume Account Perform- | Txn Date
ing

Convert a Precomputed (PC) Lease into a Simple Interest (Sl) Lease

When converting a precomputed Lease into a simple interest Lease, Oracle Financial
Services Lending and Leasing assumes the following default values:

e Accrual Calculation Method - interest bearing (simple interest)
e Maturity Date - Computed from the term and next payment due date

e Monthly Payment Amount - Computed from the interest rate, new principal balance,
accrual start date, and term.

e All balances other than the Note balance are carried over to simple interest Lease.

The resulting ‘new’ simple interest Lease will have the same account number with details
entered/computed above.

Caution: The converting a precomputed Lease into a simple interest Lease transaction can
be performed only by closing the nonperforming condition.

To reschedule precomputed Lease to interest bearing Lease

Transaction Parameters

Reschedule Pre-Compute Lease to | Txn Date
Interest Bearing Lease

Reschedule Payment Start Date

Amount

Rate

Term

Account Settlement Transaction

A delinquent account can be settled when the lender agrees for a specific 'settlement amount’
with the borrower. Here the 'settlement amount' is the net amount agreed for settlement
between both the parties. If the borrower makes that payment within the 'Good through date’,
lender would consider that corresponding account is paid off / closed even if actual payment
is less than the actual outstanding balance.

Note that, system does not allow to post account settlement transaction on 'Charged Off'

accounts. Similarly when ‘Account Settlement Transaction’ is in force, system does not allow
to charge-off the account.
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A.2

To post an account settlement transaction

Transaction Parameters

ACCOUNT SETTLEMENT TXN DATE

EFFECTIVE DATE

GOOD THROUGH DATE

AGREED SETTLEMENT AMOUNT

COMMENT

Here, the transaction date can be back dated but the effective Date for the settlement need
to be the current date or a future date.

On posting the transaction successfully, the new account condition 'Account Under
Settlement' is updated with end date as 'Good Through Date'.

e On'Good Through Date' if the settlement amount is partially or not honoured, system
automatically closes the ‘Account Under Settlement’ condition posted on the account
and also remove the settlement details posted on the account.

e In case the entire settlement amount is received on or before the 'Good Through Date',
on executing the ‘Account Settlement Processing’ batch on that day, system closes the
‘Account Under Settlement’ condition. The 'Settlement Information' in Customer Service
Summary screen and Account Details screen is retained to indicate the last settlement
information that lead to the PAIDOFF status of the account.

e 'Paid Off transaction is automatically posted so that account balance will be updated as
zero.

e System ignores the Write-off Tolerance amount to post Paid-Off transaction and
outstanding balances will be waived.

The 'Settlement Information' is updated in following screens:

e Customer Service > Summary > Account Details > Settlement Information
e Customer Service > Account Details'

If required, this settlement monetary transaction can also be reversed from the 'Payment
Maintenance' screen by clicking the 'Reverse' button.

Nonmonetary Transactions

This section catalogues the transaction codes and parameters required to complete the
following nonmonetary tasks for Lease:

e Update a customer’s name

e Maintain customer details

e Mark a customer as a skipped debtor

e Mark a customer as deceased

e Change a customer’s Privacy Opt-Out indicator

e Stop correspondence

e Modify financed insurance information

e ACH Maintenance

e Reprint a statement (batch only)

e Add or stop servicing of accounts with post dated checks as a repayment method
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Stop an ACH for an account

Add ACH bank

Cancel or adjust an ESC

Apply a refund payment to an ESC
Cancel insurance (or reverse the insurance cancellation)
Add new escrow insurance details

Add new escrow tax details

Change insurance annual disbursement
Change insurance disbursement plan
Change escrow indicators of insurance
Change insurance expiration date
Change insurance maturity date
Change tax annual disbursement
Change tax disbursement plan

Change escrow indicators of tax
Resume escrow analysis

Resume escrow disbursements

Stop escrow analysis

Stop escrow disbursements

Refund or adjust insurance

Adjust Dealer Compensation

Add / Modify Account Contact References
Account Statement Preference Mode
Cure Letter Date Maintenance
Recourse Details Maintenance

A.2.1 Customer Name Maintenance

You can update and change a customer’s name.
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To update a customer’s name

Transaction Parameters

Customer Name Maintenance Txn Date

Relation Type Code

Customer First Name

Customer Middle Name

Customer Last Name

Customer Generation

Code

The new details appear throughout the system; for example, in Customer Service screen’s
Customer(s) section and Customer Details screen’s Customer section.

oRACLE
Financial Services Lending and Leasing

- Close
> Dashieanl Customer Service x El
S origination Search | Customer Service: 20151200012836 | Review Request (Pending: 0)

Servicing
p— Account(s): 20151200012836: EATHAN EATHAN [ view || < auat
Customer Service Viewv Formatv [ Freeze i Detach mp | W & @ current O showall O Group Follow-up
SN Company Branch Sub Uit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authorization usot ushg UNDEFINED 2015120001283 LEASEVEHICLE 15 UsD 38,5063 0,00 ACTIVE 01/22/2016
Post Date Checls
Escrow Transactions
Summary | Customer Sendce. | Account Details  Customer Details | Transaction History || Pt Modes | Bankwuptcy | RepojForeclosure | Deficency | Collteral || Bureau | Crossfup Sell Actviies
Account Documents
Callateral Hanagement e
Reports
Producers
Vendors Customer Information
Batch Transactions. et || B vien | o audit
Advances
Views Format v Freeze  gf{Detach Wra
Payments & Ed o @ )
Fees i Customer Relation ECOA Name. s Bith ot Varital Status Enabled Language Education ;::‘m"f' Maiden
Interfaces 0000006022 PRIMARY INDIVIDUAL EATHAN EATHA xp0c2218 12/22/1850 ¥ ENGLISH |
AP Transactions 5
6L Transactions
CASA Reconciiation
Comversion Accounts Addresses | Telecoms | Employments | Tracking Attibutes

Address Information P aid || /et | 5 view | ¥ audt

Vieww Format v [ Freeze i Detach wap @
Type Current Permission to Call ~ Confirmed Mailing Country Address = City State Postal Address Type Street Pre Street Name
HolE i v (0 ¥ UNITEDSTATES 2300 VERMO CAUFGRNIA  NORMALADDRESS  NORTH

»
" Collections

> WP

> Tools

b setup

A.2.2 Customer Details Maintenance

You can update and change the following details regarding a customer: social security

number, marital status, disability indicator, driving license number, number of dependents,
and email address.
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A.2.3

To change other details about a customer

Transaction

Parameters

Customer Maintenance

Txn Date

Relation Type Code

Customer SSN

Customer Marital Status Code

Customer Disability Indicator

Customer Driving License Number

Customer Number of Dependents

Customer Email Address 1

Customer Birth Date

Customer Gender Code

Customer Language Code

Customer Driving Licence State Code

Customer Time Zone

The new details appear throughout the system.

Skipped Customers

When a customer cannot be located, the system enables you to mark that person as “skipped”
(as in, “the person is a skipped debtor.”) Marking a customer as skipped indicates that the
customer’s whereabouts are unknown.
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A2.4

To mark a customer as “skipped”

Transaction

Parameters

Customer Skip

Txn Date

Relation Type Code

Customer Skip Indicator

The Skip box is selected on the Customer Service screen’s Customer(s) section and
Customer Details screen’s Customer section.

ORACLE'

Financial Services Lending and Leasing

 DashBoard
Origination
Servidng
Servidng
Customer Service
Securization
Transaction Authorzation
Post Date Chedss
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactons
6L Transactions
CASAReconclation
Conversion Accounts

> Collections
> WP

> Tools

> Setup

fs

Customer Service

Sunmary | Customer Service | AccountDetall | Customer Details | Transaction History || PmtModes | Bankruptey | RepofForedosure | Defidency | Bureau | Crossip Sel Actvities

Customer  Business

Customer Information

Identification Details

View v Formatv B Freeze pfiDetach @
Customer # Relation ECOA s Name:
No data to dspley.
< I
Customer Information
Customer
Customer #
Relation Passport #
ECOA Tssue Dt
Name. Expiry Dt
Birth Dt Visa #
Marital Status Nationality
Encbled _ National 1D
Language SSN
Education License #
Mother's Maiden Name License State
ClssType
Emai

Stop Correspondence _
Disabity _

Military Service

Active Mitary Duty
Effective Dt

Birth Dt

Marital Status

Enabled

Permanent US Resident Status _

Power of Attormey __

e

JEdt || Elven | o Audt

Valher's e
Language Eduation e
b
Careum I
“
e
Reference &
Staus
FaTCA
et lace
rth Counry

Pouer of Attomey

Holder Name
Address

Framtr

To remove the Skip indicator, follow the above procedure. However, you can also type N in
the CUSTOMER SKIP INDICATOR parameter.

Mark Customer as Deceased

You can mark a particular customer as deceased by posting a non-monetary transaction.
Marking a customer as deceased indicates that the 'Account holder is deceased' and this
condition is posted on the account and an Alert is populated in Comments tab and Summary
tab. Also when a particular customer is marked as deceased, you can change the permission
to call the customer as “No” on all accounts and contacts where the customer is attached.
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To mark a customer as “deceased”

Transaction Parameters

MARK CUSTOMER AS DECEASED DATE
DECEASED

TRANSACTION DATE

RELATION TYPE CODE

REMOVE PERMISSION TO CALL

ORACLE
Financial Services Lending and Leasing

> DashBoard Clesfoumcy: Sormoe x (3 Close
> Origination Account(s): 20150500010045: CHECK COMMENT DELINQUENCY Elview | o audt =
Servkn View > Formatv Freeze i Detach Wrap & @ current(®) Show All @ Group Folow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Sta
Servcng uso1 UsHQ. UNDEFINED 20150500010045  LOAN VEHICLE (FR) -51 USD 0.00 0.00 AT
Customer Service
Securitzation
Traraction Authorization Summary | Customer Service | AccountDetails | CustomerDetals | TransactionHistory = PmtModes || Barkruptcy | RepofForedosure | Defidency | Collateral | Bureau = CrossfUp sell Activi > ~
Post Date Checks

Call Activities | Maintenance | Comments || Promises | Cheddsts | Tracdng Atwbutes | Field Investigation || References || Correspondence | Letters | DocumentTradking | Scenario Analy > ~
Escrow Transactions

Account Documents

Collateral Management Transaction Batch Information e add | AEit || [HY

Reports View v Format= [Ep Freeze i Detach Wrap (5] {8t post [5Gl vod

Producers Date Monetary ‘Transaction status Batch

Vendors 222016 X " =

b e 07/13/2016 N STATEMENT PREFERENCE MODE OPEN N L
ko 07/13/2016 N EMPLOYMENT ADDRESS MAINTENANCE POSTED n i i
- E 07/08/2016 ké CHGOFF ADVANCE / PRINCIPAL POSTED n
e 07/07/2016 N REFERENCE DETALLS ADD OPEN il o

Interfaces
AR TTesdcions Transaction Batch Information
B Tramcions I saveandadd | [ saveandstay || [ saveandRetum | Cametun ‘
Conversion Accounts

o Load Parameters

Date 07/22/2016 Transaction MARK CLISTOMER AS DECEASED status
Monetary _ Batch _
Parameters
5 View > Format~ [ Freeze  [fiDetach | ol Wrap W

Gy e Parameter Value Requred
» DECEASED DATE B v
> WP

TRANSACTION DATE B v
> Tools

RELATION TYPE CODE PRIMARY [~ v
gifetup REMOVE PERMISSION TO CALL no [=] v =

You can select the ‘Deceased Date’ and ‘Transaction Date’ (last transaction date) from the
adjoining calendar. Select the ‘Relation Type Code’ and ‘Remove Permission To Call’ (as
‘Yes’) from the drop-down list.

System identifies all the related accounts based on Customer ID and marks ‘the customer
deceased date’ on all accounts (primary or joint holder) held by the customer. If the
transaction is successful, a confirmation message is displayed in the Results section
displaying all the customer accounts on which this status is posted. Also a comment is posted
on all accounts when the ‘Permission to Call’ status is changed.
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A.2.5

The Customer Deceased Date is also indicated on the Customer Details screen’s Military
Service section.

ORACLE’

Financial Services Lending and Leasing

# Welcome, OFSUUSER +  pccessiility 1 Signout O

> DashBoard

 Origination

Servicing
Senidng

Customer Service
Securitization

Post Date Checks
Escrov Transactions
Account Documents

Reparts

Producers

Vendors

Batch Transactons
Advances
Payments
Fees

Iterfaces
AP Transactions
GLTransactions
CASA Reconciliati

7 Collections
> WEP
> Tools

> Setup

Collateral Managemen!

Customer Service x

Summary | Customer Service | Account Details | Customer Details

Customer | usiness

Customer Information

Transaction Authorizat

View~ Format~ [ Freeze of Detach

Customer = Relation ECOA

0000005005 PRIMERY INDIVIDUAL

Customer Information

Customer

Customer # 0000005005
Relation PRIMARY
ECOA INDIVIDUAL

o

Conversion Account

it
Marital Status SINGLE
Enabled ¥
Language ENGLISH
Education
Wother's Maiden Nae
Class Type NORMAL
Email
Stop Correspondence
Disability__
skip_
Bankruptcy
Piivacy Opt Out —
Biisting CIF

dwer | @
Name
SHANK LINE SRIV

Transaction History | Pt Modes  Bankruptcy | RepojForeclosure | Deficiency | Collateral

ssH Birth Dt Harital Status

05412 01/10/1985 SINGLE

Identification Details

Passport
Issue Dt
Einy Dt
Visa #
Nationality

National 1D NAT-096-1087

SSH 3000065412

License #
License State

Military Service

Active Military Duty
Effective Dt
Order Ref #
Release Dt

Customer Decease Date

[®Close.
Bureau | CrossfUp Sell Activities
At || Hyien | 2 auit
Enabled Language Education Mothers Miden |1,
Name
¥ ENGLISH NORM#
»
{aRetum
e s
Reference
Status
FATCA
Birth Place
Bith County

Permanent US Resident Status

Power of Attorney

Povier of Attorney
Halder Name
Address
Country
Nationality
Telephone fumber

Privacy Opt-Out Indicator

You can change the customer’s Privacy information sharing preference (Opt-Out indicators)
along with other choice indicators of Insurance, Share Credit and Marketing preferences by
posting the following nonmonetary transaction parameter.

Transaction Code: CUS_PRIVACY_INFO

Description: CUSTOMER OPT-OUT PREFERENCES (PRIVACY OPT-OUT)
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A.2.6

To change the customer’s privacy opt-out indicators

Transaction

Parameters

Customer Privacy Info Sharing Preference

Transaction Date

Relation Type Code

Privacy Optout

Insurance Optout

Share Credit Optout

Marketing Optout

The customer’s Privacy information sharing preferences are selected on the Customer
Service screen’s Customer(s) section and Customer Details screen’s Customer section.

ORACLE

Financial Services Lending and Leasing

v g sanot O

ABSHEKAR

Close:
T Customer Service =
> Origination Customer [* share Credit Opt Out [ Customer Decease Date 05/03/2015 &b i
-~ Existing CIF
Servicing Customer # 0000001004 KyC
Servicing & Relation PRIMARY Identification Details o
Customer Service ECOA CONSUMER DECEASED —
Seauitization Name DELINQUENCY CHECK
Passport # = Rl
Transaction Authorization COMMENT @ Sls &
Post Date Checks | BrthOt 09/03/1990 By Issue Dt tol
i £ i @ FATCA
Escrow Transactions i Stani [N oD = Expiry Dt )
Account Documents Erdid v Visa £ —
Collateral Management ; l:| RIS
- Nationality USA -
S Language ENGLISH [=] ationality g =
Froducers Education UNDEFINED [+ National 1D - - 0 Permanent US Resident [F]
e Mother's Maiden Name * 55N xx0c2321 S
Batch Transactions sy e
i oo Class Type NORMAL [=] License # ik AR
Payments Emil License State [=] B
Fees * Stop Correspondence [ Power of attorney [
Interfaces = * Disabil Military Service Holder Name
PHEL, S i Active Miitary Duty _ Adress
> WFP B Effectve Dt Country =
* privacy Opt Out [ =
> Tools ' Order Ref # Nationality [=
* Insurance Opt O S
> Setup * Marketing Opt out [F] Telephone Number

To remove the customer’s Privacy information sharing preferences, follow above procedure.
However, you can also type N in the CUSTOMER STOP CORRESPONDENCE INDICATOR

parameter.

Correspondence (stopping)

You can choose at any time to stop correspondence to a customer. When you do so, the
customer will receive no correspondence of any kind from the system.
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To stop correspondence with a customer

Transaction Parameters

Customer Stop Correspondence Txn Data

Relation Type Code

Customer Stop Corr Indicator

The Stop Correspondence box is selected on the Customer Service screen’s Customer(s)
section and Customer Details screen’s Customer section.

ORACLE'
gnancia\ Services Lending and Leasing

S Dashioard Customer Service y B oose
 Origination g = = = = b
ummary | CustomerService  AccountDetals  Customer Details  Transaction History | PmtMades | Bankuptcy = Repo/Foredosure  Deficency | Bureay | CrossjUp Sel Activities
Serviing
Customer  Business
Servicing
Customer Service
Seauitization Customer Information
Transaction Authorization A Edt || 5] View || o Audt
PostDate Checks View~ Formaty [ Freese  EfiDetach wap | @
Escrow Transactions Mother's Maide
Account Documents Customer # Relation ECOA SSN Name. Birth Dt Marital Status. Enabled Language Education Nome
Collateral Management No dats to dplay
Reports < n »
Producers
Yo Customer Information
Batch Transactions =
(aketm
Advances
‘
Payments
& Customer i
o= Ldentification Details K
Interfaces
Customer #
AP Transactons Relation Passport £ Reference #
6L Transactons oA Issue Dt status
CASA Recondilition N Expiry Dt
Conversion Accounts B Visa £ FATCA
Marita Status Natiorality
Erabled Naton D Brtitacs
i i Birth Country
Sducation License # Permanent US Resident Status __
Mother's Maiden N License State
el s Power of Attorney
> Collections Class Type
Military Service
S wWEp Enai Power of Attorney _
Stop Correspondence
Disabilty _ o - Address
> Setup Sio_ BRde 2 =

To remove the Stop Correspondence indicator, follow the above procedure; However, you
can also type N in the CUSTOMER STOP CORRESPONDENCE INDICATOR parameter.

A.2.7 Financed Insurance (modifying)

You can change other insurance details entered on the INSURANCE ADDITION transaction
with nonmonetary INSURANCE DETAILS MODIFICATION transaction. The changed
insurance information can be viewed on Customer Service screen’s Insurances screen.

A-40 ORACLE



A.2.8

Note

In case any issues on existing Lease accounts, you can back port this functionality. Con-

tact your account manager.

Transaction

Parameters

Insurance Modification

Txn Date

Effective Date

Insurance Type

Policy Effective Date Com-
pany Name

Phone # 1

Extn # 1

Phone # 2

Extn # 2

Policy #

Expiration Date

Primary Beneficiary

Secondary Beneficiary

Refund Amount Received

Full Refund Received

Comment

ACH Maintenance

The ACH maintenance transaction is for updating the existing ACH Banks details and not to
define a new Ach Bank. The transaction is effective provided the ACH account no, ACH
routing no, account type are matching with the existing Ach Banks details. On successful
posting, the confirmation number will be generated.
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A.2.9

To update the existing ACH bank details

Transaction Parameters

ACH Maintenance ACH Account Number

ACH Account Type Code

ACH Payment Frequency Code

ACH

Status Code

ACH

Bank Name

ACH Bank Routing Number

ACH Default Indicator

ACH

End Date

ACH Payment Amount

ACH Payment Amount Excess

ACH

Payment Day

ACH

Start Date

Txn Date

This information appears in the ACH section of the Account Details screen.

ORACLE’
Financial Services Lending and Leasing

Customer Service x

Escrow Transactions
Account Documents
Colateral Management

DashBoard
Origination & Search  Customer Service: 2012100010579 Review Request (Pending: 0)
Servicing

P . Account(s): 20121100010579: RUSSO JIM / RENEE
Customer Service View v Format v [ Freeze g Detach Wrap 5}
Securitzation Sub Unit Account # Product
Transaction Authorization UNDEFINED 20121100010579  LEASE VEHICLE
Post Date Checks <« =

Summary = Customer Service ~ Account Details Customer Detais | Transaction History ~PmfModes | Bankruptcy  RepofForecosure  Deficency  Colateral | Bureau | C >

Reports 3 Account Detals  Statements | Rate Schedule | Insurances | Contract Information
Producers q
Vendors “
Batch Transactions Contract Information ] view
Advances Vew~ Formatv [ Freeze  fff Detach Wrap 2]
Sy Contract Dt Amt Due at Signi L i Due Day 1stPmt Dt Maturty Dt Securty Depost Contract Recvd Dt Contract Ve
o ontrax mit Due at Signing (Estmated) ue Day 1st P iaturty curity Depost Contract Recv ontract Verfy
Interfaces 11/10/2012 2,386.11 12,999.96 10.00 11/10/2012 10/10/2015 500.00 11/10/2012 12/09/2015
AP Transactions | < I 7
GL Transactions
CASA Reconciiation
Collections
Contract | Repayment | Itemizations || Trade-n | Insurances || ESC = Compensation | Subventon & Proceeds = Disbursements | Fees ACH | Coupon | PDC | Re » ~
WFP
Tools N =
ACH Information 5] vew
Setup Veww Formatv [ Freeze [ Detach wap @ -

# Welcome, VEROUTHU v Accessiity o
&
3¢ Close
[Elvew | « Audt
8 © current© show Al O Group Folow-up
Days Past Due Currency Pay Off Amt: Amount Due Status Oldest
0 UsD 0.00 0.00 PENDING

o = 3

Stop an ACH

To stop an ACH for an account

Transaction

Parameters

Stop ACH Maintenance

Txn Date

Oracle Financial Services Lending and Leasing clears the information on the ACH section of

the Account Details screen.
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A.2.10 Statement Reprinting (batch only)

You can reprint a statement of account activity by defining the starting and closing dates
included within the statement.

To reprint a statement

Transaction Parameters
Statement Reprint Mainte- Txn Date
nance

Statement Closing Date

A.2.11 Add ACH Bank

You can add a new ach bank. This enables the customer to make a single payment from more
than one bank or monthly payments from different banks. On successful posting, the
confirmation number will be generated.

Summary || Customer Service = AccountDetals —Customer Detals = TransactionHistory | PmtModes = Bankruptcy | RepojForedosure | Defidency = Colateral | Bureau = CrossfUp Sell Activiies

Call Activiies  Maintenance Comments Promises Cheddists  Tracking Attributes = References  Corespondence  Letters  DocumentTracking  Scenario Analysis

Transdttion Batch Information A | JEit || [E]vew || of Audt
View = Fomatv & Freere o Detach UG {Bheost [ vad
Date Moretary Transartion St Biatrh
| 02/05/2016 s ADJUSTMENT TO ACH FEE - ADD CPEN N |A
12/18/2015 N ADD CLSTOMER ADDRESS PHONE POSTED N =
12/18/2015 N CUSTOMER MAINTENANCE POSTED N =
1218/2015 Y ADJUSTMENT TQ ADVANCE / PRINCIPAL - ADD POSTED N
12/19/2015 Y ADJUSTMENT TO ACH FEE - ADD VoI N
Parameters
View = Fomatv G Freere  fi Detach wan i)
Parameter Value Required
No data to display.
Result
Vewv Fomatv Freee HfiDetach | ol )
Transaction Processing Detalls
Mo data to display.
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To add a new ACH bank

Transaction

Parameters

ADD ACH BANK

ACH Account Number

ACH Account Type Code

ACH Payment Frequency Code

ACH Status Code

ACH Bank Name

ACH Bank Routing Number

ACH Default Indicator

ACH End Date

ACH Payment Amount

ACH Payment Amount Excess

A.2.12 Post Dated Checks

You can add or stop servicing of accounts with PDC as a repayment method.

The POST DATED CHEQUE MAINTENANCE transaction enables you to switch an account to
the post dated check method of repayment.

To add post dated checks as a method of repayment

Transaction Parameters
Post Dated Cheque Maintenance Txn Date
PDC Type

pdc Check Number

pdc Check Date

pdc No Of Checks

pdc Check Amount

pdc Bank Routing Number

pdc Account Type

pdc Account Number

pdc Bank Name

pdc Bank Branch Name

pdc Docket Code

pdc Comments

pdc Frequency
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A.2.13

A.2.14

The STOP POST DATED CHEQUE MAINTENANCE transaction stops processing the
payments on an account using Post dated checks. Once this transaction is posted, status of
all PDCs attached to a Lease account changes to VOID, indicating that the PDCs are of no
use.

To stop post dated checks as a method of repayment

Transaction Parameters

Stop Post Dated Cheque Maintenance Txn Date

Coupon Book Maintenance (batch only)

In reordering coupon books, you will need supply the first date of new coupons, the new
coupon start number, and number of new coupons to order.

To re-order coupon book (batch only)

Transaction Parameters

Coupon Book Maintenance Txn Date

Coupon First Payment Date

Coupon Start Number Coupon Count

To cancel the coupon book re-order before it is processed in the nightly batch, choose Void.

Extended Service Contract (ESC)

You can apply, cancel, or adjust a payment to an extended service contract.
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To cancel or adjust an ESC

Transaction

Parameters

Warranty Maintenance

Txn Date

Insurance/Warranty Cancel Indicator

Insurance/Warranty Cancel Date

Insurance/Warranty Remaining Term

Insurance/Warranty Refund Amount Estimate

Insurance/Warranty Refund Amount Received

Insurance/Warranty

Full Refund Received Indicator

Insurance/Warranty Itemization Code

To apply a refund payment to an ESC

Transaction

Parameters

Warranty Payment Mainte-
nance

Txn Date

Insurance/Warranty Refund Amount Received

Insurance/Warranty

Itemization Code

Note

A Warranty Refund transaction posted or reversed on the Maintenance screen should be

matched with a payment posting or reversal.
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A.2.15 Insurance Maintenance

To cancel insurance (or reverse the insurance cancellation)

Transaction Parameters
Insurance Mainte- Txn Date
nance

Insurance/Warranty Cancel Indicator

Insurance/Warranty Cancel Date

Insurance/Warranty Remaining Term

Insurance/Warranty Refund Amount Estimate

Insurance/Warranty Refund Amount Received

Insurance/Warranty Full Refund Received Indicator

Insurance/Warranty

Iltemization Code

The above refers to the account insurance and not asset or collateral insurance. For example,
‘Credit Life and Disability’.

A.2.16 Escrow Information and Maintenance

The following nonmonetary transactions allow you to add a new tax or insurance escrow to
an account.
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To add new escrow insurance details

Transaction Parameters
New Escrow Insurance Escrow Type
Details
Escrow Sub Type
Vendor #

Escrow Required (y/n)

Escrow Opt out (y/n)

Annual Disbursement Amount

Disbursement Rule

Transaction Date

Reference Account #

Insurance Policy #

Expiration Date

Maturity Date

Coverage Type

Coverage Term

Coverage Amount

Reason

Reference
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To add new escrow tax details

Transaction

Parameters

New Escrow Tax Details

Escrow Type

Escrow Sub Type

Vendor #

Escrow Required (y/n)

Escrow Opt out (y/n)

Annual Disbursement Amount

Disbursement Rule

Transaction Date

Reference Account #

Property Tax Type

Reason

Reference

The following nonmonetary transactions allow you to update any of the escrow information
regarding an existing tax and insurance.
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To change insurance annual disbursement

Transaction

Parameters

Change Insurance Annual Disburse-

Escrow Type

ment

Escrow Sub Type

Vendor #

Transaction Date

Annual Disbursement

Amount
Reason
Reference
To change insurance disbursement plan
Transaction Parameters

Change Insurance Disbursement Plan

Escrow Type

Escrow Sub Type

Vendor #

Transaction Date

Disbursement Rule

Reason
Reference
To change escrow indicators of insurance
Transaction Parameters
Change Escrow Indicators of Insur- Escrow Type
ance
Escrow Sub Type
Vendor #

Transaction Date

Escrow Required (y/n)

Escrow Opt Out (y/n)

Reason

Reference

A-50

ORACLE



To change insurance expiration date

Transaction

Parameters

Change Insurance Expiration Date

Escrow Type

Escrow Sub Type

Vendor #

Transaction Date

Expiration Date

Reason
Reference
To change insurance maturity date
Transaction Parameters

Change Insurance Maturity Date

Escrow Type

Escrow Sub Type

Vendor #

Maturity Date

Reason
Reference
To change tax annual disbursement
Transaction Parameters

Change Tax Annual Disbursement

Escrow Type

Escrow Sub Type

Vendor #

Transaction Date

Annual Disbursement Amount

Reason

Reference
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To change tax disbursement plan

Transaction

Parameters

Change Tax Disbursement Plan

Escrow Type

Escrow Sub Type

Vendor #

Transaction Date

Disbursement Rule

Reason
Reference
To change escrow indicators of tax
Transaction Parameters

Change Escrow Indicators of
Tax

Escrow Type

Escrow Sub Type

Vendor #

Transaction Date

Escrow Required (y/n)

Escrow Opt Out (y/n)

Reason

Reference

A.2.17 Escrow Analysis Disbursements

The following nonmonetary transactions allow you to resume and stop escrow analysis and

disbursements.
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To resume escrow analysis

Transaction Parameters

Resume Escrow Analysis Transaction Date
Reason
Reference

To resume escrow disbursements

Transaction Parameters

Resume Escrow Disbursements Transaction Date

Reason
Reference
To stop escrow analysis
Transaction Parameters
Stop Escrow Analysis Transaction Date
Reason
Reference
To stop escrow disbursements
Transaction Parameters
Stop Escrow Disburse- Transaction Date
ments
Reason
Reference

A.2.18 Insurance Payment Maintenance

To refund or adjust insurance

Transaction Parameters
Insurance Payment Mainte- Txn Date
nance

Insurance/Warranty Refund Amount Received

Insurance/Warranty

Itemization Code

Insurance/Warranty For Full Refund Received

Note

The insurance refund posted or reversed on the Maintenance screen should be matched
by a payment posting or reversal.
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A.2.19 Adjust Dealer Compensation

The following two nonmonetary transactions allows you to adjust dealer compensation (add/
subtract) in servicing stage itself for ‘Upfront and Upfront Month end methods’.

Transaction

Parameters

ADJUSTMENT TO COMPENSA-
TION AMOUNT - ADD

COMPENSATION ADJUSTMENT AMOUNT

COMMENTS

Transaction

Parameters

ADJUSTMENT TO COMPENSA-
TION AMOUNT - SUBTRACT

COMPENSATION ADJUSTMENT AMOUNT

COMMENTS

A.2.20 Add/ Modify Account Contact References

The following two nonmonetary transactions allows you to either add or update contact
references associated with an account.

e REF_STATUS NEW - To add contact reference to an account
e REF_STATUS_MAINT - To modify contact reference attached to the account

Parameters to Add contract references:

Transaction

Parameters

Add contract references

TRANSACTION DATE

RELATIONSHIP TYPE CODE

NAME

COUNTRY CODE

ADDRESS 1

ADDRESS 2

ZIP CODE

CITY CODE

STATUS CODE

YEARS

MONTHS

PHONE # 1

EXTENSION PHONE # 1

PERMISION TO CALL IND #1
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Transaction Parameters

PHONE # 2

EXTENSION PHONE # 2

PERMISION TO CALL IND #2

COMMENT

Parameters to Modify contract references:

Transaction Parameters
Modify contract references TRANSACTION DATE
REFERENCE #

RELATIONSHIP TYPE CODE

NAME

COUNTRY CODE

ADDRESS 1

ADDRESS 2

ZIP CODE

CITY CODE

STATUS CODE

YEARS

MONTHS

PHONE # 1

EXTENSION PHONE # 1

PERMISION TO CALL IND #1

PHONE # 2

EXTENSION PHONE # 2

PERMISION TO CALL IND #2

COMMENT

A.2.21 Account Statement Preference Mode

You can post the following nonmonetary transactions to define the account statement
preference mode as either EMAIL or PHYSICAL.

e Transaction Code: ACC_STMT_PREFERENCE_MODE
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A.2.23

A3

e Description: STATEMENT PREFERENCE MODE

Transaction Parameters

ACCOUNT STATEMENT PREF- | TRANSACTION DATE
ERENCE MODE

STATEMENT PREFERENCE MODE

Cure Letter Date Maintenance

You can post the following nonmonetary transactions to update ‘Cure Letter’ details such as
Start and Expiry date to the corresponding account. The posted details can be viewed in
Customer Service > Account Details > Account Information tab.

e Transaction Code: CURE_LETTER_MAINT
e Description: CURE LETTER DATE MODIFY

Transaction Parameters

CURE LETTER DATE MODIFY START DATE

EXPIRY DATE

Recourse Details Maintenance

You can post the following nonmonetary transactions to change existing recourse information
such as changing recourse type preference from Partial to Full or vice versa, recourse reason,
percentage of recourse allowed or flat amount.

e Transaction Code: RECOURSE_MAINT
e Description: RECOURSE DETAILS MAINTENANCE

Transaction Parameters

RECOURSE DETAILS MAINTE- | TRANSACTION DATE
NANCE

RECOURSE TYPE

RECOURSE REASON

MAX RECOURSE %

RECOURSE AMOUNT

Processing SCRA

SCRA (Servicemembers Civil Relief Act) is a United States federal law that protects soldiers,
sailors, airmen, Marines, Coast Guardsmen, commissioned officers in the Public Health
Service and National Oceanic and Atmospheric Administration, from being sued for payment

defaults.

The system is facilitated to be compliant with these SCRA laws. The following features are
supported:
e Interest Rate Limitation, Prevention of Acceleration of Principal during Borrower's
Military Duty
e Fees, Bankruptcy & Deferment rules applicable during Military Duty by the Account
holder/Borrower
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e Reverting to pre-SCRA terms when Account holder/Borrower is OFF Military Duty
e Validations with respect to Account holder/Borrower reporting Military Duty and
e Validations with respect to Guarantor being on Military Duty.

To be compliant with the above SCRA features, you can setup;

e Transaction Posting checks

e Related configurations OFF MILITARY DUTY through a transaction which will revert to
original contractual terms for payment amount, interest rate and term.

Post the ‘OFF MILITARY DURY’ date, if payment is missed as per contracted billing
cycle, delinquency fee transaction is posted separately.

However, delinquency fees will not be applied for period of Borrower's Military duty.

Setting up Interest Rate for SCRA

You can define different interest rate which will be an input parameter for the ON ACTIVE
MILITARY DUTY transaction. The system enables you to override default rate values with the
values you define. However, if the values are not overridden, then system will pick the
transaction from system parameter TPE_SCRA_DEFAULT_INTEREST_RATE.

The system will apply lowest rate between contract and system default interest rate. However,
you can indicate to override the Rate with one entered in the transaction input parameter.

Access to the transaction and availability of the Override and Rate parameters are setup in
Transaction Codes Access Grid and Parameters, respectively.

When the transaction is under BORROWER ON ACTIVE MILITARY DUTY status, the system
facilitates setting up and validating the following:

e While posting On Military Duty transaction, provides flexibility to choose the Fee to be
applicable through Fee Assessment Access Grid, based on On Military Duty account
condition created in the account.

e You can not initiate Foreclosure / Repossession activities on active military duty
accounts.

e The monthly payment amount must not exceed the existing payment amount.

e During deferment period, enables you to define 'NO Interest to be charged' by defining
'Stop Accrual' to the 'EXTENSION transaction' for the same terms of Extension. A batch
job re-starts Interest Accrual, once the system posts comments for the same

Once the OFF MILITARY DUTY transaction is posted on account, system facilitates setting
up and validating the following:

e The contractual terms are returned once the SCRA condition is removed. That is, the
payment amount, terms, and interest rate must revert to their pre-SCRA state. Thus,
resulting in a balloon payment at the end of Lease.

e To extend On Military Duty benefits, you can perform any of the following:
— OFF Military Duty transaction must not be posted
— If already posted, OFF Military Duty transaction must be REVERSED

— Close current Military Duty by posting the OFF transaction and then opening a new
Duty period by posting the On Military Duty Transaction. Ensure not to overlap the
periods.
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Black Book Interface

The system performs collateral valuation for all the active accounts at a set frequency.
However, valuation is not performed for collaterals with account status <ACTIVE> and Asset
Status <ACTIVE> and <PRIMARY>.

The source for the above valuation is Black book or any other Collateral Evaluator agency.
These valuation details are stored for each collateral in Collateral tables. If an account has
multiple collaterals, then the valuation details must be stored for each collateral.

You can run ‘BLACK BOOK INTERFACE’ batch to perform valuation for active accounts and
active collaterals. This batch job performs the following:

e Validates for current valuation in the Black Book interface tables and gets the latest
valuation

e After getting the valuation updates the collateral valuation with source as Source setup.
e Loads Black Book values

The system date is saved as Valuation Date along with other valuation details during batch
run. Once the batch is run, black book values will load process to Oracle Valuation Section.
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Appendix B: Payment Amount Conversions

The following table contains the calculations Oracle Financial Services Lending and Leasing
uses to convert different payment frequencies (weekly, biweekly, semi monthly, and so on) to
standard monthly values for instalment accounts.

Payment Frequency:

Scheduled Monthly Income Amount:

D = Deferred

Zero fill

P = Single payment

Zero fill

W = Weekly (due every week)

Multiple by 4.33

B = Biweekly (due every two weeks)

Multiple by 2.16

E = Semi-monthly (due twice a month) | Multiple by 2
M = Monthly (due every month) As given

L = Bimonthly (due every two months) | Divide by 2
Q = Quarterly (due every three Divide by 3
months)

T = Triannually (due every four Divide by 4
months)

S = Semi-annually (due twice a year) Divide by 6
Y = Annually (due every year) Divide by 12
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Appendix C:Generic Recovery Interface (GRI)

Introduction

In general, a Generic Recovery Interface (GRI) is a platform to connect Oracle Financial
Services Lending and Leasing (OFSLL) with any third party recovery system. This integration
facilitates auto lending institutions to repossess non-performing assets and recover them
through a network of third party vendor managed systems.

Accordingly, in an integrated system a particular account in OFSLL can be assigned to a
vendor (third party) through GRI for recovery services. Depending on each stage of the
process, OFSLL triggers appropriate web service requests to create and update the details
into the third party system. Subsequently, the acknowledged details and case updates are
retrieved into the corresponding work order(s) and account(s) in OFSLL.

Also the system parameter ‘GRI_WEBSERVICE_LOG_IND’ when enabled, logs all the GRI
related web service communications between OFSLL and external interfaced system. The
same can be viewed in Dashboard > System Monitor > Database Server Log Files tab by
selecting ‘Interfaces’ view option.

Following type of web service requests are supported:

e Create Case

e Update Case

e Case Comments

e Hold Case

e Reopen Case

e Reassign Case

e Close Case

e Case Updates Received via FireHose WebService
e Case Repossession

e Case Invoice

Pre-requisites

Following are the pre-requisites while working with third party integrated system:

e Ensure that 'Cycle' setup (Setup > Vendors> Cycles tab) is defined for the Work Order,
where channel is selected as 'Generic Recovery Interface'. Also if the system is defined
to automatically post any specific conditions on account, you need to maintain the
Action and Result Code.

e Ensure that Vendor Fees (Setup > Vendors > Vendor Fees tab) defaults the 'Estimated
Amount'.

e Ensure that the Work Order Types are mapped consistently and are in sync between
OFSLL and third party system. The following table lists the Work Order Types
maintained in the system.

Work Order Type | Description

DRK DOOR KNOCK (GRI)

IR IMPOUND INVOLUNTARY REPOSSESSION (GRI)
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Work Order Type | Description

VRP VOLUNTARY REPOSSESSION (GRI)

IVR IMPOUND VOLUNTARY REPOSSESSION (GRI)
SKP SKIP TRACE (GRI)

IRP INVOLUNTARY REPOSSESSION (GRI)

e Ensure that the details of Vendors, Collectors and Service types are mapped
consistently and are in sync between OFSLL and third party system.

e Define Invoice Rules (Setup > Vendors > Invoice Rules tab) that are applicable to each
Vendor Service with appropriate Work Order Status, Close Reason, and State
combinations. This ensures that the 'Collectible’ flag is set to "Y' for selected invoice
during processing.

Create Case

Once a non-performing account is identified in OFSLL, the details are to be registered in the
third party system for further action. Using the Work Orders tab (Vendors > Work Orders tab),
you can create a work order with the identified account details and selecting the channel as
Generic Recovery Interface (GRI).

Note that, system does not allow to create a work order during the following conditions:

e If there is already a case created with the same work order type which is active on the
account. On updating the details and clicking ‘Save’, system displays an error message
as ‘Active Work Order with same Order Type already exists on account’.

e If a CURE letter is issued on an account and the same is in-force. If the case creation
date is before the cure letter expiry date, then system displays an error message as
‘Cure Letter Issued and Active. Cannot create work order’.

For information on creating a work order, refer to section Vendors > Work Orders tab.

When the 'Channel' is selected as GENERIC RECOVERY INTERFACE, the Work Orders tab
enables 'Vendor Messages' section to specify additional details that are required by the third
party vendors to act upon the case. For more information, refer to ‘Case Comments’ section.

After the work order details are created, the same needs to be registered as a case in third
party system by updating the status. Accordingly, when the Status of Work Order is selected
as 'SEND TO GRI', the 'add Case()' web service is initiated to create a case in third party

system.

ORACLE'
Financial Services Lending and Leasing

ABSHEKAR ¥ pccessbiity 1 Sgnout O

@ vendors [¥)Close
Work Order
Save and Stay. SaveandRetun || {3 Return
> DashBoard

Origination Work Order Work Order Details

Ot 12/26/2016

StatsDt 12/26/2016

Case # UNDEFINED Currency USDOLLAR

Collateral Details
Work Crder # WO:0021410

Collateral | 2005 CHEVROLET MONTECARLO 20 |
Description

el INTERNAL Estimated 100.00

Work Order IMPOUND INVOLUNTARY REPOSSESSION (GRI) Biled Amt 0.00
Type Year 2006

Paid 0,00

7 Make CHEVROLET
Reference = Model MONTECARLO
Assigned By PRITAM

Identification # 2B4GPASG IXR378252

Account 200:SMITH

nch USHQ
Followup Dt B Vendor Information

Account Information
= Account Status  ACTIVE:DELQ:BKRP:REPO Contact ME

= | Charged off Dt Phone
Due Amt 450.03

= Total Outstanding 20500.36
Balance

Total Due 5050.33 Commen! t
DueDt 02/10/2017
DaysPastDue 315

Service Address
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The 'add Case()' web service request consists of the following Case details to be registered
in third party system:

e Primary Customer

e Secondary Customer (Based on the sequence)

e Address Details

e Account Details

e Collateral Details

When the web service request is successful, the response would contain the new case
number created in third party system. The case # is then appended to the work order and the
status is changed from 'SEND TO GRI' to 'ASSIGNED'. Also a comment is posted on the
corresponding account in Customer Service > Comments tab, with the following details:

e Type = SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = [Case No]: "NEW CASE CREATED"
e Comment By = "INTERNAL"

e Comment Dt = Comment Posted date

Search | Customer Service: 20000100015971 | Review Request (Pending: 0) | Queus Assignment

Account(s): 2000 SMITH E] view || « Audit
View = Format= & Freeze EfiDetach Virap W & @ curent@ show Al © Group Follow-up
Company Branch Sub Unit Account ¥ Product Days Past Due Currency Pay Off Amt Amount Due !
uso1 USHQ SUB UNIT1 2000 LOAN WEHICLE (FR) 315 UsD 27,947.17 4,950.33!

4 m r

Summary Customer Service AccountDetails Customer Details  Transaction History ~PmtModes Bankruptcy RepofForedosure Defidency Colateral Bureau CrossUpSellAc > ™

Call Activities | Maintenance ~Comments | Promises | Cheddists = Tracking Atiributes = Field Investigation | References | Correspondence | Letters | DocumentTracking | Scenario Ar > ¥

Comments dpadd | AEdt | B vew | o Auit
View v Formatv P Freeze ot Detach Wrap @ 3¢ Delete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044297557:UPDATED ACCOUNT DETAILS ACCEPTED BY THIR... INTERMAL 12/06/2016 07:45:48 AM -
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312529:90DEMO-GRI_INTERFACE-CASE GOT REPOSSESS... INTERNAL 12/21/2016 06:55:39 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312529:90DEMO-GRI_INTERFACE-CASE WAS ACCEFTED  INTERNAL 12/21/2016 06:48:07 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE __2044312529:90DEMO-GRI_INTERFACE-ACCEFTED CASE INTERNAL 12/21/2016 05:48:07 AM
I N SYSTEM GENERATED INSOUND FROM INTERFACE  2044312529: NEW CASE CREATED INTERNAL 12/21/2016 05:59:15 AM | I
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044297557:90DEMO-GRI_INTERFACE-ACKNOWLEDGED CASE... INTERNAL 12/20/2016 10:08:05 PM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. {CORRESPONDENCE: C... INTERNAL 12/06/2016 02:03:51PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044298164:UPDATED ACCOUNT DETAILLS ACCEPTED BY THIR... INTERNAL 12/06/2016 07:45:49 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044297557:UPDATED ACCOUNT DETALLS ACCEPTED BY THIR... INTERNAL 12/06/2016 07:45:48 AM

In case of an error in the web service response received from third party system, the status
of work order is changed from 'SEND TO GRI' to 'GRI FAILED' and a comment is posted on
the corresponding account in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE
e Comment = "<<Error Message>>"

e Comment By = "INTERNAL"

e Comment Dt = Comment Posted date

Note

Error in web service response can also arise when a work order type is not mapped be-
tween the two systems and a case creation request is sent to third party system.

Update Case

Once the details of a work order has been registered as a case in third party system, there
can be subsequent updates in the details of the mapped account arising due to mismatch in
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account details, change in address, collateral and so on. These changes need to be
incrementally updated into the third party system and are done through the following web
services which are triggered when corresponding details are updated.

Web Service Type of change in mapped account

updateCaseAccountinfo() | When Account details are updated.

updateCaseAddress() When Address details are updated.

updateCaseCollateral() When Collateral details are updated.

updateCaseDebtor() When Primary Customer details are updated.

updateCaseCosigner() When Secondary Customer details are updated.

Secondary Customer can also be the next customer type
defined in the sequence.

The update web service request consists of the modified field details that are to be updated

in third party system.

ORACLE’
Financial Services Lending and Leasing

Search  Customer Service: 2000010015971 | Review Request (Pending: ) | Queue Assignment

Account(s): 20000100015971: EDWIN Elvew | o audt
View v Format~ [ Freeze i Detach Wirap W & @ curent show AlO Group Folow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt. ‘AmountDue Status Oldest Due Dt
uso1 UsHQ SUB UNITL 20000100015971  LOAN VEHICLE (FR) 338 USD 27,894.99 5,400.36 [Jogp(iRv =ReF: -0 02/10/2016

« M » -

Summary  CustomerService | AccountDetsls  CustomerDetals | Transaction History —PmtModes Barkruptcy | RepofForecosure  Defidency | Collateral | Bureau | CrossiUp Sell Activities  External Interfaces

Call Activities | Maintenance | Comments  Promises | Cheddists | Tracking Attributes || Field Investigation | References | Correspondence || Letters | Document Tracking || Scenario Analysis | Access History

Comments dradd | AEdt | Fen | o Audit
view v Formatv  Ep Freeze  EfiDetach Wrap W 38 Delete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ ADDRESS UPDATED - ADDRESS NUMBER: OLD VALUE : 745 NEW VALUE : 111ADDRESS UPDATED - ADD INTERNAL 01/13/2017 03:01:58 AM -
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044297557:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 03:01:56 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312529:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 03:01:54 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ COLLATERAL INFORMATION UPDATED - COLLATERAL TYPE: VEHICLE, PRIMARY IND: Y INTERNAL 11/23/2016 04:50:43 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ CUSTOMER UPDATED - NAME: UPDATE-1 ADD CASE-2, RELATION: PRIMARY, DATE OF BIRTH CHAN... INTERNAL 01/13/2017 03:01:24 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ CUSTOMER URDATED - NAME: COSIGNER DETAILS-1, RELATION: SPOUSE, DATE OF BIRTHCHANGED  INTERNAL 12/06/2016 02:03:51 PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044298164:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57: 11 AM I
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044287557:UPDATED ACCOUNT DETAILS ACCEFTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57:09 AM =

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312529:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57:07 AM

Customer Service 3 (3] Close

If the web service request is successful, the modified details are updated into the case in third
party system. Also a comment is posted on the corresponding account in Customer Service

> Comments tab, with the following details:

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD
PARTY INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date and time.

In case of an error in the web service response received from third party system, case details

are not updated and the following details are posted as a comment against the account.

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment="“CASE NO: <<UPDATED ACCOUNT DETAILS NOT UPDATED IN THIRD

PARTY INTERFACE>>"
e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date and time.

C-4 ORACLE




C4

Case Comments

Case comments refers to additional details provided in the 'Vendor Messages' section of
Work Orders tab that are required by the third party vendors to act upon the case.

The ‘Vendor Messages’ section can be updated after the case has been created in third party
system and serves as a communication channel between the integrated system.

'Vendor Messages' section is available in the Work Orders tab only when the 'Channel' is
selected as GENERIC RECOVERY INTERFACE and by default, the Vendor Message Type
is selected as ‘CLIENT UPDATE'.

ORACLE
Financial Services Lending and Leasing

@ vendors (3 Close:
Work Order Work Order Details =
Dt 12/26/2016 Collateral Details
S Work Order # UNDEFINED StatusDt 12/26/2016
Origination i i currency ot )
* Channel GENERIC RECOVERY INTERFACE [ Estimated 0.00 5 n:“'ﬂ‘” "
Origination - « ork O [ITERNAL Ea fentification %
SelesLead W G-1\ERIC RECOVERY INTERFACE pad 0.00 i
Smple Application Entr Moke
kin % * Account ~ Reference #
Appication Entry Model
s Company Assigned By ABSHEKAR
Funding e Folowup Dt ) Vendor Information
Applcation Retrieval e = Account Information
Scenario Analysis Override Reason Account Status Contact
Application Documents *Status NEW [=] Charged offDt el
Image Maintenance fiecson Due Amt i
Reports Total Cutstanding
Producers . iGeleci = Balance Fax
Vendors i Total Due Comment
Due Dt
Days Past Due
Service Address [=]
Vendor Messages
Vendor Msg Type | CLIENT UPDATE -
= Vendor Msg
> Servicing
* Collections
> WEP
» Tools
> Setup

Accordingly, in the ‘Vendor Messages’ section when the details of Vendor Message Type and
Vendor Message are updated for a work order, system triggers ‘addCaseUpdate()’ to update
the same details in the third party system.

An outbound comment is posted on the corresponding account in Customer Service >
Comments tab, with the following details and the update details are also captured as a record
in Work Order History tab.

e Type =SYSTEM GENERATED

e Sub Type = OUTBOUND TO INTERFACE

e Comment = “[Case No]: <<Vendor Msg Text >>"
e Comment By = “USER”
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e Comment Dt = Comment Posted date

ORACLE’ v g sgnout O
Financial Services Lending and Leasing

Vendors 3 Customer Service yx [%] Close:

Search | Customer Service: 20160900013226  Review Request (Pending: 0) | Queue Assignment

Account(s): 20160900013226: CHAKS JACY E View | o Audit
view = Format v [ Freeze i Detach Wrap B & @ curent® Show Al ©) Group Follow-up
Company Branch Sub Uit Account £ Product Days Past Due Currency Pay Off Amt Amount Due Status a
uso1 usHQ SUB UNIT1 20160800013226  LOAN VEHICLE (FR) 108 USD 51,936.86 17,405.28

Summary || Customer Service AccountDetals | Customer Detals | TransactonHistory | PmtModes  Bankruptcy | RepofForedosure | Defidency Colatersl | Bureau  Cross/Up Sell Activities | E > 7

Cal Activiies | Maintenance =~ Comments | Promises | Cheddists Tracking Attributes | Field Investigation |~ References || Correspondence  Letters  DocumentTracking  Scenario Analysis | A > ™

Comments dpadd | Fedt | Fvew | o audt
view = Format v [ Freeze i Detach Wrap W 8¢ Delet=
Alert Type Sub Type Comment. Comment By Comment Dt
| SYSTEM GENERATED OUTBOUND TO INTERFACE 2044317321:OTHER:TOYCTA CAMRY - NEW EDITION 2017 MODEL ABSHEKAR 01/27/2017 05:22:59 AM I
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/24/2017 0 1:07:20 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE 204431732 1:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERMNAL 01/13/2017 03:00:07 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:58:03 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02 A
N SYSTEM GENERATED INBOUND FROM INTERFACE 204431732 1:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERMNAL 01/13/2017 02:53:59 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:51:26 AM B

Hold Case

A particular work order or case which is already scheduled for repossession can undergo a
status change when a payment is received (either full outstanding due or partial) on the non-
performing account associated with the work order.

Also, an automatic case status change can happen on work order for an account based on
Delinquency Days. Whenever the delinquency days falls below certain number of days as
defined in system parameter “GRI_DLQ_DAYS_AUTO_STATUS_CHG” (DELINQUENCY
DAYS FOR AUTOMATIC CASE STATUS CHANGE), system auto updates the case status
as ‘PENDING ON HOLD/ON HOLD’ on running the batch job SET-GRI
(RDNDLQ_BJ_100_01-AUTOMATIC CASE STATUS CHANGE).

Accordingly, when the status of a work order is changed to ‘PENDING ON HOLD’ in Work
Orders screen, system triggers ‘holdCase()’ web service request to update the status of
corresponding mapped case in third party system. This ensures that a work order in hold
status is not processed further with third party vendor managed systems.

For information on updating the work order details, refer to section Vendors > Work Orders
tab.

ORACLE’
Financial Services Lending and Leasing

Vendors 3 [ Close
view » Format v [ Freeze  EfiDetach Wrap 2]
Override
Work Order # Case # Channel Account. Collateral Deseripton ~~ Vendor o= - Company  Branch Status Reason Work Order Type  Assigned By Reference #
WO:0021105 2044299014 GENERIC RECOVERY INTERFACE  20000... 2006 CHEVROLET MONT... 90DEMO- uso1 UsHQ ONHOLD  JCUSTOMER .. IMPOUND TNVOLU... HMACHA
WO:0021117 2044296035 GENERIC RECOVERY INTERFACE  20151... 2006 CHEVROLET MONT... S0DEMO- usol USHQ ONHOLD  CUSTOMER ... IMPOUND INVOLU... VENKAT
WO:0021122 2044299038 (GENERIC RECOVERY INTERFACE 20160... 2006 CHEVROLET MONT... S0DEMO-. uso1 usHQ ONHOLD CUSTOMER IMPOUND INVOLU... VENKAT
WO:0021106 2044299023 GENERIC RECOVERY INTERFACE 20000... 2006 CHEVROLET MONT... S0DEMO-. uso1 usHQ ONHOLD CUSTOMER IMPOUND INVOLU... HMACHA
WO:0021067 2044297345 GENERICRECOVERY INTERFACE  20000... 2006 CHEVROLET MONT... 90DEMO-.. uso1 usHQ ONHOLD  CUSTOMER ... DOOR KNOCK (GRI) HMACHA
WO:0021070 2044297557 GENERICRECOVERY INTERFACE  20000... 2006 CHEVROLET MONT... 90DEMO-.. uso1 usHQ ONHOLD  CUSTOMER ... DOOR KNOCK (GRI) HMACHA

« i r

services | Work Order History | Tracking Attributes

m

‘Work Order History 5] tiew
View  Format + H Freeze  [fiDetach Wrap 5]
¢
Viork Order # Case # Channel Account ;z!z';’:ln Vendor RD:EE;E:E Company  Branch Status Reason Work Order Type  Assigned By R
W0:0021105 2044299014  GENERICRE... 20000100013892:... 2006 CHEVROLET .. S0DEMO-RON_INT. uso1 UsHQ PENDING ONHOLD CUSTOMER .. IMPOUND INVOLU... HMACHA
WO:0021105 2044299014 GEMERIC RE... 20000100013892:... 2006 CHEVROLET ... S0DEMO-RDN_INT. uso1 USHQ (OPEN IMPOUND INVOLU... HMACHA
WO0:0021105 2044299014 GEMERIC RE... 20000100013892:... 2006 CHEVROLET ... SODEMO-RDN_INT. uso1 USHQ ASSIGNED IMPOUND INVOLU... HMACHA i
WO:0021105 UNDEFINED ~ GEMERIC RE... 20000100013892:... 2006 CHEVROLET .. SODEMO-RDN_INT. uso1 USHQ INEW IMPOUND INVOLU... HMACHA
« i v L

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED
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e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<CASE HOLD REQUEST ACCEPTED BY THIRD PARTY
INTERFACE (Reference No)>>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date.

ORACLE’
Financial Services Lending and Leasing

Customer Service x 3] Close

Search  Customer Service: 20160300018800 | Review Request (Pending: 0) | Queue Assignment

Account(s): 20160318800: FOSTER RICK [El view || « Audit
View v Formatv [ Freeze i Detach Wrap @ & © curent® show Al © Group Fallew-up
Company Branch Sub Unit Account = Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
uso1 usHQ SUBUNIT1 2016030018800  LOAN VEHICLE (FR) 50 USD 32,536.20 3,861.52 ACTIVE:DELQ 11/24/2016 |

Summary ~ Customer Service ~AccountDetails Customer Detais || Transaction History | PmtModes || Bankruptcy | RepofForedosure | Deficency | Colateral | Bureau Cross/Up Sell Activities | External Interfaces

Call Activities || Maintenance | Comments | Promises | Checists | Traddng Attributes | Field Investigation | References | Correspondence || Letters || DocumentTracking | Scenario Analysis || Access History

Comments qpadd || AEdt | [Fvew | of Audt |
View » Format v [ Freeze  [ffiDetach Wirap W 9¢ peete .
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 01/12/2017 11:19:27 PM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION1 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR1_VR JOB REQUEST ID: 21... INTERNAL 12/13/2016 12:47:35 AM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 12/06/2016 02:03:51 PM
N SYSTEM GENERATED SYSTEM GENERATED. WELCOME LETTER GENERATED. (CORRESPONDENCE: CNLNCE WEL_LTR_VR JOB REQUEST ID: 17499 INTERNAL
I N SYSTEM GENERATED INBOUND FROM INTERFACE 2044275575 : CASE HOLD ACCEPTED BY THIRD PARTY INTERFACE : INTERNAL 11/10/2016 03:00:35 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044275575:90DEMO-RDM_INTERFACE-CASE WAS ACCEFTED INTERNAL 11/10/2016 02:54:45 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044275575:90DEMO-RDN_INTERFACE-ACCEPTED CASE INTERNAL 11/10/2016 02:54:45 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044275575:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 11/10/2016 02:51:43 AM i

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work
Order is not changed.

o Alert=Y
e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment="“CASE NO: <<CASE HOLD REQUEST NOT UPDATED IN THIRD PARTY
INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date.

Reopen Case

When the status of a work order is updated from ‘ON HOLD’ to ‘RELEASED’ in Work Orders
screen, system triggers ‘reopenCase()’ web service request to update the status of
corresponding mapped case in third party system.
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This ensures that a work order in hold status is processed further with third party vendor
managed systems.

ORACLE'
Financial Services Lending and Leasing

Vendors 5. @ ose

Vendors | Assignment Alocation | Work Orders  Folow-up  Invoices I

‘Work Order
Fradd | FEdt | Evew | o Audt
View v Format~ [ Freeze  {fiDetach Wrap 5]
& wo021117
Collateral O id A:
Work Order # Case # Channel Account s Vendor e company  Branch Status Reeasor Work Order Type % Reference # Fol |2/
Description Reason By I
WO:0021117 2044299035 GENERIC RE... 20151100019817:... 2006 CHEVROLET ... SODEMO-RDN_INT. usot usH onHOLD CLS... IMPOUND INVOLUNTARY REPOSSE .. VE.
« i 0

Work Order
[ saveand stay save andRem | (aRetwn
4 Work Order Work Order Details
ot 12/01/2016 Collateral Details
Work Order # WO:0021117 Status Dt 12/01/2016
Case & 2044293035 Currency USDOLLAR Colateral Description 2006 CHEVROLET MONTECARLO 2DR
Channel GENERIC RECOVERY INTERFACE Estimated 0.00 Identification # 284GP45G DR378252
Wiork Order Type IMPOUND INVOLUNTARY REPOSSESSION (GRI) Biled Amt 0.00 Year 2006
Account 20151100013817:DON TAMPRI Paid 0.00 Make CHEVROLET
Cempany Us01 Reference # Madel MONTECARLO
S i Seszed By MENAT Vendor Information
* Vendor  GODEMO-RDN_INTERFACE - M B e
Querride Rezson Select the work order status P e L
= Status | ON HOLD [=] Account Status CLOSED:ACTIVESTTP Phone
e — e
i, DueAmt 1078.8 Exin
ReEASeD | Total Outstanding Balance -207.84 Fax
— Total Due 0 Comment

Due Dt 02/02/2017
Davs Past e 22 2

The processing update of REOPEN case request at the third party system is tracked
separately through a FIREHOSE web service scheduled at specific interval using a batch
process. For more information, refer ‘Case Updates Received via FireHose WebService’
section.

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:

e Type=SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<CASE REOPEN UPDATED IN THIRD PARTY
INTERFACE>>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date

ORACLE’ KAR y g snou
Financial Services Lending and Leasing

Vendors x| Customer Service x [ Close
View v Format= | g7 rreeze g vemn wirap GRS} @ LUENTL SNOW AN LrOUD FOIOW-Up -
Company Branch Sub Unit Account £ Praduct Days Past Due Currency Pay Off Amt Amount Due Status
uso1 usHQ SUB UNITL 0160300021035  LOAN VEHICLE (FR) 2654 USD 46,032.86 17,561.52 ACTIVE:DE

Summary  Customer Service | AccountDetails | Customer Detaiis | Transaction History | PmtModes | Bankruptcy  RepofForedosure  Deficency | Collateral | Bureau | CrossfUp Sell Activiies | E >

Call Activities | Masintenance  Comments | Promises  Checklsts | Tracking Atrbutes | Field Investigation | References | Correspondence | Letters  DocumentTracking | Scenario Analyss A >

Comments dpadd | Ledt | Fyew | o audt E
View v Format = [ Fresze  Hff Detach \Wrap W 58 Delet=
» Alert Type Sub Type Comment Comment By Comment Dt

N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044302016:CASE REOPEN UPDATED IN THIRD PARTY INTERFACE INTERNAL 12/06/2016 07:26:30 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR . INTERNAL 12/13/2016 12:48:33 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION1 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL _LTR... INTERNAL 12/13/2016 12:47:35 AM —
N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GENERATED. (CORRESPOMDENCE: CNLNCE_WEL _LTR_VR ... INTERNAL 12/06/2016 02:03:15PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044302016: NEW CASE CREATED INTERNAL 12/06/2016 07:22:53 AM

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work
Order is not changed.

e Alert=Y
e Type =SYSTEM GENERATED
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e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<CASE REOPEN REQUEST NOT UPDATED IN THIRD
PARTY INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date

Reassign Case

A particular work order or case which is already scheduled for repossession in third party
system can be reassigned to a different vendor due to delay in action, response, status
updates or any such conditions.

Accordingly, when a case is reassigned to a different vendor, the change is processed for
update in third party system depending on the current case status maintained across systems
as indicated below:

. OFSLL Work | GRI Case .
Scenario Order Status | Status Case Reassignment Update

1 Send to GRI NEW Case is assigned to new Vendor.
FROM
CLIENT
2 Open Open Existing case is closed (i.e. status is updated

as ‘PENDING REASSIGN/CLOSE’) and new
case is created and assigned to new Vendor.

Also, system automatically updates the work order status to ‘PENDING REASSIGN/CLOSE’
based on the days defined in the lookup code ‘VEN_REASSIGN_DAYS_CD (VENDOR
REASSIGNMENT DAYS CODES). If the case status is OPEN for specific number of days as
maintained in the sub code of the above lookup code, system auto updates the case status
as ‘PENDING REASSIGN/CLOSE’ on running the batch job SET-GRI (RDNVNA_BJ_100_01
- AUTOMATIC VENDOR REASSIGNMENT).

Accordingly, when a case is reassigned, system triggers ‘reassignCase()’ web service
request for reassigning the case to new vendor in third party system. Depending on the case
status, the case is either directly assigned to new vendor, or a new case is created with new
vendor by closing the existing case.

e If Case status is ‘'NEW FROM CLIENT’ in GRI, the case is reassigned to new vendor in
GRI and no New CASE is created in OFSLL.

e If Case statusis ‘OPEN’ in GRI, the case is updated to ‘Pending on Close’ status in GRI,
new case is created in OFSLL with New Case # and assigned to new Vendor.

If a new case is created in third party system due to vendor reassignment, then the web
service response will include the new case number. Subsequently, when a close confirmation
is received on the existing case as part of case status update from FIREHOSE web service
response, the work order in OFSLL is closed (status = ‘CLOSE’) and new work order is
created with new case number, new assigned vendor and previous work order account
details.

Note the following:

— New work order is created in OFSLL only if the ‘reassignCase()’ web service
response consists of new case number created in third party system.
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— If the web service response is successful but does not contain a case #, then the
case is directly assigned to new vendor in third party system.

A comment is posted on the corresponding account in Customer Service > Comments tab,
with the following details:

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = NEW CASE NO: “<<CASE REASSIGNMENT REQUEST ACCEPTED BY
THIRD PARTY INTERFACE >>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date

ORACLE
Financial Services Lending and Leasing

Vendors ¢ Customer Service yx [®] Clos=

Search  Customer Service: 20160100025071  Review Request (Pending: 0)  Queue Assignment

Account(s): 20160100025071: JENA PRITAM Elview | o Audit
View ~ Format v [Ep Freeze i Detach Wrap ® & @ curent® Show Al ) Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status =
Us01 UsHQ SUB UNIT1 20160100025071  LOAN VEHICLE (FR) 349 USD 15,748.99 5,400.36
<l _ 11 — — »
Summary = Customer Service | AccountDetsils ~Customer Detsils | Transaction History | PmtModes  Bankruptcy | RepojForedosure | Defidency | Colateral | Bureau  Cross/Up Sel Acthities | E > ¥

Call Activities ~ Maintenance = Comments  Promises  Cheddists | Tracking Attrbutes | Field Investigation = References = Correspondence | Letters  DocumentTracking | Scenario Analysis = A > 7

Comments dpadd | AZEdt | [Fuew | o At
View v Format~  [Ep Fresze i Detach \rap ) 8¢ Delete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/24/2017 01:06:33 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:59:12 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/13/2017 02:50:25 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/08/2017 09:45:22 PM
N SYSTEM GENERATED INBOUND FROM INTERFACE _ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/02/2017 12:23:35 AM
| B SYSTEM GENERATED INBOUND FROM INTERFACE | =

IGNMENT IN PROGRESS

INTERNAL 12/29/2016 04:4;

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account and the work status is not updated nor
a new work order is created with new assigned vendor.

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = CASE NO: “<<CASE REASSIGNMENT REQUEST NOT UPDATED IN
THIRD PARTY INTERFACE >>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date

C.8 Close Case

A particular work order or case which is already scheduled for repossession can be closed
after validating the preceding status and subsequently a repossession may not be required
on the account mapped to the work order.

Accordingly, when the status of a work order is changed to ‘PENDING CLOSE’ in Work
Orders screen, system triggers ‘closeCase()’ web service request to update the status of
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corresponding mapped case in third party system. This ensures that the work order is not
processed further with third party vendor managed systems.

ORACLE’ e AR ity 1§ Ssmout ©
Financial Services Lending and Leasing

Vendors 5 (3] Close
Work Order =
dpadd | ZEdt | Guew | o Audt
view = Format v (57 Freeze i Detach Wrap o]
Work Order # Case % channel Account i vendor QUM oy Branch Status Reasor Work Order Type  Assigned By Reference #
Description Reason
WO:0021175 2044302017 GENERIC RE... 20160300021051:... 2006 CHEVROLET ... SODEMO-RDN_INT. uso1 UsH cLose CUS... IMPOUND INVOLLL... HMACHA

< I »

b  Services  Work Order History | Tracking Attributes

I

Work Order History [E] view
View v Format v E Freeze (i Detach Wrap 5]
&
Work Order # Case = Channel Account EZ!Z‘E:;” Vendor S::;Z:E Company  Branch Status Reason Work Order Type  Assigned By R
WO:0021175 2044302017 GENERIC RE... 20150300021051:... 2006 CHEVROLET ... 9ODEMO-RDN_INT. usot UsHQ PENDING CLOSE | CUSTOMER ... IMPOUND INVOLUL... HMACHA
WO:0021175 2044302017  GENERICRE... 20160300021051:... 2006 CHEVROLET ... S0DEMO-RDN_INT. Uso1 UsHQ CPEN IMPOUND INVOLU... HMACHA
WO:0021175 2044302017  GENERICRE... 20160300021051:... 2006 CHEVROLET ... S0DEMO-RDN_INT. uso1 usHQ ASSIGNED IMPOUND INVOLU... HMACHA
WO:0021175 UNDEFINED  GENERIC RE... 20160300021051:... 2006 CHEVROLET ... 90DEMO-RDN_INT. uso1 UsHQ NEW IMPOUND INVOLU... HMACHA

q] M »

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:

e Alert=N
e Type =SYSTEM GENERATED
INBOUND FROM INTERFACE

e Comment = CASE NO: “<<CASE CLOSE REQUEST ACCEPTED BY THIRD PARTY
INTERFACE >>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date

ORACLE’ -
Financial Services Lending and Leasing

e Sub Type

‘Customer Service [ Close

Search | Customer Service: 20160300018545 | Review Request (Pending: 0) | Queue Assignment

Account(s): 20160300018545: FOSTER B view || o Audit
View = Format~ B Freeze  f Detach Wrap M & @ curentO show AllD Group Follow-up
Company Branch Sub Uit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
uso1 UsHQ SUB UNITL 20160300018545  LOAN VEHICLE (FR) 264 USD 46,345.17 17,561.52 ACTIVEDELQ 04/24/2016
bl m T =|

Summary || Customer Service || Account Details | Customer Details | Transaction History | PmtModes Bankruptcy | RepofForecosure | Defidency | Collateral | Bureau  Cross/Up Sell Activities || External Interfaces

Cal Activities | Maintenance =~ Comments | Promises | Cheddists | Tracking Attributes | Field Investigation | References  Comespondence | Letters | DocumentTracking = Scenario Analysis | Access History

Comments dpadd | Zedt || Elven || o audt
View v Format v B Freeze  fiDetach wirap W 3¢ Delet=

Alert. Type Sub Type Comment Commenit By Comment Dt

N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNGE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 01/12/2017 11:19:27PM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR._VR JOB REQUEST ID: 2... INTERNAL 12/06/2016 02:03:5LPM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED, (CORRESPONDENCE: CMLNCE_COL_LTR2 VR JOB REQUEST ID: 15... INTERNAL 11/23/2016 05:06:53 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION3 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL LTR3 VR JOB REQUEST ID: 15... INTERNAL 11/23/2016 04:50:43 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE INTERNAL 11/03/3016 10:44:48 PM
N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GENERATED, (CORRESPONDENCE: CNLNCE_WEL I TR_VR JOB REQUEST ID; 17330)  INTERNAL 11/08/2016 08:27:10 FM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044274356: NEW/ CASE CREATED INTERNAL 11/09/2016 03:15:10 PM

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work
Order is not changed.

o Alert=Y
e Type=SYSTEM GENERATED
INBOUND FROM INTERFACE

e Comment = CASE NO: “<<CASE CLOSE REQUEST NOT UPDATED IN THIRD
PARTY INTERFACE >>”

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date

e Sub Type
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Case Updates Received via FireHose WebService

Retrieving case status updates from the third party system is through a FIREHOSE web
service response received into OFSLL through a pull service. Each response is channelled
through an individual Event ID and Event Type.

A FIREHOSE web service 'getGriFireHose' - scheduled at specific interval using batch
(GRIFRH_BJ_100_01) retrieves the case updates. This response consists of case activities
recorded in third party system between specific intervals (based on Max event ID).

Note that, the FIREHOSE web service response always contains specific Event Type Code
from the third party system which are updated in the database and inturn is validated for
appropriate action in OFSLL. The table below indicates the list of Event Type and the
corresponding action updated in the system.

Event Event Description Action

Type

600 ACCEPTED CASE Change Work order status to “OPEN”

601 DECLINED CASE Change Work order status to “DECLINED”

602 ACKNOWLEDGED Change Work order status to “CLOSE”

CLOSE
603 ACKNOWLEDGED Change Work order status to “ON HOLD”
HOLD

300 CASE WAS REPOED Change Work order status to “REPOSSESSED”
And
Trigger “getRepossessionDetails()” web service to
get repossession details and update in Servicing >
Repo/Foreclosure” tab.

302 CASE COMPLETED Change Work order status to “COMPLETED”

200 FIRST UPDATE ADDED | Post the received update as “Inbound Comment”

CUSTOM from Interface in Servicing >Customer Service
>Comments tab.

201 UPDATE EDITED Post the received update as “Inbound Comment”
from Interface in Servicing >Customer Service
>Comments tab.

203 UPDATE UNHIDDEN Post the received update as “Inbound Comment”
from Interface in Servicing >Customer Service
>Comments tab.

811 INVOICE SENT TO CLI- | Call the “getCaselnvoiceData()” web service and

ENT create the invoices in OFSLL.

1300 CR ADDED Update ‘Condition Report Status =Y’ and Condition

Report Recd Dt = Event Received Date

Based on the web service response received from third party system, the status updates are
posted onto corresponding work order(s) and account(s) in OFSLL.
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For example, if the FIREHOSE web service response consists of the Event Type ‘600’, it
indicates that the case is accepted by the assigned vendor in third party system and status of
the work order is to be updated to ‘OPEN’ in OFSLL. Also a comment is posted on the

corresponding account in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = "[Case No]: <<[Vendor] ACCEPTED CASE>>"
e Comment By = "INTERNAL"

e Comment Dt = Comment Posted date and time

Note

Work order status change is permitted only if the previous status matches with the defined
cycle setup (Setup > Products > Cycles). Else, update is not allowed and comment is post-
ed on the account with the message ‘Work Order Status Update failed due to mismatch of

previous status’.

Case Repossession

When a case has been repossessed, the status of the case is updated by the assigned vendor
in third party system. The case status is then retrieved through a FIREHOSE web service
scheduled at specific interval using a batch process.

On receiving the case status update as ‘REPOSSESSED’ (i.e. Event Type 300) from
FIREHOSE web service response, system triggers ‘getRepossessionDetails() web service
request to fetch the repossession details and update the status of corresponding mapped
work order and account in OFSLL.

If the web service request is successful and repossession details are received as part of the
response, the status of the work order is updated in Work Orders tab and a comment is posted
on the corresponding account in Customer Service > Comments tab, with the following
details:

e Type=SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “[Case No]: <<[Vendor]: REPO DETAILS RECEIVED FROM THIRD
PARTY INTERFACE >>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date and time

ORACLE"
Financial Services Lending and Leasing

[T e trymer Service x [ Cose
Search | Customer Service: 2016060001 Review Request {Pending: 0) | Queue Assignment =l
Account(s): 2016060001: COSIGNER Elview || o Audit
View ¥ Format~ [y Freeze i Detach Wrap W & @ curent© Show Al O Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status OldestDue Dt
uso1 usHQ SUBUNITL 20160600018906  LOAN VEHICLE (FR) 170 USD 102,758.36 51,382.92 ACTIVEDELQ 07/27/2016

Summary || Customer Service | Account Details | Customer Details | Transaction History | PmtModes | Bankruptcy ~RepofForedosure | Defidency | Colateral | Bureau = CrossfUp Sell Activities | External Interfaces

Call Activities || Maintenance | Comments | Promises | Cheddists | Tracking Attributes || Field Investigaion | References | Correspondence || Letters | Document Tracking | Scenario Analysis | Access History

Comments dpadd || AEdit || [F view || o Audt
View v Fomat~  Ep Freeze i Detach Wrap M 38 ekt

Alert Type Sub Type Comment ‘Comment By Comment Dt
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR _VR JOB REQUEST ID: 25332) INTERNAL 01/12f2017 11:19:27PM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR _VR JOB REQUEST ID: 20948) INTERNAL 12/06/2016 02:03:51PM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR2_VR JOB REQUEST ID: 18920) INTERNAL 11/232016 05:06:53 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION3 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR3_VR JOB REQUEST ID: 18506) INTERNAL 11/23/2016 04:50:43 AM
N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GENERATED. (CORRESPOMNDENCE: CNLNCE_WEL _LTR_VR JOB REQUEST ID: 17499) INTERNAL 11/10/2016 02:02:51PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044275584: GRI_INTERFACE:REPOSESSION DETAILS FROM GRL UPDATED INTERNAL 11/10/2016 05:02:30 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-CASE GOT REPOSSESSED INTERNAL 11/10/2016 05:02:25 AM “«
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-AGENT UPDATED LICENSE PLATE FROM UNDEFINED TO 123456 INTERNAL 11/10/2016 05:02:25 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584: 90DEMO-RDN_INTERFACE-ACCEPTED CASE INTERNAL 11/10/2016 04:53:19 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-CASE WAS ACCEPTED INTERNAL 11/10/2016 04:53:19 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE 2044275584 NEW CASE CREATED INTERNAL 11/10/2016 04:51:00 AM =
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The Repossession details are also updated in Repo/Foreclosure tab of Customer Service

screen.

ORACLE"
Financial Services Lending and Leasing

3 Oose

Customer Service ¢ Customer Service x

Search | Customer Service: 2016060001 Review Reguest (Pending: 0) | Queue Assignment

Account(s): 2016060001: COSIGNER Elvew || o audit
View v Formatv & Freeze & Detach Wrap B & © Curent® Show Al O Group Folow-up
Company Branch Sub Unit Account = product Days Past Due Currency Pay Off amt Amount Due Status Cldest Due Dt
uso1 usHg SUB UNITL 20160600018906  LOAN VEHICLE {FR) 170 usD 102,758.36 51,382.92 ACTVEDELQ 07/27/2016

Summary || Customer Service || Account Details || Customer Detals || Transaction History || Pt Modes | Bankuptcy | RepofForeclosure | Deficency || Colateral || Bureau || Cross/Up Sell Activities || Extemal Interfaces

Repossession  Anslyss

Repossession Details: 2B4GP45G1XR378254 dadd | Pedt || Elven || o audt L
view v Formatv [ Freeze ifiDetach Wrap o
Current FolowupDt  Work Order Type  Collateral Disposition File Received Dt Repo Dt RepoEndDt  Comment
¥ ¥ 12/31/4000 INVOLUNTARY 2010 VOLVO AMD007 NEWLY RECEIVED
Repossession Details
(aRetum
Current ¥ File Received Dt
Followup Dt 12/31/4000 Repo Dt i

Work Order Type  INVOLUNTARY Repo End Dt
Collateral 2010 VOLVO AMDOO7 Comment

Disposition NEWLY RECEIVED

Case Repo Details

Phone {123)-333-4444
Fax (333)-444-5555

Iz Drivable ¥
Personal Items HGIHG]

Case 2044275584 Storage Location Space 12123123
Vendor Work IMPOUND VOLUNTARY REPOSSESSION (GRI)
Order Type

Identification 2B4GP4SGIXR378254

Storage Days 0 Storage Location
Transport Release Date 11/09/2016

Delivered Released To 0

Repo Location
Address 999 SESAME ST

Country UNITED STATES

Vehice Color RED

Condition Report Status _ Address ADD 1

C.11 Case Invoice

When a case has been repossessed, an invoice with the actual cost incurred for repossession
and the details of the asset repossessed are updated in the third party system by the assigned
vendor.

Subsequently, when the case status update is received as ‘REPOSSESSED’ (i.e. Event Type
300) from FIREHOSE web service response, system triggers ‘getCaselnvoiceData()’ web
service request to retrieve the invoice and asset details from the third party system.
ORACLE’

g sgnout &

Financial Services Lending and Leasing
Vendors x [ Close
Work Order
[ save and stay, saveandRetun || (3Return
Work Order Work Order Details
Dt 12/22/2016 Collateral Details
Work Order # W0:0021380 StatusDt 12/22/2016
Case # 2044312777 Currency US DOLLAR Collateral Description 2006 CHEVROLET MONTECARLO 2DR
Channel GENERIC RECOVERY INTERFACE Estimated 0.00 Identification # 2B4GP45G1XR 378252
Work Order Type  IMPOUND INVOLUNTARY REPOSSESSION (GRI) Billed Amt 0.00 R L
b Account  20150100011187: paid 0.00 Make  CHEVROLET 1
Company USO1 Reference # Model MONTECARLO
Branch USHQ Assigned By VENKAT N
# Vendor Information
Vendor 90DEMO_INTERFACE Followup Dt
Override Reason Account Information T I——
. e ontac 1
L ——— Account Status  ACTIVE:DELQ:BKRP:REPO oo
g Charged off Dt
sason e
Collector Due Amt 450.03 =
Total Cutstanding Balance 15834.6
Totsl Due 5625.36 e
DueDt 03/10/2017 -

If the web service request is successful and repossession details are received as part of the
response, the details are updated in Vendors > Invoices tab and a comment is posted on the
corresponding account in Customer Service > Comments tab, with the following details:

e Type = SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = “[Case No]: <<[Vendor]: INVOICE RECEIVED FROM THIRD PARTY
INTERFACE >>”

e Comment By = “INTERNAL”
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e Comment Dt = Comment Posted date and time

ORACLE’
Financial Services Lending and Leasing

Vendors Customer Service 5 [3€] Close

Search  Customer Service: 2016010001187 | Review Request (Pending: 0) | Queue Assignment

Account(s): 20160100011187: Elyen | o Audit
view v Format~  [5p Fresze i Detach Wirap W & © curent® show Al Group Follow-up i
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status
uso1 UsHQ SUB UNIT1 2016010001187  LOAN VEHICLE (FR) 343 USD 15,809.54

Summary | Customer Service | AccountDetals Customer Detals | Transaction History | PmtModes Bankruptcy RepofForedosure  Defidency | Collateral | Bureau | CrossfUp Sell Activies | E > ¥

Cal Activities  Maintenance Comments Promises Checkists | Tracking Attrbutes  Field Investigation  References | Correspondence  Letters DocumentTracking = Scenario Analysis A > ~

Comments qpadd | FEdt | [SJven | o Audt
view v Format~ [y Freeze i Detach Wirap W 3¢ Delete

Alert Type Sub Type Comment Comment By Comment Dt

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:90DEMO-GRI_INTERFACE:INVOICE RECEIVED FROM THIRD PA... INTERNAL 12/22/2016 03:37:12 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:90DEMO-GRI_INTERFACE-ORACLE ONE HAS APPROVED THE IN... INTERNAL 12/22/2016 03:37:10 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:90DEMO-GRI_INTERFACE-INVOICE CREATED IN THIRD PARTY ... INTERNAL 12/22/2016 03:37:10 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312777:90DEMO-GRI_INTERFACE:REPOSESSICN DETAILS FROM GRIU... INTERNAL 12/23/2016 03:30:53 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:0DEMO-GRI_INTERFACE-CASE GOT REPOSSESSED INTERNAL 12/22/2016 03:30:51 AM -

The details of the invoice in the web service response are captured in Vendors > Invoice
Information tab with invoice details and Payment Schedule. By default, the status of the
invoice is ‘OPEN’ to update the payment details.

ORACLE’
Financial Services Lending and Leasing

Vendors x [®]close

Vendors | Assignment Allocation | Work Orders | Follow-up | Invoices

Invoice Information o Add | ZEdt || [E]Vew || o Audit
View Options AL [=
View = Format v |E5g| Freeze i Detach Wrap o) Validate Invoice
¢ & ®
Vendor Company Branch Invoice # ExternalRef=  Invoice Dt Due Dt Status Channel
S0DEMO-RDN_INTERFACE usot UsHQ 3851 23086216 12/22/2016 12/22/2016 aose GENERIC RECOVE
S0DEMO-RDN_INTERFACE uso1 UsHQ £} 23066207 12/21/2016 12/21/2016 OPEN GENERIC RECOVE

Invoice Information

Gakewm | [
Invoice Dt 12/22/2016 Currency USDOLLAR
B Invoice Due Dt 12/22/2016 Estmated 122,00
Status CLOSE Invoice Amt 122,00
Vendor GODEMO-RDN_INTERFACE Agreed Amt 122,00
Company US01 Details Paid Amt 122.00
Branch USHQ Channel GENERIC RECOVERY INTERFACE
Inveice = 3651 Status Dt 12/22/2016
External Ref # 23066216 Address ADD12 ADD13 REDDING, CA 96001
Details | Tracking Attributes
Invoice Details [Elvew || o auit
view v Format+ [} Freeze gt Detach ] wirap o)
Viork Order # Estimated Invoice Amt Agreed Amt Paid Amt Txn Post Dt Status Status Dt Authorized By Authorized Dt Colectble
WO:0021380 2016010001187 2738 10.00 10.00 10.00 10.00 12/22/2016 close 12/22/2016 N
WO:0021380 2016010001187 2798 100.00 100.00 100.00 100.00 12/22{2016 CLose 12/22/2016 ¥
WO:0021380 20160 100011187 2798... 12.00 12.00 12.00 12,00 12/22/2016 CLOSE 12/22/2016 N

Payment Schedule  Relat=d Tnvoice Work Orders

System auto validates the invoice details which are received from third party system with
specific business rules before creating a record in the Invoice Information tab. Hence the
‘Validate Invoice’ button in the Information tab is disabled for invoice records from external
channel (Generic Recovery Interface) and the details are marked as view only.

For more information on business rules and working with Invoices tab, refer to ‘Vendors’
chapter.
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